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1. Acerca de este documento

1.1 Información sobre la versión
En este documento se explica cómo usar los productos de radar IRIS.

Tabla 1 Versiones del documento (en inglés)

Código del do-
cumento

Fecha Descripción

M211319EN-J Abril de 2023 Novena versión. IRIS 10.0.0

M211319EN-H Abril de 2021 Octava versión. IRIS 9.1.0.

M211319EN-G Noviembre de
2017

Séptima versión.

1.2 Documentos relacionados
Tabla 2 Documentación del radar meteorológico de Vaisala

Código del documento Nombre

M211315EN IRIS and RDA Software Installation Guide

M211316EN IRIS and RDA Utilities Guide

M211317EN IRIS Radar User Guide

M211318EN IRIS Programming Guide

M211319EN IRIS Product and Display Guide

DOC236879 IRIS RDA Release Notes

M212604EN RVP10 Digital Receiver and Signal Processor User Guide

M211320EN Radar Control Processor RCP8 User Guide

M211849EN IRIS Focus User Guide

M211850EN IRIS Focus Administrator Guide

M211904EN IRIS Focus Release Notes

Vaisala lo anima a enviar sus comentarios o correcciones a helpdesk@vaisala.com.

Capítulo 1 – Acerca de este documento

RESTRINGIDO 13

mailto:helpdesk@vaisala.com


1.3 Convenciones de la documentación

Las advertencias avisan de un peligro grave. En este punto es
fundamental leer y seguir las instrucciones cuidadosamente dado que existe el riesgo
de lesiones o incluso de muerte.

ADVERTENCIA!

Las precauciones advierten de un posible peligro. Si no lee y sigue
las instrucciones atentamente, el producto se puede dañar o se pueden perder datos
importantes.

PRECAUCIONES!

Las notas destacan información importante sobre el uso del producto.

Las sugerencias ofrecen información sobre cómo usar el producto de manera más eficaz.

En esta sección se enumeran las herramientas necesarias para realizar la tarea.

Este símbolo indica que deberá tomar notas mientras lleve a cabo la tarea.

Producto y visualización del IRIS Guía de usuario M211319ES-J
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2. Descripción general del pro-
ducto IRIS

IRIS brinda funciones requeridas para la operación de una red de radares meteorológicos y
la distribución de productos de radar, incluidos control de radar local y remoto,
procesamiento de señales, generación de productos y visualización.

En las siguientes tablas, se ofrece una descripción general de los productos compatibles con
IRIS. Los productos opcionales requieren una licencia adicional.

Tabla 3 Productos IRIS

Producto Descripción

BASE

Base de eco

BASE se usa para determinar la base de los ecos.

BEAM1)

Patrón de haz de antena

BEAM es una imagen de formato transversal de tamaño de pantalla com-
pleta que muestra la intensidad promediada por rango en coordenadas
de acimut y elevación.

BEAM se usa durante la calibración y alineación y para verificar los patro-
nes de la antena.

CAPPI

PPI de altitud constante

CAPPI es un corte horizontal de una altitud seleccionada usada para la
vigilancia y la identificación de tormentas fuertes.

Es útil para el monitoreo del clima a niveles de vuelo específicos para
aplicaciones de tráfico aéreo.

FCAST1)

Pronóstico

FCAST es una matriz de vectores de dirección e intensidad utilizada para
alternar interactivamente la visualización del clima actual.

GAGE1) El producto GAGE almacena informes de los sensores del pluviómetro
para mostrar y usar en la generación de productos. Estos productos se
generan utilizando un canal de entrada de los datos enviados por un sis-
tema de estación meteorológica.

Debido a que los productos GAGE no son generados a partir de los datos
del radar, no es necesario configurarlos ni programarlos.

HMAX

Producto de altura de intensidad
máxima

HMAX muestra la altura de los datos máximos por encima de cada píxel
de salida.

Este producto requiere una exploración del volumen.

LAYER1) LAYER puede calcular los promedios de la capa de cualquier tipo de da-
tos polares de los archivos de introducción.

LAYER también puede convertir a líquido primero y calcular la VIL
Density. Cuando calcula la VIL Density, la salida está en g/m**3.

Relámpagos IRIS puede importar datos de relámpagos desde una red de detección de
relámpagos dedicada de Vaisala o desde el Sistema global de detección
de relámpagos GLD360.

MAX

Datos máximos

MAX muestra los datos máximos de cada píxel además de los proyectos
máximos Este-Oeste y Norte-Sur en los paneles laterales.
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Producto Descripción

MLHGT1)

Altura del nivel de derretimiento

MLHGT muestra un mapa de las altitudes de la capa de derretimiento.

PPI

indicador de posición en plano

PPI es una imagen de pantalla completa que se usa principalmente para
fines de vigilancia meteorológica.

RAIN11)

acumulación de lluvia por hora

RAIN1 es la acumulación de pluviosidad por hora.

RAINN1)

Acumulación de lluvia en N horas

RAINN es la acumulación de pluviosidad de las últimas N horas, donde N
es un valor seleccionado por el usuario.

RAW

Producto de datos sin procesar

Un archivo de datos RAW contiene los parámetros de salida del procesa-
dor de señales sin procesar (Z, ZT, V, W, ZDR y así sucesivamente) en
coordenadas polares.

Un archivo RAW contiene toda la información recogida durante una tarea
de medición. Se comprime para se pueda enviar a través de la red a
IRIS Analysis.

Si bien los datos RAW no se pueden visualizar, es útil para registrar en
cinta, disco o DVD, o para transferir a otra computadora de la red de IRIS
para la generación de productos.

RTI1)

indicador del tiempo del rango

RTI muestra el tiempo a lo largo del rango de visualización en ejes hori-
zontal y vertical del radar.

Se usa con frecuencia para exploraciones manuales cuando se observa
un objetivo duro.

RHI1)

indicador de altura del rango

RHI es una imagen de pantalla completa que muestra la estructura trans-
versal detallada de una tormenta; se usa para identificar tormentas seve-
ras, granizo y banda brillante.

SRI1)

Intensidad de pluviosidad en su-
perficie

SRI brinda una entrada para el producto RAIN1 para obtener las mejores
estimaciones posibles de la precipitación acumulada, incluso en rangos
más largos del radar.

STAT

Estado del sistema del radar

Un archivo STAT contiene un informe que indica el estado de todos los
componentes clave del software del radar.

THICK

Espesor de eco

THICK muestra el espesor de los ecos de nubes.

THICK es igual a la diferencia entre los valores TOPS y BASE.

El producto THICK también calcula la reflectividad promedio dentro de
la capa identificada por el dBZ Contour seleccionado.

TOPS

Mapa de superiores de eco

TOPS es un mapa de contornos codificado con colores de la parte supe-
rior de un nivel de dBZ seleccionado.

Se puede usar Z o ZT como base para la estimación.

TRACK1)

Seguimiento y pronóstico interacti-
vos de tormentas

Los productos TRACK muestran el movimiento proyectado para funcio-
nes de tormenta (centroides) basado en una serie de productos de en-
trada de diferentes horas.

TRACK es un producto de superposición creado en la Quick Look 
Window.
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Producto Descripción

VAD1)

pantalla del acimut de velocidad

VAD es una visualización de la velocidad de Doppler media en un rango
dado como una función del ángulo de acimut a medida que la antena del
radar rota a través de una exploración de acimut a elevación constante.

VIL1)

líquido integrado de forma vertical

VIL es un mapa con código de color de la profundidad estimada de agua
(en mm) contenida en una capa atmosférica seleccionable. Es un indica-
dor excelente de tormentas severas.

Se puede usar Z o ZT como base para la estimación.

VVP1)

Procesamiento de volumen de ve-
locidad

VVP proporciona gráficos de línea o secciones transversales de tiempo
contra altura de la velocidad del viento, dirección del viento y divergen-
cia contra altura.

Puede seleccionar el rango de influencia y la altura máxima.

WARN

Advertencia/Centroide

WARN es alerta automática y trazado de centroide.

Se pueden establecer alertas automáticas para áreas de interés y crite-
rios de advertencia seleccionables para el usuario.

La salida es un mensaje de alerta y una superposición de situación que
muestra las ubicaciones de centroides de características de tormenta,
como VIL o reflectividad altas.

WIND1)

dirección y velocidad del viento

WIND muestra velocidad y dirección del viento con lengüetas o cadenas
de viento.

Puede especificar el rango y la altura de los datos, y el rango y el espa-
ciado de acimut de las líneas que se muestran.

XSECT

Sección transversal

XSECT es un producto de exploración de volumen que muestra la sec-
ción transversal de altura junto con una línea definible por el usuario.

1) Producto disponible a pedido en IRIS Analysis

Tabla 4 Productos IRIS opcionales

Producto Descripción

CATCH 1)

Sección transversal

CATCH calcula la acumulación de precipitación en áreas de captación,
como cuencas.

Este producto requiere la opción Hydromet.

COMP

Compuesto de múltiples sitios del
radar

COMP produce una imagen compuesta única de los datos del radar de
varios sitios de radar.

DWELL1)

Compuesto en el tiempo

DWELL consta de un producto e imágenes sucesivas de compuestos de
un producto en el tiempo. Los objetivos móviles se muestran como un
"trazo" en la pantalla.

NDOP 1)

Doppler múltiple

NDOP proporciona un mecanismo para incluir datos de velocidad (Dop-
pler) de otro sitio del radar, lo que ahora permite la medición del viento
horizontal además del viento vertical.

SHEAR1)

Cizalladura del viento

SHEAR detecta la cizalladura del viento en la atmósfera, lo que permite
la detección de microrráfagas, frentes de ráfaga, mesociclones, frentes
fríos y ondas atmosféricas.

Capítulo 2 – Descripción general del producto IRIS
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Producto Descripción

SLINE1)

Línea de cizalladura (límite frontal)

SLINE marca la transición entre dos masas de aire en la imagen.

1) Producto disponible a pedido en IRIS Analysis.
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3. Configuración de productos
de IRIS

3.1 Configuración de productos
Los productos de radar de IRIS proporcionan información que se puede usar directamente
para el pronóstico inmediato y la previsión meteorológica. Puede configurar los productos
en IRIS Radar.

Los productos de IRIS pueden mostrar datos del radar de diversas formas. Por ejemplo:
• El producto CAPPI muestra la distribución de un parámetro del radar, como por

ejemplo la reflectividad o el ancho del espectro, a una altitud constante.
• El producto TOPS muestra un mapa de contornos con color de la altura de una

superficie de reflectividad seleccionada.
• Los productos RAIN1 y RAINN muestran la acumulación de precipitaciones durante

períodos seleccionables.
• El producto WARN verifica otros productos de IRIS para determinar si hay condiciones

climáticas significativas, como por ejemplo una cizalladura del viento superior a una
cantidad del umbral.

Cada producto está asociado con una tarea configurada. Las tareas recopilan información de
los procesadores de señales y almacenan los datos del disco en archivos de introducción.

Para obtener más información, consulte IRIS Radar User Guide (M211317EN).

Más información

‣ Herramienta Live Action de la QLW: Generación y visualización de productos
(página 220)

Capítulo 3 – Configuración de productos de IRIS
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3.2 Menú de configuración del producto

La mayoría de los menús de Product Configuration tienen el mismo formato general:
Task Summary

Contiene información acerca de la tarea que está asociada con el producto.

Map Projection
Especifica la proyección del mapa geográfico, si así se desea.

Product Parameters
Especifica los datos, el rango y otras opciones específicas del producto.

Display Parameters
Selecciona la escala de colores predeterminada, que se puede anular al momento de
la visualización.
En el caso de los tipos de datos HClass, seleccione el método de clasificación que se
proyecta en el producto. Esto no se puede anular al momento de la visualización.

1. Seleccione Menus > Product Configuration.

Producto y visualización del IRIS Guía de usuario M211319ES-J
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3.2.1 Asociación de productos con tareas

Cada producto se asocia con una tarea, que proporciona los datos de introducción para el
producto.

La información de TASK Summary, que se obtiene desde la tarea asociada, muestra los
parámetros de configuración clave de la tarea.

Al asociar una tarea con un producto, el sistema debe considerar el muestreo de la
resolución adaptada y la construcción de exploraciones de volumen para un producto.

1. Seleccione TASK Name para ver una lista de tareas.

Tenga en cuenta que algunos tipos del producto requieren tipos diferentes de
asociaciones de tareas.

Tipo de producto Descripción

Ejecutar un produc-
to a partir de los da-
tos de introducción

Ingrese un nombre de la tarea, incluidos los caracteres comodines.

El signo de pregunta (?) equivale a un carácter único; el asterisco (*) equivale a
cualquier cadena de caracteres.

Producto de explo-
ración de volumen a
partir de tareas hí-
bridas

En la sección del nombre de la tarea, haga lo siguiente:

• Especifique las tareas de entrada con un guion bajo y una sola letra.
• Especifique las letras del sufijo de la subtarea en la casilla Sub Task.

Escriba un "*" para indicar todas las subtareas.
• Escriba letras individuales, como ABC, AB, BC o AC, para seleccionar qué por-

ciones del híbrido se deben incluir.
• Escriba "–" para indicar una gama de letras; por ejemplo, "A–DF" significa ABCD

y F.

Productos RAW Siempre se generan a partir de una tarea única.

Debe generar un producto RAW separado para cada subtarea.

Si recupera datos RAW desde una cinta o si recibe un producto RAW a través de la
red, no existe un archivo de configuración de la tarea en el disco. En este caso, es-
criba el nombre de la tarea directamente en el campo, tal como aparece en el me-
nú Ingest Summary o en el menú Tape.

Productos RHI Incluya RHI en los nombres de las tareas RHI para distinguirlas de las exploracio-
nes PPI.
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2. Para optimizar el aspecto del producto y el rendimiento del sistema, defina la muestra
de la resolución adaptada.

Para obtener mejores resultados, el espacio de bin del rango y la cantidad de bins en la
tarea deben coincidir con lo que es necesario para el producto. Esto se denomina un
muestreo de la resolución adaptada. La coincidencia no tiene que ser exacta, ya que el
IRIS usa algoritmos de interpolación.
Para obtener un mejor rendimiento, adapte el espacio de bin del rango, la cantidad de
bins y el rango máximo en la configuración de la tarea a la resolución de píxeles
deseada, la escala de píxeles y el rango máximo del producto en la configuración del
producto.
Por ejemplo, si genera un producto de baja resolución (240 × 240) a un rango de
120 km (74,6 mi), y desea que un solo pixel represente 1 km (0,6 mi) de datos, configure
la tarea configurada con al menos 120 bins de rango con un espacio de 1 000 m
(3 280 pies 10 in).
Tenga en cuenta que se pueden mostrar 170 bins en las esquinas del producto. Para un
producto de resolución media con un espacio de bin de 1 km (0,6 mi), la mejor
equivalencia es para las tareas con 240 a 340 bins con un espacio de 1 km (0,6 mi).
Tenga en cuenta que el IRIS puede generar productos para cualquier espacio de bin del
rango que se pueda especificar en el menú TASK Configuration; por ejemplo, también
se pueden usar espacios de 500 m (1 640 pies 5 in) o 250 m (820 pies 3 in).
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3. Si es necesario, genere una exploración de volumen.

Algunos productos requieren tareas de exploración de volumen, exploraciones PPI Full
o PPI Sector que se tomen en ángulos de elevación múltiples. Los productos de
exploración de volumen incluyen lo siguiente:
• BEAM
• CAPPI
• MAX
• TOPS
• VIL
• XSECT
• VVP
• WIND

Para estos productos, se necesita tener ángulos de elevación múltiples en la tarea
asociada. Existe una compensación entre la cantidad de ángulos de elevación, la
calidad del producto y el tiempo de exploración de la tarea. A más ángulos de
elevación, se generan productos de mayor calidad, a costa de que la exploración de
volumen lleve más tiempo.
En la siguiente figura, se muestra una exploración de volumen típica. En este ejemplo, la
resolución de la altura es de 1 km (0,6 mi) a un rango de 60 km (37,3 mi), para las
alturas inferiores a 10 km (6,2 mi). Un rayo de 1° tiene un ancho de 1 km (0,6 mi) a
60 km (37,3 mi), de modo que este esquema coincide con la resolución de la antena. Si
es importante trabajar a un rango cercano, debe agregar ángulos de elevación más
altos para cubrir las regiones superiores.
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Figura 1 Ejemplo de exploración de volumen de inclinación 15

Al construir una configuración de tarea de exploración de volumen, una buena idea es
hacer un dibujo como el que se muestra en el ejemplo, con una escala 1:1 vertical-
horizontal, a fin de obtener un panorama real de la geometría de muestreo.

El ejemplo se corrige para la curvatura de la Tierra, como con todos los productos de
IRIS.
Además, debido a los efectos de expansión del rayo, la precisión de todos los
productos disminuye con el rango. Por ejemplo, el ancho del rayo a un rango de
120 km (74,6 mi) es de 2 km (1,2 mi) para una antena con un rayo de 1°. Este es un
límite esencial del muestreo del radar.
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3.2.2 Configuración de las proyecciones del mapa

Puede especificar el tipo de proyección del mapa que se usa para la visualización. Esto es
útil para combinar datos de otras fuentes o para generar pantallas que no estén centradas
en el radar.

Por ejemplo, los compuestos deben usar una proyección para que los datos de diversos
radares se puedan asignar a una pantalla única.

Tabla 5 Proyecciones del mapa compatibles

Proyección Descripción1)

Azimuthal equidistant (AED)2) Seleccione esta opción para un mapa estándar de visualización del radar,
donde las líneas de acimut son rectas y los ángulos no están distorsiona-
dos.

Esta proyección tiene la propiedad de que la distancia en la dirección ho-
rizontal del mapa es igual a la distancia en la dirección vertical del mapa.
Esto significa que las líneas de acimut constante (rayos del radar) son
rectas y que los círculos se pueden usar para representar líneas de rango
constante. Debido a esto, la proyección AED es particularmente conve-
niente para las aplicaciones del radar.

Por lo general, para las aplicaciones del radar, el radar se ubica en el cen-
tro del mapa, y la ubicación del radar sirve como punto de referencia del
mapa.

Tenga en cuenta que en esta proyección las líneas de altitud y de longi-
tud no son rectas. (Página 191)

En IRIS Focus, se usa para mostrar datos individuales del radar.

Mercator2) Seleccione esta opción para una asignación válida de proyección de Mer-
cator, donde las líneas de latitud y de longitud son rectas y se cruzan en
los ángulos rectos.

Además, es una línea de dirección constante desde un punto recto, de
modo que sea útil para la navegación.

Mercator tiene la ventaja de que es una norma conocida, de modo que es
más fácil combinar datos de distintas fuentes en una proyección de Mer-
cator. Tiene la ventaja de que, en alturas altas, las escalas horizontales y
verticales son diferentes (gran distorsión). (Página 38)

En IRIS Focus, se usa para mostrar datos compuestos del radar.

Equidistant cylinder Se usa para los mapas digitales del terreno en IRIS (por ejemplo, inserta-
dos en la herramienta Overlay). (Página 90)

Gauss conformal Es igual al sistema de coordenadas universal transversal de Mercator, a
excepción de que omite el factor de escala 0,9996. (Página 48)

Gnomonic Todos los arcos de gran círculo son líneas rectas. (Página 164)

Lambert conic La escala es válida a lo largo de 2 paralelas estándares. (Página 104)

Producto y visualización del IRIS Guía de usuario M211319ES-J

24 RESTRINGIDO



Proyección Descripción1)

Perspective A menudo, se usa para las imágenes satelitales. Suponemos que el satéli-
te se encuentra a una altura geosincrónica. (Página 169)

Polar stereographic Es útil cerca del Polo Norte. En esencia, es la proyección AED con el pun-
to de referencia hacia el Polo Norte. (Página 154)

Universal transverse Mercator 
(UTM)

Una proyección como la de Mercator, con el eje inverso a una longitud
seleccionable. La dimensión horizontal se comprime con un factor de
0,9996. Por norma general, las longitudes de referencia deben ser múlti-
ples de 6°.

Se usa en el ámbito militar, y es una buena opción para las regiones que
tienen una larga distancia de norte a sur. (Página 48)

1) Los números de página hacen referencia a las ecuaciones de proyección de Map Projections – A Working Manual, U.S.
Geological Survey Professional Paper 1395.

2) Disponible en IRIS Focus

1. Para configurar una pantalla del radar estándar que esté en el centro del radar:

• Para el tipo de proyección, seleccione Projection Configuration > Azimuthal 
Equidistant.

• Para Projection Name, seleccione <NONE>.

La mayoría de las veces no necesita crear ni usar archivos de proyección especiales.
Si desea que el radar no esté en el centro, debe configurar un archivo de proyección
como se describe desde paso 3.
Si ya configuró y guardó una proyección, vaya a paso 2.

2. Para usar una proyección preconfigurada, seleccione Projection Configuration > 
Projection Name.

• Se muestra una lista de los archivos de proyección disponibles en el sistema.
• En el ejemplo, la Max Range y la Output Pixel Resolution del radar no tienen

sensibilidad, ya que el archivo de proyección seleccionado las define.
• Seleccione <NONE> para el Projection Name, en cuyo caso el radar está en el centro

de la pantalla de modo predeterminado. Además, en caso de una proyección AED, el
radar se define como el punto de referencia del mapa. En este caso, los campos Max 
Range y Resolution se pueden configurar en el Product Configuration Menu.
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3. Para configurar su propia proyección, seleccione Setup > Projection Configuration.

Se abre el Projection Configuration Menu.

4. Seleccione Projection para definir el tipo de proyección.

Primero, debe definir el tipo de proyección. La lista de archivos de proyección
disponibles en File se proporciona solo para el tipo de proyección seleccionada.

5. Seleccione el comando File > Open para generar una lista de archivos AED o de
Mercator existentes, según la proyección seleccionada.

6. Seleccione Reference Point.

• Para proyecciones AED: el punto de referencia es la ubicación desde la que todos los
acimut se muestran como líneas rectas. Por lo general, se establece en la ubicación
del radar.

• Para proyecciones de Mercator: el mapa no puede cruzar la línea a 180° de esta
longitud, así que debe establecerla cerca de su ubicación. La latitud define la escala
de rango.

• Para la estereográfica polar: es la línea de longitud que desea que sea vertical en el
mapa. En efecto, es la que rota el mapa. Nuevamente, la latitud define la escala de
rango.

• Para UTM: solo se selecciona una longitud. Es el meridiano central de la línea de
UTM. Por norma general, se separan cada 6° a partir de los 3°. Use un valor cercano
a su longitud.

• Para la conforme de Lambert: también define 2 paralelas estándares.
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7. Seleccione Save para nombrar la proyección.

El nombre del archivo de proyección abierto se muestra en la barra de título del menú
(AED_200_KM en el ejemplo).

8. Fije una esquina o una ubicación central.

Para configurar una proyección, debe conocer la latitud y la longitud de la esquina NE o
SW o el centro de la pantalla.
Seleccione Fix en la ubicación que conoce y luego ingrese las coordenadas de LAT/
LON.
Con Fix seleccionada, puede cambiar otros parámetros de la geometría de la
proyección sin perder información de la coordenada.

9. Especifique el área de cobertura de la proyección (región de la proyección) de alguna
de estas 2 formas:

• Especifique la latitud y la longitud de uno de los 2 puntos no fijos.
• Especifique la distancia Norte (Y-Range) y la distancia Este (X-Range) desde el

centro.
El menú de la proyección funciona como una hoja de cálculo. Cuando cambia un
parámetro, los otros parámetros se ajustan para reflejar el cambio.

El algoritmo de la hoja de cálculo converge en una solución correcta, incluso para las
proyecciones extrañas. Un ejemplo de un caso donde puede no haber convergencia
es en una proyección AED donde el Reference Point esté a varios miles de
kilómetros del centro de la región de la proyección.
Si se encuentra con un problema en la hoja de cálculo, verifique el punto de
referencia y seleccione Default para cargar algunos números válidos.

10. Especifique los píxeles.

La cantidad de píxeles que se usan para representar datos en la proyección se
especifican para las direcciones X e Y de la pantalla de salida.
Si especificó el resto de los aspectos de la proyección, ingrese la cantidad correcta de
píxeles para X (dirección horizontal). La cantidad de píxeles para Y se ajusta de forma
automática.
Si ajusta la cantidad de píxeles para X, los otros parámetros de la hoja de cálculo
cambian, como por ejemplo los valores de LAT/LON en los puntos no fijos y el Y-Range.

11. Ajuste la hoja de cálculo.

Dado que todos los parámetros de la geometría de la proyección se conectan a través
del algoritmo de la hoja de cálculo, cuando cambia un parámetro, los otros parámetros
se ajustan de forma automática.
Esto significa que tal vez deba hacer concesiones. La hoja de cálculo facilita
experimentar con distintas concesiones.
Por ejemplo, si desea una pantalla de Mercator de 480 × 480 píxeles, los rangos de X e
Y no pueden ser iguales en general (por ejemplo, 100 km [62,1 mi]). En este caso, la
concesión puede ser, por ejemplo, un rango para X de 100 km (62,1 mi) y un rango para
Y de 99,5 km (61,8 mi), a fin de obtener una pantalla perfecta de 480 × 480.
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3.2.3 Parámetros del producto
En Parámetros del producto, defina los parámetros del producto para definir los datos que
se obtienen de la tarea y cómo mostrar los datos.

Datos : Pantalla

Seleccione Datos:Pantalla para ver una lista de opciones válidas de parámetros de
visualización. Las opciones disponibles varían según el tipo de producto.

Este parámetro especifica qué parámetro de datos deriva el producto. Por ejemplo, Z, V, W,
ZT o ZDR. Esta información proviene de la tarea que está asociada con el producto. Algunos
parámetros de datos se pueden mostrar en más de una manera.

Tabla 6 Tipos de datos

Tipo de datos Descripción

Ah, Av Atenuación integral para canales horizontales (H) y verticales (V)

Azdr Atenuación integral del formato ZDR (dB)

CSR Relación entre el eco de canales Doppler y la señal (CSR) de dBT a -dBZ

dBT, dBTh, dBTv, DBTr Energía total

dBZ Reflectividad corregida del eco

dBZt Reflectividad sin corregir

HCLASS Clasificación de hidrometeoros

Tipo de hidrometeoro calculado en el área de precipitación

KDP Fase diferencial específica

Un indicador de la tasa de cambio de la diferencia de fase entre pulsos polari-
zados horizontal y verticalmente del radar. Un cambio horizontal mayor gene-
ra un valor KDP positivo y un cambio vertical mayor genera un valor KDP ne-
gativo. Una causa típica para un área con KDP alto es una lluvia intensa.
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Tipo de datos Descripción

LDRH, LDRV Relación de despolarización lineal H a V (o V a H)

La relación de reflectividad polar cruzada y copolar medida en dB

LOG Relación señal-ruido del receptor del registro

PHIH, PHIV Fase diferencial horizontal (H) o vertical (V)

Diferencia de fase para la ida y vuelta total entre el radar y el volumen donde
se refleja la señal. PHIH se mide entre los canales HH y HV. PHIV se mide en-
tre los canales VV y VH.

PHIDP Fase diferencial

La diferencia de fase debido a la propagación entre los canales HH y VV del
radar.

PMI Índice meteorológico polarimétrico

R Tasa de acumulación de precipitaciones en unidades de mm/hora

Por lo general, para la nieve, hace referencia al equivalente líquido.

RHOHV, RHOH, RHOV Coeficiente de correlación entre los canales HH y VV (o HH y HV/VV y VH)

Los valores más altos (>0,95) indican áreas de precipitación uniforme y los va-
lores más bajos indican tipos de hidrometeoros más mezclados, como nieve
derretida, copos de nieve húmedos o residuos aéreos.

SNR Relación señal-ruido

Medición genérica de la relación señal-ruido en dB

SQI Índice de calidad de la señal

Un valor entre 0 y 1 que mide la coherencia Doppler de la señal, esto es, la co-
rrelación entre la señal y su desfase de tiempo Doppler:
• 0 indica ruido blanco
• 1 es el objetivo de punto Doppler perfecto

T Reflectividad total

La energía total que se devuelve al radar en unidades de reflectividad. En ge-
neral, representa la reflectividad horizontal sin la corrección para el eco del
suelo.

TV, TE Reflectividad vertical total (HV mejorada)

Reflectividad total desde el canal de polarización vertical (TV) y la combina-
ción del canal horizontal y vertical (TE)

V Velocidad

Velocidad radial promedio (hacia el radar o desde este) de áreas de hidrome-
teoros detectados

VC Velocidad corregida

Igual que la velocidad V, pero corregida para efectos de solapamiento de ran-
gos y solapamiento de velocidades

V: SHEAR, Vc: SHEAR Velocidad y velocidad corregida de la cizalladura del viento

W Ancho espectral

Variabilidad de los valores de velocidad Doppler dentro del área de medición
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Tipo de datos Descripción

XCOR Correlación polar cruzada, sin corregir rhohv
Debido a que este valor no se corrigió con el ruido, este es un indicador direc-
to de la incertidumbre de PHIDP.

Z Reflectividad

Conocido generalmente como dBZ, este es el tipo de datos común que mide
la reflectividad de la señal del radar y se usa para calcular la intensidad de pre-
cipitación a partir de ello.

Todas las mediciones Z se corrigen para el eco del suelo.

ZV, ZE Reflectividad vertical (HV mejorada)

Reflectividad total desde el canal de polarización vertical (ZV) y la combina-
ción del canal horizontal y vertical (ZE). Se corrige para el eco del suelo.

ZC Reflectividad corregida

Igual que la reflectividad Z, pero corregida para los efectos de bloqueo de haz
y atenuación

ZDR Reflectividad diferencial

La relación de SNR en el canal horizontal para la SNR en el canal vertical. Los
valores positivos indican más ecos horizontales prominentes y los valores ne-
gativos indican más ecos verticales prominentes. Los valores ZDR positivos al-
tos indican, en general, los tamaños de hidrometeoros más grandes.

ZDRC Reflectividad diferencial corregida

Igual que la reflectividad diferencial ZDR, pero corregida para los efectos de
bloqueo de haz y atenuación

Intervalo máximo de producto

Si selecciona un Nombre de proyección de mapa personalizado (distinto de <NONE>), no
puede configurar este campo en el menú de salida del producto. Esto se debe a que la
configuración de la proyección determina el rango máximo.
Consulte Configuración de las proyecciones del mapa (página 24).

Es el rango máximo que se configura para el producto, que debe ser menor que el rango de
datos o igual a este. El rango máximo es el rango en la dirección E-W/N-S (Este-Oeste/
Norte-Sur) centrada en el radar. Esto significa que el rango de las esquinas de la pantalla
resultante es mayor.

Rain Alg

Puede elegir el algoritmo para la estimación de precipitación de una selección que varía de
Relación Z-R R(Z) tradicional a algoritmos avanzados para la estimación de precipitación
que usa algoritmos de doble polarización: R(KDP), R(KDP,ZDR), R(Z,ZDR), NSSL2005.

Los parámetros se configuran en el archivo qpe.con que se encuentra en el
directorio /etc/vaisala/irisrda.
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Tabla 7 Algoritmos para Rain Alg

Algoritmo Descripción

Relación Z-R R(Z) Este algoritmo define R-Z con la definición tradicio-
nal: Z= AR**B.

R(KDP)

R(KDP,ZDR)

R(Z,ZDR)

Estos algoritmos calculan R con los diversos paráme-
tros de doble polarización.

NSSL2005 Este algoritmo usa un clasificador basado en la inten-
sidad de la lluvia y una ecuación diferente para cada
intensidad.

Para obtener más información sobre NSSL2005 QPE,
consulte: Ryzhkov, A. V.,  et. al. Rainfall Estimation with
a Polarimetric Prototype of WSR-88D. J. Appl Meteor.,
44, 502-515.

XY más estabilizado

XY más estabilizado puede mejorar significativamente la apariencia de los productos para
su presentación y mejorar la compresión de los datos. La estabilización lleva a cabo el
procesamiento de imágenes para promediar los contornos de color e interpolarlos a través
de espacios pequeños o píxeles faltantes en la imagen cartesiana final.

Especifique la longitud de la estabilización en km.

La estabilización necesita recursos considerables de la CPU. El límite
interno de la longitud de la estabilización es de 60 píxeles, mucho más de lo que
probablemente usaría.

PRECAUCIONES!

Para generar muchos productos estabilizados en una operación regular, Vaisala sugiere lo
siguiente:

• Use productos de baja resolución junto con la estabilización.
Es más rápido generar un producto de baja resolución y estabilizarlo que generar un
producto de resolución media y estabilizarlo.
En muchos casos, los resultados son casi idénticos, de modo que no hay ventajas
cuando se estabilizan productos de resolución media o alta.

• Use la longitud de estabilización mínima para obtener el efecto deseado. No estabilice
por demás y no use una longitud que sea más larga que la necesaria.
Las longitudes de estabilización más largas requieren más cálculos.

3.2.4 Parámetros de visualización
Los parámetros de visualización determinan la apariencia del producto.
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Display Units

La mayoría de los tipos de datos son numéricos. Display Units muestra el rango de valores y
las unidades para los valores de salida del producto.

Por ejemplo, el algoritmo de los topes de altura de ecos genera valores en km a los 100 m
(328 ft 1 in) más cercanos, lo que extiende el rango de 0 a la altura máxima de datos definida
con la herramienta setup o a 25,5 km (15,8 mi), lo que sea menor.

En la siguiente tabla se muestran los valores que puede asignarles a las unidades de
visualización.

Tabla 8 Unidades de visualización

Parámetro de visualización Rango de visualización máximo, unidades de visualización o el méto-
do del clasificador

dBZ -32 ... 96 dB mm6/m3

dBZt -32 ... 96 dB mm2/m3

Lluvia 0 ... 255 mm/h o 0 a 10,2 pulgadas/h

Liq 0 ... 1 000 mm

Vel -Vu a Vu m/s

Width 0 ... Vu m/s

ZDR -8 ... +8 dB

TOPS 0 ... 25,5 km o la altura configurada en Setup

VIL 0 ... 65,0 mm

WIND Configurado en Setup

SHEAR +-25 m/s/km

HClass Meteo, Precip, Cell, Meteo+Precip y Meteo+Cell
El primer campo de Classifiers le permite seleccionar cuáles son los re-
sultados del clasificador que se proyectan en el producto.

El selector enumera los algoritmos de clasificación disponibles y sus
combinaciones mezcladas.

Escala de colores, niveles, primer nivel/etapa

La escala de colores relaciona los valores de datos numéricos con colores.
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El campo Scale le permite seleccionar si desea usar una escala uniforme con un valor de
inicio y una fase constante, o una escala de colores personalizada que se configuró
previamente para el sistema:

• Las escalas de colores personalizadas se definen con la herramienta Color Setup.
Consulte IRIS and RDA Utilities Guide (M211316EN).
Cada escala de colores tiene un nombre que se definió en Color Setup.
Los nombres pueden reflejar escalas que son adecuadas para distintas estaciones,
como por ejemplo Summer o Winter.
Si tiene dudas, seleccione Default que, por lo general, se configura como una escala
razonable. La cantidad de fases de la escala se completa automáticamente, ya que
también forma parte de la escala de colores personalizada.

• Cuando selecciona una escala de colores uniforme, escoge la cantidad de fases del
nivel (2 ... 16). También debe establecer los siguientes campos:
• El campo 1st Level establece el valor numérico que se usa para etiquetar el lado

derecho del primer nivel en la escala de colores para el producto.
• El campo Step establece la separación entre los niveles de colores. Los números en

la leyenda de colores del producto se separan según este valor.

La escala de colores también asocia los datos de clasificación a los descriptores de clase
(identificadores de clase con leyendas de clase). Los juegos de leyendas de clase se pueden
personalizar como juegos de Classifier en el sistema (con el HydroClass Name Editor en la
herramienta Color Setup), para que coincidan con los métodos del clasificador disponibles.

En la siguiente tabla se muestran los valores que usa para 1st Level/Step, según el
parámetro de visualización.

Tabla 9 Formatos de los parámetro de visualización

Parámetro de visualización Formato de primer nivel/fase

dBZ + - XX dBZ total

dBZt + - XX dBZ total

Lluvia +XXX,X mm/h

Liq +XXX,X MM

Vel +- X,X m/s

Width + XX,X m/s

ZDR +- X,X dB

TOPS + XX,X km

VIL + XX,X mm

WIND No corresponde

SHEAR +- XX,X m/s/km
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Para la velocidad media, la selección de una fase de nivel 0 hace que se muestre la
velocidad para todo el intervalo inequívoco entre -Vu y +Vu.
Si se selecciona un número impar de niveles, se genera una leyenda con una banda
centrada en velocidad 0.
Si se selecciona un número par de niveles de velocidad, no se genera una leyenda con una
banda centrada en 0, pero sí una interrupción de color en exactamente la velocidad 0.

Cuando se selecciona una escala de colores uniforme, tiene más flexibilidad para elegir
colores. Las asociaciones de identificadores de clase con leyendas de clase se fija con Color 
Setup.

En la siguiente ilustración se muestran 2 ejemplos de los parámetros de configuración de la
visualización, una para ZT y una para la velocidad y la leyenda de color resultante que
aparecería con el producto.

En el caso de ZT, el ejemplo muestra que la parte inferior de la escala "llega a un umbral", de
modo que no se muestran los datos inferiores a -20 dBZ, mientras que el extremo superior
"se satura", dado que el color superior incluye todos los valores superiores a 50 dBZ.
Cuando selecciona escalas uniformes, no se puede cambiar el comportamiento (saturación
en comparación con el umbral) del extremo de las escalas. Este comportamiento se hereda
desde la escala de colores personalizada denominada Default, que se configura en Color 
Setup.

En el ejemplo de velocidad, al ingresar 0 para la fase del nivel, la visualización expande
automáticamente el intervalo de Nyquist. Tenga en cuenta que ambos extremos se
configuran para saturarse por velocidad.

El formato de las leyendas de colores, con respecto a cómo las etiquetas de leyenda se
relacionan con los límites de la banda de color, se configura en la herramienta Color Setup
para cada parámetro. Esta herramienta ofrece una flexibilidad considerable para definir
cómo se crean las leyendas de color para cada parámetro de datos. Consulte IRIS and RDA
Utilities Guide (M211316EN).
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Figura 2 Ejemplo del formato de la leyenda de color

Resolución de la imagen del producto

Si selecciona un Map Projection Name personalizado (distinto de <NONE>), no puede
configurar este campo en el menú de salida del producto. Esto se debe a que la
configuración de la proyección determina la resolución.
Consulte Configuración de las proyecciones del mapa (página 24).

El IRIS puede crear imágenes en prácticamente cualquier resolución, de 16 × 16 a
3 100 × 3 100 píxeles. Los productos de IRIS se crean específicamente para la resolución de
visualización requerida, lo que optimiza la coincidencia entre los píxeles de la pantalla y los
datos reales del radar. Esto significa que los productos de resolución alta no son
simplemente productos de baja resolución con píxeles replicados. Asimismo, los productos
de baja resolución no se crean cuando se degrada una resolución más alta del producto.
Cuando solicita un producto de resolución alta, obtiene la mejor imagen posible que se
puede generar desde los datos originales. Si solicita un producto de baja resolución, el
producto se computa eficientemente al calcular el producto solo a la resolución solicitada.
Además de la generación eficiente, los productos de baja resolución se pueden transmitir a
través de un enlace de comunicaciones y se pueden mostrar más rápidamente porque
contienen menos píxeles.
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El campo Resolution en los menús de Product Configuration muestran la cantidad X-Y de
píxeles. Estos se pueden cambiar cuando se ingresan cantidades distintas de píxeles o
cuando se hace emerger un menú de las resoluciones predeterminadas de la imagen, ya sea
baja, media o alta. En la siguiente tabla, se muestran los valores predeterminados para los
formatos PPI (región de imagen cuadrada con leyendas a la derecha) y RHI (región de
imagen rectangular con leyendas debajo). Los valores predeterminados se optimizan a la
resolución de los dispositivos de visualización estándares del IRIS.

Tabla 10 Resoluciones predeterminadas de la imagen

Formato RHI de
resolución prede-
terminada (rec-
tangular)1)

Formato PPI (cuadrado)2)  

 Píxeles para X Píxeles para Y Píxeles para X Píxeles para Y

Baja 240 240 288 136

Media 480 480 600 290

Alta 720 720 840 530

Súper alta 940 940 1060 750

1) Región de imagen rectangular con una leyenda opcional debajo.
2) Región de imagen cuadrada con una leyenda opcional a la derecha.

Sin importar el tipo del producto, el IRIS determina la mejor manera de mostrar el producto
en formato PPI o RHI. Si la imagen no coincide exactamente con el tamaño del pixel de un
dispositivo de visualización del objetivo, el IRIS lo ajusta para que coincida mejor. Por
ejemplo, si envía una imagen de baja resolución a una impresora de resolución media o alta,
el IRIS duplica los píxeles a fin de que la pantalla llene el área de la imagen. Asimismo, el IRIS
reduce una imagen si tiene más píxeles de los que se pueden mostrar en un dispositivo de
visualización del objetivo.

Si desea el impacto de una pantalla grande, pero no desea cargar al IRIS cuando se crean
productos de alta resolución, especifique una resolución de pantalla de 360 × 360. El IRIS
duplica estos números para que coincidan exactamente en la ventana de visualización
grande.

Asimismo, las imágenes de 240 × 240 se triplican para coincidir exactamente en una
pantalla grande, o se duplican para coincidir en una pantalla mediana.

Para obtener más información sobre los formatos de los datos, consulte IRIS Programming
Guide (M211318EN).
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3.3 BASE: producto de base de eco

Figura 3 Configuración de ejemplo de BASE

BASE se usa para determinar la base de los ecos.

De modo similar a TOPS del eco, el usuario especifica un dBZ Contour para la base. Para
cada pixel de salida en el producto, el algoritmo realiza una búsqueda descendente a través
de los ángulos de elevación sucesivos. Una altura de base se determina con una
interpolación lineal cuando el dBZ Contour especificado se cruza desde el valor superior
hasta el valor inferior.

La salida final del producto es un mapa con código de color de alturas base de eco para el
contorno de dBZ seleccionado. De forma opcional, se puede aplicar la estabilización
cartesiana.

Los radares de banda C, S y X detectan partículas de precipitación, como lluvia o nieve. No
pueden detectar partículas de nubes que son mucho más pequeñas (de alrededor de
1 000 más pequeñas en diámetro). El producto BASE no se puede usar para detectar la
altura de base de la nube para los radares que transmiten estas bandas.
Los radares de longitud de onda milimétrica (de bandas K y W) pueden detectar
partículas de nubes.
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Debido a la curvatura terrestre, el eco del suelo y el bloqueo del haz, los radares no son
eficientes para buscar características cerca de la superficie.
Esto significa que el producto BASE no puede detectar bases del eco a niveles muy bajos.
Cuando la precipitación excesiva del contorno de dBZ especificado está llegando al suelo,
o está cerca de llegar al suelo, el producto BASE muestra un color especial para indicar
que hay una BASE, pero no se puede determinar la altura.

1. Seleccione Type > BASE.

2. Configure el producto BASE:

Data:Display
Seleccione dBT Height, dBZ Height o dBZc Height

Max Range
Seleccione el rango máximo para el producto. Recuerde que los efectos de la
curvatura terrestre son mayores a mayores rangos.
Puede visualizar un PPI en el ángulo de elevación más bajo y usar la herramienta
del cursor para ver cuáles son las alturas que se pueden observar en varios
rangos.
Por ejemplo, para un ángulo de elevación de 0,5° a 100 km (62,1 mi), el haz se
centra en 2,3 km (1,4 mi). No se pueden detectar bases de eco que sean inferiores
a esto.

dBZ Contour
Seleccione el umbral de dBZ para la base de eco.

3. Aplique AZ/EL Smoother.

Ingrese los valores en grados, primero para la dirección de acimut y luego, para la
dirección de elevación.
Los valores más comunes son 1.0, 1.0.

Más información

‣ Parámetros de visualización (página 31)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)
‣ TOPS: topes de alturas de ecos (página 92)
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3.4 BEAM: Producto del patrón de haz de
antena

Figura 4 Configuración de ejemplo de BEAM

BEAM es una imagen de formato transversal de tamaño de pantalla completa que muestra
la intensidad promediada por rango en coordenadas de acimut y elevación.

El producto BEAM es similar a una sección transversal en que muestra un corte casi vertical
de la atmósfera. Se lo crea a partir de una exploración de volumen de PPI. El producto se usa
principalmente para probar el sistema y para realizar evaluaciones, como por ejemplo:

• Prueba del patrón de haz de antena. Por lo general, hay un radiador en una torre que se
encuentra a algunos km del radar. El radar se explora en el modo de PPI total o por
sector alrededor del objetivo con una separación de alta resolución (por ejemplo,
<0,5°) en AZ y EL. Por lo general, el transmisor está apagado en este paso. Luego, el
producto BEAM se puede usar para mostrarle la respuesta de la antena al radiador.

• Medición de la esfera calibrada. Es similar al caso anterior, excepto que el radar está
emitiendo radiación. La exploración del sector se realiza sobre la esfera de calibración
que, por lo general, cuelga de un globo cautivo. La visualización resultante muestra la
ubicación y la potencia de retorno de la esfera. Se puede usar para la calibración de
todo el sistema.

A una incidencia horizontal cercana (ángulos de elevación bajos), el producto BEAM es
similar a una sección transversal. Dado que el producto se puede configurar para que
promedie un intervalo de rango, el producto BEAM puede mostrar el clima u otros objetivos
en un "bloque" esférico, definido como un intervalo de rango, acimut y elevación. Por otro
lado, la sección transversal intenta mostrar un "corte" planar a través del clima.
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1. Seleccione Type > BEAM.

2. En Data:Display, seleccione Z dBZ, V V, W W o T dBZt.

3. En Min/Max Range, seleccione el intervalo de rangos en el que se realiza el promedio.

El producto BEAM calcula el promedio de los valores de dBZ o dBT sin linealización.
Todas las distancias se expresan en km.

El IRIS tiene una altura máxima seleccionable a partir de la cual no se registran los
datos (por ejemplo, 20 km [12,4 mi]). Al seleccionar el rango Min/Max Range, tenga
en cuenta que, en rangos lejanos, esta altura se excede en los ángulos superiores de
una exploración de volumen.
Por ejemplo, si el límite de altura se establece en 20 km (12,4 mi), y una exploración
de volumen usa ángulos de elevación de hasta 20°, el rango máximo que incluye
todos los datos es de 55 km (34,2 mi).

4. En Min/Max E L, defina la ventana de elevación.

Por ejemplo, si una exploración de volumen tiene ángulos de elevación de entre 0 y 5° e
incluyen estos valores, ingrese los valores 0,0 y 5,0.

5. En CW AZ Interval, defina la ventana de acimut.

El primer valor corresponde al lado izquierdo de la pantalla, el segundo valor al lado
derecho de la pantalla.
De izquierda a derecha de la pantalla, los ángulos están hacia la izquierda.
Por ejemplo, un intervalo hacia la izquierda de 0,0 a 90,0 representa un sector de 90°,
mientras que el intervalo de 90,0 a 0,0 representa un sector de 270°.

6. Aplique AZ/EL Smoother.

Ingrese los valores en grados, primero para la dirección de acimut y luego, para la
dirección de elevación.
Los valores más comunes son 1.0, 1.0.

Más información

‣ Parámetros de visualización (página 31)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)
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3.5 CAPPI: Indicador de posición en pla-
no de altitud constante

Figura 5 Configuración de ejemplo de CAPPI

CAPPI es un corte horizontal de una altitud seleccionada usada para la vigilancia y la
identificación de tormentas fuertes.

CAPPI requiere una exploración de volumen de PPI en múltiples ángulos de elevación. La
cantidad de ángulos y sus separaciones dependen del rango y de la altura de CAPPI que
desee crear.

CAPPI también admite cálculos de datos de SHEAR. Las opciones de configuración son las
mismas que las del producto SHEAR, con opciones de cizalladura radial, acimutal y de
elevación.

1. Seleccione Type > CAPPI.

Se abre el menú CAPPI Product Configuration.
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2. En Data:Display, especifique el tipo de datos para el que desea crear un CAPPI.

La mayoría de los tipos de datos de IRIS están disponibles.
Si desea generar una tasa de lluvias, seleccione qué tipo de datos de entrada se usa
para la conversión. El IRIS admite relaciones Z/R y KDP/R.

3. En CAPPI Height, especifique la altura de la superficie de CAPPI en kilómetros y en
décimas de kilómetros.

El algoritmo de CAPPI del IRIS construye los CAPPI al interpolarse en altura y rango a la
superficie de CAPPI seleccionada.
Primero se crea un producto intermedio en coordenadas cilíndricas (altura, rango de
superficie y acimut de CAPPI), y luego se realiza la conversión final a coordenadas
cartesianas para la visualización.
Ingrese un rango de números para un CAPPI en 3D.

4. Si es necesario, use la opción CAPPI Fill.

El algoritmo de interpolación requiere que para cada punto de la imagen del producto
de salida haya un ángulo de elevación por encima y por debajo de la altura
seleccionada.
Por ejemplo, la exploración de volumen en el menú de CAPPI Product Configuration de
muestra no puede crear un CAPPI a una altura de 5 km (3,1 mi) para rangos inferiores a
5 km (3,1 mi) ya que no existe un ángulo superior a 5 km (3,1 mi) en esta región.
De manera similar, si elige una superficie de CAPPI de bajo nivel, el ángulo de elevación
más bajo es superior a la superficie en rangos lejanos. En la pantalla del producto
resultante estas áreas sin muestras aparecen de color negro.
El campo CAPPI Fill usa el ángulo de elevación más alto para llenar los rangos
cercanos, y el ángulo de elevación más bajo para llenar los rangos lejanos, lo que
elimina las áreas negras. Este enfoque también se denomina Pseudo CAPPI. No se
recomienda para los productos CAPPI en 3D.

Más información

‣ Parámetros de visualización (página 31)
‣ Configuración de las proyecciones del mapa (página 24)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)
‣ Herramienta de selección de altura CAPPI (página 262)

3.6 FCAST: Pronóstico
FCAST es una matriz de vectores de dirección e intensidad utilizada para alternar
interactivamente la visualización del clima actual.

FCAST se usa en Quick Look Window para proyectar otros productos previstos, a fin de ver
las condiciones climáticas en el futuro. El producto toma otro producto de la imagen como
entrada y luego determina una velocidad y una dirección promedio del movimiento del eco.
Es similar al producto TRACK en que calcula la velocidad y la dirección media al hacer una
correlación cruzada entre la versión actual y la versión anterior del producto.
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Figura 6 Configuración de ejemplo de FCAST

1. Seleccione Type > FCAST.

2. En Type, seleccione el tipo del producto y el nombre de entrada.

Seleccione un producto que pueda crear un movimiento del eco razonable.
Si usa el producto para pronosticar el movimiento de una característica de VIL, base el
pronóstico en un producto VIL.
En el ejemplo, se seleccionó un producto CAPPI de dBZ.

3. Especifique el Threshold Level.

El algoritmo aplica una función de ponderación a los datos según este nivel. Los valores
que estén por encima de este nivel se amplifican y los valores que estén por debajo de
este nivel se suprimen con la función de ponderación.
Al seleccionar el nivel, mire una pantalla en el modo de bucle y vea qué límite de color
se mueve de forma representativa.
Por lo general, desea seleccionar un valor débil para asegurarse de que siempre esté
presente cuando haya ecos. En el ejemplo, se seleccionó 30 dBZ.

4. Especifique el umbral de Correlation.

El algoritmo de correlación devuelve un valor de velocidad, dirección y correlación que
sirve como un indicador de calidad.
El valor que ingrese se usa como un umbral. Si el valor de correlación que se calcula en
el producto es mayor que el umbral establecido, se genera un producto del pronóstico.
De lo contrario, no se genera ningún producto del pronóstico.
El ejemplo requiere una correlación del 50 %. Un valor mayor sería más restrictivo. Es
más probable que un valor menor pase cálculos de movimientos inestables cuando los
datos son ruidosos.

5. Especifique la Max Velocity in km/hr.

También es posible que el producto del pronóstico tenga una correlación lo
suficientemente alta, pero que tenga una velocidad absurda, tal vez por ruidos
aleatorios.
Para evitar esta situación, ingrese la velocidad máxima que esperaría para los ecos
meteorológicos en el área. Un valor de 120 km/h (74,6 mi/h) es una primera suposición
razonable.
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6. En Max Time Step, especifique el tiempo máximo que el producto del pronóstico mira
hacia atrás para encontrar la imagen anterior.

El producto FCAST calcula el movimiento del eco promedio cuando se establece una
correlación entre la imagen actual y la imagen anterior.
El valor de ejemplo de 15 minutos es un punto de partida razonable, ya que la duración
promedio de una célula convectiva individual es de aproximadamente 30 minutos.

7. En Output Resolution, especifique la resolución del campo de salida de los vectores.

Los productos FCAST crean un vector de movimiento único. También puede crear su
propio producto del pronóstico con sus propios algoritmos. Estos pueden tener un
campo de vectores de movimiento no uniforme.
El tamaño total del campo de salida coincide con el tamaño del producto de entrada
(en km). Por ejemplo, si el producto de entrada tiene un rango de 200 km (124,3 mi)
(400 km [248,5 mi] de espacio total), y la resolución de salida es de 5 km (3,1 mi), la
salida es una cuadrícula de vectores de movimiento de 80 × 80.

8. Para visualizar y usar el producto FCAST para el pronóstico, seleccione Quick Look 
Window > Forecast

La ventana del producto del pronóstico muestra una matriz de vectores de movimiento
similar a los productos WIND o NDOP.
La Quick Look Window muestra características de soporte adicionales que no son
compatibles con el producto FCAST en sí mismo:
• Los campos de movimiento no uniforme se usan correctamente en el pronóstico.
• Los cambios de intensidad no uniforme se aplican correctamente.

El producto del pronóstico crea una matriz correspondiente de cambios de
intensidad que se establecen en 1.

Más información

‣ Herramienta de pronóstico (página 254)
‣ Opciones de salida WIND y FCAST (página 271)
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3.7 HMAX: Producto de altura de intensi-
dad máxima

Figura 7 Ejemplo de configuración de HMAX

HMAX muestra la altura de los datos máximos por encima de cada píxel de salida.

Es similar al producto MAX que muestra el valor de la reflectividad máxima para cada pixel.
El algoritmo de HMAX requiere una exploración de volumen. Realiza una búsqueda vertical a
través de los ángulos de elevación por encima de cada pixel de salida y determina la altura
de la intensidad máxima.

En algunos casos, el producto puede mostrar la presencia y la altura de la banda brillante. En
una animación, las alturas que disminuyen rápidamente en tormentas convectivas pueden
indicar la presencia de una microrráfaga. La limitación del producto HMAX se describe en la
nota que se muestra a continuación:

Un limitación de este producto es que las alturas se cuantifican por cantidad de ángulos
de elevación. No es posible interpolar el valor máximo, de modo que la altura es la altura
del ángulo de elevación donde se genera el valor máximo (con corrección de la curvatura
terrestre). Mediante una exploración de volumen con varios ángulos de elevación y la
estabilización cartesiana en 2D se pueden mitigar los efectos de la cuantificación.
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1. Seleccione Type > HMAX.

2. En Data : Display, seleccione una de las siguientes opciones:

• dBT Height
• dBZ Height
• dBZc Height

3. En Max Range, seleccione el rango máximo para el producto.

4. En dBZ Minimum, seleccione la reflectividad máxima más pequeña para la que se
desee mostrar la altura.

5. Aplique AZ/EL Smoother.

Debido a la cuantificación de las alturas por etapas de elevación en la exploración de
volumen, tal vez desee generar una estabilización más larga que la que usaría para
realizar una estabilización en la cuantificación (por ejemplo, 3,0 km [1,9 mi]).

Más información

‣ Parámetros de visualización (página 31)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)

3.8 LAYER: promedio de capa
LAYER puede calcular los promedios de la capa de cualquier tipo de datos polares de los
archivos de introducción.

LAYER también puede convertir a líquido primero y calcular la VIL Density. Cuando
calcula la VIL Density, la salida está en g/m**3.

El algoritmo de LAYER es similar a VIL, a excepción de que se divide por espesor de capa. El
procesamiento del algoritmo es el siguiente:

1. Busca todos los puntos de la capa (teniendo en cuenta la curvatura terrestre) en un
rango determinado y en un acimut determinado que intercepta las exploraciones de
PPI de la exploración de volumen, incluido un punto por encima y un punto por debajo.

2. Si los datos son Z, los linealiza.
Si la salida es densidad VIL, convierte los valores Z en valores W (W se refiere al
contenido de agua) y promedia los valores en la capa.
A cada punto de datos se le asigna una ponderación que corresponde al intervalo de
altura que representa en la capa.

3. El resultado es un producto PPI intermedio que se transforma a producto cartesiano y
se almacena.

4. Si se selecciona Z como el parámetro de datos del producto, pero al momento de la
ejecución solo está disponible T (o viceversa), el producto se ejecuta con el parámetro
de datos disponible.

LAYER puede funcionar solo cuando hay un ángulo en la tarea, pero no se recomienda para
obtener mejores resultados. Si ningún ángulo en la tarea asociada atraviesa la capa, no se
puede calcular ningún resultado.
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Para una capa de 5 a 10 km (3,1 a 6,2 mi), en el ejemplo de exploración de volumen en la
siguiente ilustración, no se pueden calcular los promedios de la capa para los rangos
inferiores a 5 km (3,1 mi). En la visualización del producto resultante, debería haber un
círculo interno del área no explorada.
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Figura 8 Ejemplo de exploración de volumen de inclinación 15

Figura 9 Ejemplo de configuración de LAYER

1. Seleccione Type > LAYER.
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2. En Data:Display, seleccione el tipo de datos que se calcula.

• Para calcular los datos VIL Density, seleccione una de las siguientes acciones:
• dBT:VILDen
• dBZ:VILDen
• dBZc:VILDen

• Para calcular el promedio de la capa, seleccione cualquier otro tipo de datos.

3. En Layer Top y Layer Bottom, seleccione las alturas superiores e inferiores de la capa
en kilómetros y en décimas de kilómetros.

4. Si está calculando VIL Density, en ZW Relation, seleccione la relación contenido de
reflectividad-agua (Z-W).

El valor predeterminado es lluvia. Para la nieve, reduzca el coeficiente a un valor más
pequeño, por ejemplo a 2 000, para representar la menor reflectividad del hielo.

Más información

‣ VIL: líquido integrado de forma vertical (página 99)

3.9 MAX: Datos máximos con paneles la-
terales

MAX muestra los datos máximos de cada píxel además de los proyectos máximos Este-
Oeste y Norte-Sur en los paneles laterales.

El producto MAX ofrece una presentación fácil de interpretar de la intensidad y altura del
eco en una única pantalla. Es especialmente útil para representar zonas de clima severo.
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Figura 10 Visualización de ejemplo de MAX

Ya que el radar no puede ver la superficie de la Tierra, hay límites curvos en la parte
inferior de los paneles laterales.

MAX se basa en una tarea de exploración de volumen y se calcula de la siguiente manera:
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1. Construye una serie de productos CAPPI para abarcar la capa seleccionable, repartidos
uniformemente en el intervalo de altura. El número que se usa es el mayor de uno cada
500 metros o uno para cada 2 píxeles del tamaño del panel lateral, hasta un máximo de
50. Los valores se interpolan para crear la imagen del panel lateral.

2. Determina los valores de datos máximos para la proyección horizontal y la proyección
vertical: este-oeste y norte-sur.
• La proyección máxima horizontal se calcula desde el valor más alto de los datos en

una capa especificada por el usuario sobre cada pixel.
• La proyección máxima Este-Oeste se obtiene desde los datos máximos para cada

pixel a lo largo de la línea Norte-Sur correspondiente.
• La proyección máxima Norte-Sur se obtiene desde los datos máximos a lo largo de

las líneas Este-Oeste.
3. Aplica la estabilización, si está habilitada.

3.9.1 Configuración de productos MAX

Figura 11 Configuración de ejemplo de MAX
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1. Cree un diagrama de la capa que desea, similar a la siguiente ilustración.

Compárelo con las elevaciones de la tarea para ver si tiene un resolución razonable, en
especial en las partes superiores de la casilla MAX.

Layer Top = 16 km

Layer Bottom = 0 km

Center of Top Pixel
   at 15.75 km

Center of Bottom
Pixel at 0.25 km

E–W Maximum Projection

Radar

West 220 Pixels East

South

224 Pixels

North

Max Range
= 220 km

Side Panel Resolution
        = 32 Pixels

2. Seleccione Type > MAX.

3. Seleccione un Product Name que sea nemónico.

Por ejemplo, Z_0_16_220 indica que el producto cubre la capa de 0 ... 16 km
(0 ... 9,9 mi) a un rango de 220 km (136,7 mi).

4. Seleccione el TASK Name.

El TASK Name asociado debe coincidir con una tarea de exploración de volumen.
Se requieren al menos 2 ángulos de elevación.

5. En Data:Display, seleccione los datos de entrada.

Los tipos de datos disponibles incluyen dBT, dBZ, dBZc, V, Vc, W, ZDR, ZDRc y Kdp.
La tasa de lluvias se puede generar para los tipos adecuados.

6. Defina el Max Range.

El Max Range corresponde al espacio de la imagen desde el radar hasta el borde de la
imagen en la dirección Este-Oeste.
En el ejemplo, el rango de 220 km (136,7 mi) se cubre con 120 píxeles para producir
2 km (1,2 mi) por resolución del píxeles.

7. Seleccione Layer Top y Layer Bottom a los 100 m (328 pies 1 in) más cercanos.

Al seleccionar el valor superior de la capa, recuerde la altura máxima de datos
permitida para el sistema, tal como se configuró en la herramienta Setup.
En el ejemplo, la capa abarca de 0 a 16 km (0 a 9,9 mi). La resolución del panel lateral
correspondiente se establece en 32 píxeles, de modo que cada pixel representa 0,5 km
(0,3 mi). El centro del pixel inferior está a una altura de 0,25 km (0,2 mi) y el centro del
pixel superior está a una altura de 15,75 km (9,8 mi).
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8. Defina los niveles de estabilización (en km).

El XY Smoother se usa para la proyección máxima horizontal.
El XZ Smoother se usa para los paneles laterales e incluye valores para la estabilización
horizontal y la estabilización vertical.

En muchas aplicaciones, tal vez desee no usar estabilizaciones, a fin de que los
valores máximos no disminuyan con el filtro de estabilización.

9. Para Color Scale, Levels y 1st Level/Step, escriba la cantidad de niveles, el valor de
primer nivel y la fase de nivel en dBZ.

Los niveles de colores para la pantalla de Zmax son idénticos a los que se definen para
la reflectividad.

10. En Resolution, seleccione un valor de entre los siguientes valores predeterminados o
escriba otros valores en el campo.

Resolution consta de 3 números: la cantidad de píxeles Este-Oeste, la cantidad de
píxeles Norte-Sur y la altura de los paneles laterales.

Resolución Píxeles Altura

Low 240 × 240 20

Medium 480 × 480 40

High 720 × 720 60

XHigh 940 × 940 80

Los valores de resolución representan el tamaño total de la pantalla, incluidos los
paneles laterales.

Más información

‣ Parámetros de visualización (página 31)
‣ Configuración de las proyecciones del mapa (página 24)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)

3.10 MLHGT: Altura del nivel de derreti-
miento

Por lo general, la banda brillante del nivel de derretimiento representa la ubicación de los
hidrometeoros congelados que caen al aire más tibio que el nivel de congelamiento, donde
las partículas comienzan a derretirse.
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La altura del nivel de derretimiento es un aspecto importante para comprender qué ocurre a
nivel microfísico dentro de los sistemas de precipitaciones. Los cambios en la altura del nivel
de derretimiento pueden ayudar a determinar las probabilidades de granizo y relámpagos, y
están relacionados con el cálculo de la intensidad de las corrientes descendentes cuando
pasan de la fase sólida a la fase líquida. En época invernal, el cálculo de la ubicación de
precipitaciones líquidas en comparación con precipitaciones gélidas en la superficie se
mejora al conocer el nivel de derretimiento, en especial en terrenos montañosos.

La presencia de la banda brillante asociada con el nivel de derretimiento se debe
representar para las interpretaciones cuantitativas de las observaciones meteorológicas.

En el software del IRIS y de RDA, el producto SRI usa la altura del nivel de derretimiento se
usa en el producto SRI para realizar correcciones del perfil de reflectividad vertical, para
aplicar correcciones de la velocidad de caída a la velocidad radial, para distinguir entre
precipitaciones convectivas y no convectivas, para representar las atenuaciones diferentes
entre líquido y sólido y como una función de membresía en la función de clasificación de
hidrometeoros. Por lo tanto, una determinación automatizada de la altura del nivel de
derretimiento y cómo varía a nivel espacial y temporal agrega valor a todo el software del
sistema del radar meteorológico.

Figura 12 Detección de la altura del nivel de derretimiento
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El producto MLHGT que genera el IRIS es una representación de las alturas del nivel de
derretimiento en un mapa cartesiano. Las alturas del nivel de derretimiento se determinan
en una cuadrícula definida por el usuario que proporciona una ilustración que muestra cómo
cambian las alturas del nivel de derretimiento geográficamente.

Los datos del radar de polarización doble se usan como entrada junto con la información a
priori. Como con otros productos del IRIS, el producto MLHGT se pueden animar
temporalmente y se puede superponer con otros datos para aumentar la conciencia
situacional de la estructura de las precipitaciones en la atmósfera.

3.10.1 Algoritmo de MLHGT
Los datos de volumen sin procesar de polarización doble del IRIS se usan como entrada para
el algoritmo de MLHGT. Estos datos puede provenir de una sola exploración de PPI,
volumen, RHI o sector. El algoritmo también funciona independientemente de los datos de
la geometría de la exploración que hacen coincidir los datos del sistema de exploración de
coordenadas polares con un sistema de coordenadas relativo a la Tierra. Sin embargo, como
con cualquier observación del radar, un número más alto de la cantidad de elevaciones de
una exploración de volumen proporciona los mejores resultados.

En la siguiente ilustración, se muestra el organigrama del algoritmo de MLHGT. El nivel
superior muestra las entradas de la observación del radar, seguidas de la información
anterior. Los bloques representan las etapas funcionales consecutivas. Entre paréntesis se
expresa un calificador clave para cada etapa.
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Figura 13 Organigrama de flujo del algoritmo de MLHGT

El primer paso del procesamiento es garantizar que solo se consideren partículas de
precipitaciones para los cálculos de la altura del nivel de derretimiento. El PreClassifier
etiqueta a cada bin de rango como proveniente de objetivos de precipitación o no. Los bins
que no provengan de precipitaciones se eliminan de los datos considerados.

Los bins de las precipitaciones se clasifican como 'nieve derretida' o como 'otras
precipitaciones' mediante un algoritmo difuso dedicado denominado MeltClassifier.
MeltClassifier es similar al MeteoClassifier que se usa en HydroClass. Sin
embargo, el MeltClassifier sustituye a la función de membresía (MBF) de la relación
señal-ruido (SNR) por la MBF de la altura del nivel de derretimiento que usa el
MeteoClassifier. La MBF de la SNR se configura para que una SNR baja forme parte de
la clasificación 'nieve derretida' y para que una SNR alta esté en 'otras precipitaciones'. Otros
tipos de partículas, como lluvia, nieve seca, granizo y granos de hielo, se caracterizan
normalmente o también se agrupan en la clase 'otras precipitaciones'.
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El método estadístico denominado Regla de Bayes se usa para deducir la probabilidad de
que una región esté en la clasificación 'nieve derretida' u 'otras precipitaciones', usando la
información a priori y el acondicionamiento posterior. La información a priori es el primer
cálculo de las alturas de 0°C desde una fuente externa. Esto se podría insertar
automáticamente desde los datos de la radiosonda o de NWP, o podrían provenir desde los
valores climatológicos que se encuentran en IRIS/Setup.

La probabilidad del MLHGT se puede actualizar por cada observación subsecuente del radar
a lo largo del tiempo, lo que ayuda a creer en el cálculo. Si hay una cantidad muy alta de bins
de 'nieve derretida' u 'otras precipitaciones' en una región, y la relación de una condición en
comparación con la otra es alta, la confianza aumenta rápidamente. Asimismo, si hay una
cantidad baja de clasificaciones en la región o si la relación de 'nieve derretida' a 'otras
precipitaciones' es casi idéntica, la confianza sigue siendo baja. Una vez que se alcanza la
confianza mínima, el MLHGT de forma de la altura del nivel de derretimiento se asigna a esa
región; de otro modo, la altura continúa siendo el valor climatológico. La inferencia
bayesiana se puede entender conceptualmente como la construcción de una pantalla de
secciones transversales en las que la posición más probable de ML se puede reconocer de
forma visual cuando se inspeccionan las decisiones de MeltClassifier.

Las regiones se presentan como columnas de datos en un sistema de coordenadas
terrestres. El usuario puede configurar la resolución vertical y el tamaño acimutal de cada
región. El tamaño de las columnas en el dominio del rango se ajusta para que coincida con
su tamaño y su acimut. El alcance del rango de las columnas crece proporcionalmente a
medida que aumenta el tamaño del acimut como distancia del radar. De este modo, las
columnas tienen, efectivamente, la misma forma en todo el dominio. Esto es beneficioso ya
que las estadísticas se mejoran a mayores distancias, debido a un aumento en la cantidad de
puntos de datos, lo que compensa la pérdida de resolución por el ancho del haz.
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3.10.2 Configuración de productos MLHGT

Figura 14 Ejemplo de configuración de MLHGT

Use el menú MLHGT Product Configuration del IRIS para configurar el producto MLHGT.

1. Seleccione Type > MLHGT.
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2. Configure el producto MLHGT:

Variability
El algoritmo de MLHGT usa la altitud del nivel de derretimiento climatológico
como un parámetro de inicialización en la inferencia bayesiana.
El campo Variability establece los límites realistas de las soluciones de MLHGT
permitidas que se centran en los niveles de derretimiento climatológico que se
configuran en la herramienta Ingest/Setup.
Por ejemplo, si la altura del nivel de derretimiento climatológico es, por lo
general, de 3 km (1,9 mi) por sobre el nivel del mar y la variabilidad se establece
en 3 000 m (9 842 pies 6 in), el rango aceptado para la solución es desde
1,5 ... 4,5 km (0,9 ... 2,8 mi).

Todavía puede usar la función setup_change para actualizar
automáticamente las alturas de 0°C desde otras fuentes, como una
radiosonda o NWP, de forma más oportuna.

Hgt Bin Spacing
Se crea un sistema de cuadrículas de coordenadas terrestres, donde se deriva un
valor de MLHGT para cada punto de cuadrícula. Este campo establece el espacio
de bin vertical centrado en cada punto de cuadrícula.
Los datos en los bins verticales se usan como entradas para calcular la altura. Las
entradas permitidas son de 50 ... 2 000 m (164 pies 1 in ... 6 561 pies 8 in).

Az bins
La resolución espacial varía como una función del rango debido al
ensanchamiento de los radiales. Este campo define la cantidad de sectores de la
columna que existen en una vista de 360°. Por ejemplo, si agrega un valor de 24,
hay 24 columnas para cada intervalo de rango, cada uno con un tamaño de 15°
(360/24 =15).

Cuando se especifica una pequeña escala de base de la cuadrícula, se
necesitan más cálculos de MeltClassifier como entradas para alcanzar
un nivel de confianza determinado.
Si se especifica una escala de cuadrícula grande, se reduce la resolución total.
Tal vez desee alcanzar un valor intermedio, que proporcione una
disponibilidad de datos suficiente en los niveles de confianza deseados con
resoluciones más altas.

Decay Time
A medida que disminuye la confianza en los cálculos de MLHGT, ya sea porque no
hay observaciones del radar o por latencia temporal, el enfoque bayesiano de
MLHGT comunica sin problemas los cálculos de la altura observada del radar a la
altura del nivel de derretimiento climatológico en cada punto de la cuadrícula.
El campo Decay Time establece la altura de la ventana de tiempo para esta
transición uniforme. El valor predeterminado es de 1 hora.
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Min Confidence
En cada punto de la cuadrícula, el algoritmo de MLHGT verifica la confianza en el
cálculo de MLHGT del radar al compararlo con los de las cuadrículas próximas. La
confianza se acepta si supera el nivel de confianza mínimo que se define en este
campo Y si una cantidad mínima de cuadrículas próximas alcanzan el nivel de
confianza. De lo contrario, la confianza del cálculo se establece en un valor muy
bajo.

Min Cluster
Define la cantidad mínima de cuadrículas próximas que se necesitan para
alcanzar el nivel de confianza.

3.10.3 Uso del flujo de datos de MLHGT con otros productos
Para usar el producto MLHGT por completo, se lo debe distribuir a otros nodos del IRIS para
respaldar la creación del producto y la pantalla del usuario. El producto MLHGT también se
debe regresar a IRIS/Radar y al procesador de señales RVP10 en el sitio del radar.

La siguiente ilustración es un ejemplo de la distribución del producto MLHGT. En la
ilustración se da por sentado que el producto RAW se recibe en un nodo centralizado de
IRIS/Analysis. El nodo de IRIS/Analysis se configura para crear un producto MLHGT. Este
nodo tendría la configuración climatológica de las alturas de 0°C. De modo opcional, puede
existir un proceso externo personalizado que obtenga un valor de 0°C más realista desde
otras fuentes y actualice el valor de 0°C almacenado en la memoria temporal. El nodo crea
el primer producto MLHGT de acuerdo con la configuración que se guardó y lo guarda como
un archivo. Luego, el IRIS administra este archivo de producto de modo similar a otros tipos
de productos.

Figura 15 Flujo de datos de MLHGT para su uso con otros productos
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Idealmente, el producto MLHGT se propaga desde el nodo IRIS/Analysis al nodo IRIS/Radar,
ubicado en el sitio del radar. IRIS/Radar comparte inmediatamente la información del
producto MLHGT al proceso del software RDA del RVP10 a través de OP_CODE en la API de
DSP. Consulte RVP10 User Guide (M212604EN).

El RVP10 usa los conocimientos del nivel de derretimiento para la corrección de atenuación
en tiempo real, la clasificación de hidrometeoros en tiempo real y el acondicionamiento de
PhiDP para el cálculo adaptable de Kdp. Cuando se crean los archivos de introducción
originales, el nivel de derretimiento derivado del radar también se guarda en los metadatos.
Por lo general, los archivos de introducción que contienen las alturas del nivel de
derretimiento derivado se vuelven a transferir a IRIS/Analysis para su uso en la creación del
producto.

3.11 PPI: indicador de posición en plano

Figura 16 Configuración de ejemplo de PPI

PPI es una imagen de pantalla completa que se usa principalmente para fines de vigilancia
meteorológica.

PPI muestra la distribución del parámetro de datos seleccionado en una superficie con
ángulo de elevación constante, la pantalla clásica del radar. Los productos PPI del IRIS se
crean tan pronto como se completa el barrido de la elevación solicitada, en lugar de al
momento de finalizar una exploración de volumen.
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Un PPI muestra los datos desde una elevación, todos acimuts. Puede usarlo en el sitio del
radar para el control de calidad.

1. En el menú IRIS, seleccione Menu > Product Configuration.

2. Seleccione Type > PPI.

3. Seleccione el botón junto a TASK name y seleccione una tarea de la lista.

4. Seleccione el botón junto a Data:Display y seleccione un parámetro que se mostrará,
por lo general, Z para la reflectividad.

5. Ingrese Maximum Range (km) y el ángulo de elevación que se adapte a la tarea que
haya seleccionado.

Puede ver la información de la tarea en la parte superior del menú.

6. Seleccione File > Save as y dele un nombre al archivo PPI.

Más información

‣ Parámetros de visualización (página 31)
‣ Configuración de las proyecciones del mapa (página 24)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)

3.12 RAIN1: acumulación de lluvia por ho-
ra

Figura 17 Configuración de ejemplo de RAIN1
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RAIN1 es la acumulación de pluviosidad por hora.

El producto RAIN1 usa datos de CAPPI o SRI en un intervalo definido, por lo general de
60 minutos, para obtener un cálculo de la precipitación que cayó dentro de esa hora. Los
resultados se pueden mostrar o usar para derivar el producto RAINN o CATCH.

Por lo general, una exploración de volumen de uso general sirve para el producto de
precipitación. Tenga en cuenta que la precisión del producto de precipitación disminuye con
el rango ya que el haz es mayor a rangos mayores. Por ejemplo, el haz para un ancho de haz
de 1° es de 3 km a través de un rango de 180 km.

Si tiene un radar Doppler, seleccione Z como una de las salidas de datos de la tarea. Esto
se corrige para los efectos del eco del suelo.

1. Seleccione Type > RAIN1.

2. Seleccione el tipo del producto (ya sea CAPPI o SRI) y el nombre de un producto de
entrada.

Cuando use CAPPI como producto de entrada, asegúrese de que el campo del número
de capas (junto al campo Resolution) sea 1.
El tipo de datos de entrada puede ser dBZ corregido, dBZ no corregido o tasa de
precipitación.
Si integra entradas de la tasa de precipitación, el campo Minimum dBZ no corresponde.
La prioridad del producto RAIN1 debe ser inferior que la de los productos CAPPI y SRI
para garantizar que todas las entradas estén listas antes de crear el producto RAIN1.
Use el comando product de la herramienta setup para establecer las prioridades
relativas de los productos.

3. Para habilitar los mapas de eco, seleccione Clutter Map.

Para usarlo, debe crear un producto RAIN1 con un nombre coincidente y una resolución
en buenas condiciones meteorológicas.
Luego, este archivo se resta de cada acumulación por hora. El archivo del mapa de
interferencia se marca en el Product Output Menu.

4. En Minimum dBZ, establezca el valor mínimo de dBZ que se usa para calcular la
cantidad de precipitación.

Los valores de dBZ que sean inferiores se tratan como 'precipitación 0'.
Así, se evita que los ecos muy débiles se consideren dentro de la precipitación.
En la mayoría de los casos, establezca el valor en -10 dBZ, aunque debe seleccionar un
valor adecuado para su sitio.
Establezca el valor en -33 para deshabilitar Minimum dBZ.

5. En Minutes, establezca el período deseado para la acumulación de precipitación.

Por lo general, se usan 60 minutos para generar un producto de precipitación de una
hora, pero puede usar intervalos más cortos. El tiempo de acumulación mínima es de
15 minutos.

6. Si adquirió la licencia del software de IRIS/Hydromet, seleccione Gage Cal para que el
producto use el algoritmo de corrección del pluviómetro.
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Más información

‣ Parámetros de visualización (página 31)
‣ Configuración de las proyecciones del mapa (página 24)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)
‣ Descripción general de la corrección del pluviómetro Hydromet (página 360)
‣ CATCH: Acumulación de precipitación en subcuencas (página 128)

3.12.1 Programación de productos RAIN1
La Data Time que especifique al programar el producto se cuantifica al valor de la hora en la
configuración del producto para el intervalo más cercano que finaliza la integración.

Por ejemplo, si desea programar un producto RAIN1 de 60 minutos para que integre la
precipitación en las horas de 11:00 a 12:00, establezca la hora en 12:00. Si la tarea asociada
se ejecuta al final de una hora, el Product Scheduler espera a que se complete, de modo que
los datos de la tarea se puedan incluir en la integración de la hora.

Use el campo Skip Time si solo desea las acumulaciones de intervalos específicos. Puede
establecer los tiempos de omisión en cualquier múltiplo del período de acumulación. Por
ejemplo, si desea una integración de 3 horas solo para los períodos que finalicen a las 03:00,
06:00, 09:00, ..., configure el campo Skip Time en 03:00.

Establezca el campo Skip Time en 01:00, de modo que el producto RAIN1 se ejecute a cada
hora. Esto es recomendable ya que el producto RAIN1 para las acumulaciones de horas
múltiples funciona mejor si hay un producto a cada hora.

El producto RAIN1 debe esperar la llegada de todos los CAPPI de entrada durante el período
de acumulación.

El activador es la llegada de un CAPPI que representa el siguiente período de acumulación.

El programador del producto debe administrar 2 casos, es decir, el CAPPI de la siguiente
hora llega o no llega. Tenga en cuenta que en las ilustraciones de líneas de tiempo que se
muestran a continuación:

• La línea horizontal representa la hora de los datos, la hora de inicio de una exploración
de volumen.

• La C representa un producto CAPPI de entrada.
• La barra vertical representa el siguiente período de acumulación.

Caso 1: Caso normal: llegada del CAPPI de la hora siguiente

C CC C CC C C

El producto RAIN1 se ejecuta tan pronto como llega un CAPPI desde el próximo intervalo de
acumulación.
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Caso 2: Caso tardío: el CAPPI del próximo intervalo de acumulación no llega

C CC C CC C

Tail Wait

El producto RAIN1 se ejecuta luego de que las horas de Tail y Wait transcurren desde la
hora de llegada del archivo del último CAPPI de entrada.

Tail es la diferencia horaria entre la hora de los datos del último CAPPI y el siguiente
período de acumulación. El umbral de la hora de Wait se configura en Setup > Product del
IRIS, donde puede configurar un valor diferente para los casos con entradas del pluviómetro.
El umbral de la hora de Wait se ajusta para representar cualquier demora de la red.

Más información

‣ Programación de RAIN1 con producto GAGE (página 371)
‣ Programación de productos (página 120)

3.13 RAIN-N: acumulación de lluvia en N
horas

WIND_05 70.0

2Z T V W ZDR Kpd PDP RHV SQI Zv Tv SNR Ze Te

Az:Full Circle EL:3 angles from 0.5 to 4.0

Figura 18 Configuración de ejemplo de RAIN-N
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RAINN es la acumulación de pluviosidad de las últimas N horas, donde N es un valor
seleccionado por el usuario.

RAIN-N es un producto de un producto. Puede sumar cualquier cantidad de horas de
productos RAIN1 individuales. El único límite es la cantidad de productos RAIN1 que se
almacenan en el disco. La salida del producto muestra las últimas horas N de acumulación.

1. Seleccione Type > RAIN-N.

2. Especifique el nombre del producto.

Cuando especifica el nombre del producto RAIN-N, una buena idea es indicar la hora
de integración en el nombre, en el ejemplo, 03_HOUR.
Esto facilita identificar el producto en los menús de Product Scheduler y Product 
Output.

3. Configure el producto RAIN-N:

Rain1
Especifique el nombre del producto del producto RAIN1 por hora de entrada;
para hacerlo, seleccione el botón Rain1 y seleccione el nombre desde una lista de
productos o escríbalo en el campo.
Cuando ingresa un nombre del producto, la información de la tarea asociada se
muestra en la sección de TASK Summary del menú.

Hours
Especifique la cantidad de horas a integrar. Cuando ejecuta el producto, este
integra los datos de las últimas horas N.
Si falta un producto RAIN1 para una de las horas del intervalo, el algoritmo
supone que no hubo lluvias en esa hora. La salida del producto muestra cuántas
horas se integraron.

Color Scale, Levels y 1st Level/Step
Los niveles de colores se pueden especificar, pero la resolución se fija con la
resolución de la configuración de RAIN1.

Más información

‣ Descripción general de la corrección del pluviómetro Hydromet (página 360)

3.13.1 Programación de productos RAIN-N
La Data Time que especifique al programar el producto se cuantifica al valor de la hora en la
configuración del producto para el intervalo más cercano que finaliza la integración.

Use el campo Skip Time si solo desea las acumulaciones de intervalos específicos. Puede
establecer los tiempos de omisión en cualquier múltiplo del período de acumulación. Por
ejemplo, si desea una integración de 3 horas solo para los períodos que finalicen a las 03:00,
06:00, 09:00, ..., configure el campo Skip Time en 03:00.

El algoritmo de programación para el producto RAIN-N busca la llegada del producto RAIN1
más reciente (luego de la "hora actual") y luego ejecuta el algoritmo de RAIN-N.

El programador del producto debe administrar 2 casos, es decir, el producto RAIN1 llega o
no llega.
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Tenga en cuenta que en las ilustraciones de líneas de tiempo que se muestran a
continuación:

• La línea horizontal representa la hora de los datos de los productos RAIN1, que siempre
es exactamente la hora de finalización.

• R representa un producto RAIN1 de entrada.
• R* representa el producto RAIN1 de la hora actual, cuya llegada hace que se ejecute el

producto RAIN-N.
• Las barras verticales representan las horas pares.

Los ejemplos muestran el caso de una integración de 4 horas.

Caso 1: Caso normal: llegada del producto RAIN1 de la hora actual

RR R R*

Current

Hour

En este caso, llega el producto RAIN1 de la hora actual (R*). El algoritmo se ejecuta en este
momento y en los productos RAIN1 anteriores que están disponibles en las 4 horas
anteriores.

Caso 2: el RAIN1 de la hora actual no llega, pero el RAIN1 de la siguiente hora
sí lo hace

RR R

Current

Hour

Tail Wait

Next

Hour

En este caso, el RAIN-N de la hora anterior no llega, de modo que el programador debe
esperar.

Eventualmente, el RAIN-N de la hora siguiente llega, y el programador supone que el RAIN-
N de la hora actual no llegará nunca y ejecuta el producto en los RAIN1 disponibles, sin los
datos de la hora actual.

Si el RAIN1 de la hora actual llega eventualmente, no activa el algoritmo de programación ya
que el Next Data Time del Product Scheduler ya avanzó a la siguiente hora. Sin
embargo, se lo usa en el procesamiento de RAIN-N futuros, es decir, para la hora siguiente.
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Caso 3: el RAIN1 de la hora actual no llega, pero la hora de Wait termina

RR R

Current

Hour

R

Next

Hour

En este caso, el producto RAIN-N se ejecuta luego de transcurridas las horas de Tail y
Wait.

La hora de Tail es la hora de la computadora local entre la llegada del producto RAIN1 más
reciente y la hora actual.

El umbral de la hora de Wait se configura en Setup > Product del IRIS para representar
cualquier demora de la red.

Si el RAIN1 de la hora actual llega eventualmente, no activa el algoritmo de programación ya
que el Next Data Time del Product Scheduler ya avanzó a la siguiente hora. Sin
embargo, se lo usa en el procesamiento de RAIN-N futuros, es decir, para la hora siguiente.

Más información

‣ Programación de productos (página 120)

3.14 RAW: datos sin procesar

Figura 19 Configuración de ejemplo de RAW

Un archivo de datos RAW contiene los parámetros de salida del procesador de señales sin
procesar (Z, ZT, V, W, ZDR y así sucesivamente) en coordenadas polares.
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Los productos RAW se crean uno a uno a partir de los archivos de introducción.

Un archivo RAW contiene toda la información recogida durante una tarea de medición. Se
comprime para se pueda enviar a través de la red a IRIS Analysis.

Si bien los datos RAW no se pueden visualizar, es útil para registrar en cinta, disco o DVD, o
para transferir a otra computadora de la red de IRIS para la generación de productos.

Cuando un archivo de producto RAW se recupera desde una cinta o se recibe desde otra
computadora del IRIS, se crea un archivo de introducción a fin de que se puedan generar los
productos. El producto RAW se usa de las siguientes formas:

• Sistema Analysis desconectado: Los productos RAW se guardan en cintas y luego se
vuelven a leer a un sistema IRIS Analysis (no necesariamente el host del radar), a fin de
generar productos para análisis o pruebas.

• Sistema de red en tiempo real: Los productos RAW se envían a otra computadora del
IRIS y el producto se crea allí en vez de en el host del radar. Así, se aliviana la carga del
procesamiento del host del radar a otras computadoras de la red que no están tan
ocupadas. Esto es valioso si desea crear productos que no se generan normalmente
con el host del radar.

Más información

‣ Asociación de productos con tareas (página 21)

3.14.1 Configuración de productos RAW

1. Seleccione Menu > Product Configuration.

2. Seleccione Type > RAW.

3. Seleccione el botón junto al nombre de la tarea y seleccione una tarea de la lista.

Vaisala recomienda que el nombre del producto RAW sea igual que el nombre de su
tarea asociada.

4. Para copiar los archivos del producto a través de una conexión de red lenta, seleccione
Make sweep-by-sweep? > On.
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5. Para filtrar el producto RAW a fin de que solo incluya algunos de los tipos de datos de
los datos originales, deseleccione Include All Data.

Por ejemplo, tal vez desea enviar todos los datos a un cliente de investigación, pero
omite enviar los datos de doble polarización a una computadora de pantalla simple.

Vaisala recomienda dejar habilitada la opción Include All Data hasta que sea
necesario limitar los tipos de datos.

Si usa un comodín, no puede combinar datos de tareas híbridas en un archivo.

6. Seleccione File > Save as y dele un nombre al archivo RAW.

3.14.2 Grabación de datos RAW automáticamente
Puede configurar un producto RAW automáticamente cuando se ejecuta la tarea asociada.

Dado que el producto RAW requiere un espacio de disco considerable, es mejor
registrarlo "sobre la marcha", de modo que el Watchdog del disco no lo elimine
automáticamente.

1. Configure el producto RAW.

Consulte Configuración de productos RAW (página 68).

2. Cargue las tareas asociadas en el TASK Scheduler y seleccione Go.

3. En el menú Product Scheduler, cargue el producto y seleccione All.

Esto provoca que se genere un producto RAW cada vez que se ejecuta la tarea.

4. En el menú Product Output, especifique los medios de archivos deseados como el
dispositivo de salida y seleccione All en la línea del encabezado para el producto, de
modo que la salida se envíe al archivo.

5. En el menú Archive, coloque una cinta o un disco y seleccione Commands > Record.
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3.15 RHI: indicador de altura del rango

Z   :   dBZ

- 41.7 57.9

300.0

10.0

2.0  1.0

600 X 290

RHI T Z V W

56.0

Az: 6 angles from 303.0 to 313.0  El: Sector

Figura 20 Configuración de ejemplo de RHI

RHI es una imagen de pantalla completa que muestra la estructura transversal detallada de
una tormenta; se usa para identificar tormentas severas, granizo y banda brillante.

En general, programa la tarea RHI asociada a través de una región de interés.

Durante la exploración de RHI, el acimut de la antena se fija y la elevación se barre, por lo
general cerca de 0 ... 90°, para crear un efecto transversal vertical.

Si la antena lo permite, a menudo es útil realizar una tarea RHI excesiva (por ejemplo, con
elevaciones de -2 ... 182). Así, se obtiene un panorama que cubre 2 elevaciones en los lados
opuestos de la antena. Las elevaciones negativas son muy útiles en RHI si selecciona el
acimut a la dirección del haz más pequeño que bloquea el horizonte del radar.

1. Seleccione Type > RHI.

2. En Data : Display, seleccione cualquier tipo de datos que se defina en la tarea RHI.

Además, si mide V, puede seleccionar SHEAR o el tipo de datos de salida para la
cizalladura radial. La cizalladura radial es la diferencia entre la velocidad de bins
sucesivos en el rango.

Se permite el uso de SHEAR como un tipo de datos de salida a RHI, pero no a otros
productos similares, como PPI.
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3. En Max Range, ingrese hasta 2 valores en el formato de xx.x kilómetros.

Si ingresa solo un valor, se da por sentado que el primer valor es 0.
El primer límite es el comienzo de la pantalla.
Cero significa que la imagen se inicia en el sitio del radar.
Si ingresa valores negativos, los datos se toman desde otro acimut del otro lado del
sitio del radar en la misma tarea, o si se explora una tarea excesiva.
También puede ingresar valores positivos, en especial si no usa elevaciones altas y si
desea evitar esquinas planas en una imagen de forma triangular.

4. En Azimuth Angle, especifique el ángulo de acimut:

Si no conoce este valor por adelantado, el IRIS selecciona el ángulo más cercano en el
momento de la ejecución, de modo que siempre pueda obtener una pantalla.
Si la tarea asociada solo tiene un barrido del ángulo de acimut, el ángulo se usa para el
producto RHI.
Si ingresa * en el campo, el producto se crea para cada acimut de la tarea asociada.

5. En Max Height, XZ Smoother y Range filter, especifique el campo de Max Height en
XX.X km.

Dado que especifica el rango y la altura máximas, puede crear un RHI en cualquier
relación de aspecto horizontal-vertical.
Tenga en cuenta que la pantalla final se muestra desde 0 a la Max Height, por encima
de la altura de referencia.
El radar se ubica en el borde izquierdo, por encima de la esquina si el radar está por
encima de la referencia. En ese caso, se incluyen los ángulos de elevación negativos.
Los rayos se insertan de forma recta, y la cuadrícula de líneas de altura constantes se
curva para mostrar la curvatura terrestre.
Puede escribir los valores de Smoother X-Z (altura) en km.
Si tiene SHEAR como un tipo de datos de salida, es ruidoso y se debe estabilizar con un
filtro de rango. Este número no se usa para los tipos de datos que no sean SHEAR.

6. En Resolution, seleccione resoluciones o tipos de resoluciones de Low (288 × 136),
Medium (600 × 290), High (840 × 530), o XHigh (1 060 × 750) en el campo.

Los productos RHI ofrecen la mejor visualización con una resolución rectangular.

Más información

‣ Parámetros de visualización (página 31)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)
‣ XSECT: sección transversal (página 115)
‣ SHEAR: Cizalladura del viento (página 185)
‣ ¿Es mejor usar RHI o XSECT? (página 73)

3.15.1 Ejemplo de cumulonimbus con RHI
Para obtener una estructura vertical detallada, el RHI no tiene reemplazo. En el siguiente
ejemplo, se muestra una cumulonimbus vista con el RHI desde la región sudeste de los
Estados Unidos durante el verano.
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El RHI muestra que es un Cb poderoso y que crece activamente, con su parte superior a
13 km (8,1 mi). La región de eco saliente y de ecos débiles en el lado derecho indica una
entrada poderosa y bien organizada y un movimiento vertical, ambas características de una
tempestad severa. El centro de la reflectividad (el color rojo representa >56 dBZ) indica un
probable eje de granizo. Un yunque de nivel superior, presuntamente desde otro Cb, se
puede observar cerca del radar.

Figura 21 Ejemplo de cumulonimbus con RHI
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3.15.2 ¿Es mejor usar RHI o XSECT?
Puede estudiar la estructura tridimensional de la atmósfera con los productos XSECT y RHI,
que muestran una representación de rango-altura o una "porción" vertical de un parámetro
del radar.

Si tiene áreas de interés, como trayectorias a pistas en un aeropuerto, puede ejecutar
productos RHI o XSECT asociadas a las de su programación de rutina.

Tabla 11 Comparación de RHI y XSECT

Característica RHI XSECT

Ubicación del ra-
dar

La ubicación del radar se fija en un
punto.

Puede trazar una sección transversal en cualquier
punto a lo largo del volumen polar.

Tenga en cuenta que no puede bajar por debajo
de la elevación más baja.

Resolución Por lo general, RHI brinda una resolu-
ción mucho mejor.

--

Programación Si el usuario de las imágenes del radar
puede controlar las tareas, estas pue-
den definir una configuración del pro-
ducto por adelantado (se debe usar un
* para el acimut).

Cuando aparece algo interesante, pue-
den ejecutar una tarea de RHI con un
acimut que se determina con otros
productos del IRIS.

Puede programar un XSECT cuando lo desee, in-
cluso a medida.

Si los radares están en una red con varios usua-
rios, o si la programación de la tarea no tiene mu-
cho tiempo, tal vez no pueda permitir que los
usuarios ejecuten los RHI cuando lo deseen.

Más información

‣ XSECT: sección transversal (página 115)
‣ RHI: indicador de altura del rango (página 70)
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3.16 RTI: indicador del tiempo del rango

Figura 22 Configuración de ejemplo de RTI

RTI muestra el tiempo a lo largo del rango de visualización en ejes horizontal y vertical del
radar.

Un RTI se puede usar para cualquier tipo de exploración (por ejemplo, PPI, RHI), pero es
más útil para exploraciones manuales o exploraciones de "reflector", que son exploraciones
manuales en una posición fija. Tal vez la mejor aplicación sea para exploraciones de
incidencia vertical, en cuyo caso el producto RTI muestra una sección transversal de hora-
altura de la atmósfera.

En el siguiente ejemplo, se muestra un RTI y un PPI desde la misma situación. Desde ambas
imágenes, el rango máximo es de 50 km (31,1 mi) y la escala de colores es la misma. En este
caso, RTI se creó a partir de una tarea de PPI que gira 10° por segundo, de modo que el eje
horizontal se expresa en segundos desde el inicio y acimut en décimas de grados. Puede
observar la región de eco débil cerca de los 220°, a partir de los 15 km (9,3 mi) en ambos.
Esto puede bloquear el haz, lo que probablemente es más fácil de reconocer en RTI.
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1. Seleccione Type > RTI.

2. En Data:Display, seleccione cualquier parámetro que esté disponible en la
configuración de la tarea.

3. En Max Range, escriba el rango máximo en kilómetros.

4. En Sweep Angle, seleccione cualquier ángulo de elevación de la tarea.

Los ángulos se enumeran en la parte superior del menú.
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5. En TR Smoother, defina la estabilización en las direcciones XY de la imagen de RTI.

Por lo general, se usa un valor pequeño para fines de investigación y un valor mayor
para los productos de los clientes.
La estabilización de la dirección temporal se expresa en segundos, la dirección del
rango, en kilómetros.

6. En Resolution, seleccione entre baja, media, alta y extra alta.

Las resoluciones predeterminadas son rectangulares a fin de coincidir con los tamaños
de ventana predeterminados rectangulares de Quick Look Window.

Más información

‣ Parámetros de visualización (página 31)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)

3.17 SRI: intensidad de pluviosidad en su-
perficie

SRI brinda una entrada para el producto RAIN1 para obtener las mejores estimaciones
posibles de la precipitación acumulada, incluso en rangos más largos del radar.

El perfil de reflectividad vertical es la fuente de errores más importante en las mediciones de
pluviosidad del radar en climas frescos y moderados.

Por lo general, las partes superiores de las nubes de precipitación producen un eco más
débil que la base de la nube, excepto cerca de la capa de derretimiento, donde el eco es
mucho más fuerte. Por lo tanto, se necesita una corrección para calcular la intensidad de la
pluviosidad en superficie.

La SRI del IRIS le permite aplicar sus conocimientos locales, ya que proporciona formas de
ingresar información acerca del perfil de reflectividad, como así también métodos para
formular hipótesis fundamentadas.

La SRI diferencia entre casos convectivos y precipitaciones a gran escala y aplica la
corrección solo a estas últimas. Para las precipitaciones convectivas, se muestra el valor para
el bin libre de eco más bajo.

3.17.1 Algoritmo de SRI
El perfil de reflectividad y el cálculo de la altura de derretimiento de SRI no son perfectos,
pero pueden mejorar los cálculos de pluviosidad en comparación con no realizar
correcciones. Las correcciones típicas que se obtienen se encuentran en el orden de los
-10 ... +5 dBZ (en una escala de mm/h hasta un factor de 4), según la altitud del nivel de
derretimiento, la distancia desde el radar y el ángulo de elevación más bajo.
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Figura 23 Ejemplo del perfil de reflectividad de SRI

El perfil incluye lo siguiente:
• La altura h=0 corresponde a Setup > Product Zero Reference Height.

Por lo general, se establece a nivel del suelo nominal o a nivel del mar.
• La altura máxima corresponde a Setup > Ingest Data Truncation Height.
• La reflectividad varía de forma lineal en dBZ por encima y por debajo de la banda

brillante.
Se usan pendientes separadas por encima y por debajo de la banda brillante (Sr para
lluvia e Si para hielo).

• La banda brillante comienza en el nivel de 0°C (h=h0C), tiene profundidad (D) e
intensidad (I), definida como la diferencia de intensidad entre el nivel máximo y la
intensidad de la lluvia en el centro de la banda brillante, es decir, determinada por la
continuación de la pendiente de lluvias en la banda brillante.

La intensidad de la pluviosidad en superficie en cada pixel se calcula al encontrar el bin libre
de eco más bajo y al bajar reflectividad medida al nivel de referencia por medio de
2 correcciones:

1. La corrección del promedio ponderado del haz.
2. El ajuste para que el perfil obtenga la reflectividad en la altura de referencia.

El producto SRI también admite usar un mapa del terreno para determinar la altura a la que
se corrige el haz del radar. Consulte Formato del archivo del mapa del terreno (página 87).

Algoritmo de revisión convectiva

Por lo general, en las precipitaciones convectivas no hay una banda brillante detectable, o
tal vez hay una banda muy débil. Se cree que esto se debe a los tipos de partículas cerca del
nivel de derretimiento, que son típicas de las precipitaciones convectivas. Normalmente, son
copos de nieve con mucha escarcha, granos de hielo, gotas congeladas (sueltas en el aire) o
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granizo. Dado que estas partículas tienden a caer más rápidamente que los conjuntos de
nieve, no contribuyen a una banda brillante de la misma forma que los copos de nieve
húmedos grandes que caen a 1 m/s. Es decir, no hay una convergencia de grandes partículas
húmedas.

En los casos donde hay precipitaciones convectivas, no es adecuado realizar una corrección
de perfil que incluya una banda brillante; al hacerlo, se pueden producir errores graves. En el
producto SRI, esta situación se maneja al detectar regiones convectivas y al no aplicar
correcciones de perfil. Es decir, el valor medido del bin libre de eco más bajo se asigna a la
altura de referencia. Esto se lleva a cabo porque en las regiones convectivas, la reflectividad
vertical tiende a ser muy constante en altura en las altitudes más bajas.

Cada bin de rango se revisa para determinar si es un bin de rango convectivo. El enfoque se
trata de ejecutar un algoritmo de TOPS del eco en el producto SRI para un umbral
seleccionable. Tenga en cuenta que esto se lleva a cabo en la SRI para que no sea necesario
definir un algoritmo de TOPS separado.

El producto, en coordenadas cilíndricas, se crea a la misma resolución que la seleccionada
para el producto SRI. Luego se lo usa como una máscara para determinar las regiones
convectivas. Es decir, se da por sentado que cualquier bin de un rayo para el que la altura
superior es mayor que una altura seleccionable por encima del nivel de derretimiento es
convectivo.

3.17.2 Perfiles de reflectividad de entrada
Puede definir el perfil de reflectividad con los siguientes parámetros:

• gradiente de reflectividad por encima de la capa de derretimiento (7 dBZ/km [11,3 dBZ/
mi])

• gradiente de reflectividad por debajo de la capa de derretimiento (1 dBZ/km [1,6 dBZ/
mi])

• altura de la capa de derretimiento (en décimas de kilómetros)
• espesor de la capa de derretimiento (1 km [0,6 mi])
• intensidad máxima de la capa de derretimiento (7 dBZ)

El nivel de derretimiento se adjunta al archivo de introducción. En una red con varios radares
y una máquina IRIS Analysis por separado, la información del perfil se envía a la instancia del
IRIS en cada sitio del radar.

La altura de la capa de derretimiento se envía a IRIS, en Setup > Product.
Puede cambiar el valor sin reiniciar el IRIS en la herramienta Setup. Esto significa que el
perfil de reflectividad se puede ajustar con frecuencia según las fuentes de datos
externas, como el modelo numérico o los sondeos de temperatura.

Obtención de datos de entrada para el perfil de reflectividad

La forma más precisa para determinar la altura de la capa de derretimiento es el análisis de
las mediciones del mismo radar en el mismo momento, como cuando se necesita una
corrección del perfil.
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Puede observar la capa de derretimiento fácilmente en los productos VVP y XSECT del IRIS
para ver la reflectividad o, aún mejor, la velocidad vertical. Sin embargo, esto no está
siempre disponible: cuando el área de precipitación se acerca al radar, solo hay datos en las
partes superiores del perfil.

Figura 24 Ejemplo del perfil de reflectividad de VVP

Los modelos numéricos de predicción meteorológica y los sondeos con globo son buenas
fuentes para los perfiles de temperatura.

Un método volumétrico es tomar la temperatura promedio (con promedios diarios e incluso
mensuales) y calcular la altura del nivel de derretimiento al dar por sentado que el gradiente
adiabático húmedo es de 6,5°C/km. Este gradiente es un buen cálculo durante el evento de
precipitación.

Si no hay más datos disponibles, comience con la siguiente tabla.
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Tabla 12 Primeras estimaciones de valores mensuales de la altura de derretimiento para el he-
misferio norte

Mes Clima polar Latitudes medias Trópicos

Enero -1 1 2.5

Febrero -1 1 2.5

Marzo -1 1.5 3

Abril 0.2 2 3.5

Mayo 1.3 2.5 4

Junio 2.2 3 4.3

Junio 2.5 3.5 4.5

Agosto 2.0 3.5 4.5

Septiembre 1.5 3 4.3

Octubre 0.5 2.5 4

Noviembre -1 1.5 3.5

Diciembre -1 1.0 2.5

¿Qué sucede si no hay un nivel de derretimiento?

Cuando está nevando, no existe una capa de derretimiento (-1 en la tabla anterior). El perfil
se vuelve una línea descendente simple, que se define con el conjunto de parámetros.

• gradiente de reflectividad por encima de la capa de derretimiento de 7 dBZ/km
(11,3 dBZ/mi)

• gradiente de reflectividad por debajo de la capa de derretimiento de 0 dBZ/km
(0 dBZ/mi)

• espesor de la capa de derretimiento de 0 km (0 mi)
• espesor de la capa de derretimiento de 0 km (0 mi)
• intensidad máxima de la capa de derretimiento de 0 dBZ

La tarea más demandante es obtener el perfil correcto cuando la capa de derretimiento está
cerca de la superficie. Aun los errores pequeños colocan a la banda brillante fuera de su
lugar y, por lo tanto, generan sobreestimaciones y subestimaciones graves cerca del radar. Si
no puede cambiar el perfil con frecuencia, y la temperatura fluctúa por encima y por debajo
de 0 y la banda brillante aparece y desaparece, Vaisala recomienda aplicar el perfil de nieve
como se describió anteriormente. Todavía tendrá problemas de sobreestimaciones de la
banda brillante, pero al menos solucionará todos los puntos débiles por encima de ella.

Asegúrese de brindar la información de altitud desde las fuentes de datos externas que
hacen referencia a la misma altura de referencia (nivel del mar, nivel de la antena), como
se define en la configuración del IRIS. Tenga cuidado cuando la banda brillante se acerca
al suelo.
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3.17.3 Establecimiento del nivel de derretimiento actual sin rei-
niciar el IRIS

Normalmente, cuando cambia los archivos de Setup, debe salir del IRIS y reiniciarlo para
que los cambios sean válidos.

En el caso de SRI esto no es práctico, ya que, en el caso de un frente que se mueve
rápidamente, tal vez desee actualizar la altura de la capa de derretimiento a cada hora.

Para aplicar cambios en las configuraciones con el IRIS en funcionamiento, debe enviar la
información a través de una línea a un programa llamado setup_change.

1. Abra una ventana del terminal y escriba el siguiente comando:

$ echo "iris_setup.misc.ifallspd_melts[1]=20" | setup_change -load

Esto cambia la capa de derretimiento de febrero a 2,0 km (1,2 mi). Tenga en cuenta que
el número del mes se expresa en el índice de tabla al estilo UNIX, por lo tanto, 0 es
enero, 1 es febrero y así sucesivamente. Las unidades se expresan en 1/10 de km. Puede
cambiar muchas configuraciones de perfil y de nivel de derretimiento sobre la marcha.

2. Para implementar varios cambios al mismo tiempo, coloque los datos en un archivo
como se muestra a continuación:

$ echo "iris_setup.misc.ifallspd_melts[1]=20" >testfile
$ echo "iris_setup.misc.ifallspd_melts[2]=25" >>testfile
$ cat testfile | setup_change -load

Alternativamente, coloque varios pares de name=value en la misma cadena si están
separados por "\n". Puede ssh esta cadena desde una computadora central a todos
los radares. Esta interfaz está diseñada principalmente para invocarse desde archivos
de script automáticos. Para ver los valores actuales, escriba lo siguiente:

$ setup_change -list | grep ifallspd

3. Para especificar que el nivel de derretimiento es desconocido, establezca este valor
como válido en Setup.

"iris_setup.misc.lMeltHeightValid = 1"

Si deja de proporcionar esta información, debe establecer este valor como no válido.
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3.17.4 Configuración de SRI

Figura 25 Ejemplo de configuración de SRI

SRI brinda una entrada para el producto RAIN1 para obtener las mejores estimaciones
posibles de la precipitación acumulada, incluso en rangos más largos del radar.

1. Seleccione Type > SRI.
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2. Para DSP Data y Data:Display, los productos SRI requieren valores T y Z como entrada.

Asegúrese de registrar ambos en la tarea.
Para Data:Display puede seleccionar si desea ver el resultado en dBZ o en intensidad
en mm/h (dBZ:R).
En dBZc y dBZc:R, la c hace referencia a las correcciones incluidas para atenuación,
bloqueo del haz y similares, tal como están configurados para la tarea. Incluso si lo
visualiza en mm/h, el umbral de convección se expresa en dBZ.
Para los sistemas de radares que importan datos, el producto SRI también se puede
ejecutar sin datos T (energía total). En este modo, la característica de "bin libre de eco
más bajo" no está disponible, pero el producto aún puede ejecutarse.

3. En Ref Hgt, seleccione la altura de referencia para la que se calcula el perfil de
reflectividad del producto SRI.

• Fixed
Escriba la altura (km). Esta es la altura que está por encima de la referencia de 0.

• Map
El IRIS recupera la información de la altura desde un archivo del mapa del terreno.
Consulte Formato del archivo del mapa del terreno (página 87).

4. En Max Height, establezca la altura máxima donde se busca el "bin libre de eco más
bajo".

Si no existen bins libres de eco por debajo de esta altura, no se realizan correcciones.
Debe establecer un nivel razonable, como por ejemplo, debajo de 5 km (3,1 mi). Tenga
en cuenta que, en rangos lejanos, cuando el haz más bajo está por encima de Max 
Height, se usa el haz más bajo.

5. Para usar un perfil en la corrección, habilite Use profile.

Es una forma fácil para desactivar la corrección temporalmente. No necesita cambiar
otros lugares de la cadena de producción.
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6. En 0C Height, seleccione la altura del nivel de derretimiento con una de las siguientes
opciones:

• Ingest
La altura del nivel de derretimiento se extrae de Setup en la computadora del radar
al momento de la medición. (Esto es importante si procesa datos archivados).
El resto de los números del gradiente se extraen de la configuración actual en la
computadora del producto.
Si tiene una red de radares y crea los productos centralmente en un IRIS Analysis,
puede establecer un nivel de derretimiento individual para cada radar en Setup del
radar del IRIS y usar la configuración de Ingest aquí.

• Setup
El IRIS usa las alturas del nivel de derretimiento proporcionadas en Setup > General 
Setup en la computadora del producto.
Si desea usar el mismo nivel de derretimiento para todos los radares y seguir
ajustando solo un valor, use la opción Setup aquí.

• Type-In
Al probar el producto de forma interactiva, use Type-In para escribir el valor.

7. La convección es un área de eco intenso (precipitación) que está por encima de la capa
de derretimiento. Para Convection, realice una de las siguientes acciones:

• Habilite Convection para poder definir los criterios a fin de determinar si la
precipitación es convectiva o a gran escala, y solo se corrige la última.
• En la primera casilla, escriba el umbral (en dBZ) Determine el valor con la

intensidad de convección en su configuración regional.
Por lo general, un valor de 35 ... 40 dBZ es adecuado para la mayoría de las
ubicaciones en latitudes medias, y 20 dBZ en climas frescos.

• En la segunda casilla, escriba la altura superior convectiva (qué tan por encima de
la capa de derretimiento debería estar, en km) en la siguiente casilla.
Por lo general, el valor es de 1 ... 2 km (0,6 ... 1,2 mi) para permitir que haya un
espacio libre sobre la banda brillante.
El valor adecuado para la altura del umbral depende de la precisión del cálculo de
la altura del nivel de derretimiento. Cuanto más pequeño es el valor, los píxeles se
consideran convectivos con más frecuencia.

• Deshabilite Convection para corregir todas las precipitaciones con el perfil que se
mostró anteriormente.

Más información

‣ Configuración de las proyecciones del mapa (página 24)
‣ Parámetros de visualización (página 31)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)
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3.17.5 Ejemplo de corrección del perfil de SRI
En este ejemplo, se muestra la corrección del perfil en una situación típica con una banda
brillante a 3 km (1,9 mi), un gradiente por debajo de la banda brillante (en la lluvia) de
3 dBZ/km (4,8 dBZ/mi) y por encima de la banda brillante (en la nieve) de 10 dBZ/km
(16,1 dBZ/mi). El radar está ubicado a una altura de 0 km (0 mi) y la altura de referencia es
de 1 km (0,6 mi). El ancho de haz completo de potencia media es de 1°.

La corrección se calcula para 2 elevaciones, 1,0° (en negro) y 2,0° (en gris). Tenga en cuenta
que la corrección es negativa cerca del radar, donde la medición se toma por debajo de la
altura de referencia y las curvas tienen formas distintas, ya que la banda brillante solo llena
parcialmente el haz de Gauss.

El perfil de reflectividad en el caso del ejemplo. Tenga en cuenta que, en altitudes altas, el
perfil alcanza rápidamente valores que están por debajo de la señal mínima detectable
(MDS), en la parte superior de la nube.
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Figura 26 Ejemplo de corrección del perfil contra el rango

Corrección del perfil en dB como función de distancia desde el radar para una elevación de
1,0° (negro) y 2,0° (gris).

3.17.6 Formato del archivo del mapa del terreno
Los mapas del terreno se almacenan en el archivo surface_height.conf en el directorio
${IRIS_CONFIG}.

Este archivo contiene información para cada sitio del radar almacenado en un formato polar
ASCII. Estas son las primeras líneas del archivo:

SITE Boston
AZ_RESOLUTION 1.0
RANGE_RESOLUTION 1.0 300.0
AZ 0
5
3
3
3
8
14
15
12
10
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1. El comando SITE indica el nombre del sitio para los datos hasta el próximo comando
SITE.

2. La AZ_RESOLUTION especifica la resolución de acimut del archivo. En este caso, es de
1°.
Esperamos encontrar 360 acimuts diferentes en el archivo. Haga que coincida con la
resolución de acimut normal, aunque, en cualquier caso, encuentra la más cercana.

3. La RANGE_RESOLUTION especifica el aumento del rango en km y la cantidad total de
km que se desplazará.

4. En este caso, 1 km (0,6 mi) pasa a 300 km (186,4 mi).
5. A continuación está el comando AZ, seguido de una altitud de superficie en metros

para cada km del rango.
6. Luego de 300 altitudes hay otro comando AZ y luego es posible que haya otro

comando SITE.

3.17.7 Referencias de SRI
• Koistinen, J. (1991). Operational Correction of Radar Rainfall Errors due to the Vertical

Reflectivity Profile. In Proceedings of the 25th International Conference on Radar
Meteorology, AMS 1991, p.91–94

• Joss, J. and Pittini, A. (1991): Real–time Estimation of Vertical Profiles of Radar
Reflectivity to improve the Measurement of Precipitation in an Alpine Region. In
Proceedings of the 25th International Conference on Radar Meteorology, AMS 1991,
p.828–831

• Vignal, B., Galli G., Joss J. and Germann, U. (2000): Three Methods to Determine Profiles
of Reflectivity from Volumetric Radar Data to Correct Precipitation Estimate Journal of
Applied Meteorology 39(10) 1715–1726

3.18 STAT: estado del sistema del IRIS
Un archivo STAT contiene un informe que indica el estado de todos los componentes clave
del software del radar.

Por lo general, los productos STAT (estado) se crean en todos los sistemas del IRIS que son
fundamentales para el funcionamiento del sistema, como el host del radar, el generador de
productos y/o los sistemas de visualización fundamentales. En lugar de contener datos del
radar, los productos de estado contienen información acerca del funcionamiento del sistema
IRIS.

Estos productos aparecen en el menú de salida del producto y se pueden transferir a otros
sistemas del IRIS mediante este menú.

Al transferirlo a otro sistema del IRIS, el sistema receptor conoce las fallas o los problemas
del sistema emisor. Por ejemplo, los productos del estado de radar-host se distribuyen a la
mayoría de los sistemas en una red del radar, y se muestra una X roja en varias ventanas
según estos productos del estado.

El producto de estado enumera las fallas si ocurre cualquiera de las siguientes situaciones:
• Hay fallas críticas en BITEX.
• Hay una falla de comunicación en el RCP (RCP DEAD).
• Hay un error en el procesador de señales del RVP.
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• Hay una falla interna crítica del IRIS. Estos son errores internos que se señalan como
'críticos' en el IRIS.

Si hay un cambio en el estado, como una falla crítica, el producto de Status (Estado) se
genera de inmediato.

1. En IRIS Setup > Product, habilite la generación de productos de estado y configure los
parámetros del producto.

Status product generation
Si está habilitado, IRIS también genera productos de estado cuando el estado del
sistema en general cambia de OK (Correcto) a en Falla o a la inversa.

Time between status products
Defina la frecuencia con la que desea generar productos de estado (en minutos).
Seleccione 0 si no desea generar estos productos.

Make product for each task
Da instrucciones a IRIS que genere un nuevo producto de estado cada vez que se
inicia una tarea.
Esto es útil si desea subordinar la tarea del producto de estado.

Status Prod maximum file count
Escriba el número de archivos del producto de estado que se guardará en el
sistema.

STATUS product receive timeout
Seleccione Disabled o Enabled.
Si está habilitado, configure esta hora levemente mayor que la hora entre los
productos de estado. El valor predeterminado es de 11 minutos con el modo de
los productos cada 10 minutos.
Esto permite que IRIS detecte las fallas de otros sistemas conectados. Si ha
pasado más del tiempo especificado desde que un producto de estado ha
llegado desde otro sistema, es marcado como Timeout en la visualización del
estado de la red.

2. Identifique los sistemas críticos.
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3. Identifique los sistemas receptores separados.

4. Para configurar los identificadores de red, seleccione IRIS Setup > RCP > Network 
Status Reports to RCP.

Esto permite identificar los sitios informados.

5. Genere productos del estado para los sistemas receptores.

6. Determine a cuáles productos de estado se hace referencia con el archivo
SIGNALS.DAT para tomar medidas.

7. Configure el archivo SIGNALS.DAT para tomar las medidas adecuadas.

8. En el menú Product Output, configure los productos de estado para generarlos.

Ahora, los productos del estado permiten que los sistemas del IRIS le avisen a otros sistemas
de la red que están en problemas o que ha ocurrido un evento en particular.

El archivo SIGNALS.DAT puede analizar estos mensajes y se pueden tomar medidas como
enviar un correo electrónico a un teléfono celular.

3.19 THICK: producto de espesor de eco

Figura 27 Configuración de ejemplo de THICK

THICK muestra el espesor de los ecos de nubes.

THICK es igual a la diferencia entre los valores TOPS y BASE.
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Al calcular THICK, para cada pixel de salida en el producto, el algoritmo hace una búsqueda
descendente a través de ángulos de elevación sucesivos para encontrar la altura a la que la
señal supera el dBZ Contour especificado por el usuario. De manera similar, realiza una
búsqueda desde el ángulo de elevación más bajo para encontrar la altura a la que la señal
vuelve a bajar por debajo del contorno. El espesor es la diferencia entre estos valores.

La salida final del producto es un mapa con código de color de las alturas del espesor de eco
para el dBZ Contour seleccionado. También puede usar IRIS Quick Look Window > OPT
para mostrar el valor de reflectividad promedio en la misma capa.

THICK se ve afectada por los mismos límites que los productos TOPS y BASE.

1. Seleccione Type > THICK.

2. En Data : Display, seleccione dBT Height, dBZ Height o dBZc Height.

3. En Max Range, seleccione el rango máximo para el producto.

Tenga en cuenta que los efectos de la curvatura terrestre son mayores a mayores
rangos. Puede visualizar un PPI en el ángulo de elevación más bajo y usar la
herramienta del cursor para ver cuáles son las alturas que se pueden observar en varios
rangos.
Por ejemplo, para un ángulo de elevación de 0,5° a 100 km (62,1 mi), el haz se centra en
2,3 km (1,4 mi). Por lo tanto, no se pueden detectar bases de eco que sean inferiores a
esto.

4. En dBZ Contour, seleccione el umbral de dBZ para la base de eco.

5. Seleccione Pseudo para todos los píxeles en los que el ángulo de elevación más bajo
esté por encima del contorno para usar la altura del ángulo de elevación más bajo como
la base.

De manera similar, todos los píxeles en los que el ángulo de elevación más alto esté por
encima del contorno usan la altura del ángulo de elevación más alto como la parte
superior.

6. Aplique AZ/EL Smoother.

Ingrese los valores en grados, primero para la dirección de acimut y luego, para la
dirección de elevación.
Los valores más comunes son 1.0, 1.0.

Más información

‣ Parámetros de visualización (página 31)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)
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3.20 TOPS: topes de alturas de ecos

Figura 28 Configuración de ejemplo de TOPS

TOPS es un mapa de contornos codificado con colores de la parte superior de un nivel de
dBZ seleccionado.

Se puede usar Z o ZT como base para la estimación.

Las alturas se muestran en kilómetros y en décimas de kilómetros. Se requiere una tarea de
exploración de volumen de PPI (ya sea FULL o SECTOR).

El producto TOPS es un indicador excelente de clima severo y granizo. Por ejemplo, una
parte superior de 50 dBZ a 1 km (0,6 mi) por encima del nivel de congelamiento solo puede
ser producido por una tormenta convectiva vigorosa y, lo más probable, causada por la
presencia de granizo. Para las aplicaciones de tráfico aéreo, la búsqueda se puede realizar
con el valor de umbral más bajo, como 10 dBZ, para determinar la altura de la precipitación
circundante.

1. Seleccione Type > TOPS.
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2. Configure el producto TOPS:

Data : Display
• altura Z
• altura T

El producto se puede derivar a partir de los datos Z o T. Si se selecciona Z como
el parámetro Product Data, pero al momento de la ejecución solo está
disponible T (o viceversa), el producto se ejecuta con el parámetro de datos
disponible.

dBZ Contour
Puede seleccionar el nivel de contorno del umbral en dBZ. Luego, el algoritmo de
TOPS realiza una búsqueda descendente a un rango constante en coordenadas
cilíndricas para determinar cuándo se excedió el umbral. A continuación, lo
interpola en altura para obtener la altura del contorno del umbral. De modo
similar a CAPPI, debe haber una inclinación de elevación por encima y por debajo
del contorno a fin de obtener una altura superior válida.

3. Cuando la búsqueda descendente detecta un valor de dBZ superior al umbral, se
presentan los siguientes casos:

Normal Case
Se usa el valor de dBZ en el rayo superior siguiente (ángulo de elevación) al
mismo rango de superficie para interpolar la altura del contorno que debe estar
en el medio.

Undetected Echo Aloft
Si no se detecta un eco en el rayo superior siguiente en el aire, no se puede
realizar una interpolación. Sin embargo, debe existir una parte superior entre
estos 2 rayos. En este caso, la altura superior se toma como la altura del punto
donde se realizó la detección de dBZ >> Umbral.

No Ray Aloft
Si no hay un ángulo de elevación superior en el air, existe una parte superior en el
aire en algún lugar, pero no hay información acerca la altura. En este caso, un
color especial (indicado con "???" en la leyenda) denota que existe una parte
superior no determinada.
Por ejemplo, a rangos inferiores a 5 km (3,1 mi) en la exploración de volumen que
se muestra en la siguiente ilustración, el algoritmo no puede determinar las
partes superiores que están por encima del ángulo de elevación más alto.
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Figura 29 Ejemplo de exploración de volumen de inclinación 15
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Más información

‣ BASE: producto de base de eco (página 37)
‣ Parámetros de visualización (página 31)
‣ Configuración de las proyecciones del mapa (página 24)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)

3.21 TRACK: trayectoria/pronóstico

Figura 30 Configuración de ejemplo de TRACK

Los productos TRACK muestran el movimiento proyectado para funciones de tormenta
(centroides) basado en una serie de productos de entrada de diferentes horas.

Los productos TRACK constan de una serie de puntos de seguimiento conectados con líneas
o "trayectorias". Cada trayectoria muestra el movimiento de un centroide en un espacio de
tiempo especificado, más un punto de pronóstico que muestra el lugar en el que el
centroide brinda su dirección y velocidad actuales. El producto TRACK puede contener
trayectorias múltiples si hay más de un centroide en el producto de entrada, como se
muestra en la siguiente ilustración.
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Figura 31 TRACK con dos centroides

El producto de entrada puede ser cualquier producto cartesiano horizontal, como por
ejemplo un producto PPI. El producto TRACK aplica la misma lógica que el producto de
advertencia para ubicar los centroides dentro del producto de entrada. Usted define el nivel
de umbral y el tamaño de los centroides, debajo de los cuales se ignoran las características
climáticas. Cuando ingresan datos, el producto TRACK compara el producto TRACK anterior
con los datos nuevos para obtener un vector de movimiento. Esta información se usa para
definir el producto TRACK nuevo, incluido el punto de pronóstico. Se emiten advertencias si
un centroide llega a un área protegida, o si se pronostica que atravesará un área protegida.

A medida que llegan datos nuevos, el producto TRACK debe determinar si un punto de
trayectoria nuevo es una extensión de una trayectoria anterior, el inicio de una trayectoria
nueva (cuando un centroide nace) o el fin de una trayectoria (cuando un centroide muere).
Los parámetros de la trayectoria, como por ejemplo la velocidad máxima y la tolerancia para
los puntos nuevos, influencian el cálculo.

TRACK es un producto de superposición creado en la Quick Look Window.

1. Para crear un producto TRACK nuevo, seleccione Type > TRACK.

2. Para cargar un producto TRACK existente, seleccione File > Open.
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3. Configure el producto TRACK:

Product Type y Product Name
Seleccione el tipo del producto de entrada y luego el nombre del producto que
corresponda al tipo seleccionado. Tenga en cuenta que debe existir un archivo de
la configuración del producto para el tipo de producto que seleccione.
En el caso de los productos recibidos en la red, puede crear un archivo de la
configuración del producto o copiarlo en la red.

Centroid Threshold Level
El producto TRACK solo considera aquellos centroides cuyos valores cumplen o
superan este nivel del umbral.
Las unidades de medida dependen del producto seleccionado. Por ejemplo, un
umbral de TOPS se especifica en km, mientras que un umbral de VIL se especifica
en mm.

Si no está seguro sobre las unidades de medición, verifique el menú Product 
Configuration adecuado.

Threshold Area in Sq Km
Ingrese el tamaño mínimo de una región del centroide (en km cuadrados). Las
áreas que no cumplen o exceden este tamaño no se rastrean.
Por ejemplo, para una superficie de 3 km por 3 km (1,9 × 1,9 mi), ingrese "9".

Max Time Span
Ingrese el tiempo máximo permitido entre el punto de la trayectoria más nuevo y
el punto de la trayectoria más viejo a fin de que se incluyan en el producto
TRACK.
Cuando se procesa un producto de entrada nuevo, se eliminan los puntos que
sean anteriores a este espacio de tiempo.
Usted establece el tiempo al usar los botones más y menos para aumentar y
disminuir las horas o los minutos. Seleccione Ok para salir de la ventana. El
tiempo que especifique se ingresa en el campo.
También puede escribir un valor de tiempo directamente en la Time window y
seleccionar Ok.

Max Time Step
Ingrese la cantidad de tiempo que puede transcurrir entre dos puntos de la
misma trayectoria. Si transcurre más tiempo que el ingresado entre el último
punto de la trayectoria y un punto nuevo entrante, el punto nuevo se considera el
inicio de una trayectoria nueva.

Max Forecast Time
Ingrese la cantidad de tiempo en que se pueden proyectar los puntos de
pronóstico por adelantado.
El tiempo del pronóstico debe ser comparable a la duración de la característica
que rastrea.
Por ejemplo, para una tormenta severa aislada, sería típico tener un tiempo de
pronóstico de 30 minutos. En el caso de una línea de turbonada, se podría usar
un período de 1 hora.

Producto y visualización del IRIS Guía de usuario M211319ES-J

96 RESTRINGIDO



Necesita tener conocimientos sobre los tipos de clima que existen en su región.

Max Velocity
Ingrese la velocidad máxima permitida entre dos puntos de la misma trayectoria.
Si esta velocidad se ve excedida por un punto nuevo entrante, ese punto se
considera el inicio de una trayectoria nueva.
Un valor típico para este campo es 100 km/h (62,1 mi/h).

Tolerance for New Points
Ingrese el margen de error que puede existir entre un punto nuevo y un punto de
pronóstico.
Si el punto nuevo está dentro del límite de tolerancia, se lo agrega al final de la
trayectoria y se crea un punto de pronóstico nuevo.
Si queda fuera del límite, se inicia una trayectoria nueva.

Protected Areas for Warning Alert
Especifique una o más áreas protegidas.
Se genera una advertencia si un centroide cae dentro de un área protegida, o si
se pronostica que se dirigirá a un área protegida.
Seleccione Protected Areas para ver una lista de las áreas. Puede activar o
desactivar las opciones.
Al salir de la lista, aparecerán los nombres de las áreas seleccionadas en el
campo.
Las áreas protegidas se configuran con la herramienta Setup. Se limitan a ser
rectángulos con tamaño arbitrario y ángulo de orientación.
Puede configurar hasta 32 áreas. (Si realiza un cambio en Setup, debe reiniciar
IRIS para que el cambio surta efecto.)

TDWR Style
El IRIS admite dos formatos de mensajes de advertencia. En el formato TDWR,
solo se informa el centroide más fuerte del área de mayor prioridad junto con su
fuerza. Por ejemplo: "MBA 3MF 30K-, en idioma hablado: "Microburst Alert,
Three Mile Final, 30 Knot loss".
El formato IRIS más antiguo informa sobre todos los centroides en todas las áreas
protegidas, por ejemplo: 3 MBA warnings at 11:30 in: 3MF, 2MF.
Estos mensajes aparecen en la parte inferior de la pantalla y, opcionalmente,
tienen salida de voz.

Say Warning
Seleccione esta opción para que el generador del producto indique de forma
verbal el mensaje de advertencia además de mostrarlo como un mensaje.
En el menú del IRIS, también debe seleccionar Setup > Enable Speech.

Make Diagnostic Results
Además del producto TRACK, puede crear una versión de umbral del producto
de entrada, que es útil para las evaluaciones. Puede activar o desactivar esta
función, a menos que encuentre un problema con el producto TRACK.
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3.22 VAD: pantalla del acimut de veloci-
dad

Figura 32 Configuración de ejemplo de VAD

VAD es una visualización de la velocidad de Doppler media en un rango dado como una
función del ángulo de acimut a medida que la antena del radar rota a través de una
exploración de acimut a elevación constante.

Min-Max Rng
Seleccione el rango en el que se realiza el promedio de las velocidades.
El producto VAD promedia todas las velocidades del rango para todos los rayos y
almacena una estructura para cada rayo. Esta estructura incluye el valor promedio, la
desviación estándar, el conteo de datos, como así también el acimut, la elevación y el
número de barrido.

Unfolding
Seleccione esta opción para habilitar el despliegue de los datos antes de generar el
producto.

Más información

‣ Asociación de productos con tareas (página 21)
‣ Opciones de salida VAD (página 263)
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3.23 VIL: líquido integrado de forma ver-
tical

Figura 33 Configuración de ejemplo de VIL

VIL es un mapa con código de color de la profundidad estimada de agua (en mm) contenida
en una capa atmosférica seleccionable. Es un indicador excelente de tormentas severas.

Se puede usar Z o ZT como base para la estimación.

VIL puede calcular muchos valores diferentes en un intervalo de altitud o capa de la
atmósfera, incluido el líquido integrado o la reflectividad promediada. Estos pueden ser
indicadores excelentes para la actividad de tormentas severas, especialmente con respecto
a la pluviosidad potencial de una tormenta.

Ya que el VIL se puede establecer para observar la profundidad total de la atmósfera, es
bueno para detectar las precipitaciones en el aire que no llegan al suelo, algo que el PPI o el
CAPPI no pueden detectar.

Si la altura de la capa está por encima del nivel de congelación, los valores de VIL altos son
un indicador excelente de tormentas severas y granizo. Si la altura de la capa se extiende
desde la superficie hasta los 3 km (1,9 mi), los valores de VIL sirven como una guía de
pronóstico para saber la cantidad de precipitación que caerá durante los próximos minutos.

Al calcular los datos líquidos integrados (datos VIL), el producto muestra la precipitación
estimada (en milímetros) que contiene la capa definida por el usuario. A veces, esta
cantidad también se etiqueta en kg/m**2.
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1. Primero, el algoritmo de VIL busca todos los puntos de la capa (teniendo en cuenta la
curvatura terrestre) en un rango determinado y en un acimut determinado que
intercepta las exploraciones de PPI de la exploración de volumen, incluido un punto por
encima y un punto por debajo.

2. El algoritmo convierte los valores de Z o T a valores de W (contenido de agua) e integra
de la capa.
A cada punto de datos se le asigna una ponderación que corresponde al intervalo de
altura que representa en la capa. El resultado es un producto PPI intermedio que tiene
el contenido de agua total como una función del rango de superficie y del acimut.

3. Finalmente, el producto intermedio se transforma a una cartesiana y se almacena. Si
selecciona Z como el parámetro Product Data, pero al momento de la ejecución solo
está disponible T (o viceversa), el producto se ejecuta con el parámetro de datos
disponible.

Cuando se calcula la reflectividad promedio de la capa (datos LAR), el producto se
almacena en reflectividad normal. El procesamiento es casi idéntico al de los datos de VIL,
excepto que las entradas de dBZ se convierten a un valor lineal Z en vez de W, y al final lo
dividimos por el espesor de la capa. Luego, el promedio de Z se vuelve a convertir a dB.

1. Seleccione Type > VIL.

2. En Data:Display, seleccione qué tipo de datos se calcula.

• dBT:VIL Seleccione el tipo de entrada para calcular los datos de VIL.
• dBZ:VIL
• dBZc:VIL
• dBT Seleccione el tipo de entrada y de salida para calcular el promedio de la capa.
• dBZ
• dBZc

3. En Layer Top y Layer Bottom, seleccione las alturas superiores e inferiores de la capa
de VIL en kilómetros y en décimas de kilómetros.

La banda brillante afecta las mediciones de VIL. Seleccione la
capa de VIL para evitar la altura del nivel de congelamiento.
PRECAUCIONES!
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4. En ZW Relation, seleccione la relación (Z-W) de reflectividad-contenido de agua.

Este campo no tiene sensibilidad si calculamos un producto basado en la reflectividad
en vez de un producto basado en el contenido de agua. Se proporciona un valor
predeterminado para la lluvia. Para la nieve, reduzca el coeficiente a un valor más
pequeño, por ejemplo a 2 000, para representar la menor reflectividad del hielo.
VIL puede funcionar solo cuando hay un ángulo en la tarea, pero no se recomienda
para obtener mejores resultados. Si ningún ángulo en la tarea asociada atraviesa la
capa de VIL, no se puede calcular ningún resultado de VIL.
Para una capa de VIL de 5 a 10 km (3,1 a 6,2 mi), en el ejemplo de exploración de
volumen en la siguiente ilustración, no se puede calcular el VIL para los rangos
inferiores a 5 km (3,1 mi). En la pantalla del producto resultante, esta región se muestra
de color negro para indicar que el IRIS no tomó muestras de la región.
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Figura 34 Ejemplo de exploración de volumen de inclinación 15

Más información

‣ LAYER: promedio de capa (página 46)
‣ Parámetros de visualización (página 31)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)

Capítulo 3 – Configuración de productos de IRIS

RESTRINGIDO 101



3.24 VVP: procesamiento de volumen de
velocidad

Figura 35 Configuración de ejemplo de VVP

VVP proporciona gráficos de línea o secciones transversales de tiempo contra altura de la
velocidad del viento, dirección del viento y divergencia contra altura.

VVP obtiene los siguientes parámetros que se promedian sobre un volumen centrado
alrededor del radar:

• velocidad del viento y dirección horizontal
• velocidad vertical de las partículas (combinación de velocidad aérea y velocidad de

caída de las partículas)
• divergencia horizontal (en relación con los movimientos de aire verticales)
• deformación horizontal y eje de dilatación (en relación con la fuerza frontal)
• reflectividad promedio
• RhoHV promedio

Puede seleccionar qué datos se calculan y puede almacenar el producto resultante. También
puede activar o desactivar los datos. Tenga en cuenta que para los 4 botones superiores
relacionados con la velocidad, cualquier botón encendido implica que los botones
superiores también están encendidos. Además, debe activar al menos un tipo de datos.

Este algoritmo es similar a la técnica VAD, con un enfoque analítico mejorado. 1)
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Un radar Doppler solo puede medir el componente de viento, ya sea acercándose el radar o
alejándose del radar. Esto se denomina "viento radial". Sin embargo, con la observación del
viento en todos los acimuts alrededor de un círculo completo, se puede determinar la
velocidad del viento promedio y la dirección. Esto se muestra esquemáticamente en la
siguiente ilustración para un viento del sur. En la ilustración se muestra la velocidad radial a
un bin de rango como una función de un acimut. Cuando el radar apunta directamente hacia
el sur, la velocidad radial mide la velocidad total del viento (acercándose al radar). La
convención del IRIS es que las velocidades radiales positivas se alejan del radar. Cuando el
haz apunta al este o al oeste, no hay viento acercándose al radar, de modo que la velocidad
radial es de 0. La divergencia del radar se calcula al promediar la velocidad radial. Se pueden
calcular otros parámetros cinemáticos, como la deformación y el eje de dilatación del viento.

0

North

Mean Wind

South

West East

+Vu

–Vu

East SouthWest North

Velocity vs. Azimuth Display — VAD for south wind

West

Figura 36 Ejemplo de velocidad radial en contraste con la visualización del acimut

El algoritmo de VVP da por sentado que el campo de viento varía linealmente y que calcula
la velocidad del viento y la divergencia media como una función de la altura. Para cada
intervalo de la altura, el algoritmo de VVP realiza un ajuste de mínimos cuadrados de la
velocidad radial observada al modelo del campo de viento lineal. Se usan varios miles de
puntos. El resultado es una visualización gráfica de líneas de cada uno de los 3 parámetros
en contraste con la altura, con barras de errores que indican la incertidumbre del ajuste de
mínimos cuadrados.

El menú VVP Product Configuration requiere que no haya una configuración de
visualización para los gráficos de líneas.

1. Seleccione Type > VVP.

1) Consulte Waldteufel and Corbin (1979, Journal of Applied Meteorology, p. 532).
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2. Configure el producto VVP:

Min/Max Range
Seleccione el rango mínimo para evitar ecos del suelo fuertes cerca del radar, por
ejemplo, de 2 ... 5 km (1,2 ... 3,1 mi).
Seleccione el rango máximo para que el ángulo de elevación más alto se extienda
más allá de la altura máxima que seleccionó.
No se requiere una coma para separar los números.

Min/Max Height
Configure la altura mínima y la altura máxima para cubrir el alcance de la altitud
de donde desea la información del viento.

Height Levels
Especifique la cantidad de intervalos de altura. En el ejemplo de la ilustración, se
cubre un alcance de altura de 0,5 ... 15,0 km (0,3 ... 9,3 mi) en 20 intervalos, de
modo que existe un valor por cada 500 metros (0,3 mi).

Min Velocity
Especifique la velocidad mínima que se debe incluir en el ajuste del volumen del
viento.
El valor recomendado es 0,5 m/s (1 pies 8 pulg/s).
De este modo, se elimina fácilmente la compensación hacia 0 en alturas bajas
debido al eco que atraviesa el filtro del eco.
Un valor de 0 deshabilita la Min Velocity.

Bin Quota
Es la cantidad máxima de bins que se incluye en el ajuste de cuadrados mínimos
para cada intervalo de altura. El valor máximo permitido es de 10 000 bins.
Vaisala recomienda usar un máximo de 10 000.
Si solo selecciona la velocidad media (es decir, no se selecciona la velocidad
vertical, la divergencia y la deformación), puede reducir el cupo de bins para
obtener una generación de producto más rápida.

Unfolding
El despliegue se puede activar o desactivar.
La técnica de despliegue 2) se basa en perfiles de viento del prototipo
seleccionados para determinar cuál de ellos brinda los mejores resultados en el
ajuste de cuadrados mínimos.
Durante el procesamiento, el VVP se ejecuta varias veces y se selecciona el mejor
resultado.
En general, la técnica de VVP y el despliegue requieren una cobertura del eco de
al menos 90° para obtener resultados confiables.

Reflectivity, Vertical Wind, Divergence, Deformation
Opcionalmente, el VVP puede calcular la velocidad vertical, la deformación y el
eje de dilatación del campo de viento y el perfil de reflectividad media por
encima del radar.
Seleccione los parámetros que desea calcular y registrar.
Tenga en cuenta que la velocidad vertical es la velocidad de partículas. Se incluye
el efecto de la velocidad de caída.

2) Siggia and Holmes, 1991 25th Conference on Radar Meteorology, Paris
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3. Configure la tarea de VVP asociada.

El algoritmo de VVP realiza el despliegue de los datos. Para obtener mejores
resultados, configure una tarea con un rango de velocidad inequívoco grande.
Es decir, use una PRF alta (por ejemplo, de 1 200 Hz) y un despliegue de velocidad de
PRF doble (de 4:3 o 3:2), de modo que no produzca un solapamiento de velocidad.
Si la exploración de volumen estándar no usa un despliegue de PRF doble, tal vez deba
configurar una tarea separada para VVP.
Por lo general, cuatro ángulos de elevación, como 30°, 20° 10° y 5°, son adecuados, ya
que cada ángulo contribuye a varias alturas.

Más información

‣ Asociación de productos con tareas (página 21)

3.24.1 Generación de la salida de producto VVP
La salida del producto VVP consta de un archivo de datos que contiene los parámetros de
VVP para cada altura. Las pantallas se calculan sobre la marcha a partir del archivo de datos
y se pueden personalizar. Las pantallas disponibles de VVP en el IRIS son las siguientes:

• Gráficas de líneas en contraste con la altura
Se pueden seleccionar hasta 5 parámetros para el trazado en contraste con la altura. En
los trazados se incluyen las barras de desviación estándar.

• Secciones transversales de tiempo-altura
Las líneas de las lengüetas de viento, las cadenas de viento o el eje de dilatación/
deformación se superponen sobre un fondo coloreado de reflectividad, RhoHV,
deformación, divergencia o velocidad vertical. La escala de tiempo y la altura se
pueden seleccionar.

Puede seleccionar el estilo de la pantalla, los parámetros, los límites de trazado y demás en
el menú Output Options de la ventana Quick Look o Product Output Menu.

El umbral de las pantallas se basa en la autenticidad del ajuste de la velocidad. En Output 
Options, puede establecer el nivel del umbral entre 0 (mostrar todos los datos) y 1 (umbral
para todos los datos).

Más información

‣ Opciones de salida VVP: Gráficos de línea (página 267)
‣ Opciones de salida VVP: Tiempo/Altura (página 265)

3.25 WARN: Producto de Advertencia/
Centroide

El producto WARN usa otros productos de IRIS para detectar eventos meteorológicos
significativos.
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Ejemplo: Detección de granizo

La presencia de 45 dBZ a 1,5 km por encima del nivel de congelamiento es un buen
indicador de granizo en muchas ubicaciones de latitudes medias. Si se supone que el
nivel de congelamiento está a 4 km y ejecuta un producto TOPS de eco para el contorno
de 45 dBZ, la advertencia preconfigurada podría comprobar si:

• El producto TOPS muestra topes de altura de 45 dBZ a alturas mayores de 5,5 km. Si
es así, hay una alta probabilidad de granizo.

• Para evitar la emisión de una alarma que se basa en un solo pixel, un parámetro de
"región de umbral" comprueba si la región de granizo es de al menos de 10 km2 .

• VIL para la misma región (1 ... 10 km) es mayor que 5 mm (o un valor determinado
según la climatología local de granizo).

El producto WARN automatiza este procedimiento en tiempo real al buscar los productos
para eventos meteorológicos significativos y alerta al operador cuando se detecta un
evento.

Mensaje de advertencia

Puede definir el contenido del mensaje. Por ejemplo:

2 HAIL Warnings at 11:30:00 in: AREA_A AREA_B

En este caso, HAIL es el texto de advertencia seleccionado por el usuario y AREA_A es el
nombre seleccionado por el usuario del área protegida.

Los nombres y ubicaciones de las áreas protegidas se definen en la utilidad Configuración
de IRIS.

Los mensajes se agregan al menú Resumen de mensajes de IRIS.

Pantalla de la situación

Los contenidos de las pantallas de la situación son los siguientes:
• Contornos de áreas protegidas activas.
• Texto de advertencia en cada ubicación del centroide que supera el tamaño del umbral

(como HAIL o MBW).
• Un mensaje de advertencia.

La siguiente ilustración muestra un ejemplo de una advertencia de microrráfaga (MBW)
basada en el producto de cizalladura radial opcional. También se puede transmitir una
pantalla de advertencia con una superposición geopolítica seleccionable.
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MBW

MBW

Figura 37 Ejemplo de Pantalla de la situación de advertencia

Los contornos de las áreas protegidas se muestran para las áreas incluidas en el producto
WARN. En el ejemplo, los contornos de la pista son de un mapa superpuesto separado que
se une con el producto cuando se muestra.

El texto de advertencia (MBW en el ejemplo) se muestra en la ubicación del centroide del
fenómeno meteorológico que se detectó. Si se detectó fenómeno meteorológico en un área
protegida, el mensaje de advertencia se muestra en caracteres grandes en la parte inferior
de la pantalla. También se muestra la hora asociada con cada advertencia. Si se detecta más
de un resultado en un área protegida, se muestra la cantidad de resultados. Una leyenda a la
derecha de la pantalla resume las características del producto. Esto incluye el ID del
producto, la fecha, la hora de los datos y un resumen de los parámetros de configuración del
producto.

Criterios de advertencia

La característica de advertencia automática puede proporcionar alertas para una amplia
variedad de fenómenos meteorológicos, como el acercamiento de una tormenta grave,
turbulencia, peligro de relámpagos o posibles inundaciones.

Se pueden usar hasta 3 criterios. El umbral y la estabilización se llevan a cabo por separado,
luego, los resultados se asocian con un AND manera que la definición centroide se lleva a
cabo en el campo combinado. Por ejemplo, el criterio adicional de los 1 a 10 km (0,6 a 6,2
mi) VIL >>5 mm (0,2 pulg.) se podría añadir para reducir la tasa de falsas alarmas de
advertencia HAIL.
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La siguiente tabla muestra algunos ejemplos de criterios de advertencia. Cada criterio es
una tarea y está entre paréntesis cuadrados. Los resultados de múltiples tareas se asocian
con un AND.

Tabla 13 Ejemplos de Criterios de advertencia

Criterios Ejemplo

Detección de cizalladura del
viento [Shear >10 m/s/km at 0.5° EL]

AND
[ ... at 0.7° EL]

sobre una superficie de 3 km2 (1,2 mi2)

Detección de turbulencias de
tormentas [Spectrum Width >6 m/s (>19 ft 8 in / s)]

AND
[Reflectivity >20 dBZ]

sobre una superficie de 10 km2 (3,9 mi2)

Detección de granizo

[45 dBZ TOPS >1.5 km (>0.9 mi) above freezing level] 

sobre una superficie de 10 km2 (3,9 mi2)

Detección de vigilancia de
precipitaciones [1.5 to 14 km (0.9 to 8.7 mi) VIL >1 mm (>03⁄64 in)]

sobre una superficie de 10 km2 (3,9 mi2)

Detección de tormenta severa
o peligro de relámpagos [1.5 to 15 km (0.9 to 9.3 mi) VIL >10 mm (>025⁄64 in)]

AND
[10 dBZ TOPS >8 km (>5.0 mi)]

sobre una superficie de 10 km2 (3,9 mi2)

Advertencia de inundación
repentina [Hourly Rainfall or N-Hour Rainfall >5 mm (>013⁄64 in)]

sobre una superficie de 25 km2 (9,7 mi2)
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Para funcionar efectivamente, un producto WARN debe basarse en la climatología y la
experiencia locales. Vaisala puede trabajar con usted para desarrollar tal climatología o
para entender mejor las capacidades y limitaciones del producto WARN.
Vaisala no ofrece ninguna garantía, expresa o implícita, de que el producto WARN pueda
detectar todas las situaciones meteorológicas peligrosas. En ningún caso Vaisala puede
ser responsable de daños de cualquier tipo, por fallas del producto WARN al emitir una
advertencia o por falsas alarmas que pudiera emitir el producto WARN.

Más información

‣ Algoritmo de WARN (página 143)

3.25.1 Configuración de productos WARN

Utilice el menú de configuración del producto WARN para especificar el mensaje, el área de la
región del umbral, hasta 3 productos para utilizar como criterio para la advertencia y hasta
32 áreas protegidas.

1. En la barra del menú principal, seleccione Menus > Product Configuration.

2. En la barra del menú principal, seleccione Type > WARN.

Se abre el menú WARN Product Configuration.
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3. En Warning Symbol, se especifica el texto que se utiliza en los mensajes de advertencia
y el texto que se muestra en la posición centroide en la pantalla de la situación.

Por ejemplo, el texto puede ser HAIL o MBW, S++ o TRW+.

4. Ingrese el tamaño mínimo de una región del umbral en el campo Area in Sq Km.

Se descartan las áreas que no cumplen o exceden este tamaño. Ingrese el valor
deseado en km cuadrado.
Por ejemplo, para una superficie de 3 km por 3 km (1,9 × 1,9 mi), ingrese 9.
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5. Seleccione el botón junto a Product Type y Product Name, y seleccione hasta 3
productos que examinará el producto WARN.

• Los productos deben tener el mismo rango máximo de productos según los
respectivos menús de Product Configuration.

• Los productos deben tener la misma resolución según los respectivos menús
de Product Configuration.

• Los productos deben ser de un tipo de datos compatible: dBT, dBZ, dBZc,
Height, Kdp, LDRH, LDRV, R, Rain, RhoH, RhoV, RhoHV, Shear, SQI,
Time, VIL, Width y ZDR.

Los errores se informan en el momento de la ejecución en el menú Radar Status.

a. Seleccione el tipo de producto.

La información del Product Name se completa automáticamente. También puede
editar el nombre.

b. Seleccione el nombre del producto.

La lista de nombres de productos muestra los productos actuales en su sistema.
Si el producto que desea usar no aparece, ejecute el sistema hasta que aparezca.
También puede elegir un producto diferente del deseado y anule el nombre del
producto.

c. Para cada producto, use los valores Time para productos de diferentes tareas o
diferentes ejecuciones de la misma tarea.

Utilice los botones más y menos para aumentar o disminuir las horas, minutos o
segundos o escriba un valor de hora en la ventana.
Se puede ocupar este campo solo cuando hay más de un criterio. Por ejemplo, si el
segundo criterio tiene una hora de 00:10:00, cuando el primer producto esté
disponible, el algoritmo de programación buscará en el tiempo hasta 10 minutos
atrás para encontrar una versión del segundo producto.
Debe saber el horario de la tarea. Si utiliza productos basados en tareas diferentes,
debe establecer el campo Time en un número diferente de cero o el producto no se
ejecutará. En general, si todos los criterios del producto se basan en la misma tarea,
establezca todas las horas en 00:00:00 para que se utilicen solo los datos de la
misma ejecución.

d. Para cada producto, ingrese el umbral de advertencia en Threshold.

El producto WARN solo considera aquellos valores que cumplen o superan el umbral.
Las unidades de medida dependen del producto seleccionado. Por ejemplo
• Los umbrales TOPS se especifican en km.
• Los umbrales VIL se especifican en mm.
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Compruebe el menú Product Configuration apropiado si no está seguro sobre
las unidades de medición.

El producto WARN funciona sobre las bandas de color en la imagen del producto y el
umbral se ajusta en consecuencia.
Por ejemplo, para configurar una advertencia de reflectividad basado en un
producto CAPPI.
• Mostrar un ejemplo del producto.
• Elija el umbral para que coincida con el número que aparece con la banda de

color que desea usar como umbral.
Si 45 dBZ es el número que aparece con el color rojo y establece el umbral a 45 dBZ,
entonces todas las regiones que aparecen en rojo (o "superior") se incluyen en el
algoritmo de advertencia. Conviene realizar esto para verificar el algoritmo. Si
aparece el producto de reflectividad junto con la pantalla de la situación
(superposición de advertencia), las etiquetas del centroide se colocan con precisión
en las regiones de color rojo.
Para el producto VVP, el umbral se refiere a la divergencia en unidades de m/s por
km (10-3 s-1). Cuando el producto WARN se ejecuta por el VVP, se genera una
advertencia si la divergencia es superior a este valor en cualquier altura en el VVP.
Una fuerte divergencia de bajo nivel sobre el radar podría indicar una microrráfaga.
Para establecer correctamente las alertas de microrráfaga, debe conocer las
características locales de los fenómenos.

6. En Protected Areas for Warning Alert, seleccione Protected Areas para ver una lista
de las áreas.

Las áreas protegidas se configuran en la utilidad setup. Se limitan a ser rectángulos con
tamaño arbitrario y ángulo de orientación. Hay un límite de 16 áreas. (Si realiza un
cambio en Setup, debe reiniciar IRIS para que el cambio surta efecto.)

Es una buena idea nombrar a un área grande (por ejemplo, 500 por 500 km (310,7 ×
310,7 mi)) ALL. Cuando selecciona ALL, toda la zona del radar con un rango de 250
km (155,3 millas) de alcance es un área protegida.

7. Seleccione TDWR Style para utilizar el formato de mensaje de advertencia TDWR.

En el formato TDWR, solo se informa el centroide más fuerte del área de mayor
prioridad junto con su fuerza. Por ejemplo: MBA 3MF 30K–, en idioma hablado:
Microburst Alert, Three Mile Final, 30 Knot loss.
El formato IRIS más antiguo informa sobre todos los centroides en todas las áreas
protegidas, por ejemplo: 3 MBA warnings at 11:30 in: 3MF, 2MF. Estos mensajes
aparecen en la parte inferior de la pantalla y, opcionalmente, tienen salida de voz.

8. Seleccione Say/Beep Warning para que el generador del producto indique de forma
audible el mensaje de advertencia además de mostrarlo como mensaje.

También debe seleccionar Enable Speech en el menú Setup de IRIS.
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9. Seleccione Make Diagnostic para que el generador del producto cree una salida de
diagnóstico adicional.

El diagnóstico es un tipo de producto USER, con un tipo de datos USER y el mismo
nombre que el producto WARN, excepto por un MSK.
Puede visualizar este producto en el Quick-Look Window de IRIS Radar.
Este producto contiene la salida de los datos de entrada iniciales del umbral. El LSB es
la primera entrada, el bit 1 es la segunda y el bit 2 es la tercera. Para un WARN de una
sola entrada, espere un archivo binario. Puede usar esto para ver las regiones que se
están procesando.

3.26 WIND: dirección y velocidad del
viento

Figura 38 Configuración de ejemplo de WIND

WIND muestra velocidad y dirección del viento con lengüetas o cadenas de viento.

WIND calcula una matriz 2D de vectores de viento horizontales (el campo de viento
horizontal) con la información de velocidad radial y la suposición de que el viento es
uniforme en un sector limitado (por ejemplo, 10 km [6,2 mi] por 60°). Al calcular el viento
medio en varios sectores, se puede generar una aproximación al campo 2D de vientos
horizontales. Dado que el algoritmo supone que hay vientos uniformes en un sector,
también se denomina "algoritmo de viento uniforme del sector". El algoritmo puede mostrar
cambios graduales en los vectores de viento en un área de cobertura del radar. No puede
mostrar gradientes pronunciados, como frentes o microrráfagas.

Capítulo 3 – Configuración de productos de IRIS

RESTRINGIDO 113



La salida se puede mostrar como lengüetas de viento o cadenas de viento como un
producto de superposición. El viento medio se puede restar en la salida, de modo que se
muestre el viendo de perturbación. Estas selecciones se realizan cuando el producto se
muestra en la Quick Look Window o en el Product Output Menu mediante las Output 
Options.

Si no hay puntos de viento radial suficientes en un sector, el algoritmo aun calcula un
viento medio. Sin embargo, el cálculo no es confiable.
Para cada sector, se almacena la cantidad total de bins válidos del rango de velocidad que
se encuentre, como así también la cantidad total esperada para una cobertura total.
Al mostrar los resultados, las opciones de salida permiten aplicar un umbral por el
porcentaje de cobertura en un sector.
Use este umbral para reducir los valores ruidosos. Un buen punto de partida es un valor de
cobertura de área del 40 %.

1. Seleccione Type > WIND.

2. En Min-Max Rng, especifique el radio del producto, que comience en un punto cercano
al radar y que termine no tan lejos del radar.

Los vectores del viento se calculan solamente dentro de este rango.

3. En Min-Max Height, defina la capa desde la que se obtiene la información sobre la
velocidad radial, a fin de producir vectores del viento.

Ya que la cizalladura vertical puede ser considerable, Vaisala recomienda que la capa
sea de ~1 km (~0,6 mi).

4. En Range y Azimuth Spacing, defina la resolución para calcular los vectores del viento
en coordenadas polares.

Por ejemplo si Range Spacing se establece en 10 km(6,2 mi) y el Azimuth Spacing se
establece en 45°, se calcula un vector del viento para Min-Max Range cada 45° en
acimut y 10 km (6,2 mi) en rango.

5. Establezca los valores de Sector Length y Width.

Cada vector del viento se calcula en el centro de un sector, que se define con Sector 
Length (o rango) en km y el ancho del sector (o acimut) en grados.
Puede establecer los valores de Range y Azimuth Spacing de modo que los sectores se
superpongan.
Vaisala recomienda que el ancho del sector sea de ~60°.

6. En Defaults, establezca todos los campos del menú en sus valores predeterminados.

Más información

‣ Parámetros de visualización (página 31)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)
‣ Opciones de salida WIND y FCAST (página 271)
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3.27 XSECT: sección transversal

Figura 39 Ejemplo de configuración de XSECT

XSECT es un producto de exploración de volumen que muestra la sección transversal de
altura junto con una línea definible por el usuario.

El producto XSECT es similar a RHI en que muestra una representación de rango-altura o un
"corte" vertical de un parámetro del radar.

Para XSECT, la sección transversal se crea a partir de una exploración de volumen de PPI.
Esto significa que, si ejecuta una exploración de volumen estándar a intervalos regulares, se
puede crear una XSECT sin programar una tarea de RHI.

A diferencia de los productos RHI, que, por lo general, se componen de alrededor de
100 ángulos de elevación, la resolución en XSECT se limita por la cantidad de ángulos de
elevación en la exploración de volumen, normalmente de 10 ... 20. Sin embargo, la
interpolación 3D que usa el algoritmo de XSECT genera una representación excelente de la
distribución de la altura de los parámetros del radar. Además, el algoritmo corrige los
efectos de la curvatura terrestre, de modo que la escala de altura se corresponda con la
altura real por encima de la altura de referencia del producto (generalmente, a nivel del
mar).

Puede usar el producto XSECT de las siguientes formas:
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• Para las áreas de interés, como por ejemplo cuencas o terminales aéreas, puede
configurar una XSECT como un producto estándar para realizar un corte de un área.

• A medida, para atravesar una línea de tormentas o un área que se sospeche con clima
severo.
Para las secciones transversales a medida, use la herramienta de XSECT en Quick Look 
Window para configurar la línea de la sección transversal con un ratón.
Si no usa un ratón para definir una línea de la sección transversal, visualice un producto
PPI o CAPPI con anillos de rango y números de rango para poder configurar la sección
transversal.

En la siguiente ilustración se muestra la geometría correspondiente de la XSECT para el
ejemplo de la configuración anterior.

Zero
Label

Horizontal Distance 01053–

Center Point
Right
Side

Point Closest
to Radar

Cross-Section
    Line

Center Point
 Range=16
Azimuth=300

Width = 45

X = –13.9

Y = 8.0

Left
Side

10

Height

0

Orientation Angle = 50.0

If Angle is set to  50 + 180 = 230, left
and right sides of XSECT display are
swapped.

Cross Section Configuration Parameters Cross Section Display Parameters

Figura 40 Geometría de la sección transversal

1. Seleccione Type > XSECT.

2. En Data:Display, haga una selección entre las siguientes opciones: Z dBZ, Z Rain, V
Vel, W Width, T dBZt, T Rain, Zd ZDR y Zd Rain.
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3. Para Center (x,y):

a. Observe la imagen de CAPPI o PPI que desea "cortar" y decida dónde desea realizar
la sección transversal.

b. Seleccione el punto central de la sección transversal.

En este punto, son útiles las marcas de rango y las líneas de acimut.
Por lo general, se coloca el punto central de la función del radar que desea "cortar",
tal como se muestra en el ejemplo.

c. Ingrese las coordenadas de distancia-X (este) y distancia-Y (norte) en km.

Ingrese las distancias sur y oeste como números negativos.

4. Seleccione la altura máxima y el ancho horizontal de la sección transversal en km e
ingréselos en Height Width.

No deben ser valores exactos; use las marcas de rango y acimut que se muestran en la
pantalla para calcular el ancho horizontal.
En el ejemplo, la altura es de 10 km (0,6 mi) y el ancho es de 45 km (28,0 mi).

5. En Angle, seleccione el ángulo de orientación en grados.

En el ejemplo, el ángulo es de 50°. El ángulo que seleccione determina el fin del corte
de la sección transversal que se muestra en el lado derecho de la pantalla. Un ángulo de
50° se muestra de la siguiente manera:

Left Side         Right Side
23° end           50° end

Para revertir los extremos de la pantalla de salida, seleccione un ángulo de 50° + 180° =
230°.

6. En XZ Smoother, establezca las escalas de la longitud de estabilización X y Z de forma
independiente.

Por lo general, dada la interpolación que se realizó al crear el producto de la sección
transversal, las pantallas de salida requieren poca o nula estabilización.

En la pantalla de salida final, el punto cero de la escala de rango horizontal se
corresponde con el punto más cercano en la sección transversal al radar. Esto también
se muestra esquemáticamente en el ejemplo.
Esto significa que si selecciona una línea que atraviesa el radar (que se permite para
realizar un pseudo RHI), el punto 0 está en el radar, de modo que la distancia horizontal
es igual al rango del radar.
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Más información

‣ RHI: indicador de altura del rango (página 70)
‣ Parámetros de visualización (página 31)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)
‣ ¿Es mejor usar RHI o XSECT? (página 73)
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4. Programación de productos

4.1 Menú del programador de productos
El menú Product Scheduler le indica a IRIS cuándo generar un producto para operación
automática o manual.

Debido a que la generación de productos afecta los recursos de la computadora host, este
menú se puede ver, pero no controlar mediante un observador de IRIS.

Figura 41 Product Scheduler

Columna Site
Muestra el sitio para cada producto programado. Un producto se ejecuta solamente si
los datos de ese sitio llegan a IRIS desde el radar, a través de la red o desde una cinta.
Si el campo Display se establece en Master (Master Schedule), hay solo una entrada
de producto, independientemente de la cantidad de sitios programados.
Haga clic con el botón derecho del mouse para mostrar un menú en la columna de
sitios donde se enumeran todos los sitios con el símbolo * junto a cada uno para el
cual el producto se programó.
Seleccione una entrada para agregar o quitar la etiqueta *. Esto hace que sea
conveniente usar Master Schedule para agregar o eliminar sitios del programa.

Columna Product
Muestra el nombre del producto.

Columna Data
Muestra el parámetro de datos configurado para el producto.
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Columna Task
Muestra el nombre de la tarea asociada.

Next-Data-Time
La programación funciona bajo el concepto de hora de los datos, es decir, la hora en
que una tarea comienza a recolectar datos. Para un horario de tarea a tiempo, la hora
de los datos corresponde a la hora en que una tarea está programada para comenzar.
Cuando programe un producto, establezca el campo Next-Data-Time para que el
generador de productos procese solo tareas asociadas con las horas de los datos
posteriores a la siguiente hora de los datos.

Skip
La hora Skip divide el día en intervalos equivalentes de tiempo comenzando desde la
medianoche. Se genera un producto; como mucho, uno por cada intervalo de tiempo
Skip. Se usa para cada intervalo la primera ocurrencia de datos de la tarea asociada.

Request
Programa un producto según si el horario afecta las ocurrencias All, Next del
producto. También puede detener la programación del producto.

Status
Muestra el estado actual de cada producto como Running (el producto se está
generando) o Wait (el producto está esperando que se ejecute la tarea asociada, su
turno para ejecutarse según la finalización de otros productos, o el producto no está
programado para ejecutarse).
Después de la generación de un producto, el estado cambia de Running a Wait.
Cuando aparece Master Schedule, Status muestra el estado del sitio que se está
ejecutando en ese momento o que se ejecutó recientemente.

Runs
Un contador (000 a 999) que muestra la cantidad de veces que se ejecutó un
producto desde que se cargó en el menú.
Si la cantidad de ejecuciones supera 999, el contador se reinicia a 000.
Si detiene un producto, el contador no se restablece. El contador se restablece si
elimina un producto y lo vuelve a cargar en el horario. Si carga un horario nuevo, los
contadores para todos los productos se restablecen.
Cuando se muestra Master Schedule, el campo Runs refleja la cantidad total de
ejecuciones para todos los sitios programados.

4.2 Programación de productos
1. Seleccione Menú > Programador del producto .

Aparece una lista de tipos de productos disponibles.
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2. En Display, en la parte superior del menú, especifique qué sitios se mostrarán.

Valor Descripción

All Sites Muestra el cronograma para todos los sitios.

Master Muestra el Master Schedule, con una entrada para cada producto programado.

Si un producto se programa para ejecutarse en varios sitios, la entrada muestra el
sitio que lo ejecutó más recientemente.

Site Group Muestra los productos configurados para todos los sitios en el grupo.

El Site Group es un subgrupo de sitios definido en el campo Site Group.

Single Sites Muestra los productos configurados para un único sitio (seleccione el nombre del
sitio). Use este si su sistema admite un sitio.

El campo de texto adyacente muestra cuántos productos coinciden con la selección de
la pantalla.

3. En Add for, en la parte superior del menú, especifique los sitios para los cuales se
agrega el producto.

Valor Descripción

All Sites Agrega el producto para todos los sitios.

Site Group Agrega el producto para todos los sitios definidos por el Site Group.

Etiqueta con * los miembros del grupo del sitio. Si tiene un único sistema de sitio,
haga que su sitio sea el único miembro del Site Group.

Single Sites Agrega el producto solo para ese sitio. Use este si su sistema admite un sitio.

4. Para editar los productos configurados en el cronograma de productos, haga clic con el
botón derecho del campo Product y seleccione uno de los siguientes:

Valor Descripción

Add Agrega un producto al cronograma.

El producto se genera en una base continua cuando la tarea recopila datos, sujeto
al tiempo Skip.

Remove Retira de la lista el producto seleccionado para el sitio que se muestra.

Si se muestra el Master Schedule, el producto se retira para todos los sitios.

Edit Abre el menú Product Configuration para el producto seleccionado.
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5. Para generar datos solo a partir de tareas futuras:

a. Haga clic con el botón derecho en el campo Request.

b. Seleccione All o Next.

Valor Descripción

All Se procesan todos los datos de tareas asociadas que se recopilan después de la
siguiente hora de datos.

El producto se genera en una base continua cuando la tarea recopila datos, suje-
to al tiempo Skip.

Next Solo se procesan los datos a partir de la siguiente incidencia de la tarea, después
de la siguiente hora de datos.

El producto se genera solo una vez.

Se ignora el tiempo Skip.
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6. Si usa una solicitud All, puede establecer el campo Skip para que el generador de
productos no procese cada ocurrencia de la tarea asociada.

De manera predeterminada, una solicitud All genera datos de cada tarea que se
procesa. El tiempo Skip divide el día en intervalos equivalentes de tiempo comenzando
desde la medianoche.
Se genera un producto; como mucho, uno por cada intervalo de tiempo Skip. Se usa
para cada intervalo la primera ocurrencia de datos de la tarea asociada.
Por ejemplo, un tiempo Skip de 00:15 (15 minutos) significa que el producto se genera
con una frecuencia no mayor a 15 minutos, independientemente de la frecuencia con la
que se ejecute la tarea.
En la siguiente figura, se establece el campo Skip para una solicitud All para que haya
2 ocurrencias de la tarea en cada intervalo. Solo se usa la primera ocurrencia para
generar el producto.

TASK TASK TASK TASK TASK TASK TASK TASK

Time

Product Product Product Product

Skip Time
Interval

El valor predeterminado del campo Skip es 00:00, que indica que no se saltea ninguna
tarea.
Cuando se muestra el Master Schedule, se aplica un cambio en el Skip Time para todos
los sitios.

Debe considerar el cronograma de tareas cuando especifique el tiempo Skip.

Durante la operación, el campo Next-Data-Time cambia para mostrar la siguiente hora
posible en que se pueda generar el producto. Depende del tiempo Skip y la solicitud
(All o Next), de la siguiente manera:

Valores Skip y Request Descripción

Next Any Skip Time Después de completar una solicitud Next, el campo Next-Data-Time se
restablece a la hora de datos (más 1 segundo) de la tarea que se proce-
só.

Esto significa que emitir otra solicitud Next procesa la siguiente ocu-
rrencia de la tarea asociada.

Se ignora el tiempo Skip.
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Valores Skip y Request Descripción

All Skip Time = 00:00 El producto se genera para cada ocurrencia de datos de la tarea asocia-
da.

El campo Next-Data-Time se restablece a la hora de datos (más 1 se-
gundo) de la tarea que se procesó (idéntico al caso de solicitud Next).

Es lo mismo que emitir una serie de solicitudes Next.

All Skip Time >00:00 El campo Skip determina la hora más temprana en que se puede gene-
rar un producto nuevo.

Después de completar un producto, el campo Next-Data-Time se resta-
blece a la hora de inicio del siguiente intervalo de tiempo Skip.

7. Para generar datos solo a partir de tareas futuras, haga clic con el botón derecho en el
campo Request.

Opciones del
campo Request

Descripción

All Se procesan todos los datos de tareas asociadas que se recopilan después de la si-
guiente hora de datos.

El producto se genera en una base continua cuando la tarea recopila datos, sujeto
al tiempo Skip.

Next Solo se procesan los datos a partir de la siguiente incidencia de la tarea, después
de la siguiente hora de datos.

El producto se genera solo una vez.

Se ignora el tiempo Skip.

Stop Detiene el cronograma de los productos seleccionados.

Cuando se muestra el Master Schedule, se aplica un cambio en Request para todos los
sitios.
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8. Para generar productos a partir de datos antiguos, haga clic con el botón derecho en el
campo Next-Data-Time.

Esto le permite generar productos de datos de tareas recibidos de otro host de IRIS o
recuperados de una cinta.
En el siguiente ejemplo, se muestra cómo interactúa Next-Data-Time con las opciones
de solicitud All y Next.

TASK TASK TASK TASKTASK TASK TASK TASK

Past TASKS Present Future TASKS

Next Data Time

Next Request

All Request

Time

Cuando un producto se carga primero en el cronograma o se carga un cronograma
nuevo entero, el campo Next-Data-Time se puebla de manera determinada con la hora
actual.

a. En la columna Siguiente-Datos-Hora, haga clic con el botón derecho en la marca de
tiempo.

b. Seleccione los botones Siguiente > Producto > Hora para volver atrás.

9. Seleccione Archivo > Guardar y proporcione un nombre al programador del producto.

4.3 Adición de un producto a un horario
1. Seleccione el encabezado o el producto para el tipo de producto que desea ingresar.

2. Coloque el cursor sobre el campo Product y seleccione Add.

IRIS muestra una lista de productos de ese tipo.

3. Seleccione un producto.

El producto se agrega al horario.

4.4 Retiro de un producto del horario
1. Seleccione el producto que desea eliminar.

2. Coloque el cursor sobre el campo Product y seleccione Remove.

Solo puede eliminar productos. IRIS no elimina los encabezados del producto del
horario.
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4.5 Edición de la configuración del pro-
ducto

1. Seleccione el producto que desea editar.

2. Coloque el cursor del mouse sobre el campo Product y seleccione Edit.

IRIS abre el menú Product Configuration con el producto seleccionado cargado.

3. Edite el producto según sea necesario.

4. Seleccione File > Save.

5. Salga del menú Product Configuration.

IRIS lo regresa al menú Product Scheduler actualizado.

4.6 Detención de la generación de pro-
ductos

1. Seleccione el producto que desea detener.

2. Coloque el mouse sobre el campo Product y seleccione Stop.

Si el producto está esperando su generación, la solicitud Stop desprograma el producto
de los estados All o Next.
Si el producto se está generando cuando hace la solicitud Stop, no se produce un
archivo de salida del producto.

4.7 Consejos sobre cómo ejecutar pro-
ductos de radar

Optimizar el rendimiento del sistema

Puede configurar una cantidad casi ilimitada de productos en IRIS. El administrador del
sistema debe planificar con cuidado la mezcla de productos y las capacidades del
rendimiento para su instalación.

Tabla 14 Consideraciones del rendimiento del sistema para la generación de productos de radar

Consideración Descripción

Capacidades de
la CPU

Puede mejorar el rendimiento descargando los procesos de salida del producto a otra má-
quina. Considere generar productos en otro sistema IRIS Analysis.

Mezcla de pro-
ductos

Evite desperdiciar recursos de la computadora haciendo productos que nadie observará.

Por ejemplo, generalmente, las personas no observan 12 productos CAPPI. Una mezcla de
CAPPI, VIL y TOPS puede ser más adecuada.
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Consideración Descripción

Dispositivos de
salida

Considere la compensación entre dispositivos de salida y mezcla de productos.

Si administra muchos nodos remotos, puede generar menos productos.

Pantallas de al-
ta resolución

No las cree si no son necesarias. Los productos de media y baja resolución se ejecutan con
mayor rapidez. Use productos de baja resolución para pantallas remotas en línea de serie
porque las tasas de actualización son más rápidas.

Muestreo de al-
ta resolución

No lo use en las configuraciones de sus tareas si no es necesario. Si desea usar muestreo de
alta resolución (en acimut y rango), no muestree en rangos mayores que los que necesita
para su aplicación.

Productos per-
sonalizados

Si los usuarios desean solicitar muchos productos personalizados, considere comprar otra
estación de trabajo para ejecutar el software de visualización. Esto significa que puede ob-
tener datos RAW del host de IRIS y procesar productos en la otra estación de trabajo.

Productos inmediatos

La mayoría de los productos IRIS son productos de exploración de volumen que requieren
una serie de productos PPI.

Los productos inmediatos se pueden ejecutar antes de que se complete una exploración de
volumen porque se basan en un solo barrido de datos. Use productos inmediatos para
aplicaciones donde se requiere retroalimentación rápida. Por ejemplo, PPI, RHI o SHEAR.

Creación de productos a partir de datos recuperados y marcadores Keep
Cuando los archivos del producto RAW se restauran a partir de una cinta, se vuelven a
introducir automáticamente para reconstruir los archivos de introducción que se requieren
para la generación del producto.

Debido a que los datos de la cinta son antiguos, son los primeros de la lista para que el
proceso de vigilancia del sistema los elimine. Para evitar esto, haga lo siguiente en el menú
Ingest Summary:

• Antes de recuperar los archivos de una cinta, elimine algunos archivos de introducción
innecesarios.

• Después de que se restauren los archivos, etiquete los archivos de introducción con
marcadores Keep para que no se eliminen cuando ingresen archivos en tiempo real,

Para obtener información sobre el espacio reservado para los archivos de introducción,
consulte Setup en IRIS and RDA Utilities Guide (M211316EN).
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5. Configuración y programa-
ción de productos IRIS op-
cionales

5.1 CATCH: Acumulación de precipitación
en subcuencas

CATCH calcula la acumulación de precipitación en áreas de captación, como cuencas.

CATCH se usa para aplicaciones hidrometeorológicas como la estimación de la pluviosidad
total en la cuenca de un río con el objetivo de pronosticar inundaciones. Se pueden
seleccionar tanto el tiempo de la integración como las áreas de subcuenca.

CATCH también puede emitir advertencias si la precipitación en una región de subcuenca
supera el valor umbral.

CATCH es un producto de un producto para el cual el producto RAIN1 por hora sirve de
entrada. Puede sumar cualquier cantidad de horas de productos RAIN1 individuales. El único
límite es la cantidad de productos RAIN1 que se almacenan en el disco. Como parte de la
opción IRIS Hydromet, los productos RAIN1 se pueden calibrar mediante la entrada del
pluviómetro, por lo que los productos CATCH también se benefician de esta calibración.

Las áreas de subcuenca también se definen de manera similar a las superposiciones; es
decir, las regiones de subcuenca se definen utilizando puntos de vector LAT/LON y se
almacenan en un archivo en el directorio IRIS_OVERLAY.

Un archivo "catch" por lo general contiene muchas áreas de subcuenca. Puede haber más de
un archivo CATCH, por lo que los usuarios pueden tener "mezclas" diferentes de subcuencas.

La salida del producto CATCH es un archivo que contiene la profundidad de precipitación
para cada subcuenca para cada hora y el total sobre el tiempo de integración seleccionado.
Este archivo se puede mostrar por sí mismo o superponer sobre la visualización de otro
producto. Una visualización de gráfico de barras interactivo muestra las cantidades de
precipitación por hora en cada subcuenca.

Debe adquirir una licencia para la opción Hydromet para usar el producto CATCH.
Si el producto CATCH no está en el Product Scheduler o en la lista de tipos de productos
en el menú Product Configuration, entonces no tiene una licencia para el producto
CATCH.

Más información

‣ Descripción general de la corrección del pluviómetro Hydromet (página 360)
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5.1.1 Configuración de productos CATCH

WIND_05

PPI Full

Az: Full Circle El: 3 angles from 0.5 to 4.0

70.0

2Z T V W ZDR Kpd PDP RHV SQI Zv Tv SNR Ze Te

Figura 42 Configuración de ejemplo de CATCH

1. Seleccione Type > CATCH.
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2. Configure el producto CATCH:

Rain1
Especifique el nombre del producto de entrada RAIN1 por hora.
Seleccione Rain1 y elija de la lista de productos o escriba el nombre en el campo.
Cuando ingresa un nombre de producto, la información de la tarea asociada se
muestra en TASK Summary.

Hours
Especifique la cantidad de horas a integrar. Cuando ejecuta el producto, este
integra los datos de las últimas horas N.
Si falta un producto RAIN1 para una de las horas del intervalo, el algoritmo
supone que no hubo lluvias en esa hora.
La salida del producto muestra cuántas horas se integraron.

Color Scale, Levels y 1st Level/Step
Especifique que los niveles de color se pueden especificar.
La resolución se fija con la resolución de la configuración de RAIN1.

Subcatch
Seleccione el nombre del archivo de subcuencas. El archivo de subcuencas
contiene las definiciones de la subcuenca.

Issue Warn
El producto CATCH puede generar advertencias si la cantidad de precipitación en
una subcuenca supera el valor umbral.
El valor umbral para cada área de subcuenca se configura en el archivo de
subcuencas.

Offset y Multiplier
Utilice estos valores para modificar los umbrales para cada subcuenca. Se puede
hacer para compensar diferentes tiempos de integración.
Para no ajustar los umbrales en el archivo de subcuencas, establezca
Offset=0.0 y Multiplier=1.0.
Vaisala le recomienda configurar los umbrales en el archivo de subcuenca para
que sean característicos de acumulación durante un tiempo estándar, como por
ejemplo una hora. Puede usar el Offset y Multiplier para ajustar todos los
umbrales.
Por ejemplo, suponga que un indicador de peligro de inundación en una
experiencia de subcuenca muestra que el umbral de una hora es de 10 mm
(0,39 pulgadas) y que el umbral de 2 horas es de 15 mm (0,59 pulgadas) para
peligro de inundaciones. Puede configurar el valor de 10 mm (0,39 pulgadas)
para la subcuenca y luego establecer el multiplicador en 1,5 y la compensación en
0,0. Esto permite cierto grado de ajuste de los umbrales de subcuenca para los
diferentes períodos de tiempo.
Otra técnica es configurar los diferentes archivos de subcuenca con los umbrales
establecidos para diferentes tiempos de integración. En este caso, el nombre del
archivo de subcuenca debe reflejar el tiempo de integración, como CATCH_06,
para indicar que los umbrales se establecen para 6 horas.
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3. En Save As, nombre el producto CATCH.

Vaisala recomienda nombrar el producto CATCH por la cantidad de horas de
integración y un descriptor general del área, quizás incluso el nombre del archivo de
subcuenca.
Por ejemplo, si el archivo de subcuenca para una cuenca de río grande se llama
RED_RIV y el tiempo de integración es de 2 horas, guarde el producto bajo el nombre
RED_RIV_02.

Más información

‣ Definición de subcuenca (página 131)

5.1.2 Definición de subcuenca
Las áreas de subcuenca se definen en un archivo almacenado en el directorio
IRIS_OVERLAY (por lo general, etc/vaisala/irisrda/overlay).

Estos tienen el sufijo .cat y se los conoce como archivos catch.

Cuando inicia IRIS, el registro de arranque muestra el procesamiento de los archivos catch.

En general, los archivos contienen la siguiente información para cada subcuenca:
• Número de índice de subcuenca (un número entero: 1, 2, 3...) y nombre.

El nombre se usa para la visualización.
• El umbral (mm) de profundidad de acumulación para la advertencia.
• Los puntos de subcuenca en coordenadas LAT/LON.

Estos puntos deben definir una región cerrada y estar en secuencia sobre el perímetro
de la región. Es decir, el primer punto y el último punto deben ser iguales.
Las subcuencas que comparten el mismo límite se deben ingresar como regiones
cerradas completas; es decir, los puntos del límite compartidos son los mismos para
cuencas adyacentes.

• La ubicación de un punto interno para el etiquetado.
El punto debe estar dentro de la región limitada de la cuenca.

Cada archivo catch por lo general tiene muchas regiones de subcuenca. Puede haber varios
archivos de subcuenca para diferentes aplicaciones, como por ejemplo:

• Para diferentes radares en una red.
• Para especificar diferentes umbrales de advertencia para compensar diferentes tiempos

de integración.
• Para cubrir áreas de cuencas importantes diferentes.

Está permitida la superposición de subcuencas en un archivo. Por ejemplo, una región de
cuenca grande se puede ingresar como una única cuenca grande y también se especifican
las cuencas afluentes más pequeñas. IRIS permite crear un máximo de 20 archivos catch
diferentes.

Para obtener más información, consulte la herramienta Superposición en IRIS and RDA
Utilities Guide (M211316EN).

Más información

‣ Configuración de productos CATCH (página 129)
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5.1.3 Programación de productos CATCH
La Data Time que especifique al programar el producto se cuantifica al valor de la hora en la
configuración del producto para el intervalo más cercano que finaliza la integración.

Use el campo Skip Time si solo desea las acumulaciones de intervalos específicos. Puede
establecer los tiempos de omisión en cualquier múltiplo del período de acumulación. Por
ejemplo, si desea una integración de 3 horas solo para los períodos que finalicen a las 03:00,
06:00, 09:00, ..., configure el campo Skip Time en 03:00.

Si la entrada de RAIN1 se corrige mediante los datos de entrada del pluviómetro, hay un
retraso en el producto CATCH ya que el producto RAIN1 de entrada se retarda al esperar
por la llegada de los datos del pluviómetro.

La programación de los productos CATCH es la misma que para los productos RAINN.

Más información

‣ RAIN-N: acumulación de lluvia en N horas (página 64)

5.1.4 Algoritmo de CATCH
El algoritmo del producto CATCH toma los productos RAIN1 para el tiempo de integración
especificado (horas) y realiza los siguientes pasos:

1. Para cada subcuenca, todos los píxeles en el producto RAIN1 que se encuentran dentro
o entran en contacto con el perímetro de la subcuenca se agregan juntos y luego se
dividen por la cantidad total de píxeles.
Los píxeles del umbral se tratan como pluviosidad de 0.
El resultado es una pluviosidad promedio por hora para la subcuenca.

2. Este procedimiento se repite para cada hora y cada subcuenca.
3. Se obtiene la suma de todas las horas en el tiempo de integración para cada subcuenca

con el fin de obtener una acumulación promedio total para el período.
Si el botón Issue Warn está habilitado, se revisa esta suma frente al umbral de
advertencia del archivo de cuenca (ajustado por Offset y Multiplier) y se emite una
sola advertencia de IRIS para todas las áreas de la subcuenca que superan el umbral.

Para cada subcuenca, el archivo de salida final contiene:
• La LAT./LON. del punto de la etiqueta, el nombre del punto y el número del índice.
• Las acumulaciones promedio por hora sobre el tiempo de integración seleccionado.

Estas se usan para la pantalla del gráfico de barras.
• La acumulación promedio total para el tiempo de integración.
• La fracción de píxeles en la subcuenca con una precipitación diferente de cero.

El archivo de salida no contiene definiciones del límite de la subcuenca. Esto tiene
implicaciones para la pantalla cuando el producto de CATCH se transfiere a otra máquina.
Consulte Mostrar CATCH (página 133).
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5.1.5 Mostrar CATCH

Figura 43 Pantalla del producto de CATCH

Puede visualizar los productos de CATCH en la Quick Look Window, así como también en
otras salidas de pantalla.

La pantalla de la Quick Look Window para el producto de CATCH muestra lo siguiente:
• Regiones del mapa de la subcuenca con código de color donde el código de color

muestra la profundidad de las precipitaciones (consulte el ejemplo anterior). La escala
de colores es la escala de la profundidad de pluviosidad en mm o en pulgadas.

• Íconos de colores donde se dibuja el ícono (forma de cubo del pluviómetro) en el
código de color para la profundidad de las precipitaciones. Se usa este estilo de
pantalla cuando el producto de CATCH se coloca sobre otro producto.
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1. Si es necesario, configure las escalas de colores y las unidades en la herramienta de
Color Setup.

Consulte IRIS and RDA Utilities Guide (M211316EN).

2. En la Quick Look Window, muestre un producto de CATCH.

3. Para elegir un estilo de pantalla, seleccione Quick Look Window > Options.

4. Haga clic con el botón derecho del mouse en una subcuenca.

Aparece un gráfico de barras donde se muestra la acumulación de precipitaciones por
hora para el tiempo de integración.

5. Para seleccionar la escala vertical del gráfico de barras, use los indicadores ascendente
y descendente que se encuentran junto a la parte superior de la escala.
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5.2 COMP: Compuesto

Mercator or
Azimuthal Equidistant
Projection

Baseline

Figura 44 Ejemplo de geometría de proyección compuesta

COMP produce una imagen compuesta única de los datos del radar de varios sitios de radar.

COMP le permite combinar datos de muchos radares diferentes.

Las ventajas de la formación de compuestos son las siguientes:
• Expanda el área de cobertura para darles a los elaboradores de pronósticos un

panorama general.
• Zonas ciegas completadas causadas por montañas o eliminación de sectores

requeridos.
• Zonas ciegas completadas causadas por limitaciones en la estrategia de exploración

(por ejemplo, falta de exploración de ángulos de elevación altos).
• Simplifique la administración de productos para que los usuarios no tengan que

verificar muchas imágenes de un solo radar.
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Tipos de productos para la formación de compuestos

A diferencia de otros productos, cuando programa un producto de COMP, IRIS no realiza un
producto de tipo COMP. En cambio, crea un producto de entrada y lo guarda como el tipo
de producto de entrada.

Por ejemplo, si un PPI es la entrada al producto COMP, la salida es un producto de PPI.

Los tipos de productos que se pueden combinar mediante COMP son los siguientes:
• BASE
• CAPPI, incluido el CAPPI 3D (dBZ y R)
• HMAX
• MAX (sin los paneles laterales)
• PPI (dBZ y R)
• RAIN1
• SHEAR
• SRI
• THICK
• TOPS
• USER
• VIL
• WARN

Uso de compuestos por otros productos

COMP produce productos de IRIS reales en vez de simplemente "pegar" las imágenes juntas
para hacer una imagen combinada.

Esto significa que otros productos de IRIS, que utilizan productos como entrada, se pueden
ejecutar en los compuestos. Por ejemplo, se puede usar un compuesto de CAPPI como
entrada a un producto de acumulación RAIN1. Se puede usar un compuesto de CAPPI 3D
como entrada en el paquete 3D de IRIS opcional. Productos como WARN, TRACK y FCAST
se pueden ejecutar en los productos de IRIS que son compuestos.

Reasignación automática de productos de entrada

La formación de compuestos de productos puede ser complicada debido a problemas de
diferentes resoluciones del radar, rango máximo, espaciado de ángulo, cantidad de píxeles,
proyecciones del mapa y cuestiones similares.

IRIS facilita el proceso al reasignar automáticamente los productos de entrada a la
proyección y resolución de salida final. Esto significa que puede colocar productos con
diferentes resoluciones de píxeles, posición central y rango máximo, incluso en diferentes
proyecciones (Mercator frente a punto acimutal equidistante), e IRIS lleva a cabo la
reasignación para hacer el producto final.

Esto significa que cuando realiza compuestos, puede utilizar proyecciones de radar
individuales normales. No hay necesidad de realizar un conjunto especial de productos para
que sirva como entrada a los compuestos. Esto simplifica la administración de la
configuración del sistema.
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Fuentes de productos de entrada

Desde la computadora host, seleccione donde se llevarán a cabo los productos de entrada y
quién los realiza (IRIS frente a no IRIS). Los productos usados por COMP pueden:

• Generarse localmente en la misma estación de trabajo donde se realizan los
compuestos.

• Enviarse por la red desde otra estación de trabajo (IRIS o no IRIS mediante el uso de
UPI).

• Cualquier combinación de los anteriores.

Entrada de productos de los sistemas que no son de IRIS

La capacidad de enviar productos por la red hacia una computadora de compuestos central,
además de la habilidad de reasignar automáticamente los datos, facilita la combinación de
datos de los sistemas que no son de IRIS.

La función de reasignación es importante, ya que puede que no tenga control sobre el rango
o la resolución de los datos que no son de IRIS. Se puede volver a aplicar formato a los
productos de sistemas que no son de IRIS para que coincidan con los formatos de IRIS
estándares y luego se inserten en IRIS mediante el mecanismo de canales de entrada.

Vaisala brinda ejemplos de código fuente a los clientes que desean volver a aplicar formato
a los datos que no son de IRIS e insertarlos en IRIS. Estos productos luego se pueden enviar
a la estación de trabajo de IRIS compuesta de forma directa, a través de un programa de
usuario externo o mediante otro IRIS.

Compuestos de compuestos (compuestos regionales, nacionales e internacio-
nales)

La cantidad máxima de radares que se pueden usar en un compuesto es 16. Esto resulta
adecuado para la mayoría de las aplicaciones.

Para redes más grandes, se recomienda primero realizar compuestos regionales y, luego,
otros compuestos para crear compuestos nacionales o internacionales.

5.2.1 Algoritmo compuesto

Reglas básicas

COMP toma productos de varios sitios de radar y los combina en un único producto usando
las siguientes reglas:

• Los productos de entrada deben ser del mismo tipo (por ejemplo, CAPPI) y tener el
mismo nombre.
Es la manera recomendada de administrar productos en la red en general.
Tenga en cuenta que el IRIS ordena todo por sitio, por lo que no hay necesidad de
ingresar el ID del sitio en el nombre.
El tipo de producto y el nombre se especifican en el COMP Product Configuration 
Menu.
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• Los productos deben estar dentro de una determinada ventana de tiempo para poder
combinarlos.
No desea combinar datos si los productos de entrada tienen más que unos pocos
minutos de diferencia.
La ventana de tiempo se especifica en el COMP Product Configuration Menu.

Reasignación

Los productos que se combinarán se reasignan a la proyección común que se especifica en
el COMP Product Configuration Menu.

Idealmente, PPI y CAPPI deben estar a los mismos ángulos de elevación y a las mismas
alturas.

Si no están en los mismos ángulos de elevación y las mismas alturas, hay tolerancias para
combinar productos PPI de elevaciones levemente diferentes (por ejemplo, 1°) y productos
CAPPI de diferentes alturas [1000 m (3280 pies 10 pulgadas)].

Combinación

En regiones donde se superponen los radares, puede seleccionar uno de los siguientes
métodos para combinar datos del radar:

• Máximo
Máximo usa el valor máximo para combinar los datos. Es la configuración más común.

• Promedio
Promedio utiliza el promedio de datos disponibles. Se trata de una elección deficiente
si intenta cubrir regiones bloqueadas.

• Prioridad
La prioridad usa los datos del radar disponible que es más alto en la lista de los sitios
definida en COMP Product Configuration Menu.

• Más cercano
Más cercano usa los datos del radar que se encuentran en la distancia más corta. Se
ignoran los datos del radar que están más lejos.

• Ponderado
Para ponderado, el valor asignado a una ubicación se determina por el promedio
ponderado de todos los radares que detectan una señal en esa ubicación.
La ponderación es inversamente proporcional a la distancia al sitio del radar. Los datos
de los sitios de radar más cercanos tienen un impacto mayor en el valor final que los
datos de sitios alejados.

Puede elegir el algoritmo de combinación en COMP Product Configuration Menu.

Salida

No hay producto COMP. La salida de un COMP PPI es un producto PPI con el nombre que se
asignó en el COMP Product Configuration Menu.

Más información

‣ Configuración de COMP (página 139)
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5.2.2 Preparaciones de compuestos por parte del administra-
dor del sistema

Para admitir la creación compuesta, el administrador del sistema debe configurar los
siguientes elementos por adelantado. En muchos casos, estos están preconfigurados para su
sistema.

• Configure los sitios del radar en IRIS Setup > General. Consulte IRIS and RDA Utilities
Guide (M211316EN).

• Configure la proyección en IRIS Setup > projection.

5.2.3 Configuración de COMP

Figura 45 Ejemplo de configuración de COMP
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1. En Type, seleccione el tipo de producto y el nombre que desea para el compuesto.

Los productos de sitios diferentes deben tener todos este nombre.
IRIS solo le permite combinar los siguientes productos con licencia en la computadora
del compuesto:
• BASE
• CAPPI, incluido el CAPPI 3D (dBZ y R)
• HMAX
• MAX (sin los paneles laterales)
• PPI (dBZ y R)
• RAIN1
• SHEAR
• SRI
• THICK
• TOPS
• USER
• VIL
• WARN
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2. Seleccione Radar Sites y use la herramienta de selección de sitio del radar para cargar
los sitios que desea combinar.

El orden de los sitios es importante. El sitio de mayor prioridad (primero en la lista)
que está en el compuesto (algunos pueden faltar) determina la "hora de datos"
asociada al producto.
También se usa para llenar datos en regiones superpuestas si selecciona la regla de
combinación Priority.

3. En Output Site ID, especifique el sitio utilizado para identificar el compuesto.

No necesita ser un sitio de radar real. Puede usar un "sitio virtual" asociado a la
proyección o a la red.
Los sitios se configuran en el administrador de sistemas en la herramienta Setup.
Consulte IRIS and RDA Utilities Guide (M211316EN).
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4. En Map Projection, defina la proyección común.

Los productos de entrada se reasignan a este.
Por lo general, las configuraciones de proyección del mapa se realizan con el
administrador de sistemas.
Los campos Max Range y Resolution se determinan por la proyección; es decir, no los
puede editar.

5. En Max Time Span (min), defina la diferencia máxima de tiempo que el algoritmo
puede permitir para productos compuestos.

Los tiempos de producto para los productos de exploración de volumen se
corresponden al inicio de la exploración de volumen (la hora de datos).
Para PPI, es el tiempo de barrido real. Un valor de 5 minutos es probablemente cercano
al máximo que permitiría por lo general. Si no está seguro, considere la rapidez con la
que se mueven las cosas en un bucle típico.
Este número debe ser menos el período entre las exploraciones de volumen en sus
datos de entrada.

6. En Output Smoother, agregue estabilización adicional, si es necesario.

En muchos casos, los productos de entrada se estabilizan.

La estabilización es intensiva informáticamente, especialmente para cubos CAPPI en
3D. Si la estación de trabajo está demasiado ocupada, es posible que desee reducir
la estabilización.
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7. En Combining Algorithm, seleccione el algoritmo que se usa en regiones donde los
radares se superponen.

Las opciones son Maximum, Average, Priority, Nearest o Weighted (según la lista de
sitios).

Se recomienda Maximum para las regiones rellenas con espacios en blanco o
bloqueadas.

Más información

‣ Configuración de las proyecciones del mapa (página 24)
‣ Algoritmo compuesto (página 137)

5.2.4 Algoritmo de WARN
El producto WARN usa un algoritmo compuesto.

Reasignación

Los productos WARN no se almacenan en formato cartesiano, por lo que no se requiere
reasignación. La proyección de salida especificada en la configuración COMP determina la
ubicación de pantalla predeterminada y el rango cuando se muestra el producto WARN
compuesto.

Superposición

La clave para combinar productos WARN es determinar cuáles de los centroides de entrada
realmente tienen la misma característica y cuáles son diferentes. Lo hacemos con la
Centroid Distance ajustable especificada en el Product Configuration Menu.

Para productos WARN, el campo reemplaza el campo Output Smoother que se usa para
otros productos.

El compuesto se inicia al copiar la entrada de mayor prioridad. Luego, todas las demás
entradas se enlazan según un orden de prioridad. Cada centroide nuevo se compara con
todos los centroides en el compuesto que se arma. Si el centro de un centroide nuevo está
dentro de la distancia centroide de la elipse de un centroide compuesto, se trata como
superpuesto en el siguiente algoritmo de combinación.
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Combinación

Las opciones para combinar algoritmos en el Product Configuration Menu (consulte
Configuración de COMP (página 139)) son diferentes para WARN.

• OR Max
La salida contiene un centroide para cada centroide en cualquiera de las entradas. Si
2 centroides se superponen, se mantiene el centroide con mayor fuerza.

• OR Avg
La salida contiene un centroide para cada centroide en cualquiera de las entradas. Si
2 centroides se superponen, los centroides se promedian.

• AND Max
La salida contiene un centroide solamente si todas las entradas tienen un centroide en
esa ubicación. Se usa el centroide con mayor fuerza.

• AND Avg
La salida contiene un centroide solamente si todas las entradas tienen un centroide en
esa ubicación. Se usa el centroide con valor promedio.

Más información

‣ WARN: Producto de Advertencia/Centroide (página 105)

5.2.5 Programación de COMP

A

BA Run on AB only if elapsed

Time is more than allowed

BA Run on ABCC

A and/or B Run on A and/or BC

Run on A only if elapsed

Time is more than allowed

Max Time Span + Wait

Max Time Span + Wait

Case 1

Case 2

Case 3

Case 4

Time- >

Max Time Span

Next Data Time

Figura 46 Ejemplo de programación del compuesto

El algoritmo de programación tiene en cuenta que no todos los radares se encuentran en el
mismo cronograma y que no todos funcionan el 100 % del tiempo.
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Tenga en cuenta un simple caso de productos que provienen de los radares A, B y C que se
muestran en la figura anterior.

• A, B y C hacen referencia a productos que provienen de diferentes sitios de radares.
• La línea vertical de la izquierda representa la "hora de los próximos datos" del Product 

Scheduler. El algoritmo de programación solo tiene en cuenta los datos que se
encuentran delante (a la derecha) de esta línea.

• La barra superior representa el "espacio de tiempo máximo" para realizar un
compuesto. El espacio de tiempo máximo se configura en el COMP Product 
Configuration Menu. Consulte Configuración de COMP (página 139).

• El intervalo de la barra inferior es el "tiempo transcurrido" entre la hora de llegada de
un producto y la hora actual.

• Los productos se colocan en la línea de tiempo de acuerdo con la "hora de los datos"
(por ejemplo, inicio de la exploración del volumen).

• Cada sitio está ordenado por prioridad con el fin de asignar la "hora de los datos" del
compuesto. Cuando se crea el compuesto, hereda la hora de los datos del sitio utilizado
de más alta prioridad. La clasificación está determinada por el orden de la lista del sitio
en el COMP Product Configuration Menu.

Casos 1 y 2: Datos incompletos, no espere para siempre

En estos casos, el programador espera que se completen los datos hasta que el momento
entre la hora de llegada del primer producto y la hora actual supera la ventana de tiempo
más el "tiempo de espera de llegada del producto" de la Setup.

Esto permite que haya tolerancia para los relojes de la estación de trabajo del radar que no
están exactamente sincronizados o para las variaciones en el tiempo de transferencia de la
red.

Luego de su ejecución, el programador coloca el puntero de la "hora de los siguientes datos"
después de la hora de los datos del último producto.

Tenga en cuenta que solo las computadoras del radar deben tener las horas sincronizadas. El
reloj del sistema en la computadora de formación de compuestos es irrelevante.

Caso 3: A, B y C están todos disponibles y en la ventana de tiempo

Ejecútelo en A, B y C. Este es el mejor caso debido a que llegaron todos los datos.

Luego de su ejecución, el programador coloca el puntero de la "hora de los siguientes datos"
después de la hora de los datos del último producto que se acaba de ejecutar.

Caso 4: Datos fuera de secuencia o con llegada tardía

A y B llegan y, luego C llega fuera de la ventana de tiempo. Ejecútelo en A y B únicamente.
Luego de su ejecución, avance la próxima hora de datos a un punto justo después de la hora
de datos del último producto que se acaba de ejecutar.

A llega, luego B o C llega fuera de la ventana de tiempo. Ejecútelo en A únicamente. Haga
avanzar la siguiente hora de datos a un punto justo después de la hora de datos de A.

Uso de tiempos de omisión

La información anterior es para un programador en el cual el tiempo de omisión está
configurado en 0.
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En este caso, nunca se reutilizan datos, y la siguiente hora de los datos está configurada a un
punto justo después de que ingresó el último producto usado.

La única diferencia cuando se usa el tiempo de omisión es que la siguiente hora de datos
está configurada en el siguiente múltiple del tiempo de omisión después del primer
producto que se creó. Esto garantiza que no se omita un compuesto debido a que falta un
solo archivo de entrada. También significa que en algunos casos se puede usar el mismo
archivo de entrada en 2 compuestos.

Se recomienda configurar el Max Time Span por debajo del tiempo de omisión. Por lo
general, se requiere el uso del tiempo de omisión si está creando radares con diferentes
tiempos entre exploraciones de volumen.

5.3 Algoritmo DWELL: Compuesto en el
tiempo

DWELL consta de un producto e imágenes sucesivas de compuestos de un producto en el
tiempo. Los objetivos móviles se muestran como un "trazo" en la pantalla.

DWELL es similar a la técnica fotográfica de dejar abierto el obturador de la cámara
mientras toma fotografías de un objetivo en movimiento. El fondo es fijo y detrás del
objetivo móvil hay una marca "borrosa".

t–2

t–1

t0

Input Product Sequence

Dwell Product at Time t0

Figura 47 Ejemplo esquemático de DWELL

El algoritmo del producto de DWELL es un "compuesto de tiempo" de los productos de
entrada. Debido a esto, el producto generado por el algoritmo DWELL es del mismo tipo
que el producto de entrada. Por ejemplo, si hacemos "permanecer" un producto PPI, se
genera un nuevo producto PPI. Las opciones para el tipo de datos que se muestran en el
producto DWELL PPI son las siguientes:
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• Datos de entrada originales
Por ejemplo, si se usa un PPI de dBZ como entrada, entonces DWELL crea un
compuesto de tiempo de dBZ.
Esto resulta útil para mostrar dónde hubo precipitaciones durante el tiempo de
permanencia. Cuando se anima, se pueden ver con facilidad el ciclo de crecimiento, el
deterioro y el movimiento de los ecos individuales.

• Hora
Los puntos de datos en el producto de DWELL están codificados según su edad desde
la hora del producto más reciente en DWELL. En la pantalla se muestra un historial
codificado con colores de los ecos.

Debido a que los productos DWELL muestran el historial de tiempo integrado de los ecos,
resultan ser una alternativa útil para el producto TRACK.

En la detección de objetivos aéreos, se usa DWELL para hacer un seguimiento y emitir
advertencias automáticamente sobre la presencia de aviones o bandadas de aves
migratorias.

5.3.1 Ejemplos del algoritmo de DWELL
DWELL consta de un producto e imágenes sucesivas de compuestos de un producto en el
tiempo. Los objetivos móviles se muestran como un "trazo" en la pantalla.

El ejemplo que se muestra aquí es para DWELL aplicado a los productos de PPI. A
continuación, se muestra el último producto (más reciente) de PPI en la secuencia de
DWELL. Muestra una línea de turbonada en dBZ. La línea se movía de Este a Oeste y se
desarrollaba o deterioraba a medida que se desplazaba.
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Figura 48 PPI de dBZ en una sola hora

En la siguiente figura a continuación se muestra un DWELL de los productos de PPI de las
últimas 2 horas. Esto resulta útil para saber dónde hubo precipitaciones durante el período
de DWELL. En la animación se muestra el campo de expansión de las precipitaciones que
cayeron y el movimiento del eco.
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Figura 49 DWELL del PPI durante las últimas 2 horas donde se muestra el dBZ

En la última figura del ejemplo figura la edad de los puntos de datos de DWELL; es decir, la
cantidad de minutos transcurridos desde el producto de PPI más reciente en la secuencia.
La escala de colores está configurada de manera tal que el azul haga referencia a los ecos
más recientes mientras que el rojo muestre los ecos más viejos.

En el ejemplo, el azul aparece a la izquierda (oeste) donde se encuentra el eco actual. Los
ecos rojos de la derecha (este) son los ecos más viejos de puntos anteriores en la secuencia.
Esto es lo que se prevé para movimientos generales de este a oeste. El eco residual tiene un
patrón punteado (por ejemplo, a 50 km [31,1 millas] hacia el noreste).
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Figura 50 Permanencia del PPI de las últimas 2 horas donde se muestra el tiempo (edad)

5.3.2 Aplicación del algoritmo DWELL a la programación del
producto

El algoritmo básico de DWELL (sin advertencia de objetivo) toma una serie de productos del
mismo sitio y con un determinado nombre y tipo y los combina.

Programación de productos

Puede programar el algoritmo DWELL en el Product Scheduler.
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Cuando el Product Scheduler detecta la entrada de un producto más allá del Next Data
Time, este producto y todos los productos del mismo sitio, dentro del tiempo de
permanencia especificado (por ejemplo, los últimos 10 minutos) se combinan para generar
un nuevo producto del mismo tipo. Los datos almacenados en el producto pueden ser los
valores de los datos del producto original o la edad de cada punto en relación con el
producto más reciente de la serie.

Si el producto DWELL se basa en un producto PPI donde la selección de la elevación en la
configuración del producto del PPI está configurada en comodín*, tiene que tener cuidado
con la programación para evitar una carga excesiva del CPU y disminución del
rendimiento.
Para evitar que el producto de DWELL se produzca luego de la finalización de cada
barrido del PPI, Vaisala recomienda configurar el Product Scheduler > Skip Time al
tiempo que se necesita para completar la exploración de un volumen o más.

Filtros de entrada del producto

Puede aplicar los siguientes filtros de datos de entrada a cada producto de entrada antes de
que se combinen en DWELL:

• Filtro mín.
Descarta los píxeles en el producto de entrada con un valor de datos menor que el valor
mínimo especificado. Para la velocidad, se usa el valor absoluto.
Para el ejemplo de un PPI en dBZ, si el valor mínimo está configurado en 10 dBZ, se
descartan todos los píxeles con valores menores que este.

• Filtro máx.
Descarta los píxeles en el producto de entrada con un valor de datos superior que el
valor máximo especificado. Para la velocidad, se usa el valor absoluto.
Para el ejemplo de un PPI en dBZ, si el valor máximo está configurado en 50 dBZ, se
descartan todos los píxeles del producto de entrada con valores mayores que este.

• Filtro de contraste
Descarta cualquier píxel en el producto de entrada con un valor de datos que no supera
el valor de datos correspondiente en el campo de fondo computado además de un
umbral seleccionable. Para la velocidad, se usa el valor absoluto de la diferencia entre el
campo de fondo y el píxel del producto de entrada. Se obtiene el campo de fondo al
crear primero una versión estable del producto DWELL.
Para el ejemplo del producto VIL, si se configura el umbral de contraste en 3 mm
(0,12 in), entonces un píxel en un producto de entrada debe tener un VIL de 3 mm
(0,12 in) mayor que el píxel correspondiente en el campo de fondo.

Si un píxel no pasa alguna de estas pruebas, significa que está configurado en thresholded;
es decir, sin datos.

Combinación de datos

Luego del filtrado, cada píxel de la entrada se "combina" con el píxel correspondiente de la
salida de DWELL. Si, por ejemplo, hay 10 productos de entrada para combinar, puede haber
hasta 10 valores posibles para asignar el valor de salida. El algoritmo de combinación utiliza
el valor máximo. En el caso de la velocidad, se usa el valor absoluto.
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Según lo que seleccione el usuario, el algoritmo almacena la hora del píxel combinado o su
valor de datos. El tiempo está almacenado como la "edad" del píxel en relación con el
producto de entrada más reciente en la secuencia de DWELL.

En el caso de la combinación de productos WARN, se combinan las estadísticas del
centroide; es decir, se crea un nuevo producto WARN que combina todos los centroides en
la secuencia de tiempo de los productos de entrada WARN.

Campo de fondo

El filtro de contraste permite que los ecos relativamente fuertes, tales como los centros de
reflectividad, los pájaros o los aviones se aíslen del eco de fondo relativamente débil. Para el
algoritmo de advertencia de objetivo, el filtro de contraste es fundamental para detectar los
objetivos aéreos en los ecos débiles de aire libre y meteorológicos.

Se crea el campo de fondo al ejecutar primero el algoritmo DWELL sin el paso de contraste
y, luego, al estabilizar los datos con un filtro 2D. Tenga en cuenta que se usan los filtros de
máximo y de mínimo para filtrar las entradas a fin de generar el campo de fondo.

Si el producto de entrada es el PPI en diferentes ángulos de elevación, puede generar el
campo de fondo por separado para cada ángulo de elevación del PPI en vez de combinar el
PPI independientemente del ángulo.

El algoritmo de combinación para la creación del campo de fondo es el mismo que para el
algoritmo DWELL principal (es decir, el valor máximo), excepto que para la velocidad, se usa
el valor promedio de la velocidad autorizada. El motivo por el cual se usa el máximo para
todo excepto para la velocidad es que los ecos meteorológicos tienen una fluctuación de
potencia natural y se eliminan mejor con un filtro de contraste si el campo de fondo se basa
en el máximo; es decir, si el campo de fondo tiene valores mayores de modo que pasen
menos puntos meteorológicos. En el caso de la velocidad, se usa el valor promedio para
caracterizar el campo de fondo, ya que no tiene sentido usar el máximo cuando cada
velocidad es igual de probable.

Luego de la combinación, se aplica un filtro de estabilización. Este es un filtro de promedio
2D configurado en 10 por 10 km (6,2 por 6,2 mi) o píxeles de 60 × 60 (lo que sea menor),
centrado en el píxel de salida más estable. Se usa una ponderación triangular para asignar
más peso a los píxeles del centro. El filtro requiere de una cobertura de porcentaje
seleccionable para producir un valor promedio en el píxel central, por lo que se asigna un
valor "límite" al píxel central. Por lo general, el límite está configurado para una cobertura del
20 %. Esto provoca que los objetivos de puntos aislados, como los pájaros o los aviones, se
excluyan del campo de fondo para que el filtro de contraste no los filtre.

A continuación, se muestra un ejemplo de un contraste estabilizado para el mismo caso en
los ejemplos de Algoritmo compuesto (página 137).
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Figura 51 Campo de fondo para una permanencia de 2 horas donde se muestra el dBZ

El campo de fondo estabilizado por lo general tiene una intensidad de eco más baja como
resultado del proceso de estabilización. Tenga en cuenta que no hay "puntos"; es decir, solo
quedan las funciones de eco de gran escala. Por lo tanto, el campo de fondo es una
representación de los ecos de fondo promedio. Cuando esto se resta de los productos de
entrada y se aplica un límite (cuando se aplica el filtro de contraste), se quitan los ecos de
fondo, lo que deja solo los centros de alta intensidad o los objetivos de punto, como los
pájaros o los aviones.

Salida de diagnóstico para la verificación del algoritmo

Para contribuir con el ajuste del algoritmo DWELL, especialmente en el caso de una
advertencia de objetivos, el algoritmo DWELL puede producir una salida de diagnóstico.
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Para activar esta salida, seleccione Diagnostic que se encuentra en la parte inferior del
DWELL Configuration Menu. Tenga en cuenta que se produce una salida de diagnóstico
aunque más adelante desactive la advertencia de objetivo, mientras el botón de diagnóstico
esté activado.

Las salidas de diagnóstico se almacenan como productos del tipo USER. La convención de
nomenclatura es la siguiente:

• USER: < productname >DAT or TIM
La salida principal del producto DWELL es un producto del mismo tipo que el producto
de entrada (por ejemplo, un PPI) para el tipo de datos del producto de entrada (por
ejemplo, dBZ) o el tiempo (edad).
El producto de diagnóstico de USER es para el tipo de datos que no se seleccionó para
la salida principal.
Por ejemplo, si se selecciona dBZ para la salida principal, el producto de diagnóstico de
USER es para el tiempo (sufijo TIM). Si se selecciona el tiempo para la salida principal,
el producto de USER de diagnóstico es para el tipo de datos de entrada (sufijo DAT).

• USER: < productname >CON
Si el filtro de contraste está activado, el producto de USER de diagnóstico con el sufijo
CON muestra el campo de fondo. Para ver un ejemplo, consulte Ejemplos del algoritmo
de DWELL (página 147).

• USER: < productname >PIL
Si la advertencia de objetivo está activada, el producto USER de diagnóstico con el
sufijo PIL muestra el producto de "pila"; es decir, la cantidad de aciertos de objetivos
por píxel (X4) del primero en la secuencia de los supuestos vectores de movimiento (es
decir, la primera prueba).
Para tareas de diagnóstico, se puede configurar la advertencia objetivo para ejecutar un
solo vector de movimiento de modo que se pueda aislar cualquier velocidad y dirección
para el estudio.
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5.3.3 Configuración de productos DWELL con Target Detection
deshabilitada

Az: Full Circle El: 3 angles from 0.5 to 4.0

PPI Full

70.0

2Z T V W ZDR Kdp PDP RHV SQI Zv Tv SNR Ze Te

Figura 52 Configuración de ejemplo de DWELL con Target Detection deshabilitada

1. Seleccione Type > DWELL.

2. Para nombrar el producto DWELL, seleccione File > Save As.

Vaisala recomienda que el nombre del producto DWELL sea el mismo que el producto
de entrada con una D anexada al nombre con o sin la cantidad de minutos. Por ejemplo:
• Nombre del producto de entrada: Z_005_250
• Nombre del producto DWELL: Z_005_250_D
• Nombre del producto DWELL: Z_005_250D10

Esto indica un DWELL de 10 minutos.
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3. Input Product Type y Name para definir el producto de entrada; es decir, el producto
que usted quiere que habiten juntos.

Puede seleccionar cualquiera de los siguientes tipos de producto:
• BASE
• CAPPI
• HMAX
• PPI
• RAIN1
• SRI
• TOPS
• VIL
• WARN

Cuando combina productos WARN, se combinan las características del centroide de
todos los productos de entrada. Por lo tanto, la mayoría de las funciones del menú en el
producto DWELL están deshabilitadas, excepto la selección de tiempo de DWELL.

4. Defina el Time de DWELL.

Es el período de tiempo en minutos durante el cual los productos habitan juntos.
Por ejemplo, con un producto PPI nuevo que se crea o se recibe, este y todos los
productos PPI dentro de los últimos 10 minutos se incluyen en el producto DWELL PPI.

5. Para los productos DWELL que usan PPI como un producto de entrada, seleccione el
Data Type.

Si selecciona Dwell Output para que sea Data (por ejemplo, en la esquina inferior
izquierda), la versión DWELL del PPI se realiza para este tipo de datos.
En el ejemplo, se generó un DWELL PPI de dBZ.

6. Para usar el filtro de intensidad, seleccione Input Product Filters > Intensity.

El filtro de intensidad le permite eliminar cualquier punto de datos que sea menor que
el Min o mayor que el Max.
Una aplicación útil es establecer un umbral Min para eliminar ecos débiles de modo tal
que el resultado del algoritmo de DWELL muestre solamente los núcleos de
precipitación más fuertes.

Revise un ejemplo de datos de entrada para determinar de qué manera establecer
mejor los umbrales.

a. Habilite el filtro al seleccionar el botón.

b. Escriba el valor.

Las unidades son para el Data Type del producto de entrada.
En el menú del ejemplo, es dBZ.
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7. Para usar el filtro de contraste, seleccione Input Product Filter > Contrastor.

Para la detección de objetivos, es necesario el filtro de contraste para escoger un
objetivo aéreo de los ecos débiles de aire puro o del clima.

El filtro de contraste proporciona una manera de eliminar los ecos relativamente débiles
para que solo permanezcan los núcleos de eco integrados más fuertes.
Primero calcula una versión suave del DWELL (el eco de fondo) y luego lo resta de los
datos de entrada originales para obtener la versión "contrastada" final del DWELL.
El algoritmo de DWELL se ejecuta dos veces: la primera vez para calcular el campo de
fondo y la segunda vez durante la cual el campo de fondo se usa para establecer el
umbral de los datos de entrada originales. Para obtener más información sobre el
algoritmo de contraste, consulte Configuración de COMP (página 139).
Los parámetros para configurar el filtro de contraste son los siguientes:
• Thresh

Cada píxel de datos del producto de entrada debe ser mayor que el píxel
correspondiente en el campo de fondo promedio por esta cantidad; de lo contrario,
se descarta.

• % Coverage
El campo de fondo se produce por píxeles de datos más suaves que el promedio en
una caja de 10 km por 10 km (6,2 millas por 6,2 millas) que pasa sobre todos los
píxeles en el producto DWELL de primera pasada. Si el porcentaje de píxeles válidos
(no umbrales) en esta caja no supera el límite de % Coverage, el valor del "umbral"
se asigna a esta caja; es decir, no hay suficientes puntos para calcular el promedio.

8. Si su producto de entrada consta de productos PPI en diferentes ángulos de elevación,
puede seleccionar Sep PPI's.

Por ejemplo, un PPI realizado con * en el ángulo de elevación archivado tiene cada
ángulo en la exploración del volumen. En este caso, el campo de fondo puede estar en
una de las siguientes maneras:
• Método predeterminado

Todos los ángulos están fusionados para calcular el campo de fondo.
• Sep PPI's habilitado

El campo de fondo se calcula por separado para cada ángulo de elevación del PPI y
la umbralización de contraste se lleva a cabo para cada ángulo antes de fusionar los
resultados.
Esto brinda mejores resultados cuando hay gradientes verticales en velocidad o
reflectividad. Si los gradientes verticales son débiles, en realidad no importa qué
enfoque se utilice.
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9. En Dwell Output, seleccione una de las siguientes opciones:

• Data
El algoritmo de DWELL produce un producto de tiempo compuesto en las mismas
unidades que los productos de entrada.
En el ejemplo, se produciría un PPI de dBZ.

• Time
El algoritmo de DWELL produce un producto que muestra la edad de cada punto
relativo al producto de entrada más reciente.
Esta visualización facilita ubicar los objetivos móviles ya que dejan un trazo de
colores que va desde lo más antiguo a lo más reciente.

Para obtener ejemplos, consulte Algoritmo compuesto (página 137).

Más información

‣ Configuración de productos DWELL con Target Detection habilitada (página 163)

5.3.4 Algoritmo de detección del objetivo de DWELL
El algoritmo de detección del objetivo utiliza una serie de vectores de movimiento, lo cual
agranda el rango posible de la velocidad y la dirección del objetivo, con el fin de cambiar un
producto DWELL de tiempo.

Objetivos cuyo movimiento coincide con la "pila" del vector de movimiento supuesto. La
profundidad de la pila brinda una medición del "movimiento coherente" del objetivo.
Esencialmente, este es un enfoque de autocorrelación. Los pasos son los siguientes:

1. Un producto DWELL de tiempo se lleva a cabo de la manera usual.
Tenga en cuenta que si la advertencia del objetivo está activada, aunque se solicitara un
producto DWELL de datos, se crearía el DWELL de tiempo para la advertencia.

2. Los puntos DWELL de tiempo se vuelven a cambiar en el espacio horizontal de acuerdo
con un vector de velocidad de prueba.
Los objetivos que se mueven a una velocidad constante se "apilan" unos sobre otros. Lo
que se genera producto de este paso es un producto de "pila" intermedio que tiene la
cantidad de puntos de datos que se acumulan (apilan) en cada píxel.

3. Se ejecuta un algoritmo de advertencia/centroide con un límite seleccionable para la
cantidad de puntos de "pila".
El enfoque es el mismo que en WARN : Producto de Advertencia/Centroide
(página 105).
Tenga en cuenta que las unidades de producto de pila son 4 veces mayores que la
cantidad de puntos reales. Por ejemplo, para una pila de 3 puntos, la representación
sería de 12 en el producto de pila de diagnóstico (PIL).

4. Se repiten los 2 pasos anteriores en cada prueba.
5. Una vez realizadas todas las pruebas, se combinan los productos de centroide para

cada prueba con el fin de eliminar los "dobles aciertos" producidos en el mismo grupo.
Es decir, puede haber varios vientos de prueba que producen centroides de intensidad
suficiente (número de pila).
En la combinación se incluyen todos los centroides que se encuentran dentro de los
3 km entre sí al seleccionar aquel con el número de pila mayor.

6. Se revisa el producto de advertencia combinado para las áreas protegidas con las que
se entró en contacto.
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7. Se le asigna al producto WARN de salida final el mismo nombre asignado al producto
DWELL.

t–2

t–1

t0

Input Product Sequence

Dwell Product at Time t0

Shift by trial motion vector

Pile product

3 hits

Warning centroids based on the pile

Next Trial

Motion

Vector

+B

+B

+B

+B

+B

+B

Final Target Warning

+B
+B

Trial 1 WARN

Trial 2 WARN

Trial 3 WARN

Trial 4 WARN
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Figura 53 Esquema del algoritmo de advertencia del objetivo
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Formato de datos para la detección de objetivos

El algoritmo de detección de objetivos genera un producto WARN de IRIS.

Una parte de esa estructura de warning_results son 3 valores de datos. Para los
productos WARN normales, estos contienen los valores de datos promedio y máximo dentro
del centroid detectado. Cuando se generan con el algoritmo de detección de objetivos,
contienen lo siguiente:

• La altura promedio y máxima de los retornos de objetivos (km).
• La altura de la pila promedio y máxima.
• El ángulo de elevación promedio y máximo de los retornos del objetivo en grados.

5.3.5 Detección de objetivos: Tarea de entrada y optimización
del producto

Las funciones de detección de objetivos aéreos, seguimiento y advertencia del algoritmo
DWELL están diseñadas para detectar aviones o bandadas de pájaros migratorios y emitir
advertencias automáticas.

Los aviones y las bandadas de pájaros migratorios suelen trasladarse a una velocidad y
dirección bastante constantes, por lo que esta propiedad se usa para distinguir entre los
objetivos aéreos y el resto de los objetivos. En muchos casos, se pueden distinguir los
objetivos integrados en los objetivos meteorológicos débiles o los ecos de aire limpio.

Como sucede con el algoritmo de detección automática, hay una compensación directa
entre la probabilidad de detección y la tasa de falsas alarmas. Para obtener un mejor
rendimiento, debe optimizar la tarea de exploración y la generación de productos de
entrada.

Optimización de la tarea de exploración

La detección de objetivos requiere que se eliminen los objetivos externos como el eco, el
eco de segundo viaje y el ruido. La tasa de actualización debería ser lo suficientemente
rápida como para resolver el movimiento del objetivo y proporcionar información más
constante sobre las ubicaciones de los objetivos. Con el fin de desarrollar la tarea de
exploración del volumen, se necesita algo de información sobre las altitudes de vuelo.

Tabla 15 Optimización de la tarea de exploración para la detección de objetivos de DWELL

Parámetro Descripción

Rango máximo 60 ... 100 km (de 37,3 a 62,1 mi).

El rango de detección máximo depende de las características de rendi-
miento del radar.

Por lo general, se puede prever un rango de detección de alrededor de
60 km (37,3 mi) para una antena con un ancho de rayo de 1 a 1,5°.

Resolución máxima permitida por el
procesador de señales

Por ejemplo, 125 metros (410 pies 1 in).

Esto depende de las características de rendimiento del procesador.

PRF máxima y ancho de pulso míni-
mo

--
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Parámetro Descripción

Cancelación del eco de segundo
viaje

En sistemas de magnetrón, se pueden usar los límites de SQI de dBZ en
vez de esto.

Esto permite descartar objetivos no coherentes como los ecos de se-
gundo viaje.

Filtrado de eco del suelo con alar-
mas de límite de CSR (valor más ba-
jo) agresivas.

El valor depende de las características de rendimiento de la estabilidad
de la fase del radar, pero generalmente está en el rango de 10 a 20 dB.

El objetivo es eliminar los objetivos de eco fuertes que podrían producir
falsas alarmas.

SQI Ajustado en un nivel más alto que lo normal. Por ejemplo, en aproxima-
damente 0,45.

Esto se hace para eliminar puntos de velocidad que podrían producir
falsas alarmas.

LOG Ajustado en un nivel más alto que lo normal respecto del clima.

Esto se hace para eliminar la intensidad de los puntos que podrían pro-
ducir falsas alarmas.

Removedor de puntos Está desactivado para que puedan pasar los objetivos del bin único. Es-
tos podrían contener un objetivo aéreo de punto.

Ángulos de elevación Algunos ángulos de elevación que cubren solo las alturas de interés a un
rango de aproximadamente 60 km (37,3 mi). Esto permite que las ac-
tualizaciones sean más rápidas.

Por ejemplo, para un rayo de antena de 1°, los 5 ángulos de elevación de
0,5; 1,5; 2,5; 3,5; 4,5 proporcionarían una cobertura vertical continua de
hasta 2 km (1,2 mi), de 25 a 60 km (de 15,5 a 37,3 mi). A 10 km (6,2 mi) la
cobertura sería sobre el radar.

Tasa de exploración Tasa de exploración moderadamente rápida (>3 RPM) coherente con las
actualizaciones rápidas, pero aún permite aproximadamente 50 pulsos
por ancho de rayo de antena.

Por ejemplo, una PRF de 1000 Hz y una tasa de exploración de 3 RPM
(18 grados por segundo) proporcionarían 1000/18=55 pulsos para cada
grado de movimiento de la antena.

Selección del producto de entrada

Tabla 16 Tipos de productos de entrada sugeridos para la advertencia de objetivos

Tipo de producto Descripción

PPI

dBZ o velocidad radial en un
solo barrido o en varios.

Se recomienda una velocidad radial para diferenciar entre los objetivos aé-
reos y los ecos de aire limpio de fondo o los meteorológicos débiles.

Los objetivos aéreos, como los aviones o los pájaros, se mueven a una veloci-
dad diferente que la del aire, por lo que, si los objetivos son más fuertes, pro-
ducen una anomalía en la velocidad que el algoritmo de contraste puede pa-
sar.

Si el movimiento del objetivo es perpendicular al rayo del radar, el filtrado de
eco puede eliminar los objetivos, por lo que existe la posibilidad de que haya
sectores "ciegos" debido a ello.
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Tipo de producto Descripción

VIL

Cobertura de la capa de inte-
rés.

El VIL es un producto útil para las advertencias de objetivos, ya que integra
el eco a una capa seleccionada.

Se pueden usar los productos del PPI únicos, pero debido a que se encuen-
tran solo a un ángulo de elevación, no se cubren todas las alturas. Sin embar-
go, se puede usar un producto del PPI creado con el comodín * en la selec-
ción de elevación para combinar todos los productos del PPI en un volumen
independientemente del ángulo de elevación.

En este caso, se ejecuta el algoritmo DWELL al finalizar cada barrido y, debi-
do a que este es intenso, es posible que el sistema no tenga la potencia del
CPU suficiente como para llevar a cabo todos los productos DWELL además
de las otras funciones (por ejemplo, pantalla del usuario, animaciones, gene-
ración de otros productos, comunicación). La generación del producto
DWELL entonces estaría detrás del tiempo real.

Por lo tanto, si se usan todos los productos del PPI, se recomienda que en la
entrada del programa del producto DWELL se use el Skip Time en el
Product Scheduler, configurado en el tiempo entre las exploraciones de vo-
lumen. Por lo tanto, se produce un nuevo producto DWELL cuando termina
la exploración del volumen, en vez de cuando termina cada PPI individual.

Optimización del producto de entrada

Tabla 17 Optimización de los productos de entrada para la detección de objetivos de DWELL

Parámetro Descripción

Rango máximo y re-
solución de píxeles

Está configurado de manera tal que se conserve la resolución de los datos de entrada
originales.

Por ejemplo, para un espacio del bin de 125 m (410 pies 1 in) a 45 km (28,0 mi), se
debe configurar el tamaño del píxel del producto en 720 × 720 (que corresponde a un
diámetro de 90 km (55,9 mi) y 0,125 m (5 in) por píxel).

Producto más estabi-
lizado

Debe estar configurado en 0. Esto es así para que no se eliminen los objetivos de un
solo bin aislados.
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5.3.6 Configuración de productos DWELL con Target Detection
habilitada

Figura 54 Ejemplo de configuración de la detección de objetivos

Para obtener información sobre las opciones de producto WARN, consulte WARN :
Producto de Advertencia/Centroide (página 105).

1. En el DWELL Configuration Menu, seleccione Target Warning.

Aparecerá una nueva sección del menú en la parte inferior del menú principal (ver
arriba).

Capítulo 5 – Configuración y programación de productos IRIS opcionales

RESTRINGIDO 163



2. Configure las opciones de configuración de DWELL para la detección de objetivos.

Warning Symbol
Ingrese el nombre de un ícono para visualizar. Si no existe un ícono con ese
nombre, el texto que ingrese se deberá mostrar en cada ubicación de centroide.
El ícono automáticamente rota al punto en la dirección del movimiento del
objetivo.
En el ejemplo anterior, Plane es un ícono de un aeroplano que está volando hacia
el Norte. También hay íconos de pájaros.

Correlation Threshold
Se trata del umbral para la cantidad de puntos en el producto "pila" X4. Por
ejemplo, el número 8 representa 2 puntos. Tenga en cuenta que suavizar el
producto pila por lo general reduce la cantidad de puntos del valor máximo.
Entonces, un valor de producto pila de 2 correspondería a una cantidad mayor en
un máximo muy agudo.

El umbral de correlación es el parámetro afinable primario para optimizar la
probabilidad de detección y la tasa de falsa alarma.

El valor adecuado del umbral de correlación depende de la longitud de la
secuencia de DWELL. Tiempos de DWELL más largos (más productos de
entrada) producen "pilas" más grandes.

Add Wind, Use VVP, Speed y Heading Range
El trazo de los objetivos se utiliza durante el proceso de "pila" para agregar
objetivos que se mueven a la velocidad esperada. La velocidad de los objetivos es
el resultado del vuelo de estos (velocidad del aire) y del viento. Estos campos se
usan para compensar estos efectos.
Add Wind especifica si quiere que el efecto del viento se agregue al vector de
velocidad de vuelo del objetivo. Si está habilitado, el Speed Range es el rango de
velocidad esperado de los objetivos en aire en calma; es decir, su velocidad de
vuelo.
Si selecciona Add Wind, seleccione Use VVP para controlar el lugar donde el
algoritmo recibe el viento. El producto UNFOLD VVP se usa para la información
de viento medio.
De lo contrario, la sección del producto Setup tiene una velocidad de viento y
una dirección predeterminadas. En regiones de vientos alisios marítimos
tropicales, se puede establecer de manera bastante confiable en un valor único
de velocidad y dirección. Para la mayoría de las regiones, el viento
predeterminado no siempre es un valor muy bueno. Puede cambiar el valor en
tiempo real utilizando la herramienta setup_change.
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Si elige no utilizar la función Add Wind, el rango de velocidades debe incluir
la variación esperada en la velocidad del viento además de la velocidad del
objetivo. A mayor rango de velocidades, mayor cantidad de falsas alarmas
que se generan y mayor necesidad de vientos de prueba (rendimiento del
algoritmo más lento).

Target Size
Si está habilitado, el producto "pila" de DWELL está calificado para eliminar todas
las pilas grandes a fin de reducir los falsos positivos.
Si hay una línea de turbonada moviéndose en la misma dirección que los
objetivos aéreos esperados, suelen generarse advertencias de objetivo. Estas
advertencias por lo general tienen un área más grande que los objetivos reales,
por lo que se las puede descartar mediante filtros.
Escriba el número en kilómetros cuadrados.

Diagnostic Output
Si está habilitado, DWELL produce tres productos de diagnóstico. Se los
almacena como productos USER con el mismo nombre de producto asignado al
producto DWELL y un sufijo que indica el tipo de diagnóstico (DAT o TIM, CON y
PIL).
Consulte Aplicación del algoritmo DWELL a la programación del producto
(página 150).

Más información

‣ Configuración de productos DWELL con Target Detection deshabilitada (página 155)

5.3.7 Detección de objetivos: Ejemplos de pájaros migratorios
Los siguientes ejemplos se usan para realizar un seguimiento de los pájaros durante la
migración de otoño. Los objetivos son principalmente las bandadas de 30 cigüeñas grandes
o más que se desplazan del noreste al sudoeste (rango de dirección de 200 a 250) a
alrededor de 12 m/s (39 pies 4 in/s) (rango de velocidad de 8 a 16 m/s [de 26 pies 3 in a
52 pies 6 in/s]).

Estas figuras muestran los productos y las pantallas producidas por el algoritmo de
objetivos.
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PPI de entrada de la velocidad radial

Los datos de entrada se basaron en una exploración del volumen de cuatro ángulos de
elevación a un ángulo de elevación de 0,5; 1,0; 2,0 y 3,0°. La resolución de entrada es de
125 m (410 pies 1 in).

Se usan los productos del PPI de velocidad radial en un rango de 45 km (28,0 mi) para todos
los ángulos; es decir, se genera un producto llamado V_XXX_045 con el comodín * en la
selección de la elevación. Se usa una resolución de píxeles del producto de 720 x 720 para
que coincida con la resolución de datos de entrada de 125 m (410 pies 1 in).

En la siguiente figura, se muestra un ejemplo de un PPI con una elevación de 3°. Solo hay un
eco de aire limpio y, por lo general, los vientos son suaves. A 15 km (9,3 mi) al sur del radar,
hay una anomalía de velocidad que luego se puede identificar como una bandada de
pájaros. También hay otros objetivos aéreos, pero debido a que solo pueden ser de 1 o
2 píxeles, es difícil separarlos del ruido de fondo y del eco de aire limpio.
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Campo de fondo

El contraste presentado es una versión más estable de los datos de DWELL que se usa como
límite dinámico para el filtro de contraste. Para este ejemplo, se usó un criterio de cobertura
mínimo del 25 %. La DWELL es de 10 minutos. Tenga en cuenta que el filtrado de eco
agresivo eliminó casi todo el eco de aire limpio a una velocidad de 0.

Tenga en cuenta que solo se incluyeron los ecos a gran escala en el campo de fondo. Esto es
importante, ya que de otro modo se eliminarían los objetivos aéreos durante el paso de
contraste cuando se reste esta velocidad de fondo.
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Producto Dwell de datos

El producto DWELL de datos (datos seleccionados como salida principal) es un producto
del PPI que combina todos los productos del PPI de todos los ángulos de elevación de los
10 minutos anteriores (22 PPI en este caso). Solo se incluyen los valores positivos, ya que la
salida es el valor absoluto de la anomalía de velocidad en comparación con el campo de
fondo. Se usó un límite de contraste de 1 m/s (3 pies 3 in/s); es decir, solo se incluyen los
puntos de datos que difieren del campo de fondo en más de 1 m/s (3 pies 3 in/s) en el
producto DWELL PPI.

Esto muestra los rastros de la anomalía de velocidad que por lo general se debe a objetivos
de pájaros. Tenga en cuenta que todos los puntos en todos los productos del PPI
desafortunadamente se pasan a través del algoritmo DWELL. También tenga en cuenta que
el filtro de contraste eliminó eficazmente la mayor parte del eco de aire limpio.
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Producto Dwell de tiempo

El producto DWELL de tiempo muestra la edad de los puntos en minutos. Los puntos más
recientes están representados en azul y los puntos más viejos en rojo. Esto muestra con
claridad el trayecto del movimiento de noreste a sudeste. Esto incluso se hace más aparente
en la animación, ya que se ven estos rastros moviéndose por la pantalla hacia el sudoeste.

El ruido aleatorio muestra un patrón punteado caótico en el tiempo. Hay un rastro de eco de
interferencia que muestra únicamente un solo color (hacia el sudoeste a 30 km [18,6 mi]).
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Producto de pila (ejemplo con un acercamiento de 2X)

Esto muestra el resultado del paso de correlación en el cual se "apilan" los puntos DWELL de
tiempo. Debido a que cada viento de prueba produce un producto de pila diferente, la salida
de diagnóstico solo muestra el producto de pila del primer viento de prueba. En este caso,
se seleccionó el resultado para un viento de prueba en particular de 210° y 12 m/s (39 pies
4 in) al ingresar solo estos valores en los límites de los rangos de velocidad y dirección.

Los resultados demuestran que este viento de prueba "apila" de manera eficaz los rastros
coherentes del eco como se observa en la pantalla de tiempo de DWELL, mientras que el
ruido de fondo produce valores débiles únicamente. No todos los rastros producen un valor
alto, ya que los objetivos pueden estar moviéndose a velocidades diferentes. Es por esto
que es importante usar un espectro de vientos de prueba.
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Producto WARN

El resultado final es un producto de advertencia que se basa en un compuesto de todas las
advertencias para todos los vientos de prueba. En este ejemplo se usó un valor de 8 para el
límite de correlación (valor del producto de la pila). Aquí, se dibuja el ícono para indicar con
claridad el tipo de advertencia.

Como alternativa, se puede configurar la pantalla de advertencia a través del botón de
opciones de salida para mostrar el valor numérico de la altura en Kfeet de la bandada de
pájaros junto al ícono, o bien para mostrar la velocidad en nudos de la bandada. La
información de la altura solo se encuentra disponible para la detección de seguimiento
sobre la base de los productos del PPI de entrada, ya que no hay información sobre la altura
disponible de los otros productos de entrada que se pueda usar para DWELL (por ejemplo,
VIL y TOPS).

Cuando esto se anima, los pájaros parecen volar por la pantalla a la velocidad adecuada.
Algunos íconos pueden aparecer o desaparecer si son bandadas pequeñas en el borde de
detección. Las falsas alarmas ocasionales aparecen como destellos aislados durante la
animación. El parámetro de ajuste principal para equilibrar la probabilidad de detección y la
tasa de falsa alarma es el límite de correlación (altura de la pila).
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Producto Dwell de ADVERTENCIA

El ejemplo muestra los resultados del algoritmo DWELL que se ejecutan en los productos
WARN generados por la función de advertencia de pájaros. Se recomienda que los
controladores de tráfico aéreo usen esta pantalla, ya que deben avisar a los pilotos de una
posible actividad de pájaros. En el ejemplo anterior, las advertencias de pájaros individuales
permanecen durante 45 minutos. En la pantalla aparece el ícono seleccionado (en este caso
un pájaro grande) en la posición de la advertencia más reciente en la secuencia de
permanencia. Se muestran advertencias previas mediante el uso de un ícono diferente que
también gira en la dirección del movimiento. Se genera el nombre del ícono de advertencia
previa al agregar "d" (de "dwelled") al ícono principal. En este caso, obtenemos
birdd.xbm.
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El resultado es una pantalla de estilo de seguimiento donde figura la actividad de los pájaros
durante el tiempo de permanencia. Los seguimientos inactivos no poseen el ícono de pájaro
grande al final. Los seguimientos se pueden desactivar si los pájaros vuelan a una región
oscura o si la bandada es pequeña cerca del límite de detección o si los pájaros se detienen
para posarse en sus nidos o quizás para "atravesar" una zona térmica local para ganar
altitud. Sin embargo, incluso los seguimientos inactivos les permiten a los controladores
saber que hay una actividad de pájaros confirmada en el área cerca de la última revisión.

5.4 GAGE: Informes del pluviómetro
El producto GAGE almacena informes de los sensores del pluviómetro para mostrar y usar
en la generación de productos. Estos productos se generan utilizando un canal de entrada
de los datos enviados por un sistema de estación meteorológica.

Debido a que los productos GAGE no son generados a partir de los datos del radar, no es
necesario configurarlos ni programarlos.

Cada archivo de producto GAGE contiene informes de todos los pluviómetros, ubicaciones y
cantidades de precipitación por hora para un intervalo de tiempo. Por lo general, el intervalo
de tiempo es una hora, pero puede ser de 15 minutos, por ejemplo.

La pantalla muestra un GAGEicono con código de color (definido por el usuario) de
precipitación. Al hacer clic en el icono GAGE, se proporciona un historial de tiempo de
cantidades GAGE para un número seleccionable de horas.

Más información

‣ Descripción general de la corrección del pluviómetro Hydromet (página 360)
‣ Parámetros del producto (página 28)
‣ Programación de RAIN1 con producto GAGE (página 371)
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5.4.1 Mostrar GAGE

Figura 55 Pantalla del producto del pluviómetro

Puede visualizar los productos de GAGE en la Quick Look Window, así como también en
otras salidas de pantalla.

Los productos GAGE se muestran en forma de pantalla de situación con un gráfico de
pluviómetro en el lugar de cada medidor.

A cada medidor se le asigna el color de la acumulación de pluviosidad medida por este
medidor. Consulte la figura anterior para ver un ejemplo de esta pantalla con los datos del
radar debajo.

La opción de salida específica del producto para los productos del medidor le permite
especificar si se muestra la etiqueta del medidor junto a cada uno.

1. En la Quick Look Window, muestre un producto de GAGE.
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2. Coloque el cursor en la ventana de la pantalla y haga clic con el botón secundario del
mouse.

IRIS revisa la ubicación del pluviómetro más cercano y muestra un datagrama de este
con un historial de 12 horas.
El siguiente ejemplo muestra la acumulación de pluviosidad por hora de las últimas
12 horas.

Figura 56 Datagrama del pluviómetro

Puede configurar el gráfico para que solo aparezcan las acumulaciones de lluvia del
pluviómetro o las acumulaciones de lluvia del radar de los productos RAIN1 o ambas.

3. Si optó por las acumulaciones de lluvia del radar, seleccione desde qué producto RAIN1
mostrarlas.

El producto RAIN1 seleccionado se convierte en el producto RAIN1 predeterminado
que se usa como el principal producto superpuesto. Si no hay un producto RAIN1
superpuesto, entonces se desactiva la opción predeterminada.
Si cambia el producto RAIN1 predeterminado, los futuros datagramas utilizan el nuevo
producto hasta que todos queden descartados.
Puede mostrar hasta 10 datagramas del pluviómetro simultáneamente. Esto le permite
comparar diferentes medidores o productos RAIN1.

5.5 NDOP : Doppler múltiple
NDOP proporciona un mecanismo para incluir datos de velocidad (Doppler) de otro sitio del
radar, lo que ahora permite la medición del viento horizontal además del viento vertical.

Un radar Doppler único mide solamente un componente del vector de viento en 3D; es decir,
el componente de viento hacia el radar o alejándose de este: el viento radial. Podemos
pensar en un vector de viento en 3D como una combinación del viento horizontal en 2D y el
viento vertical. Por lo general, el viento horizontal es más fuerte que el viento vertical,
excepto en áreas locales de convección fuerte.
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Con un segundo radar Doppler, podemos medir 2 componentes del viento, siempre que los
haces del radar crucen al mismo ángulo (no en paralelo). Si el componente vertical del
viento se supone pequeño, con 2 radares podemos medir el viento horizontal.

En la siguiente figura se muestra una vista plana (hacia abajo) de la geometría del Doppler
doble. Cada radar toma una muestra del viento horizontal que mide el componente radial
del viento, Vr1 y Vr2. Estas dos mediciones de velocidad radial en el mismo punto, junto
con algo de trigonometría simple, se pueden usar para estimar el viento horizontal en el
punto, siempre que el ángulo de cruce no sea 0° ni 180° (haces paralelos).

Dual Doppler Geometry Plan View

Horizontal Wind Vector
Crossing

Angle

Baseline

Radar 2 Radar 1

Vr1

Vr2

Figura 57 Vista plana de la geometría de Doppler doble

Esto significa que junto con la línea de base (ángulo de cruce de 0°) o en rangos lejanos
(ángulo de cruce de 180°) no podemos usar el algoritmo porque los dos radares
esencialmente miden el mismo viento radial.

Si bien en teoría el ángulo de cruce puede estar en cualquier lugar entre 0° y 180°, nuestras
mediciones de velocidad radial no son perfectas por lo que, en la práctica, el ángulo de
cruce de <20° genera estimaciones de viento no confiables.

El producto NDOP ejecuta el algoritmo de Doppler doble para obtener estimaciones del
campo de viento horizontal. NDOP hace las siguientes suposiciones:

• El viento vertical se supone débil en comparación con el viento horizontal.
• Las mediciones de velocidad radial de entrada representan la velocidad radial del aire;

es decir, la velocidad se despliega y se corrige para la velocidad de caída de las
partículas.

La salida del producto NDOP es una rejilla de multinivel de los vectores de viento horizontal.
Pueden mostrarse por separado o pueden superponerse sobre otros ecos.

Más información

‣ Opciones de salida NDOP (página 263)
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5.5.1 Correcciones de la velocidad de entrada

Velocidad radial corregida Vc
La velocidad corregida de IRIS (Vc) puede incluir correcciones de la velocidad de caída y del
solapamiento de velocidades. La corrección de la velocidad de caída se basa en las
relaciones de VT–Z sobre y debajo del nivel de derretimiento. La corrección de
solapamiento se basa en un producto VVP.

Vc se puede generar de cualquiera de las siguientes formas:
• Cuando se recolectan los datos del procesador de señales.

Esto se configura en el TASK Configuration Menu.
Esta opción se recomienda para la operación en tiempo real.

• Cuando el RAW restablecido de la cinta o recibido a través de la red se vuelve a
ingresar (para generar archivos de introducción).

• Esto se configura en la herramienta Setup.
Tenga en cuenta que si Vc ya se encuentra en los datos durante el reingreso, se vuelve
a calcular a partir de V. Cuando se genera Vc, se conserva la velocidad radial no
corregida V.
Esta opción se recomienda para el archivado de los datos o para los sistemas donde el
ancho de banda de comunicación es limitado, de modo que la carga extra de la
transmisión de Vc (además de la velocidad radial estándar) es demasiado para la red.

Corrección de la velocidad de caída para Vc
Un supuesto clave es que los movimientos aéreos verticales son débiles en comparación con
los movimientos aéreos horizontales. Esto significa que se supone que el viento horizontal
únicamente provoca los vientos radiales. Sin embargo, si bien los movimientos verticales
pueden ser débiles, las velocidades de caída de los hidrometeoros (de 1 a 10 m/s [de 2 a 20
nudos] para la lluvia) pueden realizar una contribución significativa a la velocidad radial. Por
lo tanto, se deben corregir las velocidades radiales para el efecto de las velocidades de
caída.

El efecto de la velocidad de caída de la partícula depende del seno del ángulo de elevación.
Por ejemplo, en una elevación de 0°, las velocidades de caída no afectan la velocidad radial.
En un ángulo de elevación de 30° (una elevación máxima típica en una exploración de
volumen), se observaría la mitad de la velocidad de caída (seno de 30 = 0,5). Por lo tanto,
una velocidad de caída de 10 m/s (20 nudos) (granizo y lluvia mezclados) contribuiría en
5 m/s (10 nudos) con el viento radial que es significativo.

Se lleva a cabo la corrección de la velocidad de caída en Vc mediante el uso de una relación
VT–Z (velocidad de caída del terminal - reflectividad). Estos toman la forma general de
VT=aZb.

Debido a que las partículas son muy diferentes sobre y debajo del nivel de derretimiento, es
importante usar diferentes relaciones de VT–Z para estos 2 casos. Las relaciones
predeterminadas que se usan en IRIS son las siguientes:

• Sobre el nivel de derretimiento (nieve y granos de hielo) VT = 0.8 Z 0,06
• Debajo del nivel de derretimiento (lluvia) VT = 2.70 Z 0,11

En este caso, Z está expresado en mm6/m3 y VT en m/s.1)
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Su administrador del sistema ingresa estas relaciones en la herramienta de Setup. Además,
se ingresa la altura promedio del nivel de congelamiento para cada mes del año.

Las relaciones de VT–Z y la estimación del nivel de congelamiento no son perfectas, pero
pueden mejorar las estimaciones de la velocidad radial en comparación con el hecho de no
hacer correcciones. Las correcciones obtenidas son de 1 a 5 m/s (de 2 a 10 nudos), según el
ángulo de elevación. Las correcciones afectan en menos medida (corrección de <1 m/s
[<2 nudos]) para los ángulos de elevación menores que 5°.

Entrada de velocidad radial para NDOP - Despliegue de Vc
El producto NDOP supone que las velocidades se desplegaron. Un radar doppler tiene un
límite en la velocidad no ambigua que es el siguiente:

Vu = +– (Wavelength*PRF)/4

Se dice que las velocidades radiales que superan este límite están plegadas. En una pantalla
a color en la que el azul representa la velocidad radial hacia el radar y el rojo representa la
velocidad radial fuera del radar, un pliegue aparece como un cambio de color de azul a rojo
adyacente.

Se puede llevar a cabo el despliegue en el procesador de señal (por ejemplo, mediante el
uso de la técnica de PRF doble) o bien IRIS puede llevarlo a cabo cuando se genera Vc.

El despliegue de Vc se basa en un producto VVP que supone que el campo del viento varía
linealmente con la distancia desde el radar. El producto VVP que usa Vc debe tener el
nombre especial UNFOLD y debe estar disponible en el sistema donde se está llevando a
cabo el despliegue. Mediante esta técnica se logra un despliegue de 3 veces. Por ejemplo,
para un sistema de banda S que funciona a una PRF de 1000 Hz (rango de 150 km
[93,2 mi]), la velocidad inequívoca es de ±25 m/s (±50 nudos). Con el despliegue, la
velocidad inequívoca es de ±75 m/s (±150 nudos), la cual puede gestionar la mayoría de
situaciones meteorológicas.

Como sucede con la corrección de la velocidad de caída, se puede llevar a cabo la corrección
del despliegue de Vc en la introducción cuando se recopilan los datos del procesador de
señales (seleccionado en el TASK Configuration Menu) o en la reintroducción (seleccionada
en la Setup).

La técnica de despliegue de VVP funciona bien si la cobertura de eco es adecuada y el
campo del viento es medianamente lineal en sus variaciones. En la cercanía de las líneas de
cizalladura fuertes o los frentes, posiblemente este no sea el caso.

Si está utilizando el despliegue de velocidad de PRF doble y es adecuado para evitar el
pliegue, se recomienda que no use el despliegue basado en VVP en Vc, ya que puede
perjudicar los datos en algunos casos extremos.

1) Para ver un análisis de las relaciones de VT–Z, consulte, por ejemplo, un texto sobre la meteorología de radares como Battan, Louis,
J., 1973: Radar Observation of the Atmosphere, University of Chicago Press, p 132.
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5.5.2 Configuración de productos NDOP

Figura 58 Configuración de ejemplo de NDOP
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1. En la sección superior de la ventana de configuración de NDOP, especifique las tareas y
los sitios.

a. Para seleccionar un sitio, seleccione el botón Site.

b. Para seleccionar una tarea sobre la base de los archivos de introducción en su
sistema, seleccione el botón TASK.

Si la tarea que desea no se encuentra en la lista, ingrese el nombre de la tarea. Puede
usar las convenciones de los comodines de IRIS como los siguientes:
• PPI*

Use cualquier tarea que comience con PPI.
• PPIVOL_A

Use solo la parte A de la tarea híbrida.
• PPIVOL_BC

Use solo las partes BC de la tarea híbrida.

Si especificó una sola tarea, el campo de rango se completa con el rango máximo de
los datos para esa tarea.
Si utiliza un comodín o una especificación de tarea híbrida, el campo Range queda
en blanco.

c. Seleccione los datos de entrada, V o Vc (velocidad radial o velocidad radial
corregida).

d. Para ingresar el ID del sitio asociado a la salida del producto, seleccione Output Site 
ID.

Cuando los productos NDOP aparecen en inventarios como el Product Output Menu
o la Quick Look Window, están asociados a este sitio.

e. En la TASK (time) Window, especifique la diferencia de tiempo máxima tolerada
para combinar los datos de los dos radares.

Si la diferencia en la hora de inicio de la tarea es mayor que este valor, NDOP no
genera el producto. Esto evita los problemas provocados por advección y los
cambios temporales que podrían causar que se combinen los vientos inadecuados.
Un valor de 2 minutos es típico.

2. En la sección del medio de la ventana de configuración de NDOP, especifique la
proyección del mapa para el producto.

La proyección debería estar en un punto conveniente, quizás entre los radares, y cubrir
un rango no mayor que aproximadamente 4 veces la longitud de la línea de base. Por lo
general, este es el rango útil del producto NDOP.
Si no especifica un Projection Name, los datos se centran en la ubicación del primer
sitio del radar en la lista.
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3. En la sección inferior de la ventana de configuración de NDOP, especifique la resolución
de salida al indicar las características de la cuadrícula.

El producto NDOP produce vectores de viento en una cuadrícula 3D.

a. Especifique el Range Span.

El Range Span es la distancia en km desde el centro de la proyección, al este del
borde de la proyección, análogo al rango del radar.
Se especifica en la proyección denominada. Si no está usando un Projection Name,
ingrese el rango.
Lo típico es un rango máximo de alrededor de 4 veces la longitud de la línea base.

b. Especifique el Range Grid.

La Range Grid es un entero que especifica la cantidad de puntos en el conjunto de
salida que representa el Range Span.

c. Para el Height Span, especifique una altura máxima y una mínima (km).

d. Especifique el Height Grid.

La resolución luego se calcula a partir de:

Height Res = (Max Height - Min Height) / (Height Grid - 1)

La resolución (Res) es un campo de solo visualización que se calcula a partir de:

Range Res = (Range Span) / (Range Grid)

En el ejemplo, el Range Span es de 40 y la cuadrícula es de 16, por lo que la resolución
es de 2,5 km (1,6 mi). La cantidad real de puntos en el conjunto de salida que NDOP
lleva a cabo depende de la relación de aspecto de la proyección, que puede no ser
cuadrada.
Para una proyección cuadrada y una especificación de cuadrícula de 16, el conjunto de
salida sería de 32 × 32.

4. En la sección inferior de la ventana de configuración de NDOP, especifique el Min 
Crossing Angle.

Este es el ángulo de cruce mínimo que se usa. El valor recomendado es 20°. El
algoritmo usa el mismo valor para especificar el ángulo máximo de cruce; es decir, el
max crossing angle = 180 - Min Crossing Angle.

5. Si es necesario, active el Make Diagnostic.

Cuando está activado, el producto NDOP realiza productos CAPPI de velocidad
adicionales con los nombres de producto NDOP_CAPPI_#. Estos son los datos de
entrada que usa NDOP.
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5.5.3 Pantalla y algoritmo de NDOP
El siguiente ejemplo es una pantalla de NDOP real que muestra los vientos de nivel bajo
(1 km) para una proyección de 40 km (24,9 mi) mediante el uso de dos sistemas de radares
de banda S. 2)

La situación meteorológica es un evento de monzones invernales del norte que pasan por
China y colisionan con el este sobre el mar. En el mapa superpuesto se muestran los
contornos de los terrenos montañosos al norte de Hong Kong. Tenga en cuenta que los
vientos de 50 nudos que atraviesan las montañas pasan por el norte de Hong Kong.

Los puntos con "+" en la pantalla muestran las regiones donde se cumple el criterio del
ángulo de cruce. Estas regiones se encuentran en cualquiera de los lados de la línea de base
que conecta los 2 radares. Sin embargo, si no hay objetivos meteorológicos, no se puede
calcular el viento.

2) Cortesía del Observatorio de Hong Kong
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Figura 59 Pantalla de NDOP de ejemplo

El algoritmo realiza los pasos siguientes para computar los vientos del punto de la
cuadrícula:
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1. Cree productos CAPPI 3D de la velocidad radial para los 2 radares en la proyección
común en el espaciado de altura de la cuadrícula.
La resolución horizontal de los productos CAPPI está sujeta a las siguientes
limitaciones:
• La resolución de los píxeles de CAPPI está configurada para que sea el doble del

espaciado de los datos de la velocidad radial de la entrada. Por ejemplo, para los
bins de entrada de 125 m (410 pies i in), la resolución de CAPPI está configurada en
250 m (820 pies 3 in).

• La cantidad de píxeles de CAPPI para cada elemento de la cuadrícula de resolución
de salida debería ser de por lo menos 9 (3 × 3).
Si este no es el caso, aumenta la resolución de CAPPI.
En el mismo ejemplo, si la resolución de salida fuera de 2 km (1,2 mi), entonces por el
espaciado de píxeles de 250 m (820 pies 3 in) en (1) habría píxeles de 8 × 8 = 32
para cada punto de la cuadrícula de salida.

• La cantidad máxima de píxeles en CAPPI es 1100 × 1100. CAPPI está cortado en este
valor.
Para un rango de 40 km (24,9 mi) (80 km [49,7 mi] totales por el conjunto de
salida), habría (4 píxeles/km)*80 (km) = 320 píxeles en CAPPI (320 × 320 para una
proyección cuadrada).

2. Los datos provenientes de los productos CAPPI de velocidad radial se procesan con los
múltiples algoritmos doppler para obtener una cuadrícula de vectores de viento (x, y)
en la resolución original de CAPPI (por ejemplo, 320 × 320).

3. Los vectores de viento de alta densidad se promedian con el fin de reducir los datos a
la cuadrícula de salida final.
Continuando con el ejemplo, con 4 píxeles por km en CAPPI y una resolución de salida
de 2 km (1,2 mi), promediaríamos vectores de viento de 8 × 8 = 32 para cada punto de
la cuadrícula de salida.

4. Para eliminar el ruido y los efectos de los puntos, se limita un punto de la cuadrícula si
hay menos de 3 valores para promediar o menos que el 25 % de cobertura.
En el ejemplo, el 25 % correspondería a 8 estimaciones del viento.

Cuando se computan los promedios del vector, también se calcula el índice de calidad del
viento (WQI) y se almacena con los datos. Esto se usa con fines de limitación cuando se
muestra el producto.

El WQI se computa a partir de las varianzas #sigma#2x y #sigma#2y de los componentes
individuales de cada (x,y) vector de viento computado a partir de los datos de CAPPI. Para
cada par de velocidad de CAPPI que contribuye con el viento final X e Y, también se
computan los 2 términos de varianza, de modo que se puede derivar el WQI de la siguiente
manera:WQI = 1.0 − σx2+ σy22 /Vnorm
donde VnormVnorm es un término de normalización y la desviación estándar que resultaría si
se ingresaran al algoritmo vectores aleatorios distribuidos uniformemente a la mitad de la
velocidad de Nyquist; es decir, en ese caso se produciría un WQI de 0.Vnorm = V1u+ V2u2 /2 2
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donde V1u y V2u son las velocidades de Nyquist de los dos productos de entrada de CAPPI.

El WQI está configurado en 0 si el cálculo anterior arroja un número negativo. El cero
corresponde a un ajuste terrible entre los vientos doppler dobles promediados en cada
cuadrícula de salida, mientras que el 1,0 corresponde a una coherencia perfecta entre
todos los datos.

5.6 SHEAR: Cizalladura del viento

Figura 60 Configuración de ejemplo de SHEAR

SHEAR detecta la cizalladura del viento en la atmósfera, lo que permite la detección de
microrráfagas, frentes de ráfaga, mesociclones, frentes fríos y ondas atmosféricas.

La cizalladura del viento está asociada con muchos fenómenos:
Microrráfagas

Asociadas con tormentas convectivas. Extremadamente peligrosas para las aeronaves
durante el aterrizaje o el despegue. Las microrráfagas se caracterizan por valores
positivos de la cizalladura radial (salida fuertemente divergente) en una región
aproximadamente circular, por lo general de un tamaño menor de 3 km (1,9 millas).
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Frentes de ráfaga
Provocados por una salida fría de una tormenta convectiva (quizás una microrráfaga)
que colisiona con el aire circundante. Se caracterizan principalmente por valores
negativos de la cizalladura radial (convergencia). No obstante, según la geometría,
también pueden crear valores positivos de la cizalladura radial y la cizalladura de
acimut de cualquier signo.

Mesociclones
Caracterizados por la rotación. Los mesociclones están asociados con tornados. La
cizalladura de acimut se usa para detectar mesociclones.

Frentes fríos
Similar a los frentes de ráfaga, pero con una extensión mucho mayor.

Ondas atmosféricas
Producidas a una variedad de longitudes de onda e intensidades. Los valores de
cizalladura pueden ser positivos o negativos, según la naturaleza de la onda y la "fase"
que se observa.

IRIS puede calcular los siguientes tipos de valores de cizalladura básica para el componente
radial del viento:

• Cizalladura radial
Calculada por la diferencia de velocidad radial en rango. Valores positivos para la
velocidad radial que aumenta (se aleja) con el rango. La divergencia del viento radial es
positiva.

• Cizalladura acimutal
Calculada por la diferencia de velocidad radial en acimut. Valores positivos para la
velocidad radial que aumenta (se aleja) en sentido horario. Esto corresponde a una
vorticidad positiva.

• Cizalladura de elevación
Calculada por la diferencia de velocidad radial en elevación. Valores positivos para el
viento radial que aumenta (se aleja) con la altura.

Además de las cizalladuras básicas, las combinaciones se calculan utilizando valores de
RMS. Por ejemplo, la magnitud total de cizalladura combinada es:SQRT RAD2+ AZ2+ EL2
Cuando RAD, AZ y EL denotan los valores de cizalladura básica. Las cizalladuras combinadas
son positivas.
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Figura 61 Ejemplos esquemáticos de cizalladura del viento

Vaisala no ofrece ninguna garantía de que el producto SHEAR pueda detectar todas las
condiciones de cizalladura peligrosas.
Cuando las tormentas convectivas están en una terminal aérea, hay riesgo de
microrráfaga. El producto SHEAR es solo uno de los muchos indicadores de que puede
existir esa condición peligrosa. Se deben usar las precauciones normales para evitar la
cizalladura del viento sospechada, aunque el algoritmo de SHEAR no detecte cizalladura.
Vaisala no será responsable de daños de ningún tipo por fallas del algoritmo de SHEAR
para detectar cizalladuras de viento peligrosas ni por falsas alarmas que pudieran
producirse por el uso del algoritmo SHEAR.

1. Para crear un producto SHEAR nuevo, seleccione Type > SHEAR.

2. Para cargar un producto existente, seleccione File > Open

3. En Data:Display, seleccione V Shear.
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4. En EL Angle, defina el ángulo de elevación de los datos que desea mostrar.

Por lo general, las cizalladuras del viento asociadas con frentes de ráfagas y
microrráfagas son fenómenos de bajo nivel, por lo que para detectarlas, comúnmente,
se usan ángulos de 1° o menos.

5. Defina Rng / Az Filter.

El primer número define la escala de la longitud del rango para el producto SHEAR, en
km. La distancia determina el tamaño del salto que puede tolerar el producto SHEAR
cuando varía sobre los datos faltantes. También especifica la longitud de la
estabilización radial, que se aplica antes de la estabilización XY.
El segundo número es la escala de la longitud de acimut en grados.
El salto y la longitud del rango de acimut son análogos al filtro del rango.

6. En Shear Type, seleccione el tipo de cizalladura que desea calcular:

• Cizalladura radial
La diferencia de bin a bin en la velocidad radial.

• Cizalladura acimutal
La diferencia de acimut a acimut en la velocidad radial.

• Cizalladura de elevación
La diferencia entre la velocidad radial en el ángulo de elevación seleccionado y el
siguiente ángulo de elevación superior. Requiere una exploración del volumen.

• Cizalladuras combinadas
El valor RMS de la cizalladura radial, acimutal o de elevación. A veces, se la conoce
como cizalladura total.

7. En VVP, seleccione el nombre de un producto VVP.

La velocidad y la dirección del viento del producto WIND más cercano VVP con este
nombre se usan para eliminar los efectos del viento medio en el cálculo de la
cizalladura de acimut.
Para que se ejecute, este producto VVP se debe programar. No se recomienda el uso de
la cizalladura de acimut o combinada sin esta corrección.

8. En VVP Age, especifique el número máximo de minutos entre los datos del producto
VVP y los datos de este producto.

Esto evita que se apliquen mal los vientos anteriores de VVP. Si no se encuentra un
producto VVP en esta ventana de tiempo, no se aplica la corrección media del viento
cuando se calcula la cizalladura de acimut.

Más información

‣ RHI: indicador de altura del rango (página 70)
‣ Parámetros de visualización (página 31)
‣ Parámetros del producto (página 28)
‣ Asociación de productos con tareas (página 21)

5.6.1 Algoritmo de SHEAR
El algoritmo SHEAR que se muestra en la siguiente figura es para la cizalladura radial. La
cizalladura de acimut es similar en el espacio de "exploración B" (rango-acimut).
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Figura 62 Esquema del algoritmo de cizalladura radial

Eliminación del bin del eco de punto

Los bins del eco del punto producen valores de cizalladura altos erróneos cuando se
diferencian por las velocidades circundantes válidas. El primer paso en el algoritmo de
cizalladura es eliminar los bins de eco obvios que el filtro de eco del procesador de señales
no canceló. Todos los bins de velocidad que tengan una velocidad dentro del 2 % de
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velocidad 0 (en comparación con el rango completo de velocidad) están etiquetados como
potenciales bins de eco. Se define una escala de longitud de eco como 1/3 del valor de la
longitud del filtro de rango en km. Se rechazan las ejecuciones contiguas de los bins de eco
que son menores o iguales a la escala de longitud del eco.

Por ejemplo, supongamos que se seleccionan los valores de espaciado del bin y de la
longitud del filtro de rango de modo que la escala de longitud de eco corresponda a 3 bins
de rango. Entonces, se rechazarían cualquier bin de eco aislado único y las ejecuciones de 2
o 3 bins de eco. Las ejecuciones de 4 o más bins de eco no se rechazarían porque se
interpretan como clima real.

Independientemente de cuál sea la escala de longitud de eco, siempre se eliminan los bins
de eco aislados (bins únicos).

Diferenciación (ejemplo de diferencia radial)

El siguiente paso es realizar la diferenciación de rango de las velocidades radiales. El
algoritmo de cizalladura del viento radial computa la cizalladura al tomar la diferencia de un
bin a otro en una superficie de PPI.

Si el algoritmo de diferenciación se encuentra con un bin en blanco, omite el rango hacia el
próximo bin válido para calcular la diferencia, siempre que el bin se encuentre dentro de la
longitud del filtro de rango de 0,5*.

Por ejemplo, si el filtro de rango está configurado para que corresponda con 3 bins, el
algoritmo de diferenciación detecta una diferencia en un intervalo de un bin, pero no en uno
de 2 o más bins. Las diferencias de velocidad se colocan lo más cerca posible del centro del
intervalo de diferencia al bin más cercano que es menor o igual a la mitad del intervalo de
diferencia.

Equilibrio de las diferencias

La diferenciación es inherentemente ruidosa. El siguiente paso es equilibrar las diferencias
computadas. Esto no solo permite reducir el ruido, sino que también permite llenar
pequeños espacios de bins faltantes y cancela cualquier bin aislado restante.

El algoritmo de equilibrio utiliza una ventana triangular cuyo ancho total es igual al valor de
la longitud del filtro de rango. La suma de los pesos definidos por el filtro triangular siempre
es 1, a menos que se aplique un límite al bin.

En la figura anterior, la longitud del filtro de rango corresponde a 3 bins. Cada velocidad en
el rango de filtro se multiplica por el peso correspondiente y luego se suma. La media se
obtiene al dividir este valor por el peso total. Los bins limitados no se ponderan. Si el peso
total es menor o igual a 0,5, se rechaza el valor de cizalladura. Esto elimina los bins aislados.
Con este enfoque también se pueden completar los intervalos. Un filtro de rango más
prolongado rechaza una ejecución más prolongada de bins aislados y completa un mayor
intervalo.

Cálculo de cizalladura de acimut

La siguiente figura muestra un espacio de "exploración B" (una superficie de PPI). Las
coordenadas son el rango y el acimut. Se obtiene la cizalladura radial al establecer
diferencias en el rango a lo largo del radial.
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Figura 63 Espacio de exploración B (superficie de PPI)

El algoritmo de cizalladura de acimut es análogo al algoritmo de cizalladura radial, excepto
que:

• La diferenciación se realiza de un rayo a otro en un rango constante.
• Se especifica la longitud del filtro de acimut en grados.
• Los valores de acimut finales se normalizan y corrigen en el rango en cuanto a la

cizalladura de acimut aparente provocada por la media del viento. El valor medio del
viento se obtiene a partir del algoritmo VVP. Esta corrección es un paso opcional.

Para obtener información sobre la corrección del valor medio de la velocidad, consulte
Optimización de SHEAR para la detección de microrráfagas (página 191).

Magnitud de la cizalladura

Luego de que se obtuvieron las cizalladuras radiales y de acimut, el próximo paso es
computar la magnitud de la cizalladura. Esta es la raíz cuadrada de la suma de los cuadrados
de 2 valores de cizalladura (radial y acimut) asociados a cada bin.

Si solo se seleccionara una cizalladura (radial o acimut), se omitiría este paso.

Conversión a cartesiano y estabilización cartesiana final opcional

La conversión a cartesiano transforma los valores de la exploración B de la magnitud de la
cizalladura en coordenadas X-Y.

El algoritmo es idéntico al algoritmo de PPI, que utiliza un enfoque final para el llenado de
rango y de acimut. Se puede pasar por los datos un estabilizador 2D opcional con escala de
longitud seleccionable en este punto.

5.6.2 Optimización de SHEAR para la detección de microrráfa-
gas

La detección precisa y la generación de informes oportunos de microrráfagas en un entorno
de control de tráfico aéreo requiere que el sistema esté correctamente configurado y
optimizado.
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Vaisala le recomienda trabajar con un asesor calificado que lo ayude a ajustar y evaluar el
algoritmo SHEAR de IRIS, la adquisición de los datos, la colocación del radar y los informes
de advertencia.

Los pasos de optimización presentados aquí solo son lineamientos y no deberían
sustituirse por una evaluación integral de su sitio en particular. IRIS brinda muchas de las
herramientas necesarias para realizar esa evaluación.

Tabla 18 Corrección de la cizalladura de la velocidad media

La velocidad radial se puede expresar en términos de los componentes u y v del viento (se ignora la velo-
cidad vertical aquí porque las observaciones por lo general están cerca del plano horizontal):

donde:VR = ucosθsinφ + Vsinθsinφ
Vr es la velocidad radial

u es el componente x del viento (este)

v es el componente y del viento (norte)

θ es el acimut definido como CCW positivo desde el eje x (este)

φ es la elevación definida como movimiento ascendente positivo

El viento está representado por un viento medio [ uo, vo ] y un viento de perturbación [ u', v' ],
entoncesVR = uo+ u′ cosθsinφ+ vo+ v′ sinθsinφ
El derivado de acimut es entonces,αVRαθ + − uosinθsinφ + vocosθsinφ + ααθ u′sinθsinφ + v′cosθsinφ
donde el primer término es la cizalladura de acimut aparente provocada por el viento medio. Por lo tanto,
cuando se computa el derivado de acimut, se aplica el término de corrección de la siguiente manera:▵ VR▵ θ + uosinθsinφ − vocosθsinφ = ααθ u′cosθsinφ + v′sinθsinφ
Los valores de uo y vo se obtienen del algoritmo VVP. En términos del acimut #beta# medido en el detector
de radar tradicional (en sentido horario desde el norte), la corrección es:θ = 90 − βuocosβsinφ − vosinβsinφ

El producto SHEAR se produce primero a partir de tareas optimizadas para la medición de
alta resolución y de rango cercano de la velocidad radial.

Los productos SHEAR luego se ingresan al producto WARN, que hace una revisión para ver
si la fuerza y el tamaño de las regiones de cizalladura del viento superan el valor límite en las
áreas protegidas.

Se pueden agregar criterios adicionales, como la reflectividad en el aire de una exploración
superior o un requisito para ver la cizalladura en dos exploraciones adyacentes, al producto
WARN para reducir el índice de falsas alarmas si esto representa un problema para la
ubicación en particular.
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1. Configure IRIS para la cizalladura del viento, de modo que cuando el clima
potencialmente peligroso se acerque al área del terminal, se pueda cambiar IRIS al
modo de monitoreo de la cizalladura del viento al cargar la configuración al menú de
Radar Status.

Puede operar el producto WARN en modo de vigilancia para alertar al operador que se
debe cambiar el modo o que se puede usar la función de cambio automático de modo.
Por ejemplo, el modo de vigilancia podría constar de una secuencia de exploración de
volumen de exploración de 15. Se puede ingresar el producto WARN en un indicador de
tormenta severa como VIL. Si VIL supera el valor límite típico de las tormentas severas
para el área y este VIL se encuentra dentro de los 30 km (18,6 mi) del terminal, el
producto WARN puede emitir una alarma que avise al operador o se puede indicar el
cambio del interruptor de modo automático al modo de detección de cizalladura del
viento.
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2. Optimice el menú de TASK Configuration para la detección de la cizalladura del viento
como se muestra en el ejemplo en la siguiente figura.

En este ejemplo se usa un muestreo de alta resolución en el rango (125 o 62,5 m
[205 pies 1 in]). Las microrráfagas son fenómenos de bajo nivel, entonces lo mejor es
configurar los ángulos de elevación que están en el nivel más bajo tolerable por el eco
circundante.
Por lo general, un conjunto de ángulos de 0,5°; 1,0° y 5,0° resulta útil. Los 2 ángulos
inferiores se pueden usar para la detección de cizalladura, mientras que el ángulo
superior puede servir de base para un criterio de reflectividad del aire adicional para el
producto WARN. El modo de exploración del sector se usa para limitar la cobertura de
datos al área del terminal que acelera la tasa de actualización.

Figura 64 Configuración de TASK para la detección de microrráfagas
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3. Configure el TASK Scheduler en el modo de detección de cizalladura del viento para
brindar una tasa de actualización (tiempo de repetición) de al menos una tarea
completada por minuto.

Para obtener una respuesta óptima, no programe otras tareas. Esto le permite a IRIS
dedicar todos sus recursos a detectar microrráfagas.

4. Optimice la configuración del producto SHEAR:

• Configure el campo Product Range en el rango máximo de interés y haga que
corresponda medianamente con el espaciado del bin de entrada.
El rango de 30 km (18,6 mi) y la resolución del producto de 480 por 480 píxeles en
el ejemplo coinciden con el muestreo de 125 m (410 pies 1 in) en la tarea.
En los ángulos de elevación de ejemplo de 0,5; 1,0 y 5,0, se pueden configurar
productos de cizalladura por separado para cada uno de los 2 ángulos más bajos.

• Se recomienda no utilizar ninguna estabilización de XY adicional cuando se usa el
producto SHEAR para la detección de microrráfagas porque la estabilización suele
disminuir los valores máximos de interés en el cálculo de la cizalladura.
La estabilización radial realizada por el filtro de rango y la subsiguiente
estabilización realizada en el producto WARN son adecuadas.

El producto WARN observa los productos SHEAR para determinar si debe emitir una
advertencia o no. En el ejemplo de las 2 exploraciones de bajo nivel (0,5º y 0,9º), cada
una con su propio producto SHEAR, se puede configurar el producto WARN para
examinar cada uno. Un nivel límite de 8 m/s/km es un buen indicador de cizalladura del
viento peligrosa. Se puede usar un límite de área de 1 km (0,6 mi) que corresponde a
aproximadamente 64 píxeles para los casos de espaciado del bin de 125 m (410 pies
1 in), un rango de 30 km (18,6 mi) y una resolución del producto de 480 × 480.

5. Optimice el menú de Product Output para enviar el producto WARN a una estación de
trabajo para que el personal pueda ver la pantalla de situación.

a. Realice la solicitud de salida automática para que se envíe el producto de cizalladura
cada vez que se lleve a cabo.

b. Asegúrese de que haya una estación de trabajo que ejecute los menús de IRIS para
que cuando se detecte una cizalladura del viento, aparezcan el mensaje de
advertencia sonoro y el texto correspondiente.

Los mensajes de advertencia se emiten casi instantáneamente cuando se detecta una
cizalladura del viento. Al término de algunos segundos de haber recibido un mensaje
de advertencia, aparece la pantalla de situación. Esto depende de la velocidad del
enlace de comunicación que se conecta a la pantalla. Sin embargo, debido a que la
pantalla de situación es un producto de superposición sin una imagen compleja, se
puede transmitir de manera eficaz.
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6. Ajuste los algoritmos de detección de cizalladura del viento de cada sitio.

Esto requiere que el personal calificado realice la optimización necesaria de su entorno
meteorológico y operativo en particular.
Debe atravesar una fase de evaluación integral para probar su sistema en su sitio en
particular para el clima en particular.
Se recomienda que lleve a cabo y registre un producto RAW cada vez que se detecta
una microrráfaga y realice un análisis para determinar si se trató de un evento real o una
falsa alarma.
Para obtener una muestra más grande, posiblemente desee expandir el área protegida
para incluir el área total alrededor del radar hasta el rango máximo de detección
requerido (generalmente, de 20 a 30 km [de 12,4 a 18,6 mi]) para las aplicaciones de las
terminales aéreas. Un meteorólogo calificado debería ayudarlo con esta evaluación.

7. Si se determina que hay falsas alarmas, hay varios enfoques que puede adoptar para
equilibrar la sensibilidad contra el índice de falsas alarmas.

Cuando ajuste el sistema para reducir las falsas alarmas, es importante realizar cambios
graduales y evaluarlos en los casos de prueba que registró. A continuación, hay algunos
ejemplos de medidas que puede tomar para reducir las falsas alarmas (tenga en cuenta
que puede realizar lo opuesto de cada ejemplo para aumentar la sensibilidad):
• Aumente gradualmente el filtro de rango en el menú SHEAR Product Configuration

de 1 a 2 km (de 0,6 a 1,2 mi).
• Aumente el límite de la magnitud de SHEAR en el menú de WARN Product 

Configuration.
• Aumente el umbral del tamaño de ÁREA en el menú WARN Product Configuration

hasta 2 km (1,2 mi).
• Exija que 2 exploraciones de nivel bajo de la misma tarea detecten la SHEAR en el

producto WARN: una prueba de dos observaciones.
• Agregue un criterio de advertencia que requiera de una reflectividad aérea. Esto se

puede basar en un PPI de dBZ a un ángulo mayor.
Asegúrese de que las microrráfagas no sean comunes en su área. Si lo son,
posiblemente deba usar un criterio de VIL y usar más ángulos de elevación en la
tarea asociada.

Producto y visualización del IRIS Guía de usuario M211319ES-J

196 RESTRINGIDO



5.7 SLINE: Línea de cizalladura

Figura 65 Configuración de ejemplo de SLINE

SLINE marca la transición entre dos masas de aire en la imagen.

Debido a que el viento puede ser diferente en cada lado de la masa de aire, se producen
cambios repentinos del viento cuando pasa un frente.

En la siguiente figura, se muestra un ejemplo de una línea de cizalladura típica. Los cambios
de viento más severos están asociados a frentes de ráfaga de mesoescala, que se producen
en el borde delantero de una salida de tormenta eléctrica, y con frentes de frío de escala
más grande, que se pueden asociar con clima severo.
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Post-Frontal Wind

Pre-Frontal Wind

Figura 66 Ejemplo de línea de cizalladura típica

El producto SLINE puede detectar cambios repentinos del viento y proporcionar una
advertencia por adelantado de su acercamiento, con mejores estimaciones de la hora de
llegada y la velocidad y dirección esperadas del nuevo viento.

1. Seleccione Type > SLINE.

2. Para cargar un producto existente, seleccione File > Open

3. En Data:Display, seleccione V Shear.

4. En EL Angle, defina el ángulo de elevación de los datos que desea mostrar.

Por lo general, las cizalladuras del viento asociadas con frentes de ráfagas y
microrráfagas son fenómenos de bajo nivel, por lo que para detectarlas, comúnmente,
se usan ángulos de 1° o menos.
Puede seleccionar 1 o 2 ángulos. Si selecciona 2 ángulos, asegúrese de que ambos estén
por encima del umbral para incluirlos en la línea de cizalladura.

5. Defina Rng / Az Filter.

El primer número define la escala de la longitud del rango para el producto SHEAR, en
km. La distancia determina el tamaño del salto que puede tolerar el producto SHEAR
cuando varía sobre los datos faltantes. También especifica la longitud de la
estabilización radial, que se aplica antes de la estabilización XY.
El segundo número es la escala de la longitud de acimut en grados.
El salto y la longitud del rango de acimut son análogos al filtro del rango.
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6. En Shear Type, seleccione el tipo de cizalladura que desea calcular:

• Cizalladura radial
La diferencia de bin a bin en la velocidad radial.

• Cizalladura acimutal
La diferencia de acimut a acimut en la velocidad radial.

• Cizalladura de elevación
La diferencia entre la velocidad radial en el ángulo de elevación seleccionado y el
siguiente ángulo de elevación superior. Requiere una exploración del volumen.

• Cizalladuras combinadas
El valor RMS de la cizalladura radial, acimutal o de elevación. A veces, se la conoce
como cizalladura total.

7. En VVP, seleccione el nombre de un producto VVP.

La velocidad y la dirección del viento del producto WIND más cercano VVP con este
nombre se usan para eliminar los efectos del viento medio en el cálculo de la
cizalladura de acimut.
Para que se ejecute, este producto VVP se debe programar. No se recomienda el uso de
la cizalladura de acimut o combinada sin esta corrección.

8. En VVP Age, especifique el número máximo de minutos entre los datos del producto
VVP y los datos de este producto.

Esto evita que se apliquen mal los vientos anteriores de VVP. Si no se encuentra un
producto VVP en esta ventana de tiempo, no se aplica la corrección media del viento
cuando se calcula la cizalladura de acimut.
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9. Defina la configuración de SLINE:

Count and Time
Ingrese la cantidad de puntos de pronóstico y el intervalo de tiempo entre cada
punto de pronóstico, y seleccione Ok.
El tiempo que especifique se ingresa en el campo.

Max Time Step
El pronóstico de movimiento de la línea de cizalladura utiliza el producto de línea
de cizalladura anterior.
Max Time Step especifica cuán atrás en el tiempo puede estar el producto SLINE.
Si no existe ninguno en este marco de tiempo, no se realiza un pronóstico.

Max Velocity
Ingrese la velocidad máxima esperada. Si la velocidad calculada supera este valor,
la línea de cizalladura se considera una nueva característica y no se realiza un
pronóstico.

Shear Threshold
Ingrese la diferencia de velocidad mínima por km que debe estar presente para
indicar una línea de cizalladura. Se ignoran los vientos que no cumplan con esta
velocidad.

Threshold Area
Ingrese el tamaño mínimo del área de la cizalladura de viento en km cuadrados
que debe estar presente para indicar una línea de cizalladura. Se ignoran las áreas
de cizalladura de viento que estén por debajo de este umbral.

RMS Fit Tolerance
Ingrese la desviación estándar permitida cuando se adapte la línea de cizalladura.
La línea se descarta si los puntos no encajan con esta tolerancia, lo que indica una
dispersión aleatoria de puntos y una línea de cizalladura.

Minimum Sline Length
Ingrese la distancia mínima en km usada para estimar una línea de cizalladura. Se
ignoran las líneas de cizalladura que están por debajo de esta longitud.
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10. Configure SLINE para usar con advertencias.

Protected Areas for Warning Alert
Especifique una o más áreas protegidas. Se genera una advertencia si una línea
de cizalladura se encuentra dentro de un área protegida o si se pronostica que se
dirigirá hacia una.
Seleccione Protected Areas para ver una lista de áreas y activar o desactivar una
opción. Al salir de la lista, aparecerán los nombres de las áreas seleccionadas en
el campo.
Las áreas protegidas se configuran con la herramienta Setup. Se limitan a ser
rectángulos con tamaño arbitrario y ángulo de orientación. Se pueden configurar
hasta 32 áreas.
Si realiza un cambio en Setup, debe reiniciar IRIS para que el cambio surta efecto.
Consulte IRIS and RDA Utilities Guide (M211316EN).

TDWR Style
El IRIS admite dos formatos de mensajes de advertencia.
En el formato TDWR, solo se informa el centroide más fuerte del área de mayor
prioridad junto con su fuerza. Por ejemplo: MBA 3MF 30K–, en idioma hablado:
Microburst Alert, Three Mile Final, 30 Knot loss.
El formato IRIS más antiguo informa sobre todos los centroides en todas las áreas
protegidas, por ejemplo: 3 MBA warnings at 11:30 in: 3MF, 2MF.
Los mensajes aparecen en la parte inferior de la pantalla y, opcionalmente, tienen
salida de voz.

Say Warning
Cuando está habilitado, el generador del producto emite señales audibles del
mensaje de advertencia además de mostrarlo como mensaje.
También debe seleccionar Setup > Enable Speech en IRIS.

11. Para solucionar problemas o probar los productos SLINE, habilite una versión de
umbral del producto SLINE de entrada al seleccionar Make Diagnostic Results.

Tiene el mismo nombre de producto que SLINE.

Más información

‣ Parámetros de visualización (página 31)
‣ Asociación de productos con tareas (página 21)
‣ Parámetros del producto (página 28)

5.7.1 Firmas del radar de cizalladura
La detección de las líneas de cizalladura se basa en la velocidad doppler en vez de en la
reflectividad. Sin embargo, la medición precisa de la velocidad doppler requiere de una
potencia de retorno suficiente. La reflectividad del radar asociada a las líneas de cizalladura
puede provenir de las precipitaciones o los ecos del aire limpio. Debido a que los ecos del
aire limpio suelen ser débiles, la detección más eficaz requiere que el radar realice una
exploración lentamente para un cálculo de promedio suficiente.
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La climatología de las líneas de cizalladura para una ubicación en particular indica la
estrategia de exploración. Si las líneas de cizalladura suelen asociarse a retornos débiles, es
necesario un índice de exploración lento para una detección confiable. La compensación
entre la detección confiable de las funciones del eco débil y la necesidad de realizar
actualizaciones rápidas para detectar fenómenos como microrráfagas es una decisión que
debe tomar sobre la base del sitio y la aplicación.

Las líneas de cizalladura se caracterizan por la vorticidad y la convergencia (divergencia
negativa). La vorticidad asociada a los frentes fríos en el hemisferio norte es, por lo general,
positiva. La vorticidad asociada a los frentes de ráfagas de truenos es, por lo general pero no
siempre, positiva. Las líneas de cizalladura no se caracterizan por una divergencia positiva
como las microrráfagas.

La cizalladura de acimut (vorticidad parcial) y la cizalladura radial (divergencia parcial) por
lo general muestran una firma para una línea de cizalladura.

5.7.2 Algoritmo de cizalladura
El algoritmo de la línea de cizalladura (SLINE) utiliza el supuesto de viento uniforme.

1. Se computa la cizalladura radial, de acimut o combinada mediante el uso del algoritmo
SHEAR.
El viento de VVP anterior se usa para quitar la cizalladura de acimut aparente
provocada por el viento medio.
Se computan las cizalladuras mediante el uso de datos polares y la salida son los datos
X-Y a un espaciado de cuadrícula seleccionable.

2. Se aplica un límite a la magnitud de cizalladura con respecto a la fuerza y al área dentro
de un área especificada.
No se consideran las regiones de cizalladura que están por debajo del límite o son
menores que el límite del área.

3. Los valores de la magnitud de cizalladura de 2 elevaciones son ANDed.
Este paso es opcional si se especifica una segunda elevación.

4. Se agrega una curva al campo de cizalladura para detectar una región lineal.
Se eliminan los puntos que están fuera de la curva y esta se vuelve a ajustar.
Se puede considerar una sola línea de cizalladura en un producto.

5. Se obtiene la velocidad de movimiento normal al frente de la ráfaga al comparar los
datos de la ubicación de la línea de cizalladura actual con los datos de la ubicación
anterior.

6. Se computa el viento de VVP en ambas áreas definidas por la línea de cizalladura
mediante el uso del supuesto de viento uniforme.

7. Se proyecta el movimiento computado para determinar si la línea de cizalladura cruzará
cada área protegida y cuándo.

8. Se obtienen los resultados.

5.8 SWS: Estaciones meteorológicas de
superficie

IRIS puede almacenar y mostrar los informes METAR y SYNOP de las estaciones
meteorológicas de superficie. Estas se almacenan en el producto SWS.
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Un solo archivo de producto contiene informes de muchas estaciones (o todas) en el área de
cobertura del radar. Debido a que los datos no se generan a partir de los datos del radar, no
hay un menú de configuración del producto para crear dichos productos. En cambio, se crea
el archivo de producto cuando se pasan los mensajes de texto de METAR o SYNOP de una
estación meteorológica de superficie por un programa del canal de IRIS.

Se muestran estos datos como una serie de "trazados de estación", que muestran varios
datos almacenados, como temperatura, detección del viento, presión y similares. Estos se
pueden trazar independientemente o sobre los productos de radar. También puede hacer
clic sobre el cursor para ver los informes sin procesar de la estación.

5.8.1 Visualización de datos SWS

Figura 67 Ejemplo de datos del radar con superposición de estaciones de SWS

En el ejemplo anterior, se realizan los trazados de estación individuales centrados en las
ubicaciones de la estación. Se muestran todas las estaciones en el área de cobertura de la
pantalla.
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En el formato de trazado de estaciones de IRIS, el trazado es estandarizado, aunque las
diferentes estaciones de informe varían en cuanto a las capacidades de medición, los datos,
el intervalo y la resolución. No aparecen los números ni los gráficos individuales en el
trazado si una estación presenta el informe o si se desactivan los datos en las opciones de
salida.

Figura 68 Trazado de estación única de IRIS

Los detalles del trazado son los siguientes.

N.° 1 Cobertura de la nube

Un gráfico de torta donde figure la cobertura en octas (es decir, ochos) del trazado de la
cobertura del cielo mediante el uso de símbolos estándares. El ejemplo muestra 6 octas.

Debido a que los mensajes de METAR no ofrecen cobertura de la nube en octas, se asigna el
texto de METAR de la siguiente manera:

Mensaje METAR Octas

SKC o CLR 0 octas

FEW 1 octa

SCT 3 octas

BKN 6 octas

OVC 8 octas

Figura 69 Símbolos estándar de la octa
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N.° 2 Lengüeta de viento

Una línea con lengüetas que representa la velocidad y dirección del viento a los 5 nudos más
cercanos.

Un nudo (milla náutica por hora) es cercano a la mitad de un metro/segundo, por lo que
20 nudos serían 10 m/s. La línea apunta al viento. Tiene la mitad de una línea de lengüeta
para los 5 nudos y líneas de longitud completa para los 10 nudos y una marca triangular para
los 50 nudos. Si la velocidad del viento es de 0, se dibuja un círculo fuera del círculo de
cobertura del cielo.

El ejemplo muestra vientos de 5 nudos desde el sur.

N.° 3 Tiempo actual

Hay un gran conjunto de símbolos disponibles que se muestran en la siguiente figura. En el
ejemplo de Figura 67 (página 203) aparecen 2 puntos que representan lluvia ligera.

El Servicio Meteorológico de Estados Unidos (National Weather Service) o la Organización
Meteorológica Mundial (WMO) no necesariamente aprueban la coincidencia del texto del
clima actual METAR con los símbolos en Tabla 19 (página 207).

En la siguiente figura, los números en azul que se encuentran en la esquina superior
izquierda de las casillas blancas indican la prioridad de trazado en caso de que haya más de
un símbolo posible (los símbolos en las casillas grises no tienen ningún texto de clima actual
METAR que coincida). Para una representación gráfica de METAR mediante el uso de esta
tabla, consulte http://www.rap.ucar.edu/weather/surface/.

Capítulo 5 – Configuración y programación de productos IRIS opcionales

RESTRINGIDO 205

http://www.rap.ucar.edu/weather/surface/


Cloud development 
not observed or 
not observable 
during past hour

Clouds generally 
dissolving or 
becoming less 
developed during 
past hour

State of sky on 
the whole 
unchanged during 
past hour

Clouds generally 
forming or 
developing during 
past hour

Visibility reduced 
by smoke

Haze Widespread dust in 
suspension in the 
air, not raised by 
wind, at time of 
obs

Dust or sand 
raised by wind, at 
time of obs

Well developed 
dust devil(s) 
within past hour

Duststorm or 
sandstorm within 
sight of station 
or at station 
during past hour

Funnel cloud(s) 
within sight 
during past hour

Squall(s) within 
sight during past 
hour

Thunder heard but 
no precipitation 
at the station

Precipitation 
within sight, 
reaching the 
ground, near to 
but not at station

Precipitation 
within sight, 
reaching ground, 
but distant from 
station

Precipitation 
within sight, but 
not reaching the 
ground

Lightning visible, 
no thunder heard

More or less 
continuous shallow 
fog at station not 
deeper than 6 feet 
on land

Patches of shallow 
fog at station not 
deeper than 6 feet 
on land

Light fog

Drizzle (not 
freezing, not 
showers) during 
past hour, not at 
time of obs

Rain (not 
freezing, not 
showers) during 
past hour, not at 
time of obs

Snow (not falling 
as showers) during 
past hour, not at 
time of obs

Rain and snow (not 
falling as 
showers) during 
past hour, not at 
time of obs

Freezing drizzle 
or rain (not 
showers) during 
past hour, not at 
time of obs

Showers of rain 
during past hour, 
but not at time of 
obs

Showers of snow, 
or of rain and 
snow during past 
hour, but not at 
time of obs

Showers of hail, 
or of hail and 
rain during past 
hour, but not at 
time of obs

Fog during past 
hour, but not at 
time of obs

Thunderstorm (with 
or without precip) 
during past hour, 
but not at time of 
obs

Heavy drifting 
snow, generally 
high

Slight or moderate 
drifting snow, 
generally high

Heavy drifting 
snow, generally 
low

Slight or moderate 
drifting snow, 
generally low

Severe duststorm 
or sandstorm, has 
increased during 
past hour

Severe duststorm 
or sandstorm, no 
appreciable change 
during past hour

Severe duststorm 
or sandstorm, has 
decreased during 
past hour

Slight or moderate 
duststorm or 
sandstorm, has 
increased during 
past hour

Slight or moderate 
duststorm or 
sandstorm, has 
decreased during 
past hour

Fog at distance at 
time of obs but 
not at station 
during past hour

Fog in patches Fog, sky 
discernable, has 
become thinner 
during past hour

Fog, sky not 
discernable, has 
become thinner 
during past hour

Fog, sky 
discernable, no 
appreciable change 
during past hour

Fog, sky not 
discernable, no 
appreciable change 
during past hour

Fog, sky 
discernable, has 
begun or become 
thicker during 
past hour

Fog, sky not 
discernable, has 
begun or become 
thicker during 
past hour

Fog, depositing 
rime, sky 
discernable

Fog, depositing 
rime, sky not 
discernable

Drizzle and rain, 
moderate or heavy

Drizzle and rain, 
slight

Moderate or thick 
freezing drizzle

Slight freezing 
drizzle

Slight freezing 
rain

Moderate or heavy 
freezing rain

Rain or drizzle 
and snow, slight

Rain or drizzle 
and snow, moderate 
or heavy

Ice pellets 
(sleet, U.S. 
definition)

Isolated starlike 
snow crystals 
(with or without 
fog)

Granular snow 
(with or without 
fog)

Ice needles (with 
or without fog)

Continuous fall of 
snowflakes, heavy 
at time of obs

Continuous fall of 
snowflakes, 
moderate at time 
of obs

Intermittent fall 
of snowflakes, 
moderate at time 
of obs

Intermittent fall 
of snowflakes, 
slight at time of 
obs

Slight rain 
shower(s)

Moderate or heavy 
rain shower(s)

Violent rain 
shower(s)

Slight shower(s) 
of rain and snow 
mixed

Moderate or heavy 
shower(s) of rain 
and snow mixed

Slight snow 
shower(s)

Moderate or heavy 
snow shower(s)

Slight shower(s) 
of soft or small 
hail, with or 
without rain, 
and/or snow

Moderate or heavy 
shower(s) of soft 
or small hail, 
with or without 
rain and/or snow

Slight shower(s) 
of hail, with or 
without rain 
and/or snow, not 
assoc with thunder

Heavy thunderstorm 
with hail at time 
of obs

Thunderstorm 
combined with 
duststorm or 
sandstorm at time 
of obs

Heavy thunderstorm 
without hail but 
with rain and/or 
snow at time of 
obs

Slight or moderate 
thunderstorm with 
hail at time of 
obs

Slight or moderate 
thunderstorm 
without hail but 
with rain and/or 
snow at obs time

Moderate or heavy 
snow and/or rain/ 
hail at time of 
obs; TS past hour 
not at obs time

Slight snow and/or 
rain/hail at time 
of obs; TS during 
past hour not at 
time of obs

Slight rain at 
time of obs; 
thunderstorm 
during past hour 
not at time of obs

Moderate of heavy 
shower(s) of hail 
and/or rain/snow, 
not associated 
with thunder

Moderate or heavy 
rain at time of 
obs; TS during 
past hour not at 
time of obs

Continuous fall of 
snowflakes, slight 
at time of obs

Intermittent fall 
of snowflakes, 
heavy at time of 
obs

Continuous drizzle 
(not freezing), 
thick at time of 
obs

Intermittent 
drizzle (not 
freezing), thick 
at time of obs

Continuous drizzle 
(not freezing), 
moderate at time 
of obs

Intermittent 
drizzle (not 
freezing), 
moderate at time 
of obs

Continuous drizzle 
(not freezing), 
slight at time of 
obs

Intermittent 
drizzle (not 
freezing), slight 
at time of obs

Intermittent rain 
(not freezing), 
slight at time of 
obs

Continuous rain 
(not freezing), 
slight at time of 
obs

Intermittent rain 
(not freezing), 
moderate at time 
of obs

Continuous rain 
(not freezing), 
moderate at time 
of obs

Intermittent rain 
(not freezing), 
heavy at time of 
obs

Continuous rain 
(not freezing), 
heavy at time of 
obs

Slight or moderate 
duststorm or 
sandstorm, no 
appreciable change 
during past hour

 (descriptions abridged from W.M.O. Code)
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 (METAR text-to-symbol matching)
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Figura 70 Tiempo actual (coincidencia de texto y símbolo de METAR)

N.° 4 Visibilidad

Este código es una abreviatura de 2 dígitos para una escala algo logarítmica, como se
muestra en Tabla 19 (página 207).

El ">60" en el ejemplo significa mayor que 10 km (6,2 mi).

Los informes de METAR tienen un valor máximo de "mayor que 10 km", por lo que hay
muchos ">60" en las pantallas.

Producto y visualización del IRIS Guía de usuario M211319ES-J

206 RESTRINGIDO



Tabla 19 Códigos de visibilidad de METAR

Valor del código Significado

00 Menos que 100 metros (328 pies)

01 ... 50 Código * de 100 metros (de 100 a 5000 metros [de 328 a 16.404 pies])

51 ... 55 No utilizados

56 ... 80 (Código 50) * 1000 metros (3280 pies) (de 6 a 30 km [de 3,7 a 18,6 mi])

81 ...  88 (Código 74) * 5000 metros (16.404 pies) (de 25 a 70 km [de 15,5 a
43,5 mi])

89 >70 km (43,5 mi)

90 ... 99 No se usan para estaciones terrestres

N.° 5 Temperatura

Temperatura (°C).

N.° 6 Altura de las nubes

Puede haber hasta 3 niveles de nubes trazadas en el formato O/HH.
• Las nubes de nivel más bajo se trazan debajo de la estación, en este caso "3/40".
• El segundo nivel de nubes se traza sobre la estación, que es "6/60" en el ejemplo.
• Puede trazarse un tercer nivel sobre el segundo, que no se muestra en este ejemplo.

El primer número corresponde a las octas de cobertura y el segundo número es un valor de
código que representa la altura. Estos valores de código son similares a los valores de
código de visibilidad, excepto que las unidades son pies, como se muestra en la siguiente
tabla.

El ejemplo muestra un 3/8 de cobertura de las nubes a 1219 m (4000 pies) y un 6/8 de
cobertura a 3048 m (10.000 pies). Los informes de SYNOP contienen 1 solo nivel de altura
de las nubes, por lo que los otros no se ven.

Tabla 20 Códigos de altura de las nubes para SWS

Valor del código Significado

00 Menos de 100 pies

01 ... 50 Código * 100 pies (de 100 a 5000 pies)

51 ... 55 No utilizados

56 ... 75 (Código 50) * 1000 pies (de 6000 a 25.000 pies)

76 ... 99 No utilizados

N.° 7 Presión a nivel del mar

Presión a nivel del mar en 1/10 de un milibar sin el "9" o el "10" iniciales.
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Si la cadena comienza con 0 a 4, coloque como prefijo un "10" o un "9". En este ejemplo,
esto es 1015,0 milibares.

METAR informa la presión solo al milibar más cercano, de modo que todos los números
terminan en "0". Esta presión es la presión de QNH, que se corrige a nivel del mar.

N.° 8 Tendencia de presión

Muestra el cambio sin signo de la presión en las últimas 3 horas en 1/10 de un milibar. Está
seguido por un gráfico que muestra la tendencia del cambio.

Por ejemplo, "4/" significa que la presión aumento en 0,4 milibares durante las últimas
3 horas.

En los informes de METAR no figura la tendencia de la presión, así que queda en blanco.

En la siguiente figura se muestran los símbolos disponibles.

Figura 71 Símbolos de la tendencia de la presión de SWS

N.° 9 ID de estación
• Las estaciones METAR utilizan una cadena de 4 caracteres.
• Las estaciones SYNOP usan un número de 5 dígitos.

N.° 10 Punto de rocío

Punto de rocío (°C).

5.8.2 Opciones de salida SWS
Al mostrar un producto SWS en la Quick Look Window, puede configurar qué datos se
muestran mediante el uso de la SWS Tool.

Puede iniciar la SWS Tool de la Quick Look Window > OPT o de la Product Output Menu > 
Opts.

Para todos los campos de datos seleccionados, IRIS muestra los datos y los almacena en el
archivo.
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Pressure incluye la presión actual y la tendencia de presión.
Ceiling incluye (hasta) 3 alturas del nivel de nube.

Figura 72 SWS Tool

5.8.3 Informe sin procesar de SWS
Al mostrar un producto SWS en la Quick Look Window, puede desplazarse por una estación
y hacer clic con el botón secundario del mouse para mostrar los informes sin procesar de
METAR o SYNOP correspondientes a esa estación.

Si hay más de un informe en el archivo del producto, muestra todos, uno en cada línea. El
trazado de la estación muestra solamente el informe más reciente en el producto.
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Figura 73 Ejemplo de informe sin procesar de SWS

5.8.4 Configuración de la entrada de SWS
Los datos de SWS llegan a un sistema de IRIS a través de la transferencia de archivos y un
mecanismo de introducción.

Debe configurar la fuente de los mensajes METAR o SYNOP para transferir archivos ASCII a
un directorio conocido en el sistema de análisis de IRIS. IRIS monitorea este directorio en
cuanto a los nuevos archivos y luego ejecuta un canal de entrada para convertir estos datos
en el formato SWS interno de IRIS e incluirlos en el directorio de productos de IRIS.

Debe configurar la entrada de SWS.
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1. Asegúrese de usar una versión reciente del canal metar2iris al copiar los archivos
binarios y de configuración del directorio irisrda_templates al directorio pipes.

Este canal analiza los mensajes metar y synop.

$ cd /etc/vaisala/irisrda_templates 
$ cp pipes/metar2iris usr/bin/pipes|
$ cp metar* /etc/vaisala/irisrda

2. Configure y guarde un nuevo dispositivo de entrada en Configuración > Entrada. Por
ejemplo:
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3. Edite los siguientes archivos de configuración:

Nombre del archivo Descripción

metar_site.conf Configura la lista de sitios de las estaciones METAR o SYNOP que consta del
ID del sitio de ICAO, (el ID del sitio de WMO opcional), la LAT./LON., la alti-
tud, la descripción y la prioridad.

Debido a que los textos METAR/SYNOP no incluyen la latitud y longitud de
las estaciones, este archivo es fundamental.

Cuando llega un archivo METAR o SYNOP, se esperan todas las estaciones
en este archivo.

• Todas las estaciones que figuran en el archivo, pero que faltan en el infor-
me, están marcadas como DNR (no informó).

• Todas las estaciones que figuran en el informe, pero que faltan en el ar-
chivo se eliminan y aparece un mensaje en el archivo de registro del ca-
nal.

Debe mantener los archivos para quitar las estaciones viejas y agregar nue-
vas.

Para obtener una lista preliminar de las estaciones METAR y SYNOP, consul-
te: http://weather.rap.ucar.edu/surface/stations.txt

synop_site.conf

fmetar2Iris.conf Configura la caja de agrupación geográfica del producto. Este es el tamaño
de la caja cuando se muestra el producto SWS solo.

Se descarta cualquier estación que esté fuera de esta caja.

También configuramos el nombre del producto de SWS, el nombre del sitio
de IRIS y aspectos similares.

Los archivos de plantilla están configurados para Turquía.

4. Cree el directorio de entrada. Estos directorios deben ser propiedad del operador.

$ su
# mkdir /usr/iris_data/metar_in
# chown operator:users /usr/iris_data/metar_in

5. Reinicie el IRIS.

5.8.5 Alimentación de datos SWS

1. Para las pruebas, ingrese manualmente los datos de ejemplo en el directorio /usr/
iris_data/metar_in.

2. Para las pruebas, descargue el METAR actual de: http://aviationweather.gov/adds/
metars/.

Debe editar el archivo para agregar el encabezado de GTS y el METAR en cada línea.

3. Asegúrese de obtener un producto SWS en IRIS.
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4. Revise si hay advertencias en el archivo de registro del canal metar2iris.log
en /var/log/irisrda.

Las marcas de tiempo están compuestas por el día del mes seguido por la hora y los
minutos. El canal debe adivinar el mes y el año sobre la base de la hora actual.
IRIS espera recibir un archivo ASCII que contenga todos los mensajes de SYNOP o
METAR de la última hora. También se pueden enviar los informes especiales de METAR
al IRIS en el ínterin.

5.8.6 Ejemplos de formatos de archivos METAR y WMO
Formato de archivo ASCII de METAR, incluida una línea de encabezado de GTS de WMO y
luego el informe de cada estación. Cada informe tiene una marca de tiempo por separado.
Los signos "=" son opcionales.

SATU20 LTAA 160150

METAR LTAB 160150Z VRB01KT CAVOK 14/06 Q1015 NOSIG RMK RWY06 VRB02KT=
METAR LTAD 160150Z 36003KT CAVOK 15/07 Q1015 NOSIG RMK RWY29 VRB02KT=
METAR LTAE 160150Z 35003KT CAVOK 12/04 Q1015 NOSIG RMK RWY21 02006KT=
METAR LTAG 160150Z 10003KT 9999 SCT035 25/22 Q1005 NOSIG=

El formato de archivo ASCII de SYNOP, incluida una línea de encabezado de GTS de WMO,
una línea AAXX y luego el informe de cada estación. Todos los informes tienen la misma
marca de tiempo.

SMTT60 LTAA 160000

AAXX 16004
17015 3//// /1605 10171 20168 30109 40120 57006 60001
17018 3//// /3101 10160 20069 38899 40112 57009 60001
17020 3//// /0402 10153 20147 30085 40124 56003 60001
17022 3//// /1203 10197 20120 39966 40120 57008 60001
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6. Ventana de vista rápida

6.1 Descripción general de la ventana
Quick Look

Esta herramienta es una característica heredada usada para ver datos de radar con IRIS
Analysis.
Cuando es posible, Vaisala recomienda ver de datos de radar con IRIS Focus.

La ventana de vista rápida Quick Look Window (QLW) muestra los productos de
IRIS Analysis.

Figura 74 QLW de ejemplo: reflectividad de PPI (tamaño de pantalla de 480 x 480 con anillos
de rango y superposición)

Producto y visualización del IRIS Guía de usuario M211319ES-J

214 RESTRINGIDO



Barra de título

La barra de título muestra información específica, incluido:
• El nombre de la ventana que asignó el operador en Setup > Output.

El ejemplo muestra el nombre wind #1.
• El nivel de acercar/alejar seleccionado en la herramienta View.

El ejemplo muestra X 1, lo que indica que no hay acercamiento.
• El tamaño de la ventana en píxeles seleccionado en la herramienta View.

Esto se refiere al tamaño del área de la imagen. El tamaño real de la ventana es más
grande por los bordes y las leyendas.

• La hora de los datos de la imagen que se muestra.

Al nombrar las ventanas, considere incluir el nombre del producto. Por ejemplo, si un
producto VIL se asigna mediante el menú Product Output para que se muestre
automáticamente en la ventana, asígnele a la ventana el nombre VIL.
Además, considere asignarle a la ventana un nombre que coincida con el nombre de la
estación de trabajo "espacio de trabajo"en el entorno de escritorio común (CDE), si su
estación de trabajo lo admite.

Herramientas

Los iconos que se encuentran debajo de la barra de título proporcionan acceso a funciones
interactivas, como la configuración del circuito, el seguimiento, el cursor, el pronóstico y la
sección transversal.

Seleccione un icono para abrir la herramienta.

En la parte derecha del área de la herramienta, QLW Mode y QLW Indicator alerta a los
operadores sobre cambios en el estado de imágenes asignadas automáticamente en la
QLW.

Leyenda

La leyenda proporciona herramientas para seleccionar sitios de radar, productos y horas, y
para mostrar esta información. También puede conectar animaciones o explorar un solo
marco.

La leyenda de colores se muestra y tiene etiquetas. Use la Color Scale para seleccionar las
escalas de colores predeterminadas asignadas por el operador, o bien, para crear sus
propias escalas de colores.

6.2 Configuración e inicio de las ventanas
Quick Look

No debe hacer nada para iniciar las ventanas de vista rápida.

Cuando IRIS se inicia, las ventanas que configuró el administrador del sistema (en Setup > 
Output) aparecen automáticamente en la pantalla. La mayoría de los sistemas está
configurado para que tengan al menos 2 ventanas, pero puede tener más (consulte con el
administrador del sistema).
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Las ventanas también se pueden exportar a través de la red desde una estación de trabajo
del IRIS a otras estaciones de trabajo que estén ejecutando X-Windows, incluso
computadoras que estén ejecutando el software X-Windows en un sistema operativo
Microsoft Windows. Estas estaciones de trabajo no requieren ejecutar IRIS (pantallas libres).
Sin embargo, si exporta pantallas a través de la red, el rendimiento del circuito puede no ser
tan bueno como cuando ejecuta circuitos en su estación de trabajo local del IRIS. El
administrador del sistema puede configurar estas ventanas remotas.

Si inicia sesión en un sistema donde IRIS ya se está ejecutando, pero no hay una sesión X
ejecutándose (por ejemplo, bloqueo de pantalla o cierre de sesión), las ventanas aparecen
después de unos minutos. IRIS demora un tiempo en detectar que está de regreso.

Después de que aparece una ventana, no hay forma de cerrarla, salvo minimizarla cuando
sea útil para una vista rápida, porque las imágenes del tiempo están siempre disponibles y
los usuarios no pueden cerrar de modo involuntario. La ventana minimizada muestra un
pequeño signo en miniatura de la imagen en la pantalla.

Si la ventana se bloquea, el radar y otras funciones del IRIS siguen funcionando con
normalidad y la ventana se reinicia automáticamente después de un minuto o dos.

6.3 Control y monitoreo de la QLW
Indicador de actualización de la ventana de vista rápida

El indicador de actualización de la ventana de vista rápida (QLW) alerta sobre el estado de
las imágenes que aparecen en la QLW. Esto le permite ver, incluso a la distancia, que una
ventana se estableció para mostrar datos en vivo. El indicador de actualización se encuentra
junto al botón OPT del área de herramientas.

Modos de la ventana

La Quick Look Window funciona en los siguientes modos.

 (El fondo verde significa actualización automática desde IRIS)

• Auto Mode
La imagen se actualiza automáticamente mediante Product Output Menu (según lo
establecido por el operador) con imágenes nuevas. Este es un uso no interactivo de la
ventana.

 (El fondo rojo significa actualización no automática desde IRIS)
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• User Mode
En este modo, usted decide qué imágenes se muestran en la ventana y se pueden
manipular de manera activa (por ejemplo, al crear secciones transversales o
seguimientos sin interrupción de los productos nuevos que llegan desde el menú
Product Output). Las imágenes no se muestran automáticamente desde Product 
Output Menu.

 (Fondo verde)

• Slide Mode
Las imágenes se muestran según la configuración de la herramienta Slide Show.

 (Fondo verde)

• Loop Mode
Las imágenes se muestran según la configuración de la herramienta Loop/Animation y
se presiona el botón Most Recent para que se muestren las imágenes nuevas a medida
que llegan desde IRIS.

 (Fondo rojo)

• Las imágenes se muestran según la configuración de la herramienta Loop/Animation y
NO se presiona el botón Most Recent para que no se muestren las imágenes nuevas.

Puede seleccionar los modos User y Auto a través de Mode en el área de herramientas.
Los modos Loop y Slide se seleccionan automáticamente cuando inicia una presentación
de diapositivas o animación/circuito.

En la práctica, casi nunca debe cambiar de forma manual el modo de presentación, ya que
IRIS lo hace automáticamente:

• Cuando comienza a hacer algo por primera vez en la pantalla, IRIS cambia
automáticamente de Auto a User. IRIS no interrumpe enviando imágenes cuando está
usando la ventana.

• La QLW cambia automáticamente al modo Auto después de 5 minutos de inactividad.

Botón de ACTIVACIÓN/DESACTIVACIÓN de Legend

Botón de ACTIVACIÓN/DESACTIVACIÓN de  Legend

El área de la leyenda, la barra de título y las barras de desplazamiento se pueden desactivar
con el icono Legend, que se encuentra a la izquierda de la sección de herramientas. Haga
clic con el botón derecho del mouse en la ventana de visualización para restaurar la leyenda
o, si está usando una pantalla táctil, toque dos veces la esquina superior izquierda
(100 × 100 píxeles) de la ventana.

Desactive la leyenda si desea reducir el tamaño de las ventanas para que se puedan ajustar
más ventanas en la pantalla.
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La ubicación del encendido de cada ventana y la activación y desactivación de la leyenda se
controla desde Setup > Output.

Con la leyenda desactivada, quizás prefiera habilitar la leyenda interna que muestra una
leyenda en la ventana de visualización en lugar de un menú lateral.
Consulte Herramienta Display Options: salida del producto IRIS (página 225).

Desactivar la leyenda resulta útil para que las ventanas de visualización se vean como
"mosaicos", por ejemplo, para crear una presentación de diapositivas de múltiples
paneles.

Configuración de la contraseña del operador

Algunas funciones en la Quick Look Window están disponibles solo para los operadores, ya
que pueden afectar otras ventanas:

• Crear o eliminar puntos de referencia del "inicio" en las herramientas Cursor y Track.
• Crear o eliminar nombres de superposiciones virtuales (combinaciones especiales de

varias capas de superposiciones) en la herramienta Display Options.

Si necesita acceder a estas funciones, use la herramienta File para establecer la contraseña
de la ventana del operador configurada en Setup > General.

Seleccione Operator e ingrese la contraseña. Tenga en cuenta que, en general, la contraseña
de la ventana configurada en Setup > General no es la misma que la contraseña del
operador de UNIX.

Cuando finalice, seleccione File y vuelva a establecer el privilegio en Observer.
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6.4 Visualización de productos en la Ven-
tana de vista rápida

En la estación de trabajo, puede ver los productos en la Quick Look Window.

Puede configurar muchas ventanas de visualización en un sistema IRIS con la utilidad Setup.

Puede enviar productos a la pantalla desde el Product Output Menu según un horario de
salida del producto o desde la Quick Look Window.

Figura 75 Ventana de vista rápida

1. Para seleccionar un sitio de todos los sitios configurados en General Setup, seleccione
Site.

Seleccione el sitio que corresponde a su radar local.
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2. Para mostrar una lista de los productos disponibles, seleccione Product.

a. Por lo general, en el sitio del radar, solo tiene productos PPI. Para mostrar los
productos PPI, seleccione un PPI de la lista.

Si la lista muestra N/A, no hay productos disponibles en el disco para el sitio del
radar que ha seleccionado.

b. Para mostrar otros productos, seleccione PPI para ver todos los tipos de productos
disponibles y luego seleccione el producto.

c. Para mostrar datos de introducción, en el panel derecho superior, seleccione Live y
un nombre para la tarea.

Los productos RAW no se pueden mostrar.

3. Para mostrar las horas durante las cuales se mostrarán imágenes para el nombre del
producto seleccionado, seleccione Time (símbolo de reloj).

4. Utilice la barra corredera para explorar las imágenes más antiguas y más nuevas.

6.5 Herramienta Live Action de la QLW:
Generación y visualización de pro-
ductos

La herramienta Live Action le permite configurar, generar y visualizar varios productos del
IRIS. Si uno de estos productos está en la pantalla, se habilita la herramienta Live IRIS.

Seleccione la herramienta para mostrar una versión ligera del menú de configuración de
productos relevante. Entre los productos admitidos por esta herramienta, se incluyen: BASE,
CAPPI, PPI, SHEAR, SRI, TOPS, VIL y XSECT.
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Ejemplo: Ejemplo de herramienta Live Action para CAPPI

Figura 76 Ejemplo de herramienta Live Action para CAPPI

Puede modificar la configuración del producto sobre la marcha, como la posición de línea
transversal o la altura de CAPPI, y ver actualizaciones en vivo continuas en la pantalla, por lo
general a más de 10 marcos por segundo.

Por ejemplo, la capa superior de VIL se puede explorar para observar la VIL a varias alturas
por encima del nivel de congelamiento.

Puede explorar el objetivo CAPPI hacia arriba y hacia abajo para observar la estructura
vertical de los ecos de precipitación. El menú Live también muestra el tipo de visualización
(Z, T, V, W).

Debido a que la herramienta Live Action regenera el producto, es necesario enviar los datos
RAW a la pantalla para que estén disponibles los archivos de introducción. Además, la
pantalla debe tener licencia para la herramienta Live Action.

Más información

‣ Configuración de productos (página 19)
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6.6 Cambio del tamaño de la ventana y
del nivel de acercar/alejar

1. En la parte superior de la ventana de vista rápida, seleccione View.

2. Para cambiar acercar/alejar, seleccione un nivel de acercar/alejar y use las barras de
desplazamiento para colocar la pantalla en el área de interés.

Cuando acerca/aleja, IRIS intenta mantener el centro de la pantalla.

3. Para cambiar el tamaño, seleccione una resolución.

Cuando selecciona un nuevo tamaño de ventana, la imagen se vuelve a ajustar para
encajar de manera exacta en el nuevo tamaño. Los tamaños son la cantidad de píxeles
en el área de la imagen para la ventana (no se incluyen la leyenda ni los bordes).
• Se recomiendan las áreas de imágenes cuadradas.
• Los tamaños de imágenes rectangulares resultan útiles si la información de la

leyenda se incluye en la imagen (seleccionable como opción de salida en la QLW o
en Product Output Menu en el caso de salidas automáticas a una ventana).

Pruebe imágenes cuadradas y use el icono de leyenda  para activar/desactivar

la leyenda.
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6.7 Herramienta de escala de colores
La Color Scale Tool en la leyenda de colores le permite seleccionar diferentes escalas de
colores que se configuraron en el sistema en la herramienta Color Setup o crear su propia
escala personalizada.

Figura 77 Color Scale Tool

1. Para abrir la Color Scale Tool, seleccione el icono Color Scale.

2. Elija el Data Type para el cual desea definir una escala de colores.

Display Units muestra las unidades de medición para el tipo de datos actualmente
seleccionado.

Cuando ingresa por primera vez a la herramienta Color Scale Tool, el tipo de datos
no coincide con lo mostrado en la pantalla.
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3. Seleccione una Color Scale personalizada.

El operador del sistema define las escalas de colores personalizadas en la herramienta
Color Setup. Hay hasta 8 escalas para cada tipo de datos. Estas escalas incluyen la
elección del conjunto de colores, la cantidad de colores y los niveles de datos para cada
color.
Las escalas de colores existentes permanecen intactas en las actualizaciones del
software.
Cuando instale software nuevo, una escala de colores predeterminada y la opción
Uniform estarán disponibles para cada tipo de datos. Además, las escalas de colores
Winter y Everything están preconfiguradas para tipos de datos de reflectividad, con el
fin de coincidir las necesidades variadas de estación y aplicación.
La escala de colores Default de los datos HClass se corresponde con el conjunto de
clase de HydroClass de legado. El tipo de datos HClass incluye escalas de colores
adicionales PRECIP, CELLS, METEO y METEO-CELLS, que se corresponden con
métodos clasificadores varios (y sus fusiones significativas) disponibles en IRIS/RDA.
La opción de Uniform tiene un significado especial: puede seleccionar interactivamente
el conjunto de colores, la cantidad de colores y los niveles de inicio y paso. Es útil para
una umbralización simple de valores de datos bajos y altos, además de las fusiones más
simples de clases de eco de HydroClass.

4. Si está en modo uniforme:

a. Seleccione un Color Set.

Hay hasta 4 conjuntos de color con nombre disponibles. El operador del sistema
define los conjuntos de colores en la herramienta Color Setup.
Por lo general, definirá un conjunto Default para datos con valor positivo, como
reflectividad, tasa de pluviosidad, TOPS, VIL, etc. También definirá un conjunto de
Velocity para datos que pueden ser positivos o negativos, como velocidad, ZDR o
SHEAR.

b. Escriba la cantidad de colores para incluir en la escala (rango 2 al 16) en Levels.

c. Escriba los valores de inicio y paso en First Level/Step.

El valor de inicio se coloca en el borde superior del primer color. Se toma control de
la saturación del primer y del último color de la escala de colores Default para los
tipos de datos configurados en la herramienta Color Setup.

5. Para destacar un intervalo de datos para verificar si esos datos están en la pantalla,
seleccione Highlight > Enable y luego Edit.

Se inicia la Highlight Tool. Consulte Herramienta Highlight Tool (página 225).

6. Seleccione File > Save para guardar los resultados.

Los resultados se guardan solamente para la ventana en la que está trabajando. No
puede afectar otras ventanas. Es posible que desee ir a otras ventanas, realizar
cambios similares y guardarlos.
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Más información

‣ Opciones de salida VVP: Tiempo/Altura (página 265)

6.7.1 Herramienta Highlight Tool
La herramienta Highlight Tool, que se lanza desde Color Scale Tool, le permite destacar un
intervalo de datos en particular para ver si los datos están en su pantalla.

Use esta herramienta para seleccionar intervalos de colores (de los 16 intervalos en la
leyenda). Puede establecer el color del intervalo usando las barras de desplazamiento de
color. Esos valores de datos en la pantalla se muestran en el nuevo color.

6.8 Herramienta Display Options: salida
del producto IRIS

La herramienta Display Options le permite seleccionar componentes de la pantalla, como
superposiciones geográficas, anillos de rango, sombras, la superposición de varios
productos, centroides de advertencia, seguimientos de ecos y el ajuste de la opacidad de la
superposición de productos. Seleccione el icono para mostrar la herramienta.
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Figura 78 Menú Display Options

Cómo guardar las opciones de pantalla en la ventana de vista rápida

Debido a que hay muchas opciones de pantalla en este menú que pueden afectar la
apariencia de una ventana, IRIS ofrece una forma fácil de guardar y recuperar las
configuraciones que haya hecho. Seleccione File para mostrar las siguientes opciones:

• Save
Guarda la configuración actual del menú SOLO PARA ESTA VENTANA.
Cuando guarda una configuración, no afecta ninguna otra ventana, ningún otro usuario
ni el funcionamiento de IRIS. Esto significa que, con el permiso del administrador del
sistema, puede hacer su propia configuración personal para una ventana sin afectar
nada más.

• Load
Restaura la configuración actual guardada. Conviene realizar esto si desea hacer un
cambio temporal.

• Print
Hace una impresión del menú en la impresora predeterminada del sistema.
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Selección del tipo de producto

Cuando ingresa por primera vez a la herramienta Display Options, el tipo de producto se
inserta automáticamente en este campo.

Para elegir otro tipo de producto, seleccione el botón.

Para aplicar cambios a este tipo de producto o a todos los tipos de producto, use las
opciones de aplicación en la parte inferior de la ventana.

Si muestra CAPPI y cambia el campo del tipo de producto que se muestra arriba a, por
ejemplo, PPI, los cambios no se aplican y quedan en el producto mostrado (CAPPI) hasta
que selecciona Apply All.

Adición de superposiciones de productos

La sección Display Option Tool > Product Overlay le permite combinar distintos productos.
Casi cualquier tipo de producto se puede superponer en cualquier otro producto.

En el ejemplo de arriba, un producto TRACK interactivo se superpuso en un PPI. Las
aplicaciones típicas para esto son las siguientes:

• WARN superposiciones de productos
• WIND o NDOP (Doppler múltiple) superposiciones de lengüeta de viento
• TRACK
• SLINE (cizalladura)
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Múltiples productos se pueden superponer de esta manera. Por ejemplo, WIND y SLINE
mostrados juntos muestran los vectores del viento asociados con una cizalladura.

Las superposiciones de productos tienen opciones de alineación de tiempo:
• Nearest

El producto de superposición es el más cercano en tiempo al producto base.
• Live

El producto de superposición es la hora más reciente.

También es posible combinar 2 tipos distintos de productos de la imagen. El ejemplo
anterior muestra el producto VIL con TOPS mostrado debajo.

Cuando combina 2 productos de la imagen, es importante seleccionar escalas de colores
que contrasten para poder separar los datos. En este ejemplo, se usó una escala de grises
para TOPS. Las sombras en VIL resultan útiles.

Si su sistema IRIS admite la introducción del producto de la IMAGEN satelital, así es como
combina la pantalla satelital con los datos del radar.

Unidades de rango

Esto le permite seleccionar unidades de rango para las pantallas de salida. Las opciones son
las siguientes: científicas (kilómetros) o de navegación (millas náuticas para distancias
horizontales y kilopies para latitudes).

Hora

Esto le permite mostrar UTC u la hora local en la leyenda. La hora tiene un sufijo Z si es UTC.

Seleccione Default para dejar que la pregunta Setup controle este valor.
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Anillos de rango

Puede agregar anillos de rango, ajustar el espacio de estos y centrar los anillos en puntos
predefinidos (por ejemplo, el radar o un aeropuerto). Seleccione Rings para mostrar las
siguientes opciones:

• None
No se muestran anillos de rango.

• On
Se muestran anillos de rango, pero no están numerados.

• On W/Num
Se muestran anillos de rango con números de rango.

• Lat/Lon
Se muestra una cuadrícula de latitud y longitud. Además, la leyenda para cada
producto muestra el rango máximo del producto.

El espacio del anillo se selecciona con el botón de la derecha (Auto en el ejemplo).

Según la selección de la unidad, los espacios se muestran como km o millas náuticas.

El botón Center le permite seleccionar el centro de los anillos de rango de una lista de
puntos de inicio predefinidos. Los puntos de inicio se definen en la herramienta Cursor o
Track.

Debe tener privilegio de operador para definir puntos de inicio en las herramientas Cursor
o Track. El privilegio de operador para una Quick Look Window se establece en la
herramienta File ingresando una contraseña que se configura en Setup > Display.

Leyenda

Habilite esta opción para colocar una leyenda en la imagen real. La mayoría de los usuarios
deja esta opción desactivada ya que Quick Look Window tiene una leyenda incorporada.

Si decide colocar una leyenda en la pantalla, recomendamos hacer lo siguiente para
optimizar el tamaño de la ventana:

• Use View para seleccionar un tamaño rectangular estándar (por ejemplo, 880 × 720).
• Use el icono de leyenda  para desactivar la leyenda de Quick Look Window.
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Shadow

Habilite Shadow para elegir el tipo de sombra que se mostrará con los productos.

Una sombra sombrea características climáticas y la destaca del fondo como si fueran nubes
cubiertas por el sol. Puede desactivar las sombras o elegir entre tres profundidades de
sombra.

Tabulations

Las superposiciones de IRIS pueden tener abreviaturas o números para lugares importantes,
como aeropuertos, centros urbanos y similares.

Seleccione Tabulations para mostrar un menú con los nombres completos de las
abreviaturas en la pantalla.

Overlay Layers

Las superposiciones geográficas muestran costas, rutas, límites políticos y similares.
Consulte la herramienta Overlay en IRIS and RDA Utilities Guide (M211316EN).

Seleccione Overlay Layers para expandir el menú Display Options para incluir el menú que
se muestra arriba. Por lo general, las superposiciones de IRIS se construyen en varias capas,
por lo que los usuarios pueden activar o desactivar esas capas.

Después de seleccionar algunas capas, seleccione Apply para verificar que los cambios
tengan efecto.

Las "superposiciones virtuales" son nombres asignados a diferentes combinaciones de
capas. Para seleccionar una superposición virtual predefinida, seleccione el botón junto al
nombre de la superposición y seleccione un nombre nuevo de la lista.
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Los operadores pueden crear "nombres de superposición virtual". Si tiene el privilegio de
operador, ingrese su contraseña a través de la herramienta principal File de Quick Look 
Window. Una vez que tenga privilegio, en la ventana:

1. Seleccione el botón junto al nombre de la superposición y seleccione New.
2. Escriba el nombre nuevo en el mensaje.
3. Seleccione las capas que desea.
4. Para guardar el resultado, seleccione Display Options Menu > File > Save.

Cuando guarda, el nombre de la superposición virtual se comparte entre todas las ventanas
e impresoras de IRIS.

Apply Other Products, Cancel

Después de realizar cambios a Display Options, Apply Other Products los aplica.

Todos los cambios que se aplican solo afectan la ventana en la que se encuentra. No debe
preocuparse por el efecto en otras ventanas (y viceversa).

Apply Other Products aplica los cambios a todos los tipos de productos, solo en su ventana.
Cancel sale del menú sin hacer cambios.

Presione cualquier botón para aplicar los cambios al tipo de producto actual solo en su
ventana.

6.9 Herramienta Display Options: ventana
de vista rápida

La herramienta Display Options le permite seleccionar componentes de una pantalla, como
superposiciones geográficas, anillos de rango o sombras. Seleccione el icono para mostrar la
herramienta.
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6.10 Herramienta Product Overlay
La herramienta Product Overlay le permite superponer varios productos, centroides de
advertencia y seguimientos de ecos, o ajustar la opacidad de la superposición de productos.
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Figura 79 Herramienta Product Overlay

1. Seleccione el icono para mostrar la herramienta Product Overlay.

2. Seleccione el tipo de producto y el nombre del producto.
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6.11 Animation Tool

Figura 80 Herramienta Animation Tool en la ventana de vista rápida
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La animación es una de las mejores formas para los elaboradores de pronósticos de
observar el movimiento, el crecimiento y el deterioro de los ecos del radar. En las
aplicaciones en tiempo real, muchos usuarios de IRIS dejan un circuito ejecutándose
constantemente.

La herramienta Animation le permite controlar la secuencia de la animación.

También puede usar la herramienta Slide Show para automatizar la visualización de
distintos productos en distintos momentos.
Consulte Herramienta de presentación de diapositivas (página 239).

Loop Start y Stop

Use estos botones para reproducir (retroceder y avanzar) y detener animaciones. También
están disponibles en Legend.

Para usar la BARRA ESPACIADORA para detener un circuito o comenzarlo en la dirección
de avance, coloque el cursor en el área de la imagen del circuito.

Cuando comienza un circuito, el filtro del sitio coincide automáticamente con el circuito
para que solo se muestren las imágenes del sitio (para el cual se inició el circuito).

Loop Loading y Status

Cuando se carga un circuito, muestra la cantidad de marcos que se cargaron y la cantidad
total de marcos disponibles (29/30 en el ejemplo). El circuito comienza a reproducirse de
inmediato mientras se carga. No debe esperar que el circuito se cargue por completo antes
de que se reproduzca a velocidad del circuito.

Después de que la carga se completa, un número, el 30 en el ejemplo, indica la cantidad de
marcos en el circuito. El espacio de tiempo que se muestra es el espacio real de los marcos
en el circuito, no el Max Time solicitado.

Los factores que determinan la cantidad de marcos en un circuito incluyen:
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• Device Movie Length y tamaño de ventana predeterminado configurado en Setup > 
Output.
Si el tamaño de la ventana es el mismo que el tamaño predeterminado en Setup > 
Output, esta es la cantidad máxima de marcos que se muestran.
Si establece el tamaño de la ventana para que sea más pequeña que el tamaño
predeterminado, se mostrarán más marcos, ya que se asigna la misma cantidad de
memoria para las películas.
Si establece el tamaño de la ventana para que sea más grande que el predeterminado,
se mostrarán menos marcos.

• Max Time determina el espacio máximo posible de la película. Esto limita la cantidad de
marcos.

• La cantidad de marcos disponibles en el disco. Para ver esto, presione el icono Time.

Flush the Loop Buffer

Los circuitos son "adhesivos". Los marcos se mantienen en un búfer circular para que el
circuito no tenga que volver a cargarse si se detiene o se reinicia. Esto resulta conveniente
cuando trabaja con circuitos largos.

Si realiza un cambio en la ventana, como la escala de colores o Display Options, el búfer se
"descarga" automáticamente y el circuito vuelve a cargar sus cambios.

Si el circuito se debe descargar y volver a cargar o si el búfer circular se corrompe, use el
botón Flush para actualizar el búfer. El circuito se vuelve a cargar la próxima vez que se
reinicia.

Previous/Next

Un paso hacia delante o hacia atrás en el circuito. Es similar a usar Time Slider o las teclas de
flecha izquierda/derecha en el teclado (con el cursor sobre el área de la imagen).

Toggle

Intercambia entre la imagen actual y la imagen anterior en la pantalla, sin importar el tipo de
imagen ni la hora. A veces, esto resulta útil para comparar 2 productos distintos (por
ejemplo, TOPS y VIL).

Muestre ambos productos y luego, use el icono Toggle para mostrar cada uno de forma
alternada.

Al usar el cursor, es conveniente que la posición se muestre de forma correcta en los
2 marcos de alternación, incluso si las escalas son totalmente diferentes.
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Skip Time

Si desea enlazar una serie de datos de mucho tiempo, por ejemplo, de 24 horas, por lo
general, debe omitir algunos marcos para poder mostrar todo el espacio de 24 horas sin
superar la Device Movie Length de la cantidad máxima de marcos.

Especifique la omisión de tiempo en HH:MM. Por ejemplo, especifique 01:00 (una hora), para
que una película de 24 horas tenga 24 marcos.

El algoritmo de omisión intenta mostrar los marcos que están exactamente en los intervalos
del tiempo de omisión o lo más cerca posible. En el caso del tiempo de omisión de una hora,
los marcos estarían en la hora o lo más cerca posible justo después de la hora.

Max Time

Este es el espacio de tiempo máximo permitido.

Es posible que no pueda alcanzar esto ya que puede no haber marcos suficientes en el disco
o puede limitarlo el límite de memoria/marco de Device Movie Length configurado en
Setup > Output. El espacio de tiempo real que se alcanza se muestra en el campo Span.

Speed

Esta es la velocidad solicitada en marcos por segundo. La velocidad más rápida es a la
derecha y la más lenta, a la izquierda.

Alcanzar la velocidad depende de la velocidad de su CPU, de la cantidad de memoria que
tiene y del tamaño de la imagen que está enlazando.

Pause

Esta es la pausa en segundos entre circuitos sucesivos.

Además de marcar el final de un circuito, Pause le da a la computadora la oportunidad de
estar en reposo y de hacer otras cosas. Por ejemplo, si establece una pausa muy corta de
0,0 seg., el circuito se ejecuta continuamente, lo que puede hacer que otras tareas, como
cargar el circuito, demoren más. Si la computadora parece demasiado ocupada, prolongue
la pausa. El valor predeterminado de 1,5 segundos es razonable.
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Los circuitos de alta velocidad de imágenes grandes exigen mucho
de la CPU y de la memoria.
Si ejecuta varios circuitos de formato grande a alta velocidad sin pausa, puede usar cerca
del 100 % de la CPU y de la memoria, según la configuración del hardware del sistema.
Considere las tareas de IRIS en su sistema, como la generación del producto y la
adquisición de datos del radar. Los valores predeterminados de Speed y Pause son
puntos de partida razonables.

PRECAUCIONES!

Ajuste de la hora de término del circuito

Por lo general, el último marco del circuito se establece para ser la imagen Most Recent. En
este caso, se agregan automáticamente datos nuevos al circuito. Esto le permite dejar un
circuito ejecutándose en una pantalla para que siempre pueda ver la situación actual. Tenga
en cuenta que cuando el circuito se establece en más reciente (el predeterminado), el
indicador Mode en la parte superior muestra:

El fondo verde detrás de User indica que la pantalla se actualiza automáticamente con las
imágenes nuevas. Si el circuito no refleja los datos más recientes, Mode muestra un color de
fondo rojo.

Las opciones Current Frame y Grab Time le permiten ajustar la hora de término cuando
desea crear circuitos que no terminan con la imagen más reciente, por ejemplo, para el
análisis de los datos de archivo del último año.
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• El modo Current Frame establece la hora de término del circuito para que sea la hora
de la imagen que se encuentra actualmente en la ventana cuando se inicia el circuito.
Explore las imágenes hasta que decida cuál será el último marco e inicie el circuito. El
circuito termina en el marco que seleccionó.
Mientras inicia y detiene circuitos en este modo, la hora de término no es fija, sino que
se reajusta cada vez que el circuito se reinicia.

• Grab Time le permite seleccionar una hora específica para el término del circuito.
Explore las imágenes hasta que encuentre la que será el último marco y seleccione
Grab Time para fijar esta hora. Incluso si cambia los tipos de productos, todo circuito
que se inicie usará esta hora de término.

Current Frame y Grab Time no se actualizan automáticamente.
Evite dejar las pantallas en estos modos porque puede confundir a otros usuarios.

6.12 Herramienta de presentación de dia-
positivas

Puede usar la herramienta Slide Show Tool para observar el movimiento, el crecimiento y el
deterioro de los ecos del radar.

La herramienta Slide Show Tool puede mostrar distintos productos de distintos momentos
(mientras que la herramienta de animación se limita a una secuencia de tiempo lineal de un
producto). Por ejemplo, en la siguiente ilustración, se muestran 4 diapositivas distintas de
productos distintos en la ventana de vista rápida (QLW) durante 10 segundos.

Puede configurar múltiples ventanas para que las imágenes en distintas ventanas cambien al
mismo tiempo.

Para múltiples presentaciones en la ventana, conviene usar Setup > Output para
configurar la ubicación de la ventana de inicio, el tamaño de la ventana y la activación/
desactivación de la leyenda.

Puede usar la herramienta Slide Show Tool para la visualización de informes del tiempo
para los que no hay control de la pantalla por parte de un operador/observador.
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Figura 81 Slide Show Tool

1. Seleccione el icono de la presentación de diapositivas para mostrar la herramienta.

2. Ingrese la cantidad de diapositivas en Number of slides in show.

Este campo determina la cantidad de diapositivas en una presentación (máximo 16).
IRIS inserta la cantidad especificada de filas en blanco en la lista de la diapositiva.
Debe llenar cada diapositiva con información sobre el producto que mostrará.
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3. Para cada diapositiva, seleccione el número de diapositiva (o fila) y realice lo siguiente:

a. Especifique el sitio, el tipo y el nombre del producto.

Seleccione entre los productos en el disco.
Si no hay un producto del tipo que desea, por ejemplo, si aún no se hizo, seleccione
el nombre del producto en blanco "––––––" y escriba el nombre que desea. Cuando
el producto se haya transferido al disco, se mostrará en la presentación de
diapositivas.

b. Especifique el Time Lag.

Time Lag especifica la versión del producto según las siguientes reglas:
• 0 La versión actual (más reciente) del producto.
• 1 La versión anterior del producto, es decir, la segunda versión más reciente.
• 2 dos productos anteriores a la versión actual.

Esto permite la comparación de versiones del producto. En un entorno de múltiples
ventanas, la versión más reciente de un producto CAPPI se puede mostrar junto al
producto CAPPI de la hora anterior.

Para hacer una secuencia de tiempo en un solo paso, escriba el mismo tipo de
producto, el nombre para cada diapositiva, y especifique 0, 1, 2, ... para los
desfases.

c. Especifique el Dwell Time, es decir, el tiempo que se muestra la diapositiva en la
pantalla, antes de secuenciar a la siguiente diapositiva.

En el menú del ejemplo, cada diapositiva se muestra durante 10 segundos.
Dwell Time define el tiempo que permanece una diapositiva en la pantalla y un
horario preciso para mostrar las diapositivas, es decir:
• Diapositiva 1 mostrada a la medianoche 00:00:00.
• Diapositiva 2 mostrada a las 00:00:00 más el tiempo de permanencia de la

diapositiva uno.
• Diapositiva 3 mostrada a las 00:00:00 más el tiempo de permanencia de la

diapositivas 1 y 2.
El horario aumenta a lo largo del día.
Tenga en cuenta que una presentación de diapositivas puede comenzar en cualquier
momento, pero el horario lo define el algoritmo de arriba. Esto le permite configurar
presentaciones de diapositivas de múltiples ventanas donde todas las imágenes en
las distintas ventanas cambian al mismo tiempo y en la secuencia adecuada.

d. Seleccione Apply.

4. Para borrar información incorrecta sobre las diapositivas, seleccione el número de
diapositiva (o fila) y luego Clear.

5. Seleccione Save.

6. Para iniciar la presentación, seleccione Play slide show o el icono de presentación de
diapositivas en la leyenda.

Capítulo 6 – Ventana de vista rápida

RESTRINGIDO 241



6.13 Herramienta Cursor
Puede usar la herramienta Cursor para mostrar el valor de los datos en un punto y la
posición geográfica del punto. Además, también se muestra la posición del cursor en
relación con otro punto "de inicio" (rango y dirección).

Puede seleccionar el punto "de inicio" desde una lista predefinida que siempre incluye el
radar o puede "plantarlo" de manera interactiva.

Figura 82 Herramienta Cursor

Valor
Muestra el valor en la posición actual. Las unidades son las mismas que las que se
muestran en la imagen.

Latitud y Longitud
Muestran la latitud y longitud de la posición al décimo minuto más próximo.
Seleccione U para alternar las unidades entre grados decimales y minutos decimales.

Height (Altura)
Muestra la altura sobre la superficie curvada de la Tierra en la posición del cursor. 1)

No todas las pantallas tienen una altura, VIL, por ejemplo. En estos casos, se muestra
un valor de 0.0 para la altura.

Norte
Muestra la distancia Norte-Sur desde el punto "de inicio" hasta la posición del cursor. 1)

Este
Muestra la distancia Este-Oeste desde el punto "de inicio" hasta la posición del cursor.
1)

1) Las unidades son km o millas náuticas según la configuración de Units en la herramienta Opciones de pantalla. Consulte en
Herramienta Display Options: salida del producto IRIS (página 225).
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Rango y rango de Inclinación
Rango muestra el rango a lo largo de la superficie curvada de la Tierra en relación con
el punto "de inicio" (que, por lo general, se establece para que sea el radar). 1)

Inclinación muestra el rango a lo largo del haz del radar. 1)

No todas las pantallas tienen un rango de Inclinación asociado porque puede no
haber ángulo de elevación asociado con el producto. VIL es un buen ejemplo. En estos
casos, Inclinación se muestra como 0.0.

Rumbo
La dirección en grados desde el punto de inicio hasta el cursor como se midió en
sentido horario desde el norte verdadero.

Elevación
Para los productos que tienen una elevación asociada, esto muestra el ángulo de
elevación desde el punto de inicio hasta el cursor.
Todo producto que tenga una "altura" tiene una elevación (por ejemplo, PPI y CAPPI).
Si el punto "de inicio" es relativo al radar, la elevación es el ángulo de elevación del
radar.
Si el punto "de inicio" no es el radar, la elevación es el ángulo de elevación que un
observador observaría en ese punto para ver el cursor en su altura.

Altura de suelo
Muestra la altura del suelo sobre el nivel del mar en la ubicación del cursor.
Para usar Altura de suelo, debe agregar datos del Modelo de elevación digital (DEM)
en formato GeoTiff en el directorio usr/share/dt con el nombre de archivo
dem.tif. Los datos del DEM deben cubrir el domino geográfico explorado por los
radares dentro de la red. Los datos del DEM de buena calidad en formato GeoTiff se
encuentran disponibles en, por ejemplo: http://srtm.csi.cgiar.org.

Puede usar el cursor con otras herramientas, como Circuito o Vía. Sin embargo, en
algunos casos, el mouse se reserva para otras funciones.
Aún puede obtener lecturas de la herramienta de cursor mostrándolo primero y, luego,
seleccionando Vía. El cursor no se muestra en la pantalla, pero las lecturas reflejan de
manera correcta los valores donde apunta.

1. Seleccione el icono Cursor para mostrar la herramienta.

Puede mover el cursor en la pantalla haciendo clic con el mouse o arrastrando el cursor.
Los valores en el menú se actualizan a medida que mueve el cursor.

6.13.1 Selección y colocación de puntos de inicio
Puede definir puntos de inicio ( ) para medir la posición de una función del radar

meteorológico en relación con una ubicación seleccionada.

Por ejemplo,Thunderstorm located 120 km at 260° from the airport.
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Figura 83 Cursor Set/Plant Tool

1. En la herramienta Cursor, defina puntos de inicio mediante una de las siguientes
acciones:

• Use el mouse para colocar el cursor y seleccione Plant Home.
El punto de inicio, indicado con una Xse mueve hacia el cursor.

• Seleccione el icono Set Home para mostrar la herramienta Set/Plant Tool.
Seleccione una Point ID y luego, el punto Home de la lista.

6.13.2 Creación de puntos de inicio nombrados (solo operado-
res)

Si tiene el privilegio de operador en la ventana (File > Set Privilege to), puede usar la
herramienta Set/Plant para crear nuevos puntos designados para ubicaciones clave.

1. Seleccione . En la herramienta Set/Plant, realice una de las siguientes acciones:

• Ingrese la LAT/LON del punto de inicio y el nombre del punto de inicio. Puede
escribir la LAT/LON con grados y minutos o grados decimales.

• Seleccione Point ID y Save.

2. Coloque el cursor donde desea colocar el punto de inicio y haga clic en el icono Plant 
Home.

a. Seleccione Set Home para completar la LAT/LON de manera automática.

b. Reemplace el texto Plant con el nombre que desee.

c. Seleccione Point ID y Save.
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3. Para eliminar el nombre de un punto de inicio:

a. Con Point ID, seleccione el punto.

b. En el menú Point ID, seleccione Delete.

El radar se usa como punto de inicio hasta que selecciona otro.

6.14 Herramienta para hacer seguimien-
to/anotar

Figura 84 Herramienta para hacer seguimiento/anotar de la QLW

La herramienta para hacer seguimiento/anotar facilita que los elaboradores de pronósticos
realicen lo siguiente de forma manual:

• Crear y editar seguimientos interactivos de tormentas.
• Determinar la hora de llegada, la hora para la llegada y la distancia de la aproximación

más cercana a un punto de "destino" seleccionable (similar al punto de inicio en el
modo cursor).

• Agregar texto de anotación en varios tamaños y colores de fuente.
• Agregar iconos de mapas de bits.
• Determinar el centro del espiral de un tifón.

En el lado izquierdo del menú, se encuentra el control de la siguiente acción del cursor y la
selección de punto de destino del pronóstico.
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En el lado derecho del menú, se encuentra la información del seguimiento y del pronóstico,
como la posición del punto de seguimiento más reciente y la distancia, la dirección y la hora
de llegada desde el punto de seguimiento más reciente hasta el punto de destino
seleccionado.

Ejemplo de puntos de seguimiento, iconos y anotaciones

Los elementos de un seguimiento se muestran en el ejemplo de arriba.
• Los puntos de seguimiento se indican con un "+" y la hora debajo de cada uno. Tenga

en cuenta que se resalta el punto de seguimiento más reciente en 1926, ya que esto
corresponde al marco que se muestra actualmente.

• Forecast Line o la flecha muestra la posición esperada del eco, en este caso, 1 hora. Esta
línea también se muestra en un color resaltado para distinguirla de la línea de
seguimiento.

• Icon en este caso, es el símbolo de un aeropuerto.
• Ejemplos de anotaciones son el texto "Icon", "Target" y "Forecast Line".
• Target para el pronóstico, se indica con el símbolo "X". Se usa para pronosticar la hora

de llegada a una posición.
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 Información de destino

El "Destino" es una posición geográfica que se usa para pronosticar propósitos, como un
aeropuerto o un área urbana. La posición predeterminada del destino está en el sitio del
radar, pero puede seleccionar el destino desde una lista o plantar un destino con el cursor,
similar a los puntos de inicio en el menú del cursor.

La lista de puntos de destino es la misma que la lista de puntos de inicio. Solo el operador
puede guardarlos o eliminarlos. Consulte Herramienta Cursor (página 242).

Una vez que haya establecido el destino, la información de destino muestra:
Range y Bearing

Hasta el destino desde el punto de seguimiento más reciente. En el ejemplo, el destino
lleva 118° y 19 km.

Time to (destino)
La hora a la aproximación más cercana del seguimiento al destino.

Time at
La hora del momento en que el eco hace su aproximación más cercana.

Approach
La distancia de la aproximación más cercana como se midió desde la línea de
seguimiento hasta el destino.

6.14.1 Creación y edición de un seguimiento

1. Para iniciar un nuevo seguimiento.

a. Seleccione un Name de seguimiento existente o escriba uno nuevo.

b. Seleccione Delete All Points para iniciar un nuevo seguimiento.

El menú muestra Last Point of 0 para indicar que se eliminaron todos los puntos y
Action muestra Add Point.
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2. En Name, escriba el nombre del producto TRACK.

El campo Name del seguimiento muestra el nombre de un producto TRACK manual.
Los nombres siempre se procesan mediante MAN_ para indicar que estos son
seguimientos manuales en lugar de productos TRACK automáticos creados por IRIS.
• Para seleccionar un nombre de seguimiento existente, seleccione el botón junto al

nombre del campo y seleccione de la lista de nombres predefinidos. Siempre hay un
seguimiento con el nombre MAN_DEFAULT.

• Para crear un nombre nuevo, reemplace el texto en el campo del nombre. IRIS
agrega automáticamente el prefijo MAN_ y convierte el nombre a mayúscula.

• Para eliminar un nombre, seleccione el nombre que desea eliminar y seleccione
Delete. El nombre se elimina de la lista y se inserta MAN_DEFAULT como el
seguimiento activo.
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3. En Track Data, defina el seguimiento.

La columna central de la herramienta Track muestra información sobre el seguimiento
que está construyendo.

Last Point of <N>
N muestra el número de seguimiento, la anotación y los puntos del icono que se
definieron.

LAT/LON
Muestra la latitud y longitud del último punto de seguimiento, es decir, la hora de
los datos más reciente.
Seleccione U para alternar las unidades entre grados decimales y minutos
decimales.

Speed y Direction
Muestra la velocidad y la dirección de las características climáticas como se
calculan desde los dos puntos de seguimiento más recientes.
Seleccione U para elegir unidades comunes.

Forecast Time
Le permite establecer la hora del pronóstico.
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4. Para agregar puntos a un seguimiento nuevo:

a. Seleccione un producto para hacer seguimiento.

Por ejemplo, si desea hacer seguimiento de las tempestades más severas, seleccione
VIL, ya que es un buen indicador de la intensidad de las tormentas y tiende a ser
persistente.

b. Explore las imágenes para seleccionar una característica y ubique el cursor y haga
clic en ella.

Aparece un punto de seguimiento junto al texto para indicar la hora del punto.
El color del punto de seguimiento es un color especial resaltado para indicar que
corresponde a las imágenes mostradas.

c. Si no le gusta la posición del punto de seguimiento, vuelva a hacer clic para mover el
cursor a una nueva posición.

Arrastre el punto hacia donde desea y suéltelo.

d. Siga explorando las imágenes y agregando puntos de seguimiento.

Para evitar amontonar los puntos de seguimiento, omita algunas imágenes. No es
necesario tener un punto para cada imagen.

En el modo de seguimiento, utilice el mouse para agregar puntos de seguimiento y
las teclas de flecha izquierda/derecha para explorar.

5. Para eliminar un punto de seguimiento:

a. Seleccione Action > Delete.

b. Seleccione el punto de seguimiento que desea eliminar.

Siga presionando el botón del mouse para resaltar el punto que desea eliminar. Esto
resulta útil cuando desea eliminar un punto de seguimiento cercano a otros puntos
de seguimiento.

6.14.2 Adición y edición de texto de anotaciones

1. Seleccione Action > Add Text.

2. Escriba el texto que desea o seleccione una cadena de texto guardada.

3. Seleccione la fuente y el color del texto.
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4. Coloque el cursor donde desea que aparezca el texto y haga clic.

El cursor le muestra algunos caracteres de vista previa en la fuente y el color
seleccionados para que pueda decidir antes de hacer clic si el texto está bien.

5. Para eliminar, editar o mover una cadena de texto, seleccione Action > Delete.

6.14.3 Adición y eliminación de iconos de seguimiento y anota-
ciones

1. Para agregar un icono, como un aeropuerto o un símbolo de tormenta:

a. Seleccione Acción > Agregar icono.

b. Use el botón Icono para seleccionar el tipo de icono.

Por lo general, el nombre sugiere lo que es el icono.

c. Use Selección de color para seleccionar el color de icono.

d. Coloque el cursor (ahora con la forma del icono) en la pantalla y haga clic.

2. Para eliminar un icono:

a. Seleccione Acción > Eliminar

b. Seleccione el icono que desea eliminar.

3. Para crear sus propios iconos, use un programa, como Paint (en una PC) o Kiconedit (en
un sistema Linux).

Los iconos son iconos de mapas de bits con formato .xbm que se almacenan en el
directorio etc/vaisala/irisrda/overlay.
Para empezar, Vaisala proporciona varios iconos de muestra.

6.14.4 Seguimiento de tifones con la opción de agregar espira-
les

Use este modo para determinar la ubicación del centro de un tifón y para calcular los vientos
máximos de rotación. Incluso si el centro esté fuera del rango de la exploración del radar,
quizás pueda alinear la línea del espiral con los datos observados para determinar el centro.
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Figura 85 Ejemplo del seguimiento de un tifón

Los elementos del seguimiento de un tifón se muestran en el ejemplo.
• La línea de la banda del espiral se dibuja en la pantalla. Puede arrastrar el punto central

para cambiar la ubicación, o arrastrar el extremo del espiral para cambiar la rotación. El
objetivo es alinear el espiral dibujado con una de las bandas de lluvia.

• Los puntos de seguimiento del tifón se indican con un "+" y la hora debajo de cada uno.
Tenga en cuenta que se resalta el punto de seguimiento más reciente en 1048, ya que
esto corresponde al marco que se muestra actualmente.

• La línea de pronóstico o la flecha muestra la posición esperada del ojo, en este caso,
1 hora. Esta línea también se muestra en un color resaltado para distinguirla de la línea
de seguimiento.

• El objetivo para el pronóstico, se indica con el símbolo "X". Se usa para pronosticar la
hora de llegada a una posición.
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1. En la sección Track/Annotate > Spiral Winds, calcule los vientos máximos.

El modelo de viento de la QLW de IRIS revisa los datos y busca el mejor ajuste de una
rotación sobre el punto central, más una traslación horizontal media.

a. Ingrese los valores.

• La velocidad del viento y el viento máximo en ese diámetro.
• La dirección y velocidad promedio de la traducción.

b. Seleccione Compute.

El cuadro de texto a la derecha del botón Compute muestra el estado de este
cálculo.
Tenga en cuenta que este cálculo requiere mucha CPU.
Debe tener los datos de la velocidad polar en su máquina activa. Si los datos no
están disponibles, la opción Compute aparecerá en color gris.

Si mueve la ubicación del espiral, el estado muestra Repositioning Spiral. Esto
permanecerá hasta que presione el botón. En este caso, muestra Fitting winds, y
finalmente, Success. Puede tomar hasta un minuto para hacerse el ajuste.
Hay una cantidad de errores posibles en el ajuste. Por ejemplo:
• Si el clima está despejado y no hay velocidades en los datos, el estado muestra
Error: 0 velocity points.

• Si el ajuste no se puede resolver, el estado muestra Error: Bad fit.
Si intenta ajustar un movimiento ciclónico a un conjunto de datos que no está rotando,
obtiene números inútiles, como la velocidad de una rotación pequeña en un rango
amplio. Además, debido a que el radar no puede detectar rotación sobre el radar, si
coloca el cursor dentro de algunos kilómetros del radar, los números no son válidos.
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2. Para cambiar el hermetismo de la línea del espiral, use el widget Angle y aumente el
ángulo hacia arriba y abajo de 5° a 20°.

Este es el ángulo en grados que el espiral del algoritmo le hace a un círculo. Un número
menor hace un espiral más hermético.

a. Establezca la dirección del movimiento ciclónico en su ubicación en CW o CCW con
la opción Rotate.

b. Establezca el rango mínimo y máximo que se muestra del espiral usando el tipo
Range en los campos.

6.15 Herramienta de pronóstico
Use la Forecast Tool para llevar productos al futuro para ver la posición de pronóstico de las
características climáticas.

En el siguiente ejemplo, la región exterior oscura representa el área no explorada, mientras
que el círculo interior más claro representa el área explorada. La imagen del radar se
adelanta 3 horas para un movimiento supuesto de 24 puntos a 43º.
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Figura 86 Ejemplo de pronóstico con un tifón

La imagen se puede cambiar de las siguientes maneras:
• Entrada del usuario

El pronosticador ingresa una velocidad y una dirección como en el ejemplo.
El eco se cambia por una velocidad y dirección constantes. Esto se muestra en el
ejemplo anterior.

• Producto FCAST (IRIS o producto de pronóstico del usuario)
Los productos de pronóstico se pueden producir con IRIS o con programas externos
para crear productos de pronóstico e introducirlos en el IRIS.
Los ecos pueden estar sujetos tanto a un campo de movimiento no uniforme y un
campo de cambio de intensidad no uniforme.
El producto FCAST del IRIS calcula el campo de viento uniforme según el movimiento
de eco promedio como se calcula de una correlación cruzada en 2D de la imagen actual
y anterior. No se calcula cambio de intensidad. Consulte al administrador del sistema
para ver qué productos FCAST están disponibles en su sistema.
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Pronóstico de entrada del usuario

Si obtuvo una velocidad y una dirección nominales del producto de rastreo manual, puede
realizar una proyección de pronóstico manual con la siguiente configuración:

• Botón Use FCAST Product presionado.
• Speed y Direction se establecen manualmente mediante tecleo o potenciómetro

corredizo.
• FCAST Time se establece en qué tan hacia adelante desea mirar.
• Valid Time muestra la hora a la cual el pronóstico es válido; es decir, la hora de datos de

la visualización más el Forecast Time.

Pronóstico del producto FCAST
• Seleccione Use FCAST Product.
• Seleccione el producto de pronóstico, si hay alguno disponible, del widget de opción.

En este caso, se toman la velocidad y la dirección del producto de pronóstico y los campos
de entrada del usuario no tienen sensibilidad.

El algoritmo de FCAST en la Quick Look Window toma como entrada un producto y un
producto de pronóstico (matriz de vectores de movimiento y cambios de intensidad).

Los pasos involucrados en el pronóstico son los siguientes:
1. Se crea una matriz de salida con las mismas proyección y resolución que el producto de

entrada (por ejemplo, una entrada CAPPI que queremos pronosticar).
2. Los vectores de movimiento del producto de pronóstico y los puntos de la matriz de

cambio de intensidad se vuelven a asignar en la matriz de salida. Esta nueva asignación
significa que el producto de entrada y el producto de pronóstico no deben tener la
misma proyección, la misma resolución ni el mismo rango.

3. Por lo general, hay muchos más píxeles en la matriz de salida que puntos de grilla en el
producto de pronóstico. Por lo tanto, es necesario interpolar el vector de movimiento
auxiliar y los puntos de cambio de intensidad a cada punto de píxel en la matriz de
salida. El resultado es que cada píxel de la matriz de salida tiene un vector de
movimiento y un cambio de intensidad relacionados.

4. Para cada píxel de la matriz de salida, el vector de movimiento se usa para "mirar atrás"
en el tiempo según el tiempo de pronóstico seleccionado. Este vector "con
desplazamiento hacia atrás" apunta a un píxel en el producto de entrada ajustado. Se
usa el valor de este píxel para el píxel del producto de salida.

5. Los cambios de intensidad en la matriz de salida se aplican píxel por píxel para ajustar
los datos para crecimiento y deterioro.

Más información

‣ FCAST: Pronóstico (página 42)

6.16 Herramienta de sección transversal
(XSECT)

La sección transversal interactiva es una buena manera de ver la estructura de la tormenta y
las alturas del eco.

Producto y visualización del IRIS Guía de usuario M211319ES-J

256 RESTRINGIDO



Figura 87 Ejemplo de sección transversal con un tifón

La ventana en la esquina superior izquierda es una pequeña ventana con formato XSECT.
Esto aparece de forma automática cuando hace una sección transversal. Tenga en cuenta
que debido a que el radar no puede ver la superficie de la Tierra, la parte inferior de la
sección transversal es un límite curvado.

La línea de la sección transversal se muestra en la pantalla. La pequeña flecha en el centro
de la línea muestra la forma en que ve la sección transversal. En este caso, la sección
transversal se ve desde el este a través del ojo del tifón.

La herramienta XSECT, que se muestra a la derecha, le permite configurar casi todos los
aspectos de la sección transversal.

Escalas de colores de la pantalla de la sección transversal

La sección transversal usa la escala de colores configurada en la herramienta Color Scale
para el tipo de datos que se muestra.

La sección transversal y las escalas de colores del producto base coinciden si tienen el
mismo tipo de datos. Por ejemplo, si solicita una sección transversal de dBZ y el producto
base es dBZ, la escala de colores de la sección transversal coincide con el producto de
entrada.
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Si desea cambiar la escala de colores en la sección transversal, use la herramienta Color 
Scale y seleccione el tipo de datos (dBZ, V y similar). Luego, vuelva a hacer XSECT. Los
colores nuevos se aplican cuando se vuelve a hacer la sección transversal.

Escala de rango de la sección transversal

La escala de rango de altura es km o miles de pies y la escala de rango horizontal es km o
millas náuticas, según la selección de unidades en la herramienta Display Options.

El origen (rango cero) corresponde al punto en la línea o su extensión más cercana al radar.
Es decir que el origen es el punto donde estaría la línea o una extensión de ella en un ángulo
correcto a una línea dibujada desde el radar.

Range 0

+Range

- Range

Cross-Section

Range Convention

Figura 88 Escala de rango de la sección transversal

 Pantalla de la sección transversal en ventana estándar

Para mostrar secciones transversales en una ventana estándar seleccione un producto
XSECT.

Las secciones transversales heredan el nombre de la ventana y del tipo de datos cuando se
enumeran en la herramienta de selección de productos.

6.16.1 Creación de una sección transversal

Las secciones transversales se generan al interpolar datos polares originales.
Para hacer una sección transversal, debe tener archivos de introducción del procesador de
señal o de los datos SIN PROCESAR en su sistema. Si la ventana se exporta a su pantalla
desde otro sistema, ese sistema debe tener los archivos de introducción.

1. Seleccione un producto "base" adecuado.

No puede usar productos como RAIN1 y RAINN para una sección transversal ya que no
representan una hora específica.

2. Seleccione la herramienta XSECT (el icono con el cuchillo).
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3. Use el mouse para colocar los puntos finales de la línea de la sección transversal.
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4. Configure la sección transversal:

a. En Height, especifique la altura de la sección transversal en km al 0,1 km (100 m)
(328 pies 1 pulgadas) más cercano.

b. En Data, seleccione los tipos de datos de la lista.

La variable izquierda representa el tipo de datos de entrada y la variable derecha
representa lo que se muestra.
El siguiente ejemplo muestra un ejemplo de diversidad de polarización.

c. En Size, seleccione un tamaño de ventana grande o pequeño.

Por lo general, un tamaño pequeño es mejor, ya que ocupa menos área de la
pantalla y genera con mayor rapidez.

d. En Smoother, seleccione la escala de la longitud de la estabilización horizontal y
vertical en km.

Producto y visualización del IRIS Guía de usuario M211319ES-J

260 RESTRINGIDO



5. Para la sección transversal, seleccione el icono XSECT.

6. Monitoree el progreso de la configuración de la línea de la sección transversal en el
campo Status, en la parte inferior de la herramienta.

• Range y Azimuth se refieren al punto central de la línea.
• Status muestra el progreso: Setup, Running y Done.

Si los datos de introducción para la hora de los datos solicitada (es decir, la hora del
producto base) no están en el disco, el estado muestra Error y un mensaje le informa
que los archivos de introducción no estaban disponibles. En este caso, avance en el
tiempo y vuelva a intentarlo, o revise el Ingest Summary Menu para ver los datos
disponibles.

6.17 Herramienta de opciones de salida
del producto

Hay muchos productos para los cuales puede especificar opciones de salida adicionales. Si
uno de estos productos está en la pantalla, se habilita el icono de la herramienta Output 
Options.

La herramienta Output Options le permite ajustar la visualización de estos productos para
su aplicación.

Puede seleccionar File > Save para las opciones VVP, WIND/FCAST y NDOP para guardar la
configuración de su ventana (no afecta otras ventanas).
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Si está usando productos WIND, FCAST o NDOP como superposiciones en otros
productos, a veces, conviene mostrar (por ejemplo) el producto WIND y la herramienta de
opciones para WIND. Luego, deje la herramienta para que pueda usarla, si es necesario,
cuando ve WIND superpuesto en otro producto.

6.17.1 Herramienta de selección de altura CAPPI

Para productos CAPPI con varios niveles (productos CAPPI en 3D), puede usar esta
herramienta para cambiar las alturas.

También puede usar las teclas de flecha UP/DOWN (el cursor debe estar en la parte de la
pantalla de la ventana para usar las teclas de flecha).

Más información

‣ CAPPI: Indicador de posición en plano de altitud constante (página 41)
‣ Opciones de salida NDOP (página 263)

6.17.2 THICK Opciones de salida

Figura 89 Herramienta de salida THICK
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El producto THICK muestra la diferencia en altura de la instancia más baja y más alta de
cualquier contorno de reflectividad.

Es posible que el producto THICK también muestre el valor de reflectividad promedio
dentro de la misma capa. Esta herramienta le permite cambiar los tipos de datos que se
muestran en el producto THICK.

6.17.3 Opciones de salida NDOP

Las opciones de salida del producto NDOP son una combinación de las opciones de WIND y
la selección de altura de CAPPI.

Debido a que esta herramienta funciona con WIND, FCAST, NDOP y CAPPI, es posible que
quiera dejarlo en la pantalla.

Más información

‣ NDOP : Doppler múltiple (página 175)
‣ Herramienta de selección de altura CAPPI (página 262)
‣ Opciones de salida WIND y FCAST (página 271)

6.17.4 Opciones de salida VAD
Durante la visualización, puede seleccionar uno o todos los ángulos de elevación en el
producto VAD.

En la siguiente figura se brinda un ejemplo de un ángulo único. Estos datos no se
desplegaron.
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Figura 90 Ejemplo de pantalla del acimut de velocidad

Figura 91 Herramienta de salida VAD

All Heights/1 Height
Los productos VAD del IRIS constan de un trazado de velocidad para todos los
acimuts. Puede elegir visualizar solo un trazado de una altura o muchos trazados que
muestren todas las alturas.
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Height
Si seleccionó 1 height, utilice esta barra deslizable o las teclas del cursor para moverse
hacia abajo y hacia arriba en la lista de alturas.

Plot Max
Aquí configure la velocidad máxima que se mostrará en los trazados.

Más información

‣ VAD: pantalla del acimut de velocidad (página 98)

6.17.5 Opciones de salida VVP: Tiempo/Altura
Puede usar las Time-Height Output Options para mostrar una sección cruzada de altura
contra tiempo de los parámetros VVP con el fondo de color especificado y un trazado
superpuesto.

El producto VVP muestra los perfiles verticales de las propiedades de viento Doppler
promedio sobre el radar, como velocidad del viento, dirección del viento y divergencia. El
menú Output Options le permite elegir mostrar los datos de viento en una de las siguientes
maneras:

• Elija Display_Style > Graphs para mostrar un gráfico de parámetros de VVP contra
altura en un momento único. Puede seleccionar 1, 2 o 3 gráficos.
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• El producto WIND traza la velocidad y la dirección del viento horizontal.
Para este tipo de producto, puede elegir si mostrar todas las mediciones de viento o
solo aquellos vientos que se desvían de la media.
Puede elegir lengüetas de viento o cadenas de viento para representar velocidad y
dirección, y puede especificar un porcentaje de umbral de cobertura.

1. Revise que VVP sea el tipo de producto actual.

2. Seleccione Options.

Se muestra el menú Time-Height Output Options.

3. En Color Background, elija la información que desea mostrar en el fondo.

4. En Overlay Plot, elija el tipo de trazado de superposición.

• Las lengüetas de viento utilizan la convención meteorológica estándar de
1/2 lengüeta para 5 nudos, 1 lengüeta para 10 nudos y triángulos para 50 nudos.

• Las cadenas de viento apuntan lejos de la dirección del viento, y la longitud de la
cadena indica la velocidad de viento relativa.
Puede establecer la longitud máxima de las cadenas de viento utilizando Display 
Style > Graphs Scale Limit para la velocidad del viento.

• Las líneas del Axis of Dilatation muestran el ángulo de "estiramiento".
Los frentes tienden a formarse en forma paralela a este ángulo. La longitud es
proporcional a la deformación que indica la fuerza del estiramiento.
Puede establecer la longitud máxima de la dilatación utilizando Display Style > 
Graphs Scale Limit para la deformación.

• Seleccione None si no desea mostrar un trazado de superposición.

5. En Time Span min, establezca la duración del eje de tiempo (horizontal) en minutos.
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6. En Time Step min, establezca el paso de tiempo mínimo para trazar los datos.

Es útil para evitar colisiones de las lengüetas de tiempo cuando los datos están
separados por poco espacio. Escriba 0.0 para ver todos los datos.
Por ejemplo, si hay un perfil de VVP cada 5 minutos y este campo se establece en 10,
entonces se traza cada perfil.

7. En Max Height km, escriba la altura máxima (escala vertical) que desee mostrar.

Tenga en cuenta que la altura del perfil de VVP puede ser menor que la altura que
muestre, en cuyo caso se muestra un color de fondo en blanco.

8. Para evitar colisiones de las lengüetas de viento en altura, puede especificar el Height 
Step km.

Escriba 0.0 para ver todos los datos.

9. En algunos casos, las estimaciones de viento son ruidosas debido a señales débiles o
cobertura deficiente. Si es necesario, utilice Std Dev Thresh % para umbralizar
estimaciones deficientes para que no se muestren.

Especifique un número entre 0 (no umbralización) y 100 (todo se deja fuera del
umbral). Un valor de 80 es lo típico.

10. Para probar la configuración, seleccione Apply.

El punto de velocidad se muestra si lo siguiente es verdadero:Stan dardDeviation < − In tℎresℎold100 × 1.0 + Velocity/10.0
Más información

‣ Generación de la salida de producto VVP (página 105)
‣ Opciones de salida VVP: Gráficos de línea (página 267)
‣ Herramienta de escala de colores (página 223)
‣ Opciones de salida WIND y FCAST (página 271)

6.17.6 Opciones de salida VVP: Gráficos de línea
Los productos VVP se pueden mostrar en formato gráfico de parámetros de perfil de viento
VVP contra altura. Se pueden trazar 1, 2 o 3 gráficos lado a lado.
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1. Utilice la herramienta Product Selection para seleccionar un producto VVP.

2. Seleccione el icono Options para mostrar el menú Display Options.

Asegúrese de que el Product Type sea VVP.

3. Seleccione Options para mostrar el menú VVP Output Options.

Se muestra el submenú Graphs o Time Height.

4. Si se muestra Time Height, seleccione Display_Style > Graphs.
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5. Realice cambios para habilitar los parámetros de trazado que desee usar y los valores
relevantes típicos en la columna Scale Limits:

Wind Speed
Seleccione trazar la velocidad del viento en el gráfico.
Escriba el valor para especificar la velocidad de viento máxima que desea trazar.

Wind Direction
Seleccione trazar la dirección del viento. No puede editar la columna Scale Limits
para este campo.

Divergence
Seleccione trazar la divergencia del viento. Escriba el valor para especificar la
divergencia máxima que desea trazar.

Vertical Velocity
Seleccione trazar la velocidad vertical. Escriba el valor para especificar la
velocidad vertical máxima que desea trazar.

Deformation
Seleccione trazar la deformación horizontal. Escriba el valor para especificar la
deformación máxima que desea trazar.

Axis of Dilation
Seleccione trazar el eje de dilatación. No puede editar la columna Scale Limits
para este campo.

Reflectivity
Seleccione trazar la reflectividad. Escriba el valor para especificar la reflectividad
máxima que desea trazar.

Max Height in km
Escriba la altura máxima para los datos que incluirá en el trazado.

Std Dev Thresh %
Ingrese el porcentaje umbral de desviación estándar para los datos que incluirá
en el trazado. Se usa para umbralizar estimaciones pobres. La escala va del 0 (sin
umbral) al 100 (umbralización total). Un valor de 80 es lo típico.

Alternativamente, seleccione Defaults para usar un conjunto razonable de valores
predeterminados como punto de inicio.

6. Seleccione Apply.

Los cambios se muestran en la pantalla VVP actual como gráfico.

7. Seleccione Display Options > File > Save.

Más información

‣ Generación de la salida de producto VVP (página 105)
‣ Opciones de salida VVP: Tiempo/Altura (página 265)
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6.17.7 Opciones de salida WARN

Figura 92 Opciones de salida WARN

Los centroides WARN de IRIS se muestran como una elipse con un nombre adentro o como
un icono gráfico rotado hacia la dirección de movimiento del centroide.

Centroid Label

Las opciones de Centroid Label son para una segunda línea de etiquetas en elipsis o para
una etiqueta a la derecha del icono.

El centroide WARN tiene 4 opciones de etiquetas. Los datos que se muestran provienen de
la primera de las 3 entradas posibles para la advertencia. Las unidades son las mismas que
en una pantalla de los datos de IRIS estándar, excepto que la cizalladura del viento se
muestra como pérdida/ganancia de nudos y la altura se muestra en kilopies.

None
No hay etiqueta adicional.

Maximum
El centroide está etiquetado con el valor máximo de los datos del centroide.

Average
El centroide está etiquetado con el valor promedio de los datos del centroide.

Speed
El centroide está etiquetado con la velocidad de un objetivo. Esto solo se aplica a los
sistemas que tienen el producto DWELL configurado para la detección de objetivos.

Centroid Fill

Las opciones Centroid Fill se aplican a pantallas del estilo elipsis cuando el producto WARN
se superpone en otro producto.

Puede elegir el estilo del efecto de relleno del centroide para que se pueda identificar
claramente en la pantalla. Las opciones son las siguientes:

Open
El área del centroide no está rellenada, está delineada.

Hatched
El área del centroide está rellenada con un patrón inclinado de líneas.

Producto y visualización del IRIS Guía de usuario M211319ES-J

270 RESTRINGIDO



Filled
El área del centroide está rellenada con un color sólido.

Uso operativo

Configure las opciones de Warn Tool y en Display Options, seleccione un producto para
superponer.

Seleccione File > Save para guardar las opciones de Warn Tool.

6.17.8 Opciones de salida WIND y FCAST

1. Asegúrese de que WIND o FCAST sean el tipo de producto actual.

2. Seleccione Options.

Aparece el menú de Wind Output Options con opciones para trazar la velocidad y la
dirección del viento horizontal.
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3. Defina las opciones de la pantalla WIND.

Subtract Mean Wind
Seleccione Yes para que IRIS reste el vector de viento medio de todos los
vectores de viento y muestre los vectores de viento de perturbación.
Seleccione No para mostrar el ventor de viento completo.

Wind Display Style
Muestre los vectores del producto WIND como lengüetas de viento o cadenas de
viento.
Los vectores de WIND son estimaciones de vientos horizontales que utilizan un
algoritmo de viento uniforme en sectores alrededor del radar.
Las lengüetas de viento apuntan hacia la dirección del viento, con marcas de
escotilla que denotan la velocidad del viento conforme a la convención
meteorológica estándar de 1/2 lengüeta para 5 nudos, una lengüeta completa
para 10 nudos y triángulos para 50 nudos.
Las cadenas de viento apuntan lejos de la dirección del viento, con la longitud de
la cadena que indica la velocidad de viento relativa (a más larga la cadena, mayor
la velocidad).

String Max Length
Si elige Strings como el estilo de visualización del viento, ingrese la longitud de
cadena máxima en metros/segundo.
Cualquier punto de datos que supere esta longitud se muestra a la longitud
máxima.

Area Coverage Threshold %
Agregue puntos umbrales para los cuales la cobertura aérea de los datos de
velocidad radial sea menor que el valor seleccionado. Un valor de 50 % es lo
típico.

Más información

‣ Opciones de salida NDOP (página 263)
‣ Opciones de salida VVP: Tiempo/Altura (página 265)
‣ FCAST: Pronóstico (página 42)
‣ WIND: dirección y velocidad del viento (página 113)

6.18 Impresión y exportación de pantallas
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1. Para exportar una pantalla, seleccione File > Export

Aparece la herramienta Export Tool con la configuración de la salida a un archivo de
disco en la computadora local o a una computadora remota en los formatos GIF, TIF,
BMP o Post Script.
Los formatos se controlan en Setup > Output.

2. Para imprimir una pantalla, seleccione File > Print

Más información

‣ Envío de un producto a un dispositivo (página 281)

6.19 Comandos del teclado de la QLW

Para usar los comandos del teclado, coloque el cursor en el área de la imagen de la
ventana de vista rápida (QLW).

Pulsación de teclas Acción

↔ Flecha hacia la IZQUIERDA/
DERECHA

Avanzar/retroceder en secuencia de tiempo en un solo paso

BARRA ESPACIADORA Alternar la activación y desactivación del circuito

↕ Flechas hacia ARRIBA/ABAJO Paso de altura hacia arriba/abajo para CAPPI o NDOP
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7. Solicitud de la salida de pro-
ducto

7.1 Descripción general de la solicitud de
la salida de producto

Los archivos del producto creados por el generador de productos se almacenan en el disco.
De allí, se pueden enviar a pantallas, impresoras, medios de almacenamiento u otras
computadoras.

El proceso de salida agrega toda superposición solicitada y da formato al producto para el
dispositivo de salida seleccionado. El menú Product Output dirige la salida al destino
solicitado.

Puede usar el menú Product Output para explorar los archivos del producto disponibles y
seleccionar algunos para enviar a su estación de trabajo. También puede solicitar que todas
las versiones futuras de un producto en particular se envíen automáticamente a su estación
de trabajo o dispositivo seleccionado. Por ejemplo, si desea ver un producto PPI cada vez
que se ejecute una tarea de exploración de volumen particular. Además, un operador puede
enviar un producto a un destino en particular, como una pantalla remota, una impresora o un
DVD.

7.2 Dispositivos y archivos de salida del
producto

El menú Product Output puede enrutar la salida a muchos dispositivos:
Printer

Impresoras postscript configuradas en su sistema.

Window
Una ventana de color en la estación de trabajo local. El host IRIS genera la pantalla. La
ventana se puede exportar para que aparezca en una estación de trabajo remota.

Network
Envía archivos del producto a otro sistema a través de la red o a un archivo de disco en
el sistema. El sistema remoto puede recibir una notificación con conector del archivo.
El formato del archivo se puede convertir a cualquier otro formato usando "canales de
salida".

Archive
Se puede usar una unidad de cintas o un disco MO para almacenar datos.

Puede configurar la lista de dispositivos de salida en la herramienta Setup. Consulte IRIS and
RDA Utilities Guide (M211316EN).

Para obtener una lista de los canales de salida suministrados con el sistema, consulte IRIS
and RDA Utilities Guide (M211316EN).
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Los productos cartesianos se pueden mostrar en una ventana usando hasta 32 colores de
datos, con colores adicionales disponibles de superposición y anotación. Se puede mostrar
cualquier resolución del producto. Los tamaños de la pantalla de IRIS estándar incluyen las
siguientes resoluciones:

• Medium. Para pantallas de 480 x 480 píxeles.
• High. Para pantallas de 720 x 720 píxeles.
• X-High. Para pantallas de 940 x 940 píxeles.

7.3 Acceso al menú Salida del producto

Menú de filtro
Le permite elegir los archivos que aparecen en la lista de productos.
Consulte Filtros de salida del producto (página 276)

Lista de productos
Muestra la lista de productos que seleccionó.
Consulte Salida del producto: Lista de productos (página 278)

1. Seleccione Menus > Product Output de la barra de menús de IRIS o de cualquiera de
los otros menús de IRIS.
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7.3.1 Filtros de salida del producto

Figura 93 Filtros de salida del producto

Cuando ingresa por primera vez al menú Product Output, todos los productos posibles se
enumeran en la parte inferior del menú. La lista puede ser bastante larga, lo que haría difícil
encontrar los productos que necesita. Use la sección Filter para reducir la lista solo a los
productos que le interesen.

Site
Ingrese una ID del sitio para seleccionar datos de un solo sitio del radar o ingrese el
carácter comodín para seleccionar datos de todos los sitios.
Seleccione Site para ver una lista de sitios conocidos. Los contenidos de esta lista
dependen de los sitios que se configuran en la herramienta Setup.

Type
Ingrese un tipo de producto en este campo para seleccionar productos de un solo tipo
o ingrese el carácter comodín para seleccionar productos de todos los tipos.
También puede seleccionar desde una lista de tipos con los archivos de datos.

Product Name
Ingrese el nombre de un producto para reducir la lista a productos que tengan ese
nombre.
Puede incluir caracteres comodines en el nombre del producto. Un signo de pregunta
(?) equivale a cualquier carácter único; un asterisco (*) equivale a cualquier secuencia
de cero o más caracteres.

TASK
Ingrese el nombre de una tarea para filtrar productos generados por una tarea
específica.
Puede incluir caracteres comodines en el nombre de la tarea.
Por ejemplo, al ingresar el nombre de un producto de *PPI*_?, se seleccionan todas
las tareas híbridas que contienen PPI en algún lugar del nombre.

Scan
Ingrese un tipo de exploración en este campo para seleccionar productos de un solo
tipo, ingrese el carácter comodín para seleccionar productos de todos los tipos o
seleccione desde una lista de tipos.

From, To
Ingrese un rango de horas para filtrar productor por hora del día.
También puede seleccionar desde una lista de rangos.
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Day, Month, Year
Ingrese un día, mes o año para filtrar productos por fecha.
También puede seleccionar desde una lista de valores.

Files
Controle la cantidad de archivos a incluir en la lista.

Max
Controle la cantidad de productos a incluir en la lista. "*" significa que no se aplica
ningún límite. Todas las listas de IRIS se limitan a un máximo de 1000.

Apply
Seleccione Apply para actualizar la lista de productos, según su criterio de selección.

Grab
Si seleccionó un producto, seleccione Grab para insertar el sitio, tipo y nombre del
producto, la tarea y la fecha en los campos del filtro.

All Wild
Seleccione All Wild para convertir todos los campos al carácter comodín.

Wild Time
Seleccione Wild Time para cambiar solo los campos de horas, mes, día y año al
carácter comodín.

Commands
Seleccione una de las siguientes operaciones para realizar en los archivos de producto
seleccionados a través del menú del filtro. Estos comandos se aplican a los productos,
pero no a los encabezados.
• Keep

Evita que el proceso de vigilancia elimine los productos seleccionados.
• Delete

Marca los archivos seleccionados para que el proceso de vigilancia los elimine.
• Reingest

Marca los archivos seleccionados que se deben volver a introducir.
• Remove Tag

Desmarca todo producto seleccionado que se haya etiquetado.
• Send

Envía todos los productos seleccionados al dispositivo de salida.
• Cancel Send

Cancela toda solicitud enviada para los productos seleccionados.

Opciones de pantalla 

Seleccione este icono para especificar las opciones de salida que se usarán cuando se envíe
el producto a un dispositivo de visualización.

Configuración de la escala de colores 

Seleccione este icono para especificar las opciones de color que se usarán cuando se envíe
el producto a un dispositivo de visualización.
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Opciones de salida específica del producto
Opts

Este botón aparecerá en color gris a menos que seleccione el tipo de producto CAPPI,
FCAST, NDOP, THICK, VVP o WIND.

• CAPPI : Indicador de posición en plano de altitud constante (página 41)
• FCAST : Pronóstico (página 42)
• NDOP : Doppler múltiple (página 175)
• THICK : producto de espesor de eco (página 90)
• VVP : procesamiento de volumen de velocidad (página 102)
• WIND : dirección y velocidad del viento (página 113)

Mostrar encabezados

Muestre las líneas del encabezado con una de las siguientes opciones:
• Files Only

Muestre archivos en el inventario con un encabezado para cada archivo que se muestra.
Esto también muestra Headers in Use.

• Headers Only
Muestre solo las líneas del encabezado.

• Files + Headers
Muestre archivos y todos los encabezados.
Los únicos encabezados adicionales que se ven en Files + Headers son para productos
en el disco que puede haber eliminado recientemente.

• Headers in Use
Muestre encabezados que tienen configuradas solicitudes de envío automático.
Esto muestra encabezados con solicitudes de envío automático para cualquier salida,
no solo para el dispositivo de salida seleccionado.

Puede que desee configurar sus asignaciones de salida del producto según los
encabezados del producto solamente. Para hacerlo, seleccione Headers Only.

7.3.2 Salida del producto: Lista de productos
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La lista de productos en la parte inferior del menú Product Output enumera cada nombre
del producto en una línea del encabezado, seguido de las versiones del producto que está
en el disco. Cada versión se identifica mediante la fecha en que se recolectaron los datos,
que es la hora de inicio de la tarea asociada.

Site y Type

El campo Site muestra la ID del sitio del radar donde se recolectaron los datos para el
producto.

El campo Type muestra el tipo de producto, como PPI o RHI.

Puede hacer clic derecho en los campos para administrar los archivos. Consulte Marcación
de un producto (página 282).

Name

El nombre del producto para la configuración de este tipo de producto.

Product-Specific Parameters

Los parámetros estándar de generación de producto que se muestran en la siguiente tabla
se toman de la configuración del producto y se muestran en Product-Specific Parameters.

Tabla 21 Parámetros estándar de generación de producto

Tipo de producto Parámetro 1 Parámetro 2 Parámetro 3

BASE ... Umbral de dBZ Rango máximo

BEAM Límites de acimut Límites de elevación ...

CAPPI Parámetros de datos Altura Rango máximo

CATCH Horas ... Rango máximo

FCAST Velocidad y dirección Umbral de datos Rango máximo

GAGE Minutos promedio Lluvia/Disdrómetro ...

IMAGE ... ... Rango máximo

MAX Base de la capa Superficie de la capa Rango máximo

NDOP Lista de sitios ... Rango máximo

PPI Parámetros de datos Elevación Rango máximo

RAIN1 Producto de entrada Minutos promedio Rango máximo

RAINN Horas ... Rango máximo

RAW Parámetros de datos Todos/Ninguno Rango máximo

RHI Parámetros de datos Acimut Rango máximo

RTI Parámetros de datos Inicie Az y El Rango máximo
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Tipo de producto Parámetro 1 Parámetro 2 Parámetro 3

SHEAR Marcas R, A o E Elevación Rango máximo

SLINE Elevaciones ... Rango máximo

SRI Nivel de derretimiento Marcas de perfil/convec-
ción

Rango máximo

TDWR Velocidad del viento CF Dirección del viento CF Velocidad de ráfaga CF

TOPS ... Umbral de dBZ Rango máximo

TRACK Producto de entradas Umbral del área Umbral de datos

USER Parámetros de datos ... Rango máximo

VIL Altura mínima Altura máxima Rango máximo

VVP Altura mínima y máxima Cantidad de pasos Bin Quota

WARN Símbolo y área Cantidad de entradas Cantidad de aciertos

WIND Altura mínima y máxima ... Rango máximo

XSECT Parámetros de datos Ctr punto R, AZ Ángulo de orientación

Resolución

Los parámetros específicos del producto para productos cartesianos incluyen la resolución
horizontal del producto en píxeles. Para productos 3-D, también se incluye la resolución
vertical, por ejemplo, 480×10.

El proceso de salida del producto siempre genera una pantalla incluso si la resolución de
salida no coincide con las capacidades de su pantalla. Lo hace omitiendo o duplicando
píxeles, según sea necesario. Por ejemplo, si envía una pantalla de baja resolución a un
dispositivo de visualización de resolución media, como una impresora, el proceso de salida
del producto duplica cada píxel para ajustar la imagen en la impresora a tamaño completo.

TASK

El nombre de la tarea asociada.

Time

La fecha y hora (hora local) cuando se recopilaron los datos del producto.

Request

Use el campo Request para solicitar la salida del producto. Coloque el cursor del mouse
sobre una entrada de la lista de productos y seleccione Send.

El menú que se muestra depende de la entrada que seleccionó en la lista.

Si selecciona una línea del encabezado de la lista, puede elegir enviar todos los productos o
solo la siguiente ocurrencia del producto al dispositivo de salida. También puede elegir sitios
específicos donde desee recibir la salida. Cada sitio que elige se marca con un asterisco.

Después de emitir la solicitud Send, el campo Request muestra un mensaje donde se indica
el estado de la solicitud.
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7.4 Envío de un producto a un dispositivo
Puede enviar uno o más productos existentes a un dispositivo de red, o uno o más
productos futuros a un dispositivo de red en uno o más sitios.

1. Para enviar productos existentes:

a. Seleccione Dispositivo.

b. Seleccione el dispositivo al que desea enviar el producto.

c. Seleccione los productos que desea enviar mediante una de las siguientes acciones:

• Haga clic en el botón izquierdo del mouse sobre un elemento de la lista.
Presione CTRL+clic para seleccionar más de una entrada de la lista.

• Haga clic y arrastre el mouse para seleccionar un grupo de entradas de la lista.
Presione CTRL+clic y arrastre el mouse para seleccionar varios grupos de
entradas.

• Use el menú Filtro para crear una lista de los productos que desea enviar.

d. Seleccione Enviar en uno de los siguientes menús:

• Si seleccionó las entradas con el mouse, coloque el cursor sobre la columna de
solicitud y haga clic con el botón derecho del mouse.

• Si seleccionó las entradas del menú Filtro, seleccione Comandos.

e. Seleccione Enviar:

El producto se marca para enviarse al dispositivo seleccionado y espera que el
formateador de salida lo envíe.

Si la selección contiene encabezados y productos, el comando solo se aplica a
los productos.
Para realizar una operación en los encabezados, debe seleccionar solo
encabezados.

2. Para enviar una o más versiones futuras de un producto:

a. Seleccione el encabezado para el tipo de producto que desea enviar.

b. Haga clic derecho en la columna de solicitud para seleccionar cualquier cantidad de
sitios que su sistema conozca para recibir todas las versiones siguientes del
producto.

Cuando se agrega al disco una versión nueva del producto se emite de forma
automática una solicitud de envío.
Aparece un mensaje de estado en la columna Solicitud.

3. Para cancelar una solicitud de envío, coloque el cursor sobre la columna Solicitud y
seleccione Cancelar.

Si selecciona un solo producto, cancela solamente la solicitud de envío de ese producto.
Para cancelar la solicitud de productos futuros, haga clic con el botón derecho en la
columna de solicitud y cancele la selección del sitio.
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El estatus de envío se muestra con los siguientes indicadores:
Listo

El producto se envió correctamente al dispositivo de red seleccionado.

Enviar
Hay una transmisión de producto pendiente con un tiempo de espera máximo
configurable de 1 hora o menos. El usuario debe retransmitir manualmente el producto
con el botón ENVIANDO si se alcanza el tiempo de espera.

Enviando
Está en curso la transmisión del producto.

----
En este momento, no hay solicitud.

Anulado
Por ejemplo, la transmisión falló debido a un corte en la red. El producto se debe
retransmitir con el botón ENVIANDO de forma manual.

Cancelado
Debido a que se alcanzó el tiempo de espera de transmisión del producto o a que el
usuario canceló la transmisión, una transmisión de producto está cancelada.

Error
Ocurrió un error. Compruebe el menú Estado del radar.

Más información

‣ Impresión y exportación de pantallas (página 272)

7.5 Marcación de un producto
Normalmente, el proceso de vigilancia elimina archivos del producto, ya que el espacio del
disco se llena eliminando los archivos del producto más antiguos.

También puede marcar la vigilancia para conservar o eliminar archivos del producto.

1. En la primera columna de la lista de productos, haga clic en el botón izquierdo del
mouse sobre una entrada de la lista.

Para seleccionar más de una entrada de la lista, presione CTRL+clic.

2. Use el menú Filter para reducir la lista a las entradas que desea marcar.

Producto y visualización del IRIS Guía de usuario M211319ES-J

282 RESTRINGIDO



3. Marque las entradas con una de las siguientes opciones:

Keep
Evita que el proceso de vigilancia elimine un archivo.
Esto resulta útil si tiene archivos que desea guardar durante varios días.
Note que la mejor forma de hacer un registro de archivo es enviarlo a la cinta.

Delete
Marca la vigilancia para que elimine un archivo de forma inmediata.
Esto resulta útil si desea recuperar un archivo SIN PROCESAR desde la cinta para
que se vuelva a introducir de forma automática.
Esto no se puede hacer si el archivo del producto SIN PROCESAR ya existe en el
disco. Primero, se debe eliminar.

Clutter
Para los productos RAIN1, esto marca el archivo que funciona como mapa de eco
para el producto.
Si se etiqueta más de un archivo del mismo nombre del producto, se usa la
versión más reciente. El proceso de vigilancia no elimina mapas de eco.

Remove Tag
Elimina una marca.
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8. Realización de las operacio-
nes de archivo

8.1 Descripción general de las operacio-
nes de archivo y recuperación

IRIS puede archivar, recuperar y reproducir los datos del radar. Si se recupera un producto
SIN PROCESAR (datos de coordenadas polares) desde el archivo, IRIS puede generar
productos a partir de los datos recuperados como si estos se recolectaran en tiempo real.
Los productos de imágenes se pueden recuperar desde el archivo y, luego, mostrarse. Entre
los dispositivos compatibles, se incluyen:

• Cinta, como DAT
La grabación en una cinta es conveniente, pero la recuperación puede ser lenta si el
archivo que desea se encuentra al final.

• Unidades de discos ópticos
Los discos ópticos, como las unidades ópticas de magneto reescribibles, son más
costosos que la cinta, pero duran más y son mucho más convenientes gracias a su
capacidad de acceso aleatorio.

• Archivos de disco grandes (LDA)
Los LDA le permiten aprovechar los sistemas de almacenamiento masivo de bajo costo.

• Sistemas de DVD+RW (por ejemplo, SONY DRU–500AX (interno), SONY DRX–500ULX
(externo en Firewire o USB 2.0)
Los DVD ofrecen bajo costo para la unidad y el medio, y brinda aproximadamente 5 GB
de almacenamiento. Compatible con sistemas Linux.

8.2 Uso del menú Archive
El menú Archive controla los dispositivos de archivo host.
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This is a test

File Site  Type Task TimeProduct

File   Menus   Drive   Commands

wind    Archive Menu TAPE1 DAT

Archive ID

Help

Type Product NameSite TASK From To Day Mon Year Files

100

CommandsApply Grab All Wild Wild Time Start List at

Commands WriteStatusMount On

1

Done Idle @ 1

SIG_96_11_27_E1W

DateProducts-Specific-Parameters

d 1 HAI CAPPI  Z_020_240  Z   2.0km   240km   480 P      PPIVOL   17:11:13  12 Jul 1997

d 1 HAI PPI       Z_020_240  Z   2.0deg   240km   480 P      PPIVOL   17:11:13  12 Jul 1997

d 1 HAI CAPPI  Z_030_240  Z   3.0km   240km   480 P      PPIVOL   17:11:13  12 Jul 1997

r 1 HAI CAPPI  V_020_240  V   2.0km   240km   480 P      PPIVOL   17:11:13  12 Jul 1997

r 1 HAI CAPPI  V_030_240  V   3.0km   240km   480 P      PPIVOL   17:11:13  12 Jul 1997

d 1 HAI RHI      Z_XXX_120 Z 90.0deg  120km   600 D      RHI          16:10:13  12 Jul 1997

d 1 HAI RHI      V_XXX_120 V 90.0deg  120km   600 D      RHI          16:10:13  12 Jul 1997

 1 HAI RAW    AERIAL           Z V W  240km   One        AERIAL    16:05:00  12 Jul 1997

36 /36 Files 9.7M/9.7M Bytes

Figura 94 Archive Menu

Menú de filtro
Puede usar el menú de filtro estándar para seleccionar los productos que aparecen en
el área de registro de archivo.

Área de control del archivo
La parte del medio del menú ofrece comandos para controlar las operaciones de
archivo, como montar o grabar, y muestra la información de estado de las funciones
del dispositivo de archivo.

Área de registro del archivo
La parte inferior del menú muestra los archivos del producto que se están grabando, si
los hay, en el archivo que está montado actualmente.

1. Asegúrese de que el dispositivo de archivo esté configurado en Setup > Archive.

2. En IRIS, seleccione Menus > Archive Menu y, por ejemplo, haga lo siguiente:

• Monte una cinta o un disco de IRIS (medios de archivos) e inicie el proceso de
grabación.

• Recupere archivos del producto y almacénelos en el disco del sistema.
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3. Todas las operaciones se dirigen a un dispositivo de archivo seleccionado. Para elegir
un dispositivo de archivo (cinta o disco óptico), seleccione Archive > Drive.

4. Seleccione una unidad de la lista.

Las opciones varían según las unidades configuradas para su sistema. Si no hay
unidades de archivo disponibles, la lista contiene la entrada UNKNOWN.

5. Para dirigir la salida hacia el dispositivo de archivo, haga solicitudes de envío en Menus 
> Product Output.

8.2.1 Área de control del archivo

Commands WriteStatusMount Released Off

Archive ID SIG_96_11_27_E1W

Done

Figura 95 Área de control del archivo

El área de control de archivo le permite seleccionar los comandos del dispositivo de archivo
y revisar la información de estado.

Commands

Seleccione Commands para mostrar los siguientes comandos de la cinta:
• Mount un disco o una cinta.
• Unmount un disco o una cinta.
• Stop la operación actual.
• Record un archivo del producto para archivar.
• Retrieve un archivo del producto a partir del archivo y copiarlo en el disco.
• Inventory los archivos del producto en el archivo.

Status

Status muestra el estado actual de la unidad de archivo y debe corresponder a la solicitud
del comando. Las entradas de estado son:

• Rewind (para cinta)
La cinta se está rebobinando, por ejemplo:
• El usuario publica el comando Unmount.
• IRIS posiciona la cinta para una operación Retrieve.
• IRIS llenó una cinta durante una operación Record.

• Writing
La cinta o el disco se está grabando.

• Scanning
La cinta se está montando o se está creando un inventario. Scanning también se
muestra la cinta se posiciona para una operación Retrieve o Record.

• Reading
La unidad se encuentra en el proceso de recuperación de un archivo.
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• Idle
La unidad no está haciendo nada, es decir, el usuario no publicó un comando o se
completó el último comando.

• Off Line
La unidad especificada no está en línea. No se puede realizar una operación de archivo
hasta que se solucione este problema. Puede ser necesario insertar el medio o
presionar un botón de carga. Consulte el manual de la unidad.

• Unavailable
Alguien más está usando la unidad, la unidad está rota o no se instaló.

• Released
Actualmente, IRIS no está conectado a la unidad. La unidad está disponible para que la
use IRIS u otros procesos.

• Full
El medio está lleno, un EOT o se encontró un disco lleno durante una operación Record.
Para seguir grabando, el medio se debe desmontar, un nuevo medio se debe montar y
se debe volver a invocar Record.

• BOT (cinta)
Inicio de la cinta, se insertó una cinta nueva en la unidad y está lista para montarse. Este
estado también aparece después de que se haya realizado Rewind.

• EOT (cinta)
Final de la cinta, IRIS encontró el final de la cinta. Por lo general, IRIS rebobina la cinta
automáticamente, por lo que el mensaje se reemplaza por Rewind.

Pueden aparecer hasta 3 indicadores de estado juntos en el campo Status. Por ejemplo, si
un proceso Record llena la cinta, la cinta se rebobina y permanece inactiva hasta que el
operador cambia las cintas o emite otro comando, el campo Status indica lo siguiente:

Idle BOT Full

Si la cinta se explora para crear un inventario, el campo de estado muestra lo siguiente:

Scanning

Cuando un proceso de grabación no tiene nada que hacer, el estado muestra:

Idle

Si nuevos archivos del producto etiquetados para el archivo (en el menú Product Output)
están disponibles, se graban automáticamente.

Cuando se completa el comando Mount y la cinta está al inicio a la espera de comandos, el
campo Status muestra:

Idle BOT
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Archive ID

Identifica el único nombre asignado a una cinta o a un disco cuando se inicializa.

Los primeros 3 caracteres son la ID del sitio de IRIS donde se inicializó el medio, seguidos de
la fecha en la que se inicializó el medio. Los últimos 3 caracteres son un código aleatorio
único.

Write

Write muestra si se estableció la protección de escritura de la cinta o del disco.
• On significa que IRIS puede escribir en el medio.
• Off significa que IRIS no puede escribir en el medio.

El mensaje aparece después de que se publica un comando Mount.

Comandos del menú de filtro
Site

Ingrese una ID del sitio para seleccionar datos de un solo sitio del radar o ingrese el
carácter comodín para seleccionar datos de todos los sitios.
Seleccione Site para ver una lista de sitios conocidos. Los contenidos de esta lista
dependen de los sitios que se configuran en la herramienta Setup.

Type
Ingrese un tipo de producto en este campo para seleccionar productos de un solo tipo
o ingrese el carácter comodín para seleccionar productos de todos los tipos.
También puede seleccionar desde una lista de tipos con los archivos de datos.

Product Name
Ingrese el nombre de un producto para reducir la lista a productos que tengan ese
nombre.
Puede incluir caracteres comodines en el nombre del producto. Un signo de pregunta
(?) equivale a cualquier carácter único; un asterisco (*) equivale a cualquier secuencia
de cero o más caracteres.

TASK
Ingrese el nombre de una tarea para filtrar productos generados por una tarea
específica.
Puede incluir caracteres comodines en el nombre de la tarea.
Por ejemplo, al ingresar el nombre de un producto de *PPI*_?, se seleccionan todas
las tareas híbridas que contienen PPI en algún lugar del nombre.

Scan
Ingrese un tipo de exploración en este campo para seleccionar productos de un solo
tipo, ingrese el carácter comodín para seleccionar productos de todos los tipos o
seleccione desde una lista de tipos.

From, To
Ingrese un rango de horas para filtrar productor por hora del día.
También puede seleccionar desde una lista de rangos.

Day, Month, Year
Ingrese un día, mes o año para filtrar productos por fecha.
También puede seleccionar desde una lista de valores.
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Files
Controle la cantidad de archivos a incluir en la lista.

Max
Controle la cantidad de productos a incluir en la lista. "*" significa que no se aplica
ningún límite. Todas las listas de IRIS se limitan a un máximo de 1000.

Apply
Seleccione Apply para actualizar la lista de productos, según su criterio de selección.

Grab
Si seleccionó un producto, seleccione Grab para insertar el sitio, tipo y nombre del
producto, la tarea y la fecha en los campos del filtro.

All Wild
Seleccione All Wild para convertir todos los campos al carácter comodín.

Wild Time
Seleccione Wild Time para cambiar solo los campos de horas, mes, día y año al
carácter comodín.

Seleccione Commands para mostrar las operaciones que puede realizar en los archivos
desde el menú Filter:

• Retrieve marca todos los archivos seleccionados para la recuperación.
• Cancel desmarca todos los archivos seleccionados.

Menú de filtro Start List At

La lista de registro de archivo puede tener cientos de archivos. Use la opción Start List At
para iniciar la lista en un archivo seleccionado.

Puede seleccionar un número de inicio en un menú o ingresar directamente el número en el
campo. Esto es conveniente para las cintas que están en orden cronológico.

8.2.2 Área de registro del archivo

File Site  Type Task TimeProduct DateProduct-Specific-Parameters

d 1 HAI CAPPI  Z_020_240  Z   2.0km   240km   480 P      PPIVOL   17:11:13  12 Jul 1997

d 1 HAI PPI       Z_020_240  Z   2.0deg   240km   480 P      PPIVOL   17:11:13  12 Jul 1997

d 1 HAI CAPPI  Z_030_240  Z   3.0km   240km   480 P      PPIVOL   17:11:13  12 Jul 1997

r 1 HAI CAPPI  V_020_240  V   2.0km   240km   480 P      PPIVOL   17:11:13  12 Jul 1997

r 1 HAI CAPPI  V_030_240  V   3.0km   240km   480 P      PPIVOL   17:11:13  12 Jul 1997

d 1 HAI RHI      Z_XXX_120 Z 90.0deg  120km   600 D      RHI          16:10:13  12 Jul 1997

d 1 HAI RHI      V_XXX_120 V 90.0deg  120km   600 D     RHI          16:10:13  12  Jul 1997

 1 HAI RAW    AERIAL           Z V W  240km   One        AERIAL   16:05:00  12 Jul 1997

Figura 96 Área de registro del archivo
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El área de registro de archivo es una lista de archivos que están en el archivo. Esta lista se
usa para especificar los archivos para una operación de recuperación o verificar el progreso
de una operación de grabación.

Para las cintas, el orden de la lista es el mismo que el orden de los archivos en la cinta. Por lo
general, están en orden cronológico.

Para los discos ópticos, lo archivos aparecen en el mismo orden que en el menú Product 
Output.

Los registros de archivo se conservan en el disco como archivos de texto ASCII.

Cuando se monta una cinta, IRIS revisa si hay un registro de cinta correspondiente. Si la cinta
es una cinta de IRIS válida, se muestra la lista.

En el caso de un disco óptico, se genera un registro nuevo cuando se monta un disco.

File

Esta columna contiene información de estado del archivo. La primera columna muestra el
número de archivo secuencial de la cinta (1, 2, ... ) y la segunda columna contiene uno de los
siguientes símbolos:

• r
El archivo se etiquetó para una operación de recuperación.

• d
El archivo está en el disco y en la cinta. La recuperación no está permitida.

• "en blanco"
El archivo está solo en la cinta y no se etiquetó para la recuperación.

Haga clic con el botón derecho en File para seleccionar una de las siguientes opciones:
• Retrieve marca un archivo para la recuperación.
• Cancel desmarca el archivo.

Site

Muestra la ID del sitio del radar donde se recolectaron los datos para el producto.

Type

Muestra el tipo de producto, como PPI o RHI.

Product

Muestra el nombre del producto para la generación más reciente del tipo de producto.

Product-Specific-Parameters

Muestra información adicional sobre e producto.

TASK

Muestra el nombre de la tarea asociada.

Time

Muestra la fecha y hora (hora local) cuando se recolectaron los datos para el producto.
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8.3 Inicialización de una cinta o un disco
para la grabación

IRIS puede montar solo cintas o discos de IRIS válidos que otro programa de utilidad haya
inicializado. Si intenta montar un medio no inicializado, el campo Status muestra:

NonIris

Use la herramienta de inicialización del medio para hacer lo siguiente:
• Inicializar una cinta o un disco en blanco.
• Sobrescribir una cinta o un disco sin datos de IRIS.
• Sobrescribir una cinta o un disco de IRIS.

Si sobrescribe un medio de IRIS o de otro tipo, asegúrese de no
destruir datos importantes ni el software (cintas de seguridad o de entrega).
Solo los operadores están autorizados a usar la herramienta de inicialización de cinta.

PRECAUCIONES!

No inicialice una cinta o un disco existente si desea grabar datos
adicionales o recuperar datos de IRIS. Si inicializa una cinta o un disco de IRIS existente,
se destruirán los datos que ya están en el medio.

PRECAUCIONES!

1. Asegúrese de que la unidad esté disponible. Toda cinta o disco de IRIS se debe
desmontar y retirar.

2. Inserte el medio en la unidad y configure la unidad en línea. Asegúrese de que el medio
esté habilitado para la escritura.

3. Si se está ejecutando IRIS, revise el menú Archive y, si es necesario, desmonte el medio
que desea inicializar.
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4. Desde el mensaje del sistema operativo, invoque el comando init_iris adecuado
para su dispositivo.

A continuación, se muestran algunos ejemplos:

$ ini t_iris_tape  (for drive unit 1 tape)
$ init_iris_mo     (for drive unit 1 disk)
$ init_iris_mo -u2 (specifies the 2nd drive unit)
$ init_iris_dvd -h (to get help on usage)
$ init_iris_lda -h (to get help on usage)

Asegúrese de escribir el guion bajo (_) como se muestra. El nombre del comando es
intencionalmente largo, por lo que no puede escribirlo por error.
"-u2" especifica la segunda unidad si hay más de una.
El argumento "-h" imprime las opciones de uso.
Se revisa la unidad y se le solicita que confirme la inicialización. La unidad pasa por
varios pasos de inicialización que aparecen en pantalla. Si se olvidó de habilitar la cinta
para la escritura, recibirá un error de protección de escritura cuando IRIS intente
escribir la información de encabezado. Habilite la cinta para la escritura y vuelva a
escribir el comando.
Al final de la inicialización, IRIS muestra un número de cinta único que se usa en el
futuro para hacer referencia a los inventarios del disco que se conservan para la cinta.

Escriba el nombre del medio que asigna IRIS en la etiqueta de
la cinta o del disco. Esto permite que otras personas sepan que la cinta o el disco se
inicializó.

PRECAUCIONES!

El nombre de la cinta se basa en los primeros 3 caracteres de la ID del sitio, el año, el
mes, el día y un número aleatorio para que la cinta sea única.

8.4 Montaje de una cinta o disco
Use el comando Mount para montar los medios inicializados.

1. Asegúrese de que el medio se haya inicializado.

Consulte Inicialización de una cinta o un disco para la grabación (página 291).

2. Inserte la cinta o el disco en la unidad y configure la unidad en línea.

Consulte la documentación del fabricante.

3. Seleccione Commands > Mount.

IRIS explora el medio para determinar el tipo de medio que se montó y revisa el disco del
sistema en busca de un registro de cinta correspondiente.

El campo Status informa Scanning durante la operación Mount.

IRIS informa los resultados en el campo Filter Summary como uno de los siguientes:
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• 40*/250 Files 11 M/ 202 M Bytes
Por ejemplo, esto indica que el medio es un medio de archivo de IRIS válido con un
registro completo. La lista de registro muestra los primeros archivos del producto que
están en el medio (si los hay). En este ejemplo, hay 250 archivos y 202 MB en el medio.
La lista de registro muestra actualmente 40 archivos que ocupan 11 MB (* significa que
hay más archivos que se pueden mostrar).

• Incomplete Log
Esto indica una cinta de IRIS válida, pero un registro de cinta no válido o incompleto en
el disco. El registro de cinta muestra los primeros archivos en la cinta lo mejor posible.
Puede que desee realizar un inventario si debe hacer una operación Retrieve.

Después de una exitosa operación Mount, IRIS muestra la ID de archivo, que se debe
comprobar frente a la etiqueta en el medio.

Si durante la operación Mount se detecta un medio de formato desconocido o una cinta o un
disco en blanco, IRIS no monta el medio y el campo Status muestra NonIris.

8.5 Grabación de datos
El comando Record inicia el proceso de grabación. Las solicitudes de salida realizadas desde
el menú Product Output para la unidad de archivo seleccionada se escriben al comienzo de
una cinta en blanco o se agregan al final de una cinta de IRIS. El medio de archivo se puede
dejar montado de modo que los archivos nuevos se puedan escribir automáticamente en el
archivo sin tener que ingresar al menú Archive. Esto continúa hasta que el medio se llene.

Los comandos Retrieve, Unmount y Inventory se pueden emitir durante la operación de
grabación sin tener que emitir primero el comando Stop. Un efecto secundario de grabar
en una cinta de IRIS es que se crea un nuevo registro de cinta cuando IRIS explora para
encontrar el último archivo de la cinta. Si graba en una cinta que tiene Incomplete Tape
Log, se genera un nuevo registro de cinta. No es necesario realizar un inventario en este
caso.

1. Ingrese al menú Product Output y seleccione los archivos del producto que desea
enviar a la unidad de archivo. Asegúrese de especificar la unidad correcta. Puede hacer
solicitudes de envío individuales o usar los comandos de la línea del encabezado para
especificar que todos los productos futuros se envíen al archivo.

2. Coloque un medio parcialmente lleno o recién inicializado en la unidad de archivo
adecuada. Asegúrese de que el medio esté habilitado para la escritura.

3. Seleccione Menus > Archive Menu y seleccione la unidad de archivo adecuada.

Revise que el campo Status indique Idle o Released.

4. Seleccione Commands > Mount.

5. Revise Filter Summary para asegurarse de que el medio se montó correctamente, y
revise el campo Archive ID y la lista de registro para asegurarse de que este sea el
medio que desea escribir.
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6. Seleccione Commands > Record.

Cuando haya finalizado la grabación, el campo Commands muestra Record Done y el
campo Status muestra Idle.
El registro contiene entradas para los archivos nuevos que se agregaron.
Puede emitir más comandos (como Unmount), pero muchos usuarios dejan el medio
en este estado de modo que las solicitudes futuras para archivo desde el menú
Product Output se llenen automáticamente.

7. Si el medio está lleno antes de que haya finalizado la grabación, la cinta rebobina a BOT
y titila el mensaje TAPE FULL ON DRIVE (drive id) de todo el sistema.

a. Ingrese al menú Archive y desmonte la cinta.

b. Monte una cinta nueva.

c. Para reiniciar la operación de grabación donde quedó, seleccione Commands > 
Record.

Los productos se acomodan en fila para enviarse a la unidad y se envían en cuanto
selecciona el comando de grabación en los medios nuevos. Así, si el proceso de
vigilancia normal elimina los medios que se encuentran antes que estos archivos en fila,
no se pierden datos en el archivo. El tiempo depende del tamaño del disco del sistema
IRIS, pero por lo general, demora varias horas.

8. Para detener la grabación manual, seleccione Commands > Stop.

IRIS espera el próximo comando, que puede ser retomar el proceso de grabación. El
registro refleja los archivos nuevos que se agregaron antes de que se haya emitido el
comando Stop.

8.6 Creación e impresión de un registro

Los inventarios de archivo de disco no se crean para los dispositivos de LDA. El inventario
para estos se hace sobre la marcha.

El comando Inventory se invoca cuando no hay registro de cinta o cuando el registro de
cinta se daña. En el segundo caso, el campo de ID de archivo muestra Incomplete Log.

Para los discos ópticos, los registros se crean automáticamente cuando se monta un disco.

La impresión se realiza en una impresora de texto en lugar de una impresora de color, según
la configuración que hizo el administrador del sistema en su sistema. No es necesario
montar una cinta para imprimir el registro de cinta.
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8.6.1 Creación de un registro en cinta

1. Seleccione Commands > Inventory.

IRIS explora la cinta y crea un nuevo registro. Esto puede demorar algún tiempo.
Tenga en cuenta que cuando IRIS anexa archivos a una cinta de IRIS existente, un nuevo
registro de cinta se genera automáticamente.

2. Cuando la cinta se llene, imprima el registro de cinta y guárdelo en un cuaderno o
archivo cerca de donde guardó las cintas. (También debe configurar la protección de
escritura).

Esto facilita determinar los del archivos del producto que están en la cinta cuando se
recuperan datos.

8.6.2 Impresión de un registro en cinta o disco

1. Desde el mensaje del sistema operativo, cambie los directorios a la ubicación de los
registros:

$ cd $IRIS_INV_TAPE

2. Para ver una lista de los registros de cinta disponibles en este directorio, escriba:

$ ls

Se enumera otro archivo para cada registro de archivo, que se identifica con la ID de
archivo correspondiente a la etiqueta de la cinta o del disco.

3. Encienda la impresora predeterminada en su sistema y escriba (por ejemplo):

$ lp SIG_88_03_08_S9C.LIS

La ID de archivo SIG_88_03_08_S9C es un ejemplo.

8.7 Recuperación de archivos del produc-
to desde un archivo

Puede usar el menú Archive para recuperar archivos del producto desde la cinta y volver a
colocarlos en el disco donde están disponibles para la visualización o, en el caso del
producto SIN PROCESAR, para la generación de productos subsiguientes.

Capítulo 8 – Realización de las operaciones de archivo

RESTRINGIDO 295



El comando Retrieve saca archivos del producto desde el archivo y los almacena en el disco
del sistema. Retrieve requiere que primero etiquete todos los archivos que se recuperarán.
Los archivos se pueden etiquetar incluso mientras Retrieve u otras operaciones estén en
progreso.

1. Debido a que Retrieve depende mucho del registro, realice un inventario para las cintas
de IRIS con registros incompletos.

Consulte Creación e impresión de un registro (página 294).

Retrieve funciona si no se hizo un inventario, pero solo se pueden recuperar los
archivos que se enumeran en el registro de cinta.

2. Determine la cinta o el disco que tiene los datos que desea. La mejor forma de hacerlo
es tener un libro de registros impresos. Debido a que los medios de IRIS pueden tener
una gran variedad de productos, una simple etiqueta, por lo general, no es suficiente
para describir lo que hay en el medio.

3. Cargue el medio en la unidad y configure la unidad en línea.

Active la protección de escritura para evitar que usted u otro operador escriba en la
cinta por accidente.

4. Ingrese al menú Archive y seleccione Commands > Mount.

Revise la información en el registro para asegurarse de que sea consistente con lo que
pensó que había en el medio.

5. Para etiquetar archivos para la recuperación, seleccione los archivos que desea
etiquetar mediante una de las siguientes acciones:

• Haga clic con el botón izquierdo del mouse sobre una entrada del registro para
seleccionarla, o presione CTRL+clic para seleccionar más de una entrada.

• Haga clic y arrastre el mouse para seleccionar un grupo de entradas en el registro, o
presione CTRL y luego, haga clic y arrastre el mouse para seleccionar varios grupos
de entradas.

• Use el menú Filter para crear una lista de los archivos que desea recuperar.

Producto y visualización del IRIS Guía de usuario M211319ES-J

296 RESTRINGIDO



6. Seleccione Retrieve de uno de los siguientes menús:

• Si seleccionó las entradas con el mouse, coloque el cursor del mouse sobre el
registro de cinta y haga clic con el botón derecho del mouse.

• Si seleccionó las entradas del menú Filter, seleccione Commands.
Si cambia de opinión, seleccione Cancel para quitar la etiqueta del archivo.
Cuando se selecciona un producto para Retrieve, aparece una r junto al número de
archivo.
Después de que un archivo se haya recuperado correctamente, o si ya está en el disco,
se muestra una d junto al número de archivo correspondiente.

Los archivos que ya están en el disco no se pueden etiquetar para Retrieve.

7. Seleccione Commands > Retrieve.

IRIS coloca la cinta y copia los archivos etiquetados en el disco. Aparece una d junto al
archivo después de que se copia en el disco.
Puede seguir etiquetando archivos o quitando etiquetas incluso mientras Retrieve esté
funcionando.
También puede salir del menú Archive, y el proceso Retrieve continuará su función.
Por ejemplo, puede dirigirse al menú Product Output y solicitar salida desde algunos
de los productos que restauró en el disco.

8.8 Detención de las operaciones del ar-
chivo

Use Commands > Stop para detener la operación de archivo actual.

Si emite un comando Stop durante una operación Record o Retrieve, no se dañará ningún
archivo.

El comando Stop tiene distintos efectos según la operación que se detiene:
Durante la grabación

Stop permite que se complete el archivo que se está escribiendo.
Si se vuelve a emitir Record, IRIS reanuda la grabación al final del último archivo.

Durante la recuperación
Stop finaliza la recuperación del último archivo y luego, detiene la recuperación.
Si se vuelve a emitir Retrieve, el proceso de recuperación continúa donde quedó.

Durante el inventario
Stop detiene el inventario. El registro resultante está incompleto y el resumen del filtro
muestra Incomplete Log.
Las operaciones Retrieve que están limitadas a la parte del registro que se completó
aún se pueden realizar. Si se vuelve a emitir el comando Inventory, el inventario se
inicia desde el comienzo de la cinta.
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Durante el montaje
Stop cancela la operación Mount y rebobina la cinta.

Durante el desmontaje
Stop no tiene efecto.

8.9 Desmontaje de una cinta o disco
El comando Unmount hace que IRIS rebobine una cinta y saque de línea la cinta o la unidad
de disco óptico. La información de registro se borra de la pantalla. Este comando se debe
invocar antes de que se pueda montar una cinta nueva.

1. Seleccione Commands > Unmount.

2. Espere que la cinta se rebobine por completo y luego, sáquela de la unidad de cinta.

Si el medio es un DVD, el contenido del búfer temporal usado para escribir el DVD se
descarga en el DVD, es decir que no se pierden datos en el búfer.
Esto puede retrasar el paso de desmontaje durante 20 segundos. Si cierra IRIS (qiris)
sin desmontar el DVD, el búfer se carga de la misma forma (retrasa el qiris).
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9. Administración de archivos
de introducción

9.1 Administración de archivos de intro-
ducción

Los archivos de introducción son los datos recopilados del procesador de señal cada vez
que se ejecuta una tarea. Un archivo de introducción no es lo mismo que un producto de
datos sin procesar, el cual almacena datos de introducción en un formato comprimido.

Los archivos de introducción están catalogados por sus tareas asociadas y almacenados en
un disco en un archivo de resumen de introducción. IRIS usa un proceso de vigilancia
automático para eliminar los archivos de introducción antiguos.

En el menú Ingest Summary hay una lista de los archivos de introducción que se encuentran
actualmente en el disco. Use la parte superior del menú para seleccionar los archivos que
desea mostrar. En la parte inferior del menú hay una lista de los archivos de introducción.

Figura 97 Menú Ingest Summary
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1. Seleccione Menus > Ingest Summary.

La lista de Ingest Summary que se encuentra en el panel inferior está ordenada según
el tiempo, con los archivos más nuevos en primer lugar.

Tag
Muestra k para conservar, d para eliminar o en blanco si no hay ninguna marca
configurada.

Site
Muestra la identificación del sitio del radar desde el cual se recopilaron los datos.

TASK
Contiene el nombre de la tarea.

Scan
Contiene el tipo de exploración usado para recopilar los datos, como RHI o PPI.

Range
Contiene el valor del campo de Max Range obtenido de la configuración de
tareas.

Data
Enumera los parámetros de los datos (Z, T, V, W) para la tarea.

Sweeps
Muestra la cantidad de barridos que la tarea recolectó. Si la exploración se detuvo
antes de tiempo, en esta columna figuran las tareas parcialmente completadas
como N/M, incluso si la tarea se detuvo durante el último barrido.

Start Time
Muestra la hora en que comenzó la tarea para recopilar datos.

Size
Muestra el total de espacio en disco ocupado por los archivos de introducción
para esta tarea en ejecución.

2. Seleccione una entrada de la lista y coloque el cursor del mouse sobre cualquiera de los
campos para que aparezcan las siguientes opciones:

• Keep etiqueta todos los archivos seleccionados con la señal de guardar para que el
proceso de vigilancia no los elimine.
Esto es necesario si desea guardar archivos de introducción, incluidos aquellos que
se restauraron a partir de una cinta, para la generación de productos no en tiempo
real en un modo de análisis. Por ejemplo, si desea crear un producto mañana a partir
de los datos de introducción de hoy.
Consulte Aplicación y eliminación de etiquetas de los archivos de introducción
(página 302).

• Clutter etiqueta un archivo seleccionado como mapa de eco.
• Un-Tag quita las señales de eliminar o de guardar de los archivos seleccionados.
• Delete etiqueta todos los archivos seleccionados con la señal de eliminar con el fin

de liberar más espacio en el disco para nuevos archivos de introducción.
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3. Use el menú Filter ubicado en el panel superior para reducir la lista a los archivos de
interés por sitio, tarea, exploración o tiempo.

Site
Ingrese una ID del sitio para seleccionar datos de un solo sitio del radar o ingrese
el carácter comodín para seleccionar datos de todos los sitios.
Seleccione Site para ver una lista de sitios conocidos. Los contenidos de esta lista
dependen de los sitios que se configuran en la herramienta Setup.

TASK
Ingrese el nombre de una tarea para filtrar productos generados por una tarea
específica.
Puede incluir caracteres comodines en el nombre de la tarea.
Por ejemplo, al ingresar el nombre de un producto de *PPI*_?, se seleccionan
todas las tareas híbridas que contienen PPI en algún lugar del nombre.

Scan
Ingrese un tipo de exploración en este campo para seleccionar productos de un
solo tipo, ingrese el carácter comodín para seleccionar productos de todos los
tipos o seleccione desde una lista de tipos.

From, To
Ingrese un rango de horas para filtrar productor por hora del día.
También puede seleccionar desde una lista de rangos.

Day, Month, Year
Ingrese un día, mes o año para filtrar productos por fecha.
También puede seleccionar desde una lista de valores.

Files
Controle la cantidad de archivos a incluir en la lista.

Apply
Seleccione Apply para actualizar la lista de productos, según su criterio de
selección.

Grab
Si seleccionó un producto, seleccione Grab para insertar el sitio, tipo y nombre
del producto, la tarea y la fecha en los campos del filtro.

All Wild
Seleccione All Wild para convertir todos los campos al carácter comodín.

Wild Time
Seleccione Wild Time para cambiar solo los campos de horas, mes, día y año al
carácter comodín.

Commands
Aplique etiquetas a los archivos de introducción seleccionados por el menú
Filter:
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• Keep etiqueta todos los archivos seleccionados con la señal de guardar para
que el proceso de vigilancia no los elimine.
Esto es necesario si desea guardar archivos de introducción, incluidos
aquellos que se restauraron a partir de una cinta, para la generación de
productos no en tiempo real en un modo de análisis. Por ejemplo, si desea
crear un producto mañana a partir de los datos de introducción de hoy.
Consulte Aplicación y eliminación de etiquetas de los archivos de
introducción (página 302).

• Clutter etiqueta un archivo seleccionado como mapa de eco.
• Un-Tag quita las señales de eliminar o de guardar de los archivos

seleccionados.
• Delete etiqueta todos los archivos seleccionados con la señal de eliminar

con el fin de liberar más espacio en el disco para nuevos archivos de
introducción.

9.2 Aplicación y eliminación de etiquetas
de los archivos de introducción

Eliminar archivos puede interferir con la subsiguiente generación de
productos. Asegúrese de que no se necesita el archivo para la generación del producto
antes de eliminarlo. La única circunstancia que puede requerir de una eliminación
manual es cuando necesita hacer espacio al restaurar un archivo SIN PROCESAR de la
cinta.

PRECAUCIONES!

1. Seleccione uno o más archivos de la lista. Hay varias formas de hacer una selección:

• Haga clic con el botón izquierdo del mouse sobre la lista para seleccionarla o
presione CTRL+clic para seleccionar más de una entrada de la lista.

• Haga clic y arrastre el mouse para seleccionar un grupo de entradas en la lista o
presione CTRL y luego, haga clic y arrastre el mouse para seleccionar varios grupos
de entradas.

• Use el menú Filter para producir una lista de los archivos de introducción que desea
etiquetar.

2. Seleccione Keep, Delete o Un-Tag de uno de los siguientes menús:

• Si seleccionó las entradas con el mouse, coloque el cursor del mouse sobre la lista de
archivos de introducción y haga clic con el botón derecho del mouse.

• Si seleccionó las entradas del menú Filter, seleccione Commands.
Los archivos están marcados con una k (guardar) o una d (eliminar), o se eliminaron las
etiquetas, según el comando que seleccionó.
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10. Selección de los archivos
de superposición

10.1 Descripción general de la superposi-
ción

Esta herramienta es una característica heredada usada para ver datos de radar con IRIS
Analysis.
Cuando es posible, Vaisala recomienda ver de datos de radar con IRIS Focus.

Puede usar la herramienta Overlay del IRIS para dibujar superposiciones o mapas a fin de
que se muestren en la parte superior de otros productos IRIS/Open. Las superposiciones se
usan para las salidas del producto y para la visualización en tiempo real.

Una superposición puede constar de lo siguiente:
• Límites geográficos y políticos que se muestran con o sin líneas de latitud y longitud o

anillos de rango.
• Cadenas de texto para etiquetar áreas de interés, por ejemplo, ciudades.
• Iconos del mapa de bits creados por el usuario y que se aplicaron en la superposición.

Los iconos pueden representar cualquier característica, por ejemplo, aeropuertos,
estaciones de tren y similares.

• Las líneas, el texto y las líneas mencionadas anteriormente se pueden separar en
distintas capas dentro del archivo de superposición. Luego, cuando se visualiza, se
pueden mostrar todas estas capas o solo un subconjunto, lo que genera
superposiciones flexibles que aparecen de modo diferente según cuáles sean las capas
activas. Las capas se pueden dibujar con colores diferentes.

• Las capas de fondo son regiones llenas de color que se muestran debajo de las
imágenes del radar, donde no hay datos meteorológicos. Por lo general, las capas de
fondo se usan para indicar áreas de agua.

Cada superposición se define en un archivo ASCII que usa un enfoque de "punto a punto" (a
veces denominado un enfoque de vectores). Esto permite dibujar superposiciones en
cualquier factor de escala.

Usted usa la herramienta Overlay para crear y modificar sus propias superposiciones en una
ventana de su estación de trabajo.

Por lo general, obtiene el mapa básico (costas, fronteras, ríos) de Vaisala y luego lo
personaliza para que se adapte a sus necesidades. A menudo, es conveniente generar capas
separadas para intereses separados (cuencas de ríos, aeropuertos). IRIS admite hasta
20 archivos de superposición.

Las superposiciones del IRIS son archivos ASCII, de modo que los puede editar sin un editor
de texto (vi, o emacs, que se distribuye con el IRIS).
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10.2 Activación de la superposición
1. Active la herramienta Superposición; para ello, escriba: overlay&

La superposición se inicia de modo predeterminado con una ventana vacía en su
estación de trabajo.
La configuración de la sesión previa aún es válida al momento del reinicio.

2. Abra un archivo de superposición (.ovr) desde el directorio /etc/vaisala/
irisrda/overlay.

3. Seleccione Archivo > Mostrar latitud y longitud para ver la latitud y longitud de su
cursor.

Puede usar el ratón para desplazar el cursor por el mapa. Para encontrar un punto
preciso, use los botones de flecha del teclado para moverse de pixel a pixel.

4. Para definir el modo en el que se muestra la latitud y la longitud, seleccione Archivo > 
Unidades Latitud Longitud.

Puede mostrar los valores como grados y decimales o como grados, minutos y sus
decimales.
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5. Seleccione Archivo > Opciones para definir la visualización del mapa.

Se muestra la ventana Opciones.

a. En el panel superior, defina lo siguiente:

Tamaño de visualización en km
Defina el tamaño horizontal del mapa en km.

Desplazamiento norte/este en km
Desplácese por el mapa original y cree subáreas.

Capas para dibujo
Defina si desea trabajar con todas las capas del mapa o solo con un
subconjunto.

b. En el panel inferior, defina lo siguiente:

Puntos de relleno
Indique las áreas, por lo general lagos, que desea colorear con un determinado
color.

Anillos de rango 
Centrado en un punto predefinido, por lo general un sitio del radar.

Protegido
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Las áreas que usa con el producto WARN.

Lat Lon
Muestra una cuadrícula de latitud y longitud.

Sin capa de fondo
No usar una capa de fondo.

c. Seleccione la proyección del mapa.

Por lo general, Acitumal se usa en las aplicaciones de un radar, Mercator en
compuestos de áreas tropicales y Estereográfica polar en compuestos cercanos a
los polos.
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6. Seleccione Archivo > Agregar/Modificar capa para crear o modificar una capa.

Todo lo que agregue en una superposición se aplica en una capa. Puede agregar o
eliminar texto, iconos y puntos de relleno. También puede seleccionar un "puntero", que
le muestra la posición del cursor.

a. Asígnele un color a cada capa desde un conjunto predefinido, que se muestra en una
casilla junto al nombre de la capa.

Para definir más colores, use la herramienta Color.

b. Para agregar contenido a una capa nueva o existente, seleccione Crear nueva capa.

Aparece Agregar/Eliminar herramienta.
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• Para agregar iconos, debe incluir un texto junto al icono.
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Cuando se usan iconos, Vaisala recomienda que los justifique a la derecha o a la
izquierda, ya que el icono va al punto y el texto debe estar junto al icono. Puede
resaltar el texto para darle un fondo de color.

• Cuando se agrega texto, la mayoría de los usuarios desea justificar el texto al
centro, de modo que el punto que se muestra con la latitud y la longitud en la
columna superior esté debajo del carácter medio del texto.

c. Para combinar 2 capas, en la ventana Agregar/Modificar capa, seleccione la capa
del objetivo y – – –.

d. Para evitar que el color de relleno se filtre alrededor del borde de los límites de la
superposición, use el comando RANGE para comunicarle a Superposición qué tan
lejos dibujó la superposición.

e. Defina los puntos de relleno de la capa de fondo.

Los puntos de relleno se usan para hacer una capa de fondo. Una subcapa puede
contener hasta 400 puntos de relleno. Superposición comienza a partir de cada uno
de los puntos de llenado indicados y completa todas las áreas contiguas, con parada
en las líneas de superposición.
Puede ingresar muchos puntos de relleno para la misma región de relleno. En
realidad, esto es obligatorio para una costa con bahías profundas, de modo que la
región se rellene correctamente en todas las escalas. Muchas superposiciones
contienen una costa y usan una capa de fondo azul para el océano.

f. Para eliminar elementos de un mapa, seleccione una opción de Finalizar.

Cuando selecciona una opción de Finalizar, el cursor se convierte en una
herramienta de eliminación y puede borrar elementos del mapa cuando se señalan y
se hace clic sobre ellos. Existe una herramienta de eliminación por separado para el
texto, los iconos y los puntos de relleno, a fin de minimizar el riesgo de eliminar algo
por error. Si no puede eliminar lo que desea, probablemente está trabajando en una
capa equivocada.
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7. Seleccione Encabezado para verificar el encabezado del archivo de superposición.

Consulte Encabezado de la superposición (página 310).

10.3 Encabezado de la superposición
Coordenadas absolutas

Si la superposición se define en coordenadas absolutas, todos los puntos de las
superposiciones se definen en términos de un par de coordenadas de longitud y altitud. De
esta forma, se establece una posición absoluta para cada punto.

Los siguientes comandos del encabezado se deben incluir en la parte superior del archivo de
superposición:

Tabla 22 Comandos del encabezado de latitud y longitud de la superposición

Comando Descripción

PROJECTION latlon Informa que la superposición del sistema está en coordenadas absolutas.

DRAW_CENTER lon lat Le informa a Overlay dónde centrar la imagen.

Por lo general, son las coordenadas del sitio del radar o un área de interés
cercana especial, como por ejemplo un aeropuerto.

FILL_CENTER lon lat Especifica el centro del área de relleno. Por lo general, es el centro de la ma-
triz de puntos de datos que generó.

FILL_RANGE range Establece el rango máximo de las cubiertas de la capa de fondo, en km.

Overlay dibuja un círculo a esta distancia desde el centro de relleno antes
de rellenar la capa de fondo.
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Coordenadas relativas

Si la superposición se define en coordenadas relativas, todos los puntos se definen en
términos de unidades del mapa. Las unidades del mapa son cualquier unidad de medida
arbitraria que está E/W y N/S de un origen (0,0), que puede estar en cualquier lugar del
mapa.

A menudo, los milímetros de un papel gráfico se usan para designar los puntos en un mapa.
El mapa debe estar en proyección acimutal equidistante, con el punto de referencia
especificado. Un factor de escala especifica la conversión entre estas unidades del mapa y la
distancia en la superficie de la Tierra.

Los siguientes comandos del encabezado se deben incluir en la parte superior del archivo de
superposición:

Tabla 23 Comandos del encabezado de la unidad del mapa de la superposición

Comando Descripción

PROJECTION aed Informa que la superposición del sistema está en coordenadas relativas.

SCALE scale Establece el factor de escala en km/unidad del mapa.

El comando SCALE n se debe usar para especificar cuántos kilómetros
se especifican en cada unidad del mapa.

Por ejemplo, si se usa un comando RADAR 100 200 y SCALE 0.5, y si
luego se especifica un punto como POINT 110 200, este punto está
exactamente a 5 km al este de la posición de referencia.

RADAR x y Establece el punto de proyección en unidades del mapa y especifica la
ubicación del punto de referencia en las unidades del mapa.

REFERENCE lon lat Establece el punto de proyección en coordenadas absolutas.

DRAW_CENTER lon lat Igual que en la proyección de latlon.

FILL_CENTER lon lat Igual que en la proyección de latlon.

FILL_RANGE range Igual que en la proyección de latlon.

Para la compatibilidad inversa, el comando MIDDLE antiguo todavía tiene el significado de
establecer el centro de dibujo y el centro de relleno.

10.4 Asignación de una superposición al
sitio del radar

El administrador del sistema del IRIS asocia un archivo de superposición predeterminado
para cada sitio conectado al sistema. Puede asignar una superposición diferente al sitio.
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1. En el menú Overlay, resalte el sitio que desea cambiar.

Se muestra una lista de superposiciones disponibles.
En la siguiente figura, se muestra un ejemplo con 2 superposiciones para el sitio HEL:
HELSINKI y KARTTA.

Overlay

XXX — KING

SIG — SIGMET

HUN — HUNTSVI
LLE

HEL — HELSINK
I

WND — SIGMET

Site Overlay Name

File   Menus   Commands    Help

HEL–HELSINKI

HEL–KARTTA

HUN–HUNTSVILLE

KNG–KING

SIG–SIGMET

WND–SIGMET

Figura 98 Ejemplo de una superposición del sitio

2. Seleccione una superposición de la lista.

El menú también muestra las ID del sitio para las que la superposición es válida.
Si intenta mostrar un producto con una superposición no válida, el IRIS muestra el
mensaje Overlay origin more than 1000 km from radar location (1 000 km =
621,4 mi). Si le aparece este mensaje, verifique que se asigne la superposición correcta
al sitio del radar.
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Apéndice A. Meteorología de
radar básica

A.1 Bins, barridos y volúmenes
A medida que el radar gira alrededor de su eje 360° en un barrido, el radar meteorológico
transmite pulsos de microonda hacia la atmósfera y recibe las señales reflejadas por los
hidrometeoros, como la lluvia, el granizo o la nieve. Después de un barrido, el radar
normalmente cambia su elevación e inicia un nuevo barrido.

Las mediciones de reflexión de un pulso se clasifican en bins. Un bin es una única muestra de
datos meteorológicos detectados en una dirección, altitud y distancia conocidas desde el
sitio del radar. El tamaño radial de un bin aumenta con la distancia, por lo que los bins más
alejados del sitio del radar cubren un área mayor que los bins cercanos. En general, cada
barrido contiene el mismo número de bins, independientemente de la elevación.

Figura 99 Bins y barridos

Los volúmenes son un conjunto completo de datos de mediciones sin procesar recopilados
durante los barridos y que se utilizan para calcular un modelo de la atmósfera. El volumen
máximo es la mitad de una esfera (desde la elevación de 0° hacia arriba), pero otras formas
son más típicas.
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A.1.1 Reflectividad
Se suele decir que las cosas en la atmósfera reflejan la radiación, pero el término físico
preciso es retrodispersión. Se mide en Z (factor de reflectividad del radar) y se suele
expresar en dBZ (reflectividad del radar).

La ecuación famosa del radar desde la óptica clásica dice que:Z = Pr 2LCK
• P es la potencia promedio medida (en vatios) de varias muestras en el radar
• r es el rango hasta el bin
• L es la atenuación
• C es la constante del radar (hardware)
• K es el índice de refracción y depende de las propiedades dieléctricas de la partícula

Para meteorólogosRe flectivity = Watts_Re ceived × Distan ce_SquaredAttenuation × Hardware_Constan t × Rain_or_Snow_Constan t
Para los físicos de las nubes, Z es una suma ΣNiDi6 donde Ni es la cantidad de partículas con
diámetro Di por volumen de unidad en la atmósfera. Significa que una gotita con un
diámetro de 4 mm (0,16 pulgadas) da 4096 veces tanta energía como una gotita de 1 mm
(0,04 pulgadas). Y que no podemos decir si hay una gotita de 2 mm (0,08 pulgadas) o
64 gotitas de 1 mm (0,04 pulgadas).

Z varía entre 0,001 y 10.000.000. Para obtener números entendibles, usamos una escala de
decibeles:dBZ = 10log Zmm6mm−31mm6mm−3
En la siguiente figura, se muestran los valores típicos para varios fenómenos en la atmósfera.
Puede ver que la fuerza de la reflectividad por sí sola no es suficiente para la identificación
de objetivos.
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Figura 100 Valores dBZ para varios fenómenos

Para la hidrología, necesitamos una ecuación para combinar la reflectividad del radar con la
tasa de precipitación. Todas estas ecuaciones son empíricas y aproximadas, ya que Z es
proporcional a D6 y la tasa de precipitación R (mm/h) es proporcional a D3.7. Además,
debemos suponer algo sobre el tamaño de las gotas. Para 64 gotas de 1 mm
(0,04 pulgadas) de diámetro o una gota de 2 mm (0,08 pulgadas) de diámetro, Z es igual,
pero R no. Una buena primera estimación es la ecuación clásica de Marshall Palmer:Z = 200R1.6 que es igual a R = Z/200 0.625
A.2 Haz del radar
A medida que aumenta la distancia desde el sitio del radar, la granularidad del haz del radar
disminuye, lo que degrada la exactitud de los productos de radar. Por ejemplo, un haz de 1°
enviado desde la antena tiene un ancho de 2 km a 120 km de distancia. La siguiente imagen
muestra cómo los bins detectados crecen a medida que se alejan del radar.
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Figura 101 Resolución del radar a través del área detectada

Muchos productos de radar se ven afectados por la curvatura de la Tierra. Un haz de radar
transmitido en un ángulo vertical de 0° desde el sitio del radar en un entorno plano estaría
780 metros por encima del suelo a 100 km de distancia, antes de contabilizar la refracción
atmosférica. Si bien todos los productos de radar de IRIS Focus están corregidos para los
efectos de refracción y curvatura, aún no es posible detectar los fenómenos meteorológicos
por debajo del umbral de la curvatura.

La siguiente imagen muestra una sección transversal vertical de una acción típica de
exploración de volumen. La imagen está corregida para la curvatura de la Tierra. Obsérvese
cómo la resolución vertical aumenta cuanto mayor es la distancia horizontal. Lo mismo
sucede con la resolución horizontal.

Figura 102 Ejemplo de exploración de volumen de inclinación 15
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A.3 Problemas en la interpretación de las
imágenes del radar

Ecos no relacionados con los hidrometeoros:
• Reflexión de microondas desde la superficie del suelo o agua, espejismo del radar
• Pájaros, insectos, restos de aeroplanos
• Objetivos sólidos como postes y edificios
• Otras fuentes de microondas como el sol y otros radares
• Ecos de segundo viaje

Los ecos de objetivos sólidos, pájaros y demás se denominan interferencia. El software del
radar meteorológico realiza una cancelación de interferencia que elimina la interferencia sin
destruir los datos de hidrometeoros.

Diferencias en la intensidad del eco no relacionadas a las diferencias en intensidad de
precipitación:

• Problemas de calibración:
• Bloqueo de haz: los edificios cercanos a la antena pueden sombrear parcial o

totalmente los ecos desde cierta dirección.
• Atenuación en la lluvia: los ecos detrás de lluvia intensa pueden desaparecer,

especialmente si la longitud de onda es pequeña. La corrección de la atenuación puede
ayudar en situaciones en las que el eco es demasiado débil, pero no puede corregir una
situación en la que no hay eco.

• Fase de agua: el hielo, el hielo que se derrite y el agua dispersan las microondas de
manera diferente. La banda brillante puede ser de 7 dBZ.

• Tamaño de la gota: especialmente granizo que se derrite. Gotita de 2 mm = 64 gotitas
de 1 mm.

Aunque la medición sea correcta, no existe una correlación del 100 % con un medidor:
• Lejos de la antena, el haz está muy por encima de la tierra y puede sobrepasar una

nube precipitada. La lluvia se puede evaporarse por debajo de la altura de medición.
Puede producirse una mejora orográfica.

• En inviernos fríos, la diferencia entre la altura y la superficie de medición puede ser de
10 dB. La corrección del perfil de reflectividad vertical puede ayudar a corregir errores
cuantitativos, pero si no hay medición, la corrección no ayuda.

A.4 Mediciones de viento de Doppler
En comparación con los radares no Doppler, un radar Doppler puede proporcionar
cancelación de interferencia y productos de viento.

Un radar Doppler mide la velocidad del reflector al estudiar cómo cambia entre muestras la
fase de microondas en comparación con el pulso enviado.

• Un objetivo no móvil no tiene cambio de fase.
• Un objetivo cuyo movimiento no tiene componente en dirección al haz del radar no

tiene cambio de fase.
• Un cambio de fase de exactamente 2p no parece un cambio de fase.
• Un cambio de fase de exactamente 2p+d parece un cambio de fase d.
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• Un cambio de fase de exactamente n*2p+d parece un cambio de fase d. Esto se llama
solapamiento.

Para obtener buenas mediciones de Doppler, se deben procesar varias muestras juntas (64
es un buen número). Esto establece los límites a la velocidad de la antena.

La velocidad máxima que se puede medir sin ambigüedad esVmáx = PRF × λ4
donde λ (lambda) denota la longitud de onda.

A.5 Cancelación de interferencias
El eco se define como ecos de colinas, edificios, postes, mar y ruido como marcas en la
imagen generadas por los componentes electrónicos del equipo. El objetivo de la
cancelación del eco es eliminar el eco sin destruir los datos de lluvia.

Para ilustrar un filtro de Doppler, estudiamos el espectro de velocidad de un bin. Es decir, la
velocidad de Doppler de cada muestra, siendo el eje horizontal la velocidad (hacia o desde
el radar, 0 en el medio). Si todas las muestras indican que no hay velocidad, sabemos que el
objetivo no se está moviendo. Sin embargo, incluso los movimientos de la antena brindan
algo de velocidad. Y hay casos en los que hay lluvia en las colinas.

En la siguiente imagen, se muestra un espectro de Doppler de un bin que contiene eco
(velocidad cercana a 0) y lluvia moviéndose hacia el radar (montículo grande a la izquierda)
además de algo de ruido (pequeños montículos por todos lados, vistos solos a la derecha).
Para encontrar la configuración correcta para el filtro de Doppler, podemos acercar las líneas
rojas entre sí (se destruyen menos datos de lluvia) o alejarlas (se cancela más eco).
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Figura 103 Trazado típico del espectro
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Apéndice B. Corrección de la
velocidad radial

B.1 Corrección de la velocidad radial
El movimiento de un barco o de una plataforma aérea induce un error de la velocidad radial.
IRIS corrige este error al compensar el movimiento de la plataforma.

Las mediciones del movimiento del barco se recopilan del controlador de la antena y se
aplica opcionalmente la corrección de la velocidad radial a los archivos de introducción para
que se corrijan todos los productos subsiguientes y la visualización en tiempo real. Tenga en
cuenta que la corrección de la velocidad radial y todos los parámetros de movimiento de la
plataforma se archivan como parte del encabezado de rayos extendido.

B.1.1 Parámetros de movimiento y transformación de coordena-
das

Para sistemas con el RCP8 de Vaisala, consulte la derivación teórica de la estabilización en
RCP8 User Guide (M211320EN).

Tabla 24 Variables básicas de la detección de movimiento de barcos

Símbolo Definición

H Dirección medida en sentido horario desde el norte

θ H - π/2

#thetaoverdot# Tasa de cambio de dirección

P Cabeceo medido relativo al horizonte + para arco hacia abajo

#Poverdot# Tasa de cambio del cabeceo

R Alabeo medido relativo al horizonte + para puerto hacia abajo

#Roverdot# Tasa de cambio del alabeo

u Velocidad hacia el Este

v Velocidad hacia el Norte

w Velocidad hacia arriba

Dado un vector x en coordenadas terrestres y el vector correspondiente x#prime# en
coordenadas de barco,x′ = Ax  y x = A−1x′
donde las matrices de transformación son:
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Tenga en cuenta que A-1 es la transposición de A. Donde los vectores se definen de la
siguiente manera:

x = EastNortℎUp x′ = Towards rigℎtTowards bowTowards zenitℎ
B.1.2 Corrección de la velocidad radial
La velocidad radial escalar de los dispersores VR se puede expresar de la siguiente manera:VR = VRmeas− VR sℎip
donde VR meas es la velocidad Doppler medida por el procesador de señales y VR ship es la
corrección de la velocidad radial para el movimiento de barcos. La corrección de la
velocidad radial se encuentra al tomar el producto escalar del vector de la antena x en
coordenadas terrestres con la velocidad de la antena en coordenadas terrestres yA, de la
siguiente manera:VR sℎip = x ⋅ yA⋅
El vector de la antena es un vector de unidad que apunta en la dirección de la antena, que
depende del acimut y la elevación verdaderos (en relación a la tierra) de la antena, de la
siguiente manera:

x = sin AZ cos ELcos AZ cos ELsin EL AZand EL are eartℎ relative
Se los conoce a partir del controlador de la antena. Entonces, el problema es determinar el
yA, la velocidad de la antena.

La corrección de velocidad utilizada en IRIS permite los siguientes tipos de detección de
movimiento del barco:

Unidad de navegación inercial (INU)
(INU Case) La INU se coloca por lo general cerca de la antena. La INU informa
cabeceo, alabeo y dirección (y sus tasas de cambio), además de movimiento Este,
Norte y vertical (u, v, w). En este caso, la INU se usa como el punto de referencia del
barco.
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Sistema giroscópico con GPS
(Gyro Case) El sistema giroscópico reporta cabeceo, alabeo y dirección (y sus tasas de
cambio). El movimiento translacional medio del centro del barco (u, v, w) se obtiene
de un GPS u otros sistemas de navegación. En este caso, el centro de rotación del
barco se usa como el punto de referencia del barco.

El dispositivo de interfaz es la unidad de control de la antena del RCP. La información de
orientación y navegación pasa al IRIS mediante la conexión de la línea en serie al
controlador de la antena.

Antenna

Location
YA

YAI YA YI

INU LocationYI

YAS YA YS

YS

Ship Center

of Rotation

YIS YI YS

Figura 104 Vectores utilizados para la corrección de velocidad en coordenadas terrestres

En general, la INU no se ubica en el centro de rotación del barco ni de la antena. Los vectores
de ubicación se muestran en la figura anterior en coordenadas terrestres. El vector de
posición de la antena en coordenadas terrestres se puede expresar de la siguiente manera:

INU Case: yA = y1+ yA− y1
Gyro Case: yA = yS+ yA− yS
de modo que

INU Case: yA = y1+ ΔyAI
Gyro Case: yA = y1+ ΔyAS
donde ΔyAI = yA+ yI y ΔyAS = yA+ yS
Si expresamos los vectores Δ en términos de las coordenadas relativas al banco, se obtiene:

INU Case: yA = y1+ A−1Δy′AI
Gyro Case: yA = yS+ A−1Δy′AS
La diferenciación de estas dos expresiones genera las expresiones finales para la velocidad
de la antena:

INU Case: yA = yI⋅ + A⋅ −1Δy′AI
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Gyro Case: yA = yS⋅ + A⋅ −1Δy′AS
Tenga en cuenta que, debido a la INU, la antena y las coordenadas del centro del barco no
cambian en relación a las coordenadas del barco.yAS⋅ = yAI⋅ = 0
Los componentes de la matriz A-1 son los siguientes:

A⋅ −1 = A⋅ 11−1 A⋅ 12−1 A⋅ 13−1A⋅ 21−1 A⋅ 22−1 A⋅ 23−1A⋅ 31−1 A⋅ 32−1 A⋅ 33−1
donde:A⋅ 11−1 = − P⋅ sinPcosθ − θ⋅ cos Psin θA⋅ 21−1 = − P⋅ sinPcosθ − θ⋅ cos Pcos θA⋅ 31−1 = − P⋅ cos

Estas ecuaciones muestran que el movimiento de la antena se puede expresar como el
movimiento translacional de un punto de referencia (en la INU o en el centro de rotación del
barco), más un movimiento rotacional a un brazo de momento desde el punto de referencia
a la antena.

El movimiento translacional del punto de referencia es:

Como la INU lo detectó para el INU Case: y⋅ I = uvw
Como el GPS lo detectó para el Gyro Case: y⋅ S = uvw
Como caso especial, si la INU y la antena se ubican a exactamente la misma posición,
entonces

INU Case: Δy′AI = 0 de modo que yA⋅ = yI⋅
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En este caso, la velocidad de la antena es igual a la velocidad de la INU ya que el momento
de fuerza es de longitud 0.

B.1.3 Radares de la cola de aeronaves
Para radares de la cola de aeronaves, la matemática para la corrección de la velocidad es
diferente.

Tabla 25 Corrección de la velocidad para radares de la cola de aeronaves

Parámetro Descripción

Acimut Debido a que el eje de la rotación primaria es horizontal, el acimut es el ángulo relativo a una
exploración perpendicular. Entonces, cero significa explorar en un plano, positivo significa ex-
plorar un cono que mira hacia adelante y negativo significa explorar en un cono que mira hacia
atrás.

Elevación Debido a que el eje de la rotación primaria es horizontal, la elevación es el ángulo de rotación
alrededor del eje del movimiento de la aeronave, con cero apuntando hacia afuera hacia el ala
izquierda y positivo apuntando hacia arriba desde allí.

Ángulos re-
gistrados

Los ángulos registrados son relativos a la aeronave y toda sincronización de ángulos se realiza
relativa a la aeronave.

No tiene sentido corregir los ángulos en relación con el nivel del suelo antes del registro.

Cabeceo y
alabeo

Signo revertido en aeroplanos contra barcos.

El cálculo de las matrices A definidas para barcos tienen el signo revertido. Tenga en cuenta,
dado que no se realiza otra interpretación del alabeo y el cabeceo, esto se puede ignorar.

El vector de la antena relativo a la aeronave es el siguiente:

x′ = −cos EL cos AZsin AZsin EL cos AZ AZ and EL are aircraft relative
Antes de calcular el producto escalar de la corrección de la velocidad, primero debemos
convertirlo en relación a la tierra utilizando la ecuación anterior:x = A−1x
Luego, todo es igual que para los barcos.

B.1.4 Configuración de la corrección de la velocidad radial
Debe ingresar los componentes del vector del brazo de momento en la herramienta Setup:

INU Case Δy'AI! :

Δy'AI1

Distancia de la antena hacia adelante de la INU en el plano de referencia.

Δy'AI2

Distancia de la antena al puerto de la INU en el plano de referencia.
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Δy'AI3

Distancia de la antena hacia arriba a partir de la INU normal al plano de referencia.

Gyro Case Δy'AS :

Δy'AS1

Distancia de la antena hacia adelante del centro del barco en el plano de referencia.

Δy'AS2

Distancia de la antena al puerto de la línea central en el plano de referencia.

Δy'AS3

Distancia de la antena hacia arriba a partir del centro del barco normal al plano de
referencia.

Realice las mediciones hacia la bocina de alimentación de la antena. Se deben observar con
atención los signos de los componentes. Las unidades son metros. Tenga en cuenta que las
preguntas en Setup se refieren al caso INU. Si tiene el Gyro Case, ingrese los brazos de
momento correspondientes relacionados con el centro de rotación del barco.

Setup tiene una pregunta adicional sobre la compensación de altura de la INU. Se trata de
un número fijo que se agrega a la altura informada por la INU. Ya que la mayoría de las INU
informan la altura de manera precisa, este número se debe establecer en cero. El valor de
este número no afecta la corrección de la velocidad.

• Especifique el formato de la antena en Setup, sección RCP.
• Especifique el encabezado de rayo extendido en Setup, sección de introducción.
• Si tiene un RCP8 de Vaisala, configure como se describe en RCP8 User Guide

(M211320EN).
• Utilice el menú de TASK Configuration para activar o desactivar la corrección de la

velocidad para cada tarea.

B.1.5 Prueba de la corrección de la velocidad radial
Vaisala ofrece varios programas para probar la función de corrección de la velocidad.

B.1.5.1 Utilización de la herramienta Antenna para probar la corrección de la
velocidad

La herramienta Antenna muestra la información de navegación que se informa desde el
controlador de la antena además de la velocidad de la antena ΔyA y la corrección de la
velocidad.

Use la herramienta Antenna si debe verificar lo siguiente:
• Los signos de todos los ángulos (alabeo, cabeceo, dirección)
• Los signos de las velocidades angulares (alabeo, cabeceo, dirección)
• Los signos de las velocidades translacionales (u, v, w)
• Que las correcciones de velocidad sean razonables y estén libres de problemas

provocados por datos de entrada no confiables

Para obtener más información, consulte IRIS and RDA Utilities Guide (M211316EN).
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B.1.5.2 Utilización de la herramienta Rays para probar la corrección de la velo-
cidad

La herramienta Rays le permite analizar los datos de introducción.

Además, debido a que los productos RAW se pueden recuperar del archivo para crear
archivos de introducción regenerados, puede revisar el registro de datos.

Puede usar los valores de la herramienta Rays para verificar el algoritmo de corrección de
velocidad a partir de un cálculo independiente.

B.1.6 Sugerencias de pruebas en el sitio
Debe realizar la prueba final en el mar. Se trata de un entorno no controlado para la prueba;
sin embargo, es una prueba útil de todo el sistema de la corrección de velocidad. Los
objetivos en tierra fijos deben tener una velocidad corregida de 0 según se observa desde la
plataforma móvil. No utilice boyas con reflectores de radar. Son objetivos excelentes, pero
por lo general no están fijos.

Cruzar la zona marítima a ~10 km (6,2 millas) y observar objetivos terrestres fijos mientras
recolecta datos del IRIS. Es posible que quiera usar una exploración del sector para esto a
elevación baja. Verifique lo siguiente:

• La visualización a color en tiempo real debería mostrar los objetivos terrestres a
velocidad cero.

• La herramienta Rays debería mostrar los objetivos a velocidad cero.
• Se pueden construir productos de velocidad de PPI con una fina escala de velocidad de

resolución para verificar la corrección de la velocidad.

Si la velocidad corregida de los objetivos terrestres no es 0, debe aislar el problema. Si la
antena está correctamente estabilizada, es probable que tanto la INU (o el sistema
giroscópico) y el controlador de la antena estén funcionando correctamente. Por lo tanto, es
más probable que el error esté en la alineación:

• La vertical del sistema INU o giroscópico y la vertical de la antena deben estar
coalineadas.

• Los acimut del sistema INU o giroscópico deben estar coalineados.
• Los brazos de momento se deben medir correctamente.

La alineación del sistema INU o giroscópico con la antena se puede revisar con la función de
rastreo del sol de la herramienta Antenna. La medición del momento de fuerza se puede
revisar dinámicamente.

B.1.6.1 Ajuste dinámico de los momentos de fuerza

Medir brazos de momento o extraerlos del plano del barco puede ser difícil. El componente
de banda a banda del brazo de momento generalmente es la medida más fácil y, en la
mayoría de los casos, la antena se centra en el barco. Esto deja los momentos verticales y
anteriores/posteriores.

Puede revisar estos momentos de manera dinámica al observar objetivos terrestres en
configuraciones especiales del barco o de la antena.
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1. Aísle el componente vertical del brazo de momento al explorar sobre el haz del barco
mientras mira a objetivos de eco en la costa.

En este caso, la corrección de la velocidad está dominada por el alabeo del barco y el
brazo de momento vertical. El error de posición de banda a banda del brazo de
momento de la antena tiene el mismo efecto. En esta configuración, ajuste el brazo de
momento vertical en Antsetup hasta que la velocidad observada de los objetivos
terrestres sea 0. El barco debe estar en alabeo durante esta prueba.

2. Apunte la parte anterior o posterior de la antena para observar los objetivos con eco.

Ajuste el componente anterior o posterior del brazo de momento para eliminar
cualquier error de velocidad remanente. El barco debe estar cabeceando durante esta
prueba.

B.1.7 Algoritmo de corrección de la velocidad: Ejemplo de INU
1. VR = VR − VR sℎip
2. VR sℎip = x ⋅ yA⋅
3. yA = yI⋅ + A⋅ −1Δy′AI
4. y′ = SpeedEastSpeedNortℎSpeed Up as measured by tℎe INU
5. ΔyAI = antenna position forwardportover tℎe INU position
6. −1 = A⋅ 11−1 A⋅ 12−1 A⋅ 13−1A⋅ 21−1 A⋅ 22−1 A⋅ 23−1A⋅ 31−1 A⋅ 32−1 A⋅ 33−1
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HEAD
Dirección medida en sentido horario desde el norte

θ
HEAD - π/2

θׄ
Tasa de cambio de direcciónP
Cabeceo medido relativo al horizonte + para arco hacia abajoP⋅ Pׄ
Tasa de cambio del cabeceoRR
Alabeo medido relativo al horizonte + para puerto hacia abajoR⋅
Tasa de cambio del alabeo
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Apéndice C. Funciones del
IRIS TDWR

C.1 Elementos provistos con la opción
IRIS/TDWR

En el paquete opcional IRIS/SHEAR se incluyen características para las aplicaciones de
radares meteorológicos doppler del terminal:

• Producto SHEAR
La ejecución del producto WARN en un producto radial SHEAR se usa para la detección
de microrráfagas.
Consulte SHEAR : Cizalladura del viento (página 185).

• Producto SLINE
Detecta cambios en el viento asociados a frentes de ráfagas y de frío. Puede utilizar
cizalladura radial, de acimut o una combinación de ambas.
Consulte SLINE : Línea de cizalladura (página 197).

• Pantalla de cinta
Los terminales de la pantalla de cinta (RBDT) son pantallas de gran formato solo de
texto que se usan para mostrar e indicar las alertas a los controladores. IRIS es
compatible con los RBDT Dale de estilo FAA de los EE. UU. que son dispositivos de
hardware de línea en serie y con los RBDT virtuales (vribbons) que son pantallas de
ventanas X.
Consulte Pantallas de cinta (página 338).

• Integrador de TDWR/LLWAS
Utiliza el algoritmo de la FAA de los EE. UU. para integrar información de los productos
de advertencia de cizalladura de IRIS y LLWAS (sistema de alerta de cizalladura del
viento de bajo nivel) para generar productos TDWR para incluir en las pantallas de cinta
de estilo FAA de los EE. UU. estándares. Tenga en cuenta que no se requiere un sistema
LLWAS.
Consulte Herramienta de pistas e integrador de TDWR/LLWAS (página 350).

• Herramienta de la pista
Herramienta gráfica para seleccionar las pistas activas que están en uso. El integrador
de TDWR/LLWAS usa la información para seleccionar para qué corredores de pista se
emiten alertas al RBDT.
Consulte Herramienta Runways (página 357).

Estas características, junto con todas las características estándares de IRIS, permiten a los
controladores obtener información concisa y oportuna relacionada con la cizalladura del
viento y otros fenómenos meteorológicos que pueden afectar las operaciones del terminal
de aire.
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El TDWR que utiliza la FAA de los EE. UU. se basa en la tecnología de alrededor de 1985.
Desde entonces, las velocidades de computadora han aumentado considerablemente.
También se han producido cambios en los algoritmos, los estándares de redes y las
interfaces de usuario. El objetivo de IRIS/TDWR es tomar los mejores elementos de los
diseños de TDWR e implementarlos en el contexto de la tecnología actual.

Vaisala no garantiza que la opción de IRIS/TDWR funcione de acuerdo con las
especificaciones de la FAA de los EE. UU.

C.2 Terminología de IRIS/TDWR
A continuación, encontrará un resumen de la terminología de TDWR de la FAA de los
EE. UU. y su correspondencia con la terminología de IRIS:

Área
En IRIS se llama área protegida. Por ejemplo, el 33LA_1MF de pista significa una caja
(de generalmente 1 milla cuadrada) centrada 1 milla náutica del extremo próximo a su
fin (extremo sur) de la pista 33 (a la que se llega nominalmente en un encabezado de
330°).

Datos de base
Los datos de dBZ, V y W básicos. En IRIS, la versión comprimida es el producto RAW.
La versión no comprimida se llama datos de introducción.

Corredor
En cada pista hay dos corredores, un corredor de llegada y otro de salida.

Terminal de pantalla de mantenimiento (MDT)
Se usa para controlar y monitorear el sistema TDWR. Debido a que IRIS es un sistema
de cliente-servidor en red, el concepto de un "terminal" dedicado para esta función no
se aplica realmente, ya que cualquier estación de trabajo de la red puede proporcionar
esta función. Por cuestiones de administración, a veces resulta útil tener una estación
de trabajo de IRIS/pantalla dedicada a la tarea del MDT.

Alerta de microrráfaga (MBA)
Alerta de microrráfaga fuerte. En IRIS, se basa en la ejecución del producto WARN en
un producto radial SHEAR.

Sistema de alerta de cizalladura del viento de bajo nivel (LLWAS)
Se basa en los anemómetros colocados alrededor del terminal de aire. LLWAS no se
encuentra disponible en todos los sitios. Cuando se encuentra disponible, sirve de
respaldo del TDWR cuando la cobertura del radar está obstruida o no hay objetivos
dispersos.

Sistema de adquisición de datos del radar (RDA)
Sistema de recopilación de datos. En IRIS, esto consta del procesador de señales, el
procesador de control del radar y una estación de trabajo que ejecuta el software de
IRIS/radar.
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Generador de productos del radar (RPG)
En TDWR, esta es una computadora por separado que recibe los datos de base del
RDA y genera productos.
En IRIS, esta es una estación de trabajo que ejecuta IRIS/Analysis que recibe datos de
otra estación de trabajo que ejecuta IRIS/Radar. En IRIS, se pueden combinar las
funciones de RDA y RPG.

Pantalla de cinta (RBDT)
Pantalla de solo texto para los controladores. Se conecta a una estación de trabajo de
IRIS a través de una línea en serie.

Pantalla de la situación (SD)
Pantalla meteorológica simplificada donde se muestran formas ovaladas para ilustrar
las microrráfagas y las posiciones de línea de las cizalladuras del viento actual y
prevista. En IRIS, se logra esto mediante la visualización simultánea de los productos
WARN y SLINE.

Alerta de cizalladura del viento (WSA)
Alerta de una línea de cizalladura o frente de ráfaga basado en el producto SLINE
(línea de cizalladura) o una microrráfaga débil basada en la ejecución del producto
WARN en la cizalladura radial.

C.3 Ejemplo de configuración del hard-
ware de IRIS/TDWR

Vaisala es compatible con configuraciones de hardware redundantes simples y dobles.
Debido a las características de comunicaciones de red en IRIS, hay muchas configuraciones
de hardware posibles que permiten que varias estaciones de trabajo realicen diferentes
tareas.

El siguiente es un ejemplo de un sistema no redundante.

Apéndice C – Funciones del IRIS TDWR

RESTRINGIDO 331



TDWR Hardware Configuration Example

Non-Redundant Case

RDA

RPG
MDT

RBDT's
SD

RVP7

RCP02

SCSI

RS232

IRIS/Radar

Radar Product Generator Maintenance Display Terminal

TCPIP

Network
TCPIP

Network

IRIS/Analysis

Ribbon Displays

Note that RBDT's can be

installed on any IRIS

workstation (up to 8 each).

RS232 RS232

Situation Display

IRIS/Display

Note: There can be many

SD's served by an RPG ~12.

IRIS/Display

Radar Data Acquisition

Figura 105 Ejemplo de configuración del hardware de IRIS/TDWR

Gracias a la arquitectura de IRIS, se podrían combinar las funciones de RPG y MDT en la
estación de trabajo de RDA. Reducir la cantidad de hardware aumenta la confiabilidad del
sistema y reduce el mantenimiento. La estación de trabajo de RDA también tiene todas las
características de una SD.

Para los sistemas redundantes, hay dos RDA y dos RPG. El RDA tiene interfaces de red
dobles y las activas producen datos de base para ambos RPG. Esto significa que todos los
productos se hacen dos veces. Cada SD está configurada con 3 interfaces de red, una para
cada RPG y otra para la salida de red a la SD. Cada SD está equipada con 2 interfaces de red,
una para cada RPG. Por lo tanto, cada SD recibe 2 versiones de cada producto, uno de cada
SD. Si un RPG o una red falla, la SD continúa recibiendo productos del otro.

C.4 Flujo de datos para la generación de
la pantalla de cinta

La función principal del procesamiento de TDWR es generar mensajes de la pantalla de cinta
para los controladores (acompañados por un tono de advertencia de audio).

Las características estándares de salida y visualización de IRIS también se usan para
construir imágenes para las pantallas de situación (SD); es decir, pantallas simplificadas que
muestran áreas de advertencia de las pistas, centroides de alerta y líneas de cizalladura con
posiciones de pronóstico. Debido a que las SD son pantallas normales de IRIS, también se
pueden mostrar otros productos de IRIS.
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Las pantallas de cinta se generan cuando el IRIS local (el IRIS donde está conectada la
pantalla de cinta) recibe un producto de TDWR especial.

Data Flow to Generate Ribbon Display

IRIS/Analysis on RPG

Product Configuration Files

SLINE

Config

SHEAR

Config

WARN

Config

Product

Process

Ingest  Files

of Base Data

Product Files

TDWR SLINE WARN on

SHEAR

Receiver Output

TDWR

Runway

Utility

TDWR/LLWAS

Integrator

TCPIP

LLWAS

Data

(optional)

Products

TCPIP

TDWR

Network

Output

RS232C

9600 Baud

Note: SLINE and

WARN (on SHEAR)

are also sent to SD

along with other IRIS

Products

Dale or Vribbon
Ribbon DisplayIRIS   Workstation

Situation Display

Figura 106 Flujo de datos para generar productos de la pantalla de cinta de TDWR

La generación normal de productos de IRIS permite la realización de productos de SLINE y
WARN para la cizalladura radial (advertencias de microrráfagas). Estos productos tienen
todas las áreas protegidas posibles activadas, incluso para pistas inactivas.

Los resultados se envían a un integrador de TDWR/LLWAS por separado. El integrador
obtiene datos de LLWAS (si está disponible) e información de configuración sobre las pistas
activas actuales de la herramienta de pistas. El resultado que recibe IRIS es un producto de
TDWR filtrado de modo que solo la información requerida por la pantalla de cinta está
presente. El algoritmo de integración es el de FAA/MIT Lincoln Lab desarrollado para el
TDWR de la FAA de los EE. UU.

Por lo general, tanto el IRIS como el integrador se ejecutan en el RPG, aunque es posible
ejecutar el integrador de TDWR/LLWAS en una SD. Sin embargo, esto provocaría problemas
de configuración debido a que hay grandes posibilidades de que haya muchas SD.
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El RPG luego coloca el producto de TDWR en la SD y cuando lo recibe, se aplica
automáticamente formato para que se convierta en un mensaje de la pantalla de cinta y se
envíe a la línea en serie de SD.

El proceso mediante el cual se colocan los productos al RBDT tiene un filtro configurable
adicional. El controlador puede especificar qué corredores se muestran en una SD. Utilice el
comando ribsetup para configurar esta opción.

C.5 Resumen de configuración de IRIS/
TDWR

Siga los siguientes procedimientos para instalar y configurar los componentes de TDWR.

1. Configure IRIS para el funcionamiento de TDWR.

a. Configure las áreas de las pistas (áreas protegidas).

Consulte Configuración de las áreas protegidas para TDWR (página 334).

b. Configure las tareas de exploración y los productos SLINE y SHEAR.

Consulte Configuración de las tareas y los productos de IRIS para TDWR
(página 336).

c. Configure las salidas para el integrador y las SD.

Consulte Configuración de las salidas de productos de IRIS para el TDWR
(página 336).

2. Instale y configure las pantallas de cinta. Consulte:

• Pantallas de cinta (página 338)
• Configuración del software de la pantalla de cinta (página 343)

3. Configure el integrador de TDWR/LLWAS (runways.conf).

Consulte Herramienta de pistas e integrador de TDWR/LLWAS (página 350).

4. Use la herramienta runways para configurar la dirección de la pista.

Consulte Herramienta Runways (página 357).

C.6 Preparación del IRIS
Preparar el sistema de IRIS implica configurar las áreas protegidas, la estrategia de
exploración, la generación de productos y la salida para el funcionamiento de TDWR.

C.6.1 Configuración de las áreas protegidas para TDWR
Las áreas protegidas se configuran en la herramienta Setup > Product de IRIS.
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33–_RWY

33–_1MD

33–_1MF

33–_2MF

33–_3MF

33–_2MD

33–_3MD

Figura 107 Configuración de las áreas protegidas para TDWR

Convención de nomenclatura del área

La convención de nomenclatura para designar los corredores de las pistas y las áreas
protegidas (también llamadas "áreas") es la siguiente:

• Los 2 primeros dígitos corresponden al nombre de la pista, también llamado nombre
del "corredor". En el ejemplo, es "33".
Los nombres correspondientes para la dirección inversa (pista 15) se generan
automáticamente.
Vaisala recomienda usar la convención de nomenclatura de la dirección del "límite
norte" para un corredor.

• Se usa la próxima posición si hay una pista izquierda y derecha. Por ejemplo, use 33R y
33L para indicar las pistas izquierda y derecha.
Si hay una sola pista, use un guión como en el ejemplo; es decir, 33–.
Tenga en cuenta que si las pistas izquierda y derecha se encuentran a una distancia de
aproximadamente 500 m (1640 pies 5 in) entre sí, es más fácil designar un solo
corredor para las alertas en vez de 2 corredores por separado que casi se superponen
por completo.

• En el siguiente campo hay un carácter de guión bajo que sirve como separador.
• Los últimos 3 dígitos se usan para especificar el "área". En el ejemplo, con "1MF" se

especifica un área protegida que se extiende desde el extremo de la pista hacia 1 milla
del extremo de la pista. Se recomienda usar el texto RWY para especificar la pista en sí.
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Una vez que eligió los nombres de la pista y del área, construya la geometría de las áreas
protegidas; es decir, la información del tamaño y la orientación que se requieren en la
herramienta de Setup > Product de IRIS. Consulte IRIS and RDA Utilities Guide (M211316EN).

Es difícil lograr que las áreas sean correctas. Como ayuda, Vaisala le proporciona una hoja
de cálculo en EXCEL que le facilita configurar las áreas protegidas de las pistas. Póngase
en contacto con un representante de Vaisala para obtener una copia.

Luego de haber creado sus áreas protegidas, pruébelas con la herramienta Overlay. Esto
requiere haber configurado la superposición para su sistema. Consulte Overlay en IRIS and
RDA Utilities Guide (M211316EN).

Para ver las áreas protegidas sobre la superposición, seleccione Overlay > Options > 
Protected.

En la pantalla figuran las áreas protegidas. Realice un acercamiento según sea necesario
para verlas. Las áreas no están etiquetadas.

Verifique que todas las áreas se encuentren en las ubicaciones correctas y que todos los
bordes estén correctamente alineados. Si no, salga de Overlay y regrese a la configuración/
producto de IRIS para editar y guardar la información del área protegida. Vuelva a hacer la
prueba con Overlay para ver si lo hizo correctamente.

C.6.2 Configuración de las tareas y los productos de IRIS para
TDWR

Configurar las tareas de exploración y los productos de SLINE y SHEAR requeridos para el
funcionamiento de TDWR depende de los requisitos específicos del usuario y las
limitaciones del sitio.

Por ejemplo, algunos clientes pueden solicitar la recolección de la información de
exploración de un volumen completo durante la operación de TDWR (para un monitoreo
meteorológico general), mientras que otros querrán que la exploración esté destinada a la
detección de cizalladura del viento de bajo nivel.

La mayoría de las veces se configura el sistema para que cambie automáticamente de un
modo de monitoreo meteorológico a un modo de monitoreo de peligros cuando el clima es
severo cerca del terminal.

Use la configuración de ejemplo como punto de partida de la operación. Debe ajustar este
ejemplo para cumplir con los requisitos del sitio. Por lo general, esto se hace cuando se
instala el sistema.

C.6.3 Configuración de las salidas de productos de IRIS para el
TDWR

La configuración de la salida del producto de IRIS para el TDWR consta de:
• Generación de los productos de TDWR para la SD (estaciones de trabajo de IRIS/

pantalla con hardware o pantallas de cinta virtuales).
• Generación de los productos SHEAR y SLINE para el integrador de TDWR/LLWAS.
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Ambas configuraciones de generación se realizan en el sistema donde se está ejecutando el
integrador de TDWR/IRIS. Por lo general, se trata de una estación de trabajo de IRIS/
Analysis que funciona como un RPG (generador de productos del radar). En los ejemplos a
continuación, este nodo se llama cyclone.

1. Configure la salida a la SD:

a. Configure los dispositivos de salida de red para la SD en la configuración/salida de
IRIS.

El siguiente es un ejemplo de una salida de red a una estación de trabajo llamada
SD1. En el ejemplo se usan un directorio de objetivo de IRIS estándar y un puerto de
notificación de TCPIP.

b. Configure el IRIS Product Output Menu para lograr una salida automática de los
productos del TDWR a la SD.

Consulte Envío de un producto a un dispositivo (página 281).
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2. Configure la salida al integrador de TDWR/LLWAS:

a. Use la configuración/salida de IRIS para configurar la salida al integrador.

Consulte el siguiente ejemplo. Use el formato de nombre de archivo Short.
Debido a que el integrador se ejecuta en la misma máquina, use Copy en vez de RCP
(copia remota).
El puerto de notificación debe coincidir con el configurado para el integrador en el
archivo runways.conf (consulte Configuración de la herramienta Runways e
Integrator: runways.conf (página 351)). El puerto recomendado es 30726 como se
muestra en el ejemplo.

b. Configure el IRIS Product Output Menu para lograr la generación automática de los
productos SHEAR y SLINE en el integrador.

Consulte Envío de un producto a un dispositivo (página 281).

C.7 Pantallas de cinta
Un controlador de ATC ocupado no tiene tiempo de mirar las pantallas de situación a color e
interpretarlas.
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Las pantallas de cinta son pantallas alfanuméricas (conectadas a las pantallas de situación)
que permiten al personal de ATC acceder a información concisa sobre el estado de varios
corredores de pistas con respecto a la cizalladura del viento y los eventos de microrráfagas.
En la pantalla se muestran mensajes de texto simples de la forma:

32LA MBA 3MF 40K- 180 14
32LD 190 15
33LA WSA RWY 25K+ 190 17
33LD WSA RWY 25K+ 160 14

• Mediante la primera línea se informa al controlador sobre una alerta de microrráfaga
para la pista 32 en un alcance final de 4,8 km (3 millas). Se puede prever una pérdida de
velocidad aérea de 40 nudos. Al final de la línea está el viento de superficie medido
(dirección y velocidad en nudos) en el extremo del umbral de la pista o desde cualquier
otro punto en el campo (según la disponibilidad de la información del viento de un
LLWAS u otra fuente).

• La segunda línea muestra la pantalla normal sin mensajes de advertencia. Solo se
muestra el viento.

• La tercera y cuarta línea muestran una alerta de cizalladura del viento (línea de
cizalladura) para la pista 33L (entrada y salida) con una ganancia prevista de 25 nudos.
Al final de cada línea figuran los vientos del umbral.

Además de los mensajes de texto, suena un tono de alerta sonoro cuando se emite una
alerta. El controlador presiona un botón ubicado en la parte delantera de la pantalla de cinta
para aceptar el tono de alerta.

C.7.1 Pantallas de cinta admitidas
IRIS es compatible con las siguientes pantallas de cinta:

• Dale Electronics, Inc., monitor de pantalla plasma/sistema de alarma modelo
ADP-250M045 (-1 para 220 V). Utilizado por la FAA de los EE. UU. Debido a su brillo es
ideal para los entornos de cabina de la torre que tienen una luz de fondo alta.

• Pantallas de cinta virtuales de IRIS Esta es una pantalla de ventana X que se puede
colocar en una estación de trabajo o una PC que ejecute la ventana X.

La estación de trabajo de IRIS debe contar con una licencia de soporte de pantalla de cinta.

C.7.2 Instalación del hardware de la pantalla de cinta de Dale
Se pueden "conectar en cadena" hasta 8 pantallas de cinta Dale a una estación de trabajo de
IRIS como se muestra en la siguiente figura.

La notación M y F hace referencia al extremo del cable (DB25M o DB25F).
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Ribbon Display Connection to IRIS

IRIS Workstation

RS232C 9600 Baud

M MMF F

J1 J2 J1 J2 J1 J2

Figura 108 Instalación de la pantalla de cinta de Dale

Tabla 26 Asignaciones de pin de la pantalla de cinta

J2 J1 Señal

1 1 GND (blindaje)

3 2 Recepción de datos

2 3 Transmisión de datos

7 7 GND (tierra)

C.7.3 Uso general de la pantalla de cinta de Dale

Ribbon Display Front Panel Controls

ACKNOWLEDGE

SELF TEST BRIGHTNESS ALARM VOLUME

NORMAL

BYPASS

OFF

MANUAL

AUTO

SELECTOR
POWER

DURATION FREQUENCY       WARBLE

Figura 109 Controles de la pantalla de cinta de Dale
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El panel delantero con bisagras se desmonta para dar acceso a los controles locales. El área
de controles se enciende cuando se abre la puerta.

Self Test
Mantenga presionado el botón SELF TEST para escribir el carácter en la pantalla. El
número de identificación del monitor, el número de modelo y la versión de software se
muestran en la última línea de la pantalla de autoprueba.
Si es necesario, puede cambiar el número de identificación con el interruptor de
selección.
La alarma auditiva se activa y puede ajustar el volumen y los tonos modulados.
Si se envían datos al monitor mientras SELF TEST está presionado, el monitor
configura D6 y D7 (del byte de estado) en el nivel alto cuando se suelta el botón para
indicar que los datos enviados a la unidad no se capturaron y que la pantalla debería
regenerarse.

Brightness
Use el control BRIGHTNESS para ajustar el brillo de la pantalla.
Para aumentar el brillo, gire el control hacia la derecha.
Cuando gira el control a la posición izquierda máxima (pasando el tope del
interruptor), el brillo se controla automáticamente según la cantidad de luz ambiente
en la sala.

Normal/Bypass
Coloque el interruptor en la posición NORMAL para establecer comunicación entre el
monitor, el host y otros dispositivos periféricos.
Coloque el interruptor en la posición de BYPASS para guiar las señales de RS-232D
alrededor del monitor.
Este interruptor de hardware permite aislar el circuito de I/O del monitor cuando está
en la posición BYPASS.

Selector
Puede configurar el número de identificación del monitor de 0 a 7 al presionar el
interruptor.
Para configurar el número de identificación, mantenga presionado el botón SELF TEST
y ajuste el control SELECTOR hasta que aparezca el número deseado en la pantalla.
Nota: Hay tres posiciones que muestran 0. Todas funcionan como identificador #0.

Controles de la alarma y ajustes
La alarma sonora tiene 2 tonos que se encienden y apagan de forma alterna para crear
un efecto de "modulación".
Puede ajustar los parámetros de los tonos modulados mediante DURATION,
FREQUENCY y WARBLE.

Volume
Use el control VOLUME para ajustar el volumen de la alarma sonora de 60 a 85 dBa.
Gire el control completamente hacia la izquierda para desactivar la salida del altavoz
de la alarma. Al girar el control hacia la derecha, se aumenta el volumen, y al girarlo
hacia la izquierda, se baja.

Duration
Permite que varíe el tiempo de activación/desactivación (ciclo de trabajo) de los dos
tonos.

Apéndice C – Funciones del IRIS TDWR

RESTRINGIDO 341



Frequency
Sube o baja la frecuencia de los 2 tonos de modulación.

Warble
Varía la tasa en las que se alternan los 2 tonos.

Acknowledge
Cuando la computadora host envía una alarma, el monitor activa la alarma sonora y
enciende el interruptor ACKNOWLEDGE.
Presione el interruptor ACKNOWLEDGE para reconocer y silenciar la alarma.

C.7.4 Pantalla de cinta virtual de IRIS
Para los sistemas que no tienen la pantalla de cinta del modelo de Dale, se proporciona la
pantalla de cinta virtual (vribbon).

También resulta práctico para ver las pantallas de Dale para verificar que estén
correctamente configuradas; es decir, puede ver una versión virtual de la pantalla de Dale.

Los observadores, operadores y controladores pueden acceder a la vribbon. La pantalla
vribbon se ejecuta localmente en una SD al abrir un terminal y escribir:

$ vribbon

Figura 110 Pantalla vribbon

La pantalla tiene 10 líneas. Las nueve líneas superiores se usan para mostrar las advertencias
de varios corredores de entrada y de salida. En el ejemplo, la pista de salida 15 tiene una
alerta de microrráfaga con una pérdida de 45 nudos. Los vientos máximos son de 60° (060)
a 13 nudos. La línea inferior muestra los datos de viento del campo central y el estado de la
señal de alarma.
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vribbon puede mostrar cualquiera de las 8 pantallas de cinta físicas. Para ello, debe
seleccionar el número de pantalla (de 0 a 7). vribbon también tiene una alarma de tono
que se puede silenciar (no desactivar) al seleccionar Acknowledge.

C.7.5 Configuración del software de la pantalla de cinta

Para ejecutar el software de IRIS para el soporte de la pantalla de cinta, su sistema debe
contar con una licencia para usar esta función y debe tener privilegios de operador.
Consulte a su gerente de sistemas.

Descripción general

En la herramienta de configuración de la pantalla de cinta encontrará las siguientes
funciones:

• Los corredores de entrada y de salida de la pista se asignan a cada línea de la pantalla.
• Se pueden configurar hasta 8 pantallas para cada estación de trabajo de IRIS y se

pueden configurar las líneas para cada pantalla de forma independiente.
• Se pueden guardar hasta 4 configuraciones. Esto se usa para instalaciones en las que

las diferentes asignaciones de pistas activas pueden requerir diferentes disposiciones
de pantalla.

Configure las pantallas de cinta con la herramienta ribsetup.

Luego de haber definido las áreas protegidas, se usa la herramienta ribsetup para definir la
apariencia de la pantalla de cinta; es decir, qué información de pista se muestra en cada una
de las líneas de cada pantalla de cinta.

Para iniciar la herramienta ribsetup debe ser operador. Abra la ventana del terminal y
escriba:

$ ribsetup &

Aparece la herramienta ribsetup como se muestra a continuación:
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Cuando aparece el menú por primera vez, está en modo de "selección". Puede seleccionar
entre cuatro configuraciones diferentes que se definieron previamente. En el ejemplo
anterior, se definieron 2 configuraciones: una para la pista 33 y la otra para la 15. Las otras 2
configuraciones no se usan.

Se deben definir las configuraciones para que correspondan a las pistas reales que
generalmente se usan juntas en la operación. Cuando se vuelve a configurar el área del
terminal en respuesta a una nueva dirección del viento, se usa este menú para seleccionar la
pantalla de cinta correspondiente a la nueva configuración.

A continuación, se describen las funciones del menú.
File

Brinda las funciones.
• Load

Se usa para restablecer el menú de la configuración de archivo guardada
actualmente si desea "deshacer" los cambios.

• Save
Guarda los cambios.

• Print
Para imprimir el menú por cuestiones de documentación.

• Exit
Para salir del menú. Tenga en cuenta que las pantallas de cinta permanecen activas
cuando sale.
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Status
Seleccione Status para ver un submenú del estado de comunicación de cada una de
las 8 pantallas de cinta que se pueden instalar en la estación de trabajo de IRIS.

En la fila superior del menú aparecen los números de la pantalla de cinta
correspondientes a las 8 pantallas que se podrían conectar a su estación de trabajo de
IRIS. Tenga en cuenta que es posible que en su sistema haya menos de 8 pantallas. En
la segunda fila aparecen los nombres que se configuraron para las pantallas. Los
cuatro últimos nombres están configurados en "ninguno" para indicar que no están en
uso.
Se indica el estado de cada pantalla de cinta como OK o Dead. La pantalla Dead
posiblemente se desactivó o tiene un problema de cableado. Además, es posible que
el número de la pantalla configurado en la pantalla en sí sea incorrecto (consulte Uso
general de la pantalla de cinta de Dale (página 340)).
El tiempo de actualización muestra el tiempo en segundos desde la última
comunicación entre el IRIS y la pantalla. Se muestra el conteo de entrada y de salida
para indicar la cantidad de bytes de entrada desde la pantalla y de salida hacia la
pantalla. A veces esto resulta útil para depurar problemas de comunicaciones.

Config
Mediante los submenús se puede personalizar la apariencia de cada una de las
pantallas de cinta.

Config/Config... (puerto de salida en serie)

Esta selección determina qué puerto de salida de línea en serie se usa para las pantallas de
cinta. Solo se necesita un solo puerto debido a que las pantallas están conectadas en
cadenas entre sí. Escriba el nombre del dispositivo de la siguiente manera:
/dev/ttyXXX
XXX depende del sistema, por ejemplo:

• Linux ttyS0 o ttyS1
• HP tty0p0 o tty0p1

Consulte con el administrador del sistema de IRIS si no está seguro.
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Cantidad de conjuntos activos (1, 2, 3, 4)

Con esto puede determinar cuántos conjuntos diferentes desea. En el ejemplo, hay dos
conjuntos activos. Escriba el nombre que desee para los conjuntos activos y seleccione File 
> Save.

Menú de configuración de la pantalla

De esta manera se puede acceder al menú de configuración. El menú de configuración se
usa para configurar la apariencia de la pantalla de cinta para cada conjunto activo.

Presione el botón que se encuentra debajo del nombre del conjunto activo para ver su
configuración de pantalla. Tenga en cuenta que de esta manera no se cambia el conjunto
activo en las pantallas de cinta; es decir, solo afecta lo que se muestra y edita en el menú de
configuración. El botón se vuelve amarillo para indicar qué conjunto se está mirando o
editando. En el ejemplo, el menú de configuración está configurado para ver RWY 15 (botón
amarillo).

En la parte superior del menú de configuración aparece el número de pantalla y está
codificada con los colores rojo o verde para indicar si el estado de la pantalla es OK o Dead.
Los números de la pantalla corresponden a la posición del "selector" (0 a 7) que está
configurada en cada una de las pantallas de cinta. Se recomienda que si, por ejemplo, tiene
4 pantallas, los interruptores de selección de las pantallas estén configurados en 0, 1, 2 y 3.

También hay un botón junto al número de pantalla para seleccionar si una pantalla está
habilitada o no. Si se instala una pantalla, se debe hacer clic en el botón. En el ejemplo, las
primeras cuatro pantallas (0 a 3) están habilitadas, mientras que las pantallas 1, 2 y 3 están
deshabilitadas (color rojo), lo que indica que están apagadas o que hay un problema de
comunicación.

Debajo de cada número de pantalla hay un nombre de pantalla (por ejemplo, Tower1).
Configúrelos para indicar la ubicación o función de la pantalla de cinta en particular. Se
recomienda que use el texto None o Unused para indicar cuando una pantalla no está
instalada. Para cambiar el nombre, escriba el texto.
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Figura 111 Menú de configuración de la pantalla de cinta

En la parte inferior del menú de configuración hay 9 entradas para cada pantalla que
corresponden a las 9 líneas disponibles para las advertencias en una pantalla de cinta. Para
configurar lo que aparece en cada línea, primero resáltela y, luego, haga clic con el botón
secundario del mouse para ver una lista emergente de todos los corredores posibles como
se muestra a continuación.

Los nombres de los corredores se obtienen de las áreas de advertencia de configuración/
producto de IRIS creadas (consulte el comienzo de esta sección). Además, hay una línea en
blanco (para configurar las líneas en blanco en la pantalla) y hay otras áreas protegidas
arbitrarias que pueden no estar asociadas con un corredor en particular. Por ejemplo, se
puede configurar una sola área protegida grande para mostrar las alertas en cualquier parte
dentro de los 8 km (5 millas) del terminal.
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Seleccione el corredor del submenú para cada línea de la pantalla. Repita el procedimiento
para todas las pantallas.

En el ejemplo, cada una de las cuatro pantallas habilitadas está configurada de manera
idéntica. En general, esta es una buena práctica porque permite que sea más fácil mantener
el sistema. Si las operaciones lo requieren, las diferentes pantallas pueden tener diferentes
configuraciones.

Para realizar cambios grandes, use el botón Clear All. Si comete un error, use File > Load
para restablecer los valores guardados.

Luego de configurar un conjunto, use File > Save para guardar sus resultados. Posiblemente
también desee usar File > Print para documentar sus configuraciones. Luego, puede hacer
clic en un conjunto diferente (botón amarillo debajo del nombre del conjunto) y configurar
las pantallas para esto. Continúe hasta haber configurado todos los conjuntos activos.

C.7.6 Prueba de la pantalla de cinta con tdwr_sim

No ejecute la herramienta de prueba tdwr_sim durante el
funcionamiento normal del sistema, ya que podría interferir con la señal de las
advertencias reales.

ADVERTENCIA!

Para probar la pantalla de cinta y por cuestiones de capacitación, Vaisala brinda la
herramienta tdwr_sim. La herramienta genera un producto de TDWR simulado con alertas
para los corredores seleccionados con el fin de verificar que las pantallas de cinta funcionen
correctamente. Tenga en cuenta que de esta manera no se verifica que el sistema de IRIS
genere adecuadamente las advertencias.

1. Inicie un terminal y escriba:

$ tdwr_sim
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2. Cuando se le indique Enter Corridor Count, ingrese la cantidad de corredores que
tiene en su sistema.

En el ejemplo que se ha usado en este apéndice habría cuatro (33A, 33D, 15A, 15D). El
máximo conteo admitido por el simulador es 16.

3. Presione ENTER.

Los nombres del corredor se muestran línea por línea. Puede ingresar un texto
arbitrario para generar un mensaje de prueba.
A continuación se muestra una sesión de prueba:

Enter Corridor Count [4]: 4
Enter Alert type for Corridor 0 (15-A)[ ]:
Enter Alert type for Corridor 1 (15-D)[ ]: MBA
Enter Alert type for Corridor 2 (33-A)[ ]:
Enter Alert type for Corridor 3 (33-D)[ ]:
Sending product to IRIS.
Enter Corridor Count [4]:

tdwr_sim envía un producto de TDWR simulado a IRIS, que se transmite a cada
pantalla de cinta configurada para mostrar las alertas del corredor seleccionado (en
este caso, 15–D).
Esto provoca que en la pantalla de cinta aparezca un mensaje de advertencia como se
muestra a continuación.

4. Para borrar una alerta, presione la BARRA ESPACIADORA para reemplazar la
advertencia por una línea en blanco.

Si no se envía ningún mensaje nuevo a las pantallas de cinta durante 150 segundos,
aparece el texto NO DATA AVAILABLE en todas las pantallas de cinta.

5. Para detener tdwr_sim, ingrese CTRL+C.
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C.7.7 Mensajes de alerta de la pantalla de cinta

33–A MBA 3MF 40K– 180 14

Approach/Departure Corridor

Type of Alert (Microburst or Wind Shear)

Location (e,g, 3 miles final approach)

Expected airspeed gain/loss

Wind direction at threshold or other specified location

Figura 112 Mensajes de alerta de la pantalla de cinta de TDWR

C.8 Herramienta de pistas e integrador
de TDWR/LLWAS

El integrador de TDWR/LLWAS es un proceso de software por separado (que no forma
parte del software de IRIS principal) que combina alertas de cizalladura del viento de IRIS y
un sistema LLWAS opcional para generar productos de TDWR. El integrador funciona como
un filtro en las alertas; es decir, este:

• Solo pasa las alertas de las pistas activas como lo especifica la herramienta runways.
• Si un área tiene 2 o más alertas, se pasa la alerta más importante, por ejemplo, una

alerta de microrráfaga es más importante que una alerta de cizalladura del viento.
• Solo pasa la alerta del área del primer encuentro en un corredor. Por ejemplo, si
33L_3MF y 33L_2MF tienen alertas de microrráfagas, entonces se emite la alerta de
33L_3MF en la pantalla de cinta debido a que un avión encontraría esto primero.

• En caso de que el sistema falle, este utiliza las alertas de otro sistema, por ejemplo, si
TDWR falla, solo se usan los datos de LLWAS.

• Para cada área, se combinan las alertas de TDWR y LLWAS de la siguiente manera: Se
pasa una alerta intensa (MBA) de cualquier sistema, mientras que una alerta débil
(WSA) requiere de confirmación de otro sistema. Se ajustan los umbrales para lo que se
considera fuerte y débil en cada sitio.

Los productos de TDWR del integrador se envían de vuelta a IRIS para su distribución al SD
con el fin de impulsar las pantallas de cinta. Consulte Flujo de datos para la generación de la
pantalla de cinta (página 332).

El integrador toma como entrada los siguientes datos:
• Productos SLINE de IRIS (advertencia de ráfagas delanteras)
• Productos WARN (en cizalladura radial) de IRIS (advertencia de microrráfaga)
• Datos de entrada de LLWAS (si está disponible, para advertencias de LLWAS).
• Configuración de la pista activa de la herramienta runways.

Se genera un nuevo producto de TDWR y se ingresa a IRIS cuando:
• Se reciben nuevos datos de entrada.
• Se cambia la configuración de pista activa.
• Expiró el tiempo máximo de espera (tiempo especificado de la orden de 60 segundos).
• El nombre del sitio del producto es el mismo que el nombre del sitio del radar.
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Se usan todas las entradas cuando se genera un producto de TDWR, a menos que una
entrada sea "obsoleta"; es decir, sea mayor que el tiempo especificado (de la orden de
120 segundos). Por ejemplo, si el LLWAS falla, el integrador continúa utilizando los datos de
LLWAS viejos hasta alcanzar el límite de tiempo de los datos "obsoletos". Si todos los datos
son "obsoletos", no se genera ningún producto de TDWR en absoluto. En este caso, no hay
salida al IRIS y, eventualmente, en las pantallas de cinta aparece NO DATA AVAILABLE.

IRIS/Integrator Communication

IRIS

Integrator

/srv/iris_data/product

SLINE                                            TDWRWARN on
SHEAR

Output

Receiver
Socket

Port
30725

OutputReceiver
Socket

Port
30726

SLINE WARN on
SHEAR

LLWAS

Receiver
/srv/iris_data/tdwr

Socket
Port

30727

TDWR/LLWAS
Integrator

Runways
Utility

LLWAS
Data

(optional)

Figura 113 Comunicación del IRIS/Integrador

C.8.1 Configuración de la herramienta Runways e Integrator:
runways.conf

La configuración del integrador y la herramienta runways se almacena en el archivo
runways.conf en el directorio IRIS_CONFIG que se supone aquí que es el
directorio /etc/vaisala/irisrda.

Los pasos de configuración son:
1. Cree el directorio de datos tdwr (ubicación predeterminada /usr/iris_data/
tdwr).
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2. Instale el archivo runways.conf (ubicación predeterminada /etc/vaisala/
irisrda/runways.conf).

3. Edite el archivo runways.conf.

Cree el directorio /usr/iris_data/tdwr.

Debe tener privilegios de administrador para este paso. El directorio tdwr puede estar en
cualquier parte en la estación de trabajo que ejecute el integrador. Sin embargo, le
recomendamos colocarlo en el mismo lugar que el directorio del producto IRIS_PRODUCT.

En una instalación estándar, este es un directorio llamado /usr/iris_data. Este puede
ser diferente en su sistema. Para ver la ubicación del directorio del producto, revise /usr/
sigmet/config/profile.

Para realizar el directorio tdwr, inicie sesión como administrador o conviértase en el usuario
experto e ingrese:

# cd /usr/iris_data
# mkdir tdwr

Configure los privilegios del directorio de forma tal que coincidan con los de otros
directorios (realice un ls –ll para ver cómo están configurados los otros directorios). En
caso de una instalación estándar, escriba:

# chown operator tdwr
# chgrp users tdwr
# chmod 777

Instale el archivo runways.conf.

El archivo runways.conf se guarda en el directorio /$IRIS_ROOT/config
(generalmente /etc/vaisala/irisrda).

Revise si el archivo existe en este directorio. Inicie sesión como operador y escriba:

$ cd /etc/vaisala/irisrda
$ ls

Compruebe que el archivo runways.conf se encuentre en la lista. Si no, copie la plantilla
de la siguiente manera:

$ cp /usr/sigmet/config_template/init/runways.conf /usr/sigmet/config

Edite el archivo runways.conf.

Edite el archivo runways.conf (use vi, emacs o el editor de textos de ASCII). El archivo
se muestra a continuación:
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# File: ${IRIS_CONFIG}runways.conf
# Contains configuration information for the TDWR/LLWAS integration
# algorithm  and the runways utility.
# Number of runways to define: COUNT 3
# For each runways: Primary direction, Secondary direction, default direction.
# The default direction is the direction to use at powerup until changed
# manually  by runways.

RUNWAY 1 33- 15- LLWAS

RUNWAY 2 36R 18L LLWAS

RUNWAY 3 36L 18R LLWAS

# Uncomment this if you want all corridors reported out of integration.
#DONT_FILTER_RUNWAYS
# Turn logging on, choices are FILE or TERM or BOTH or NONE LOG BOTH
# Define input related info:
# Socket port; Directory; Timeout to consider input data stale

IRIS_IN 30726

IRIS_IN_DIR /usr/iris_data/tdwr/

IRIS_IN_TIME 120

# Define output related info:
# Socket host and port; Directory;
# Timeout to retransmit output even with no changes

IRIS_OUT cyclone 30725

IRIS_OUT_DIR /usr/iris_data/product/

IRIS_OUT_TIME 60

# Define LLWAS input related info:
#LLWAS_IN 30727
# Since the LLWAS input does not contain sitename or lat/lon. These
# need to be specified to handle the case where IRIS input is lost.
# For systems with no LLWAS input, it is recommended that you comment
# this whole section off.

# Specify radar lat and lon in signed degrees. Negative is south latitude, or
# West longitude.

RADAR_LATLON 43.00 -71.00

# If you want to take the latlon from the IRIS input, if  available, then
# comment out this line.

ALWAYS_SET_LATLON
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# Specify desired radar sitename. Max 16 chars, requires quotes if you
# have imbedded whitespace.

RADAR_SITENAME "THIS IS A TEST"

# If you want to take the sitename from the IRIS input, if available, then
# comment out this line.

ALWAYS_SET_SITENAME

# List of users who are allowed to operate the runways utility.

OPERATORS operator

# End of file

Las líneas del archivo se describen en detalle a continuación:

• COUNT 3

Esta es la cantidad de pistas físicas; es decir, tiras de hormigón.

• RUNWAY 2 36R 18L LLWAS

Se asigna un número arbitrario a cada pista (por ejemplo, 1, 2 y 3). Estos números
deben ser secuenciales comenzando desde el 1.
Los nombres de cada pista se especifican en los siguientes dos campos (por ejemplo,
36L y 18R).
El último campo corresponde a la pista activa predeterminada cuando se inicia por
primera vez el software. Este puede ser cualquiera de los nombres de pista o, si está
disponible, el LLWAS. En el caso del LLWAS, se usa la dirección de la pista especificada
en los datos del LLWAS cuando se inicia por primera vez el integrador. Si no hay datos
del LLWAS, entonces se usa la dirección de la pista en el primer campo durante el
arranque.

• # DONT_FILTER_RUNWAYS

Por lo general, esta línea debería tener un comentario (el signo #).
Si no lo está (sin el signo #), el integrador pasa las alertas de todas las áreas aunque no
estén asociadas a las pistas activas.
Aún así, las pantallas de cinta pueden realizar el filtrado; es decir, se puede configurar
ribsetup para excluir las pistas inactivas. Consulte Configuración del software de la
pantalla de cinta (página 343).
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• # Turn logging on, choices are FILE or TERM or BOTH or NONE
LOG BOTH

• Si inicia el integrador desde un terminal, configúrelo en AMBOS.
• Si inicia el integrador de forma automática, configúrelo en ARCHIVO. El archivo de

registro se almacena en var/log/irisrda.

• IRIS_IN 30726
IRIS_IN_DIR /usr/iris_data/tdwr/

Mediante estas entradas se configuran las características de la entrada desde IRIS hasta
el integrador.
IRIS_IN es el puerto del conector que usa IRIS para avisar al integrador cuando se
envía un nuevo producto. Esto debe coincidir con el dispositivo de red de
configuración/salida de IRIS que se configuró para enviar productos desde IRIS al
integrador. El puerto predeterminado es 30726.
IRIS_IN_DIR es el directorio donde IRIS envía productos al integrador. Esto debe
coincidir con el directorio configurado al comienzo de esta sección y el directorio
configurado en la configuración/salida de IRIS para el integrador de TDWR. Consulte
Configuración de las salidas de productos de IRIS para el TDWR (página 336).

• IRIS_OUT cyclone 30725
IRIS_OUT_DIR /usr/iris_data/product/

Mediante estas entradas se configuran las características de la salida desde el
integrador hasta IRIS.
IRIS_OUT es el nombre del nodo (ciclón) y el puerto del conector (30725) donde IRIS
recibirá los datos. Por lo general, esta es la estación de trabajo local donde se ejecuta el
integrador. El puerto del conector debe coincidir con la variable del entorno de
IRIS_NETRCV respecto del receptor de red. Esto se configura en /usr/sigmet/
config/profile.
IRIS_OUT_DIR es el directorio donde se envían productos de TDWR. Esto debe
coincidir con el directorio configurado para IRIS_PRODUCTS, que generalmente
es /srv/iris_data/product. Esto se configura en /usr/sigmet/config/
profile.

• IRIS_IN_TIME 120

Este es el tiempo en segundos después del cual, se considera que una entrada es
"obsoleta". Por ejemplo, si el LLWAS deja de enviar datos, el integrador continúa
utilizando los datos de LLWAS durante 120 segundos (en el ejemplo). Luego de
120 segundos, los datos viejos del LLWAS no se usan para generar los nuevos
productos de TDWR.
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• IRIS_OUT_TIME 60

Este es el tiempo máximo entre la generación de productos de TDWR. Se genera un
nuevo producto de TDWR si se produce una de las siguientes situaciones:
• Llega una nueva entrada.
• Cambia la configuración de las pistas activas.
• Una de las entradas queda obsoleta (se agota el tiempo de espera de
IRIS_IN_TIME).

• Se excede el IRIS_OUT_TIME de la última generación del producto de TDWR.
• Mediante IRIS_OUT_TIME se puede garantizar (en este ejemplo) la creación de un

producto de TDWR al menos cada 60 segundos siempre que haya entradas válidas
(los datos no sean obsoletos).

• LLWAS_IN 30727

Este es el puerto del conector que usa LLWAS para avisar al integrador cuando se
encuentran disponibles nuevos datos del LLWAS. Si no cuenta con un LLWAS, comente
esta línea al agregar # al comienzo.

• <LLWAS Site Information>

Si tiene un sistema de LLWAS, debe especificar la LAT./LON. del radar y el nombre del
sitio, ya que estos no se encuentran en el encabezado del LLWAS.
Esta información es necesaria si el radar falla y las alertas se basan en el LLWAS
únicamente. Si no cuenta con un LLWAS, comente todas las líneas de esta sección.

• OPERATORS operator controller>

Mediante estos controles se accede al menú de pistas de la identificación del usuario en
la lista. Tenga en cuenta que cualquiera puede ver el menú de pistas, pero solo los
usuarios de la lista pueden cambiarlo.

C.8.2 Inicio de la herramienta del integrador

Inicio del integrador manual

Para iniciar el integrador de TDWR/LLWAS debe ser operador de IRIS. En una ventana del
terminal en la estación de trabajo donde se ejecuta el integrador (generalmente un sistema
de IRIS/Analysis de RPG), escriba:

$ tdwr_llwas_int

Esto permite iniciar el software y registrar eventos en la ventana del terminal. Convierta en
ícono el terminal para poder leer cualquier mensaje en el registro.
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Configuración del integrador automático

El enfoque recomendado es iniciar el integrador automáticamente cuando arranque la
estación de trabajo. Para ello, cree un archivo de inicio de forma similar al arranque de
siris automático.

C.8.3 Herramienta Runways

Los controladores usan la herramienta runways para especificar qué pistas están activas. El
algoritmo del integrador de TDWR/LLWAS usa esta información para filtrar las alertas de las
áreas inactivas. Por ejemplo, cada área de la pista tiene dos nombres, por ejemplo, 33L_3MD
corresponde a la misma área física que 15R_3MF. La dirección de la pista especificada en la
herramienta runways permite determinar cuál de estos nombres se usa para identificar el
área. Además, si no se usa una pista, toda la pista y todas sus áreas asociadas pueden
configurarse en inactivas.

Se debe ejecutar la herramienta runways en el mismo nodo de IRIS donde se ejecuta el
integrador (por lo general, esta es la estación de trabajo de IRIS asignada para generar
productos); sin embargo, puede exportar la pantalla de runways a otra estación de trabajo
en la red. Por lo tanto, se puede ejecutar la herramienta de runways desde cualquier
estación de trabajo en red.

Independientemente de si está en una estación de trabajo local o remota, debe tener los
privilegios para iniciar sesión en el sistema. Tenga en cuenta que la mayoría de las
instalaciones permiten a los observadores ver la herramienta runways, pero solo los
controladores (y quizás los operadores) pueden cambiar su dirección. La línea OPERATORS
en el archivo runways.conf especifica qué usuarios pueden controlar la herramienta
runways. Consulte Configuración de la herramienta Runways e Integrator: runways.conf
(página 351).
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Inicio de la herramienta Runways

La herramienta de runways se puede configurar de manera tal para que se inicie
automáticamente en su sistema. El administrador del sistema se encarga de su
configuración. Consulte Configuración de la herramienta Runways e Integrator: runways.conf
(página 351).

En un terminal de línea de comando, escriba:

$ runways &

Si se encuentra en otra estación de trabajo puede usar rlogin <nodemame> o sigterm
<nodename> para abrir un terminal en el nodo donde se ejecuta el integrador. Tenga en
cuenta que si usa el enfoque de rlogin, antes de ejecutar las pistas debe escribir lo
siguiente:

$ export DISPLAY=< yournodename >:0.0

Esto permite exportar la pantalla de pista a su estación de trabajo. Si la pantalla de pista no
aparece en su estación de trabajo, posiblemente deba escribir lo siguiente en el terminal de
su estación de trabajo (no en el sistema remoto):

$ xhost +

Esto permite que aparezcan ventanas de otras estaciones de trabajo en la pantalla. Consulte
con el administrador del sistema si desea que esto se habilite automáticamente.

Detención de la herramienta Runways

Para salir de la herramienta runways seleccione File > Exit en la esquina superior izquierda.
Tenga en cuenta que el integrador usa las configuraciones especificadas en la herramienta
Runways luego de que salga.

Configuración de las pistas activas/inactivas

Cada pista configurada en runways.conf debe tener una línea en el menú como se
muestra al comienzo de esta sección. Con el botón ubicado en la columna izquierda más
alejada se activa o desactiva la pista. Se indican las pistas inactivas con el símbolo "X" sobre
la pista como se muestra en el ejemplo de 33/15.

Selección de la dirección de la pista

Se indica la dirección de la pista mediante el color verde del nombre de la pista y la dirección
del ícono de avión. Se puede seleccionar la dirección de la pista manualmente al hacer clic
en el nombre de la pista, o automáticamente mediante el LLWAS (si está disponible). Para
habilitar la selección automática del LLWAS, haga clic en el botón de la columna del LLWAS
para cada pista.
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Estado del LLWAS

Si el LLWAS se encuentra disponible en el sistema, se muestra su estado de comunicación
con el integrador en la columna del LLWAS. En la imagen anterior se muestra la pantalla
DEAD sobre un fondo rojo para indicar que el LLWAS no se está comunicando con el
integrador.
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Apéndice D. Corrección del
pluviómetro Hydromet

D.1 Descripción general de la corrección
del pluviómetro Hydromet

IRIS/Hydromet es un paquete de IRIS opcional para aplicaciones hidrometeorológicas.

Tabla 27 Funciones de IRIS para aplicaciones hidrometeorológicas

Funciones estándares Funciones opcionales

Visualización de la tasa de precipitación en mm/h o
in/h para una relación de Z-R seleccionada en los me-
nús de Product Configuration para:

• PPI
• RHI
• CAPPI
• MAX
• XSECT

La selección de unidades se realiza por la selección de
escala de colores.

Producto CATCH:

• Brinda la profundidad promedio de la precipitación
en regiones de subcuencas para períodos seleccio-
nables.

• Se visualiza como regiones codificadas por color o
como iconos codificados por color.

Las regiones con subcuencas se definen de manera si-
milar a las superposiciones. En la ventana de vista rá-
pida, puede hacer clic con el botón derecho del mou-
se sobre una región o un ícono para ver la representa-
ción en gráfico de barras de la cantidad de lluvia caída
en la subcuenca por hora.

RAIN1

La acumulación de precipitación por hora para rela-
ciones de Z-R seleccionables.

Entrada de producto GAGE con calibración del pluvió-
metro. Esto permite que las acumulaciones por hora
RAIN1 del radar se calibren según la lluvia real medida
en los medidores.

Los productos GAGE pueden contener el coeficiente y
el exponente ZR (por sitio) derivados de la medición
de un disdrómetro o de otra fuente.

RAINN

Acumulación de precipitación de horas múltiples se-
gún las cantidades por hora.

Visualización de un historial de 12 horas.

Más información

‣ CATCH: Acumulación de precipitación en subcuencas (página 128)
‣ GAGE: Informes del pluviómetro (página 173)
‣ RAIN-N: acumulación de lluvia en N horas (página 64)

D.2 Flujo de datos de Hydromet para la
corrección del pluviómetro

En la siguiente figura, se muestra el flujo de datos para la corrección del pluviómetro.
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CAPPI Products

GAGE Product

GAGE Input Pipe

Input GAGE Data File

IRIS Product Directory 

IRIS Input Directory for Raingage Files

RAIN1 Algorithm

From external raingage network

Corrected RAIN1 Product

Format Conversion for Hourly Gage Totals

IRIS Product Generator

IRIS Product Generator

RAINN & CATCH
Algorithms

CATCH Product

RAINN Product

Gage Correction
Pipe

Can be changed by user

Figura 114 RAIN1 Flujo de datos de la corrección del pluviómetro
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• Entrada desde la red del pluviómetro externo
El cliente proporciona los datos del pluviómetro en forma de archivos que el cliente
transfiere automáticamente a través de la red hasta un directorio que se define en el
menú Setup > Input de IRIS.
Cada archivo debe contener la acumulación total para la hora anterior para todos los
medidores. Consulte Formato del archivo de datos del calibrador (página 363).

• Canal de entrada para la conversión de formato a producto GAGE
El canal de entrada es un convertidor de formato que convierte los datos del cliente al
formato del producto GAGE. El canal de entrada se especifica en Setup > Input.
Se trata de un software que generalmente se personaliza para la red del pluviómetro en
particular. Puede crear sus propios canales o Vaisala puede proveer el canal
AsciiToGage, en cuyo caso también se proporciona el código de fuente del canal
para que los clientes puedan mantener las tuberías en el futuro.

• Producto GAGE
Se trata de un producto dentro de IRIS que contiene los totales del pluviómetro para
todos los medidores de la red para la última hora. Consulte Formato del archivo de
datos del calibrador (página 363).

• Productos CAPPI de entrada
El producto de acumulación de pluviosidad por hora RAIN1 de IRIS utiliza productos
CAPPI como entrada. Los productos CAPPI pueden estar en dBZ, dBT o la tasa de
precipitación correspondiente según la relación de Z–R predeterminada como por
ejemplo Z=200R1,6.
Por lo general, se utiliza un pseudo CAPPI "lleno" para que, a rangos más lejanos, se
use el ángulo de elevación más bajo para llenar los datos.

• Procesamiento de RAIN1 y proceso de calibración del pluviómetro
La corrección del medidor se activa cuando se enciende el botón correspondiente en el
menú de configuración del producto RAIN1. En este caso, el generador de productos de
IRIS espera todos los productos CAPPI y el producto GAGE para la hora anterior y
luego ejecuta el algoritmo de RAIN1.
Para obtener más información sobre las consideraciones de programación para el
algoritmo RAIN1 con corrección de GAGE (es decir, sobre cómo manejar el retraso del
tiempo de llegada de los productos GAGE), consulte Programación de RAIN1 con
producto GAGE (página 371).
El algoritmo RAIN1 procede normalmente como se describe en RAIN1 : acumulación de
lluvia por hora (página 61).
El paso adicional de la corrección de GAGE se realiza mediante un algoritmo "Product
Pipe". Vaisala proporciona un algoritmo basado en Brandes and Wilson (1982). Puede
proporcionar su propio algoritmo de corrección del canal de productos en lugar del
suministrado. Consulte IRIS Programming Guide (M211318EN).
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• Producto RAIN1 corregido
El proceso de calibración del pluviómetro genera el producto RAIN1 final corregido
para que usen los productos RAINN y CATCH.

Puede hacer que se genere un producto RAIN1 no corregido mediante la ejecución
del producto RAIN1 (con un nombre diferente) con el botón de corrección del
pluviómetro deshabilitado. Por ejemplo, nombre el producto no corregido HOURLY y
el producto corregido HOURLY- GAGE.

• Productos CATCH y RAINN
El producto RAIN1 sirve de base para los productos RAINN y CATCH.
También puede ejecutar los productos WARN en el RAIN1. De esta manera, todos los
productos subsiguientes que se basan en el RAIN1 para la entrada se benefician del
algoritmo de corrección.

D.3 Formato del archivo de datos del ca-
librador

Los archivos de datos del pluviómetro se deben enviar automáticamente a un directorio
especificado en Setup > Input del IRIS para el canal de entrada.

Los datos se puede enviar mediante FTP, RCP o NFS. El archivo debe contener los totales del
medidor por hora para todos los medidores junto con la demás información de respaldo
requerida por el producto GAGE, como por ejemplo fecha y hora, y ubicación del
pluviómetro.

El formato del archivo de datos de entrada es el siguiente:
• Cada archivo es de texto plano ASCII y la estructura general son campos de colección

que constan de una palabra clave seguida de uno o más valores de datos. Esto hace
que el formato sea expansible, ya que se pueden agregar con facilidad palabras clave
nuevas en el futuro y cada lector de software puede elegir qué conjunto de palabras
clave necesita procesar.

• El espacio en blanco se usa para separar las palabras clave y los valores de datos. Se
pueden usar comillas alrededor de un valor de cadena si existe la posibilidad de que la
cadena contenga un espacio en blanco. Cada línea termina con un caracter de "línea
nueva".

• Cada archivo representa datos de cualquier cantidad de estaciones, pero solo se
informa una hora de datos en cada fila. Esa hora es la hora final de los datos y se
informa utilizando las palabras clave TIME y SPAN en las primeras líneas del archivo. La
resolución de tiempo fundamental se cuantifica a intervalos de un minuto.

• Cada informe de estación de pluviómetro consta de una línea con al menos las palabras
clave CODE y LONLAT, más la palabra clave RRATE o RFALL. Las palabras claves QUAL
y REM son opcionales.

En general, el canal de entrada se debe personalizar, ya sea escrito por el cliente o por
Vaisala. Este es el formato que utiliza el canal de entrada AsciiToGage. Si desea utilizar
otro formato, debe escribir su propio canal de entrada personalizado.
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Este formato de datos recomendado para el medidor de entrada no coincide con el
formato del producto GAGE ya que el canal de entrada cambia el formato del producto
para IRIS.
La información básica debe estar en el archivo o, en algunos casos, en un archivo de
configuración separado para el canal de entrada. Consulte IRIS Programming Guide
(M211318EN).

Las palabras clave son las siguientes:
# any comment

Se ignora toda línea que comience con "#", además de las líneas en blanco.

TIME yyyymmddhhmm
La hora final para todas las estaciones informadas en este archivo. La cadena de
dígitos indica el año, el mes, el día, la hora y los minutos. Esta palabra clave aparece
una vez al comienzo del archivo.

SPAN nn
El intervalo de tiempo en minutos decimales para todos los datos informados en este
archivo. Esta palabra clave aparece una vez al comienzo del archivo. IRIS admite
intervalos de 60 minutos.

CODE nnnnnn
El código de estación para un pluviómetro. El código es una cadena arbitraria de
15 caracteres de largo o menos. El campo debe estar presente para cada medidor
informado.

LONLAT nn.nnnnn nn.nnnnn
Latitud y longitud de un pluviómetro. La longitud es el número real entre -180 y +180
con valores positivos que representan la longitud Este.
La latitud es el número real entre -90 y +90 con valores positivos que representan la
latitud norte. Se puede usar cualquier número de dígitos decimales de precisión. El
campo debe estar presente para cada medidor informado.

RRATE nn.nnn
La tasa de lluvia caída en milímetros/hora para un pluviómetro. Deben estar presentes
tanto el campo RRATE como el RFALL para cada medidor informado.

RFALL nn.nnn
La cantidad de lluvia caída en milímetros para un pluviómetro. Deben estar presentes
tanto el campo RRATE como el RFALL para cada medidor informado.

Z/R ccc.c e.ee
Campo opcional que está disponible para pluviómetros del tipo disdrómetro capaces
de calcular una relación Z/R. Los números son la constante y el exponente en la
ecuación Z = CRE. Cuando no hay lluvia o el disdrómetro no puede realizar una
medición, se envían valores de 0,0 para ambos números. Esto se interpreta como un
indicador especial que significa que se deben usar los valores predeterminados.

QUAL nn
La calidad de datos (0: no útil; 10: mejor) para un informe del pluviómetro. El campo
es opcional. Si se omite la calidad de datos, se supone que es "10" (mejor).
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REM xxxxxxxxxxx
Permite insertar un comentario en el archivo. Le sigue un campo de texto arbitrario.
Utilice comillas para los comentarios si incluyen un espacio en blanco.

En el siguiente ejemplo, se muestran datos del pluviómetro para 5 sitios durante un intervalo
de tiempo de 60 minutos que finaliza a las 22:00 el 10 de julio de 2000. Tenga en cuenta
que las columnas exactas y la precisión numérica pueden variar, al igual que el orden de las
palabras clave en cada línea.

REM "Example format of an IRIS Rain Gage input file" TIME 200007102200 SPAN 60
CODE 001213 LONLAT 127.312533 38.172512 RRATE 4.5
CODE 000223 LONLAT 127.2223 38.2155 RRATE 2.2
CODE 000095 LONLAT 127.31 38.2283 RFALL 0.083
LONLAT 127.1214 38.1825 QUAL 0 RRATE 1.2 REM "Gage broken"
CODE 000122
CODE 000109 RRATE 1.1 LONLAT 127.2884 38.1277
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D.4 Configuración de RAIN1 con correc-
ción del pluviómetro

1. Configure los productos CAPPI de entrada.

El algoritmo RAIN1 comienza con productos CAPPI. Consulte CAPPI : Indicador de
posición en plano de altitud constante (página 41).
Para optimizar los productos CAPPI para RAIN1 con corrección de GAGE, considere lo
siguiente:
• Tipo de datos CAPPI establecidos a R según Z.

La entrada CAPPI debe estar en unidades de tasa de precipitación. Esto genera que
la interpolación de CAPPI se realice sobre la tasa de precipitación en lugar de dBZ.
Por lo tanto, el peso de la interpolación es lineal en unidades de tasa de
precipitación.
Use el factor de reflectividad corregida Z en lugar del factor de reflectividad
corregida T para que pueda beneficiarse de la corrección y la cancelación del eco.

• Resolución de CAPPI de aproximadamente 1 km (0,6 millas)
La resolución del producto RAIN1 es idéntica a la del producto CAPPI de entrada.
Vaisala recomienda que el rango máximo para CAPPI y la cantidad de pixeles se
establezca para producir una resolución de aproximadamente 1 km. Por ejemplo,
para un rango máximo de 240, un producto 480 × 480 debe tener una resolución de
1 km (0,6 millas).

• Altura de CAPPI de aproximadamente 1 km, Relleno establecido en Sí (Pseudo 
CAPPI)
Seleccione una altura de CAPPI de nivel único de aproximadamente 1 km según la
altura del terreno circundante. Tenga en cuenta que las alturas de CAPPI se definen
como altura por sobre el nivel de referencia que generalmente se establece en el
nivel del mar (en Configuración/RCP de IRIS). Habilite CAPPIRelleno para que
CAPPI se defina para rangos cercanos y lejanos donde no sea posible interpolar a
1 km.

• Utilice la relación de Z-R predeterminada de Z=200R1,6

Vaisala recomienda que al principio use una relación de Z=200R1,6 predeterminada
como la relación de Z-R predeterminada en el producto CAPPI. Luego de algunas
experiencias, puede elegir modificarla para que se acerque más a su precipitación.
Esta relación también se puede ajustar según la estación.

2. Configure el producto RAIN1.

Para la configuración del producto RAIN1, seleccione los CAPPI de entrada que se
configuraron arriba. Use la misma relación de Z-R en el producto RAIN1 como se usó
para los CAPPI.
Si desea usar la corrección del medidor, seleccione el botón de corrección del medidor.
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3. Actualice el archivo de configuración de corrección de GAGE (Rain1GageCor.conf)

El algoritmo de corrección del pluviómetro usa el archivo de configuración
Rain1GageCor.conf en el directorio /etc/vaisala/irisrda.
Copie la plantilla que se encuentra en el directorio /etc/vaisala/
irisrda_templates en /usr/sigmet/config durante la instalación.
A continuación se presenta un ejemplo del archivo Rain1GageCor.conf.

# Rain1GageCor.conf for the Rain1/GAGE correction program
LOG NONE
# OVERRIDE_PRODUCT_NAME JOE
# VERBOSE
MIN_VALID_GAGE 1.00
MIN_VALID_RADAR 1.00
MIN_CORRECTION 0.20
MAX_CORRECTION 5.00

• LOG
Configura dónde va la información de registro. Las opciones son NONE, TERM, FILE
o BOTH. FILE significa lugar en el archivo ${IRIS_LOG}/Rain1GageCor.log.

• MAX_CORRECTION y MIN_CORRECTION
• Los factores de corrección del calibrador máximo y mínimo evitan que las

correcciones grandes posiblemente erróneas contaminen los datos.
Los números se ingresan como factores, como por ejemplo 3 y 0,3 para el máximo y
el mínimo respectivamente.
Si se supera el límite, el algoritmo usa el valor del límite; es decir, los factores de
corrección se saturan al límite.

• MIN_VALID_GAGE
El monto mínimo de acumulación de pluviosidad por hora para un medidor del que
se considera tiene una cantidad válida de pluviosidad.
Depende en cierta medida de la precisión de los medidores. Lo típico sería un valor
de 3 mm (0,12 pulgadas). Tenga en cuenta que esto corresponde aproximadamente
a un factor de reflectividad promedio de una hora de 21 dBZ.

• MIN_VALID_RADAR
La acumulación de RAIN1 mínima, promediada sobre el medidor que es válido.
Las acumulaciones de precipitaciones del radar menores que este valor se
consideran inválidas y no se calcula una corrección del medidor. Es similar a la
acumulación del medidor válida mínima, excepto que en este caso es para el radar.
Lo típico sería un valor de 3 mm (0,12 pulgadas).

• MIN_VALID_COVERAGE
Cuando se promedian los píxeles de RAIN1 del radar sobre un medidor (1, 9, 25, 49
píxeles y similar) para hacer una corrección, por lo general no todos los píxeles son
válidos.
Si el porcentaje de píxeles válidos es menor que este valor, no se calcula una
corrección de medidor. Por ejemplo, si el porcentaje mínimo se establece en 50 % y
el promedio del medidor está por encima de los 3 × 3 píxeles, al menos 5 píxeles
deben ser válidos para que se genere una corrección.

• OVERRIDE_PRODUCT_NAME
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Use este comando si desea cambiar el nombre del producto RAIN1.
• RADAR_AVERAGE
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Es la distancia en km alrededor del pluviómetro donde se deben promediar las
reflectividades del radar. En el caso donde la resolución de CAPPI de entrada sea de
1 km [por ejemplo, rango máximo de 240 km y 480 × 480 píxeles], establecer la
distancia promedio en 1,5 km daría como resultado un promedio mayor a 3 × 3
píxeles centrado sobre el píxel que contiene el medidor. En la siguiente figura se
muestran algunos ejemplos.

Radar Data Averaging about a Raingage Location

    (Input CAPPI pixel resolution set to 1 km for example)

Gage

Averaging Distance Set to 0.5 km

Averaging Distance Set to 1.5 km

Averaging Distance Set to 2.5 km

Gage

Gage
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4. Defina las configuraciones de Configuración de IRIS.

a. En Configuración > Entrada, especifique las características de entrada de los
archivos del pluviómetro del usuario, incluido el directorio donde llegan los archivos
y el nombre del canal de entrada que se usa para convertir el formato de los datos
en el producto GAGE de IRIS.

Consulte IRIS and RDA Utilities Guide (M211316EN).
Dependiendo del sistema, también puede haber un archivo .conf para el canal de
entrada. El canal de entrada se almacena en /usr/bin/pipes.

b. En Configuración > Producto, configure la relación Z-R predeterminada.

Por lo general, se establece en Z=200R1,6 (entrada 200 y 1,6). No obstante, puede
establecerla de manera diferente según la experiencia local.
Tenga en cuenta que puede anular este valor en la configuración del producto
RAIN1.

c. En Configuración > Producto, configure el tiempo de espera de GAGE.

Es el tiempo requerido luego del final de la hora para el producto GAGE que se
generará. El retraso se genera principalmente por el retraso en la llegada a la red de
los datos del pluviómetro del usuario.

D.5 Algoritmo para la calibración del me-
didor de RAIN1

El algoritmo predeterminado para la corrección del pluviómetro que se provee se modela
según Brandes and Wilson (1982). El algoritmo usa un paso de tiempo básico de una hora;
es decir, se comparan totales de GAGE para cada hora con los totales del radar por hora
(según una relación de Z-R predeterminada) para la misma hora. La relación (acumulación
del medidor de 1 hora/acumulación del radar de 1 hora) es el factor de corrección para un
medidor.

Luego, se corrige el producto RAIN1 mediante la interpolación de los factores de corrección
para todos los medidores en cada píxel en el producto RAIN1 y la multiplicación del valor de
píxeles del radar por el factor de corrección. Los pasos del algoritmo básico son los
siguientes:
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1. Cálculo del factor de corrección del medidor para cada medidor
La corrección del medidor es la relación de (acumulación del medidor de 1 hora)/
(acumulación del radar de 1 hora).
• La acumulación del medidor se toma del producto GAGE. Debe ser mayor que la

acumulación del medidor válida mínima para un factor de corrección que se
calculará.

• La acumulación del radar para el medidor se calcula primero realizando un producto
RAIN1 no corregido para la hora y luego promediando los píxeles alrededor del
medidor (según la distancia promedio; consulte Configuración de RAIN1 con
corrección del pluviómetro (página 366)).
Los píxeles se promedian al sumar solo los píxeles válidos (no umbrales) y luego
dividirlos por la cantidad de píxeles válidos.
Para una corrección de medidor que se calculará, la acumulación de pluviosidad
promedio debe ser mayor que la acumulación del radar válida mínima, y la cantidad
de píxeles válidos (no umbrales) debe ser mayor que el porcentaje mínimo de la
cobertura de RAIN1 del radar.

• Si ambas acumulaciones de 1 hora del medidor y del radar son válidas, se calcula la
corrección del calibrador. De lo contrario, el medidor se indica como no válido.

• Se aplican los límites del factor de corrección máximo y mínimo.
• Este procedimiento se repite para cada medidor.

2. Interpolación de la corrección del medidor para cada píxel
Los factores de corrección del medidor se aplican al producto RAIN1 no corregido para
generar el producto de salida RAIN1 final corregido. La técnica es que el valor de
acumulación de pluviosidad en cada píxel en el producto RAIN1 no corregido se
multiplica por un factor de corrección promedio.
El factor de corrección promedio para un píxel se calcula a partir de todos los
medidores al pesar el factor de corrección para cada medidor de manera inversa con su
distancia desde el píxel; es decir,

C− + Σ CiDiΣ 1Di
donde C− es la corrección del medidor promedio para un píxel, Ci es la corrección en el
medidor y Di es la distancia entre el medidor y el píxel. Tenga en cuenta que el valor
mínimo de Di se fija en 1 km (0,6 millas).

D.6 Programación de RAIN1 con produc-
to GAGE

El algoritmo de programación para la generación del producto RAIN1 es diferente de la
programación de RAIN1 estándar ya que el generador del producto debe esperar la llegada
tanto de los CAPPI como del producto GAGE para la hora anterior. Para compensar el
retraso en la llegada del producto GAGE, se define un Gage Wait Time en Setup > Product
de IRIS. En las siguientes figuras, esto se identifica como WaitG.
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La notación muestra una línea de tiempo que representa la hora de los datos; es decir, en el
caso de un CAPPI, esta es la hora en que se inició la exploración del volumen según el reloj
de la computadora del radar, que puede ser diferente del reloj en la computadora donde se
generó el RAIN1. En el caso de un producto GAGE, se trata de la hora exactamente en hora
al final de la hora de acumulación. Las barras verticales muestran las horas pares.

Caso 1A: Caso normal, llegada de CAPPI y GAGE

CC C C CC C C

G

Es el caso normal cuando llegan los dos productos, CAPPI y GAGE. El producto GAGE llega
algo después de la hora, pero en Data Time se traza exactamente en hora. El producto
RAIN1 se ejecuta tan pronto como llega el producto GAGE y llega el primer CAPPI de la hora
siguiente.

Caso 1B: Llegan los CAPPI, llega el GAGE para una hora futura

C CC C CC C C CC CC C C

G

Aquí falta una hora en la cadena de producto CAPPI. Se ejecuta el producto RAIN1 (sin
corrección de GAGE). Aquí se supone que los productos GAGE llegan en orden de tiempo y
que los datos de la hora faltante nunca aparecen.

Caso 1C: Llegan losCAPPI pero no el GAGE

C CC C CC C C

Tail WaitG

Aquí, no llega el producto GAGE. Se ejecuta el producto RAIN1 (sin corrección de GAGE)
cuando la hora local de la computadora del producto es posterior a la hora de llegada para
el último CAPPI de entrada más las horas Tail y WaitG. La hora Tail es la diferencia
entre la hora de datos de la última entrada y la siguiente hora entera. La hora WaitG es la
Raingage Arrival Wait Time de Setup > Product.

Tenga en cuenta que si el producto GAGE finalmente llega, se ignora.
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Caso 2A: Llega el GAGE pero no llega el primer CAPPI de la siguiente hora

C CC C CC C

G

Tail WaitG

Es similar al caso anterior. En este caso, después de que transcurran las horas Tail y
WaitG, se ejecuta el producto utilizando los CAPPI disponibles en la hora anterior. Hay una
corrección de GAGE y el algoritmo de RAIN1 utiliza todos los productos CAPPI disponibles.

Caso 2B: No llegan ni GAGE ni el primer CAPPI de la siguiente hora

C CC C CC C

Tail WaitG

Es casi idéntico al Caso 2A; es decir, después de que transcurrieron las horas Tail y WaitG,
se ejecuta el producto utilizando los productos CAPPI disponibles en la hora anterior,
excepto en que no hay corrección de GAGE.

Caso de degeneración: No llega nunca ningún CAPPI

G

Tail WaitG

En este caso, no se genera producto RAIN1.

Más información

‣ GAGE: Informes del pluviómetro (página 173)
‣ Programación de productos RAIN1 (página 63)
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D.7 Referencias del pluviómetro Hydro-
met

Brandes, E. A. and J. W. Wilson, 1982: Thunderstorms: A social, Scientific and Technological
Documentary; Vol 3: Instruments and Techniques for Thunderstorm Observation and
Analysis. E. Kessler, Editor. U.S. Department of Commerce, NOAA Environmental Research
Laboratories.
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Apéndice E. Ejemplos de confi-
guración de tareas

E.1 Configuraciones de tareas
Puede personalizar y agregar configuraciones de tareas predeterminadas.

Tenga en cuenta las siguientes pautas al crear o modificar tareas:
1. Ya que no es posible obtener los mejores datos de velocidad y reflectividad al mismo

tiempo, las tareas predeterminadas se dividen de la siguiente manera:
• Vigilancia de rango largo con resolución espacial aproximada para detectar ecos

débiles (tarea SURVEILLANCE)
• Volumen polarimétrico de rango medio con buena resolución espacial para datos de

reflectividad y polarimétricos de alta calidad (tareas VOL_A y VOL_B)
• Volumen de rango corto con buena resolución espacial para datos de velocidad de

alta calidad (tarea WIND)
2. Para maximizar la calidad de datos de procesamiento de señal, todas las tareas usan

datos de 2 bytes en el servidor del radar.
Por defecto, todos los productos RAW se truncan en 1 byte para la transmisión. Si el
ancho de banda lo permite, use datos de 2 bytes en productos RAW.

3. Después de instalar y calibrar el sistema del radar o si modifica los parámetros
predeterminados de procesamiento de tareas, debe ajustar los valores del umbral de
calidad.
Por ejemplo, si incrementa la cantidad de muestras, ingrese un valor de LOG levemente
disminuido para mejorar la sensibilidad de la medición.

4. Las tareas utilizan filtro Doppler número 4, que es un filtro adaptivo gaussiano (GMAP)
con un ancho de 0,4 m/s.
Según las condiciones del eco, pruebe un filtro más débil (número 3 o más pequeño) o
un filtro más fuerte (número 5 o mayor) para encontrar el filtro óptimo para su sitio del
radar. Todas las tareas utilizan un umbral de CSR de 40 dB.
Según las condiciones del eco, puede probar un valor más fuerte (menos que 40 dB).
Antes de finalizar la configuración, mida con clima real para verificar que no se
desvanezcan los ecos meteorológicos cercanos a velocidad cero (guía de Doppler).

5. Para sacar provecho de la sensibilidad mejorada del procesamiento de señal
polarimétrico, utilice el momento de datos Ze para generar productos de eco.

E.1.1 SURVEILLANCE
La tarea SURVEILLANCE se optimiza para la detección a larga distancia del eco de
precipitación. Usa el ancho de pulso más largo disponible del sistema del radar
meteorológico.

Apéndice E – Ejemplos de configuración de tareas

RESTRINGIDO 375



Los sistemas de doble polarización usan la reflectividad mejorada Ze junto con una gran
cantidad de muestras procesadas para mejorar significativamente la sensibilidad en
comparación con los sistemas de polarización única. Las muestras se recolectan de una gran
zona de contribución utilizando un espacio acimutal más ancho de los rayos del radar (2º) y
un rango que se promedie en varios bins de rango consecutivos.

La configuración predeterminada tiene un rango máximo de 450 km. Úselo en climas
cálidos. En climas más fríos, disminuya el rango máximo; por ejemplo, 350 km en verano o
250 km en invierno. Los rangos más cortos permiten mayores frecuencias de repetición de
pulso (dentro del rango) y se pueden configurar más pulsos dentro del tiempo de ejecución
constante.

El umbral LOG se optimiza para las condiciones tropicales con un claro margen de
incertidumbre de ruido, incluso en condiciones de lluvia extrema. En climas más fríos, con un
radar calibrado, el umbral LOG puede ser tan bajo como 1,2 dB.

En la siguiente ilustración, se muestran los detalles de la configuración de la tarea para un
sistema de doble polarización. Los círculos de color azul indican elementos con valores
diferentes en sistemas de polarización única.
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Figura 115 Configuración de la tarea SURVEILLANCE: doble polarización

Resolución de acimut 1.00°
Polarización Horiz.
Muestras 35
DP Attn Cor Z ZDR deshabilitado
Promedio/declaración de rango 2
Modo del procesador FFT
Hora de datos medidos T, Z, Vel, Ancho, SQI

E.1.2 VOL_A
La tarea VOL_A es la parte inferior de la exploración VOL_A y VOL_B de volumen híbrido.
Se optimiza para observaciones y mediciones de precipitación dentro de un rango de
250 km. Utilice un modo de frecuencia de repetición de pulso único para obtener la máxima
calidad de Z y momentos de doble polarización.

Los sistemas de doble polarización utilizan la reflectividad mejorada Ze para mejorar la
sensibilidad. Se controla la calidad de los campos de datos Z para verificar el rechazo
máximo del eco no meteorológico. Los datos Z presentan los verdaderos campos de
precipitación. Las observaciones combinadas de KDP y Z se usan en estimaciones de
pluviosidad cuantitativas.

Apéndice E – Ejemplos de configuración de tareas

RESTRINGIDO 377



En condiciones difíciles con eco en movimiento, eco del mar e interferencia, puede elevar el
umbral de PMI hasta 0,55. Intente con un valor de SQI más alto con algo de pérdida de
precipitación en la capa de derretimiento y en convección fuerte.

En la siguiente ilustración, se muestran los detalles de la configuración de la tarea para un
sistema de doble polarización. Los círculos de color azul indican elementos con valores
diferentes en sistemas de polarización única.

Figura 116 Configuración de la tarea VOL_A: doble polarización

Polarización Horiz.
DP Attn Cor Z ZDR deshabilitado
Modo del procesador FFT
Hora de datos medidos T, Z, Vel, Ancho, SQI

E.1.3 VOL_B
La tarea VOL_BE completa las elevaciones más altas del volumen híbrido al proporcionar
observaciones de momentos estándares y de doble polarización para productos de
volumen, como CAPPI.
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La tarea utiliza alta frecuencia de repetición de pulso y entrega vientos radiales de alta
calidad en el rango de +/- 16 m/s. Debido a una alta frecuencia de repetición de pulso, altas
elevaciones y los rangos modestos en uso, son posibles los espectros estrechos de
precipitación. La calidad de los momentos estándares y de doble polarización es buena. El
volumen de datos híbridos de VOL_B ofrece entradas para una variedad de productos
meteorológicos.

En ángulos de elevación más altos:
• Es menos probable que el sistema detecte ecos de segundo viaje u objetivos no

meteorológicos; por lo tanto, no se usa la umbralización de SQI y PMI para campos de
datos Z por defecto, a diferencia de la tarea VOL_A.

• No se selecciona la reflectividad mejorada Ze como para rangos de medición corta de
elevaciones altas, ya que no proporciona mejoras significativas de sensibilidad.

En la siguiente ilustración, se muestran los detalles de la configuración de la tarea para un
sistema de doble polarización. Los círculos de color azul indican elementos con valores
diferentes en sistemas de polarización única.
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Figura 117 Configuración de la tarea VOL_B: doble polarización

Polarización Horiz.
DP Attn Cor Z ZDR deshabilitado
Modo del procesador FFT
Hora de datos medidos T, Z, Vel, Ancho, SQI

E.1.4 WIND
La tarea WIND es una exploración de volumen de distancia corta que proporciona
observaciones de viento para productos como VVP y WIND.

La tarea utiliza el modo principal de FFT solo en H. Una sólida frecuencia de repetición de
pulso doble brinda vientos no ambiguos de hasta +/- 50 m/s hasta un rango de 78 km. La
configuración de calidad es la misma que para un Doppler clásico.

Una relación de frecuencia de repetición de pulso doble más alta (4:3, 5:4) puede aumentar
el régimen de velocidad no ambigua o el rango máximo. No obstante, usar relaciones de
PRF doble más altas además de rangos más largos disminuye la calidad de los datos de
velocidad.
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Figura 118 Configuraciones de la tarea WIND

E.1.5 Tareas SUNCAL y ZDRCAL
En los archivos /etc/vaisala/irisrda/suncal.conf y zdrcal.conf hay
configuraciones detalladas de las tareas SUNCAL y ZDRCAL.
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Figura 119 Configuraciones de las tareas SUNCAL y ZDRCAL

SUNCAL

Para la tarea SUNCAL, ajuste el inicio, la detención y el tiempo de repetición de cada sitio
para que la tarea se ejecute tres veces al día: poco después del amanecer, al mediodía y
justo antes del anochecer.

ZDRCAL

La tarea ZDRCAL solo se usa para sistemas de doble polarización.

E.2 Configuraciones de producto y pro-
gramador

E.2.1 Productos RAW
El sistema del radar produce productos RAW en el servidor del radar y los envía al sitio
central para la generación de productos.

Para reducir el ancho de banda de comunicación, por defecto, los datos se truncan a una
resolución de 1 byte 8 bits de la resolución original de 2 bytes 16 bits.

Si el ancho de banda de comunicación lo permite, use la resolución de 16 bits para mejorar la
calidad de los datos para el procesamiento posterior:

1. En el menú de configuración del producto, seleccione Type > RAW.

De manera predeterminada, la opción es Forced 8-bit Format, que trunca el contenido.
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2. Seleccione Preserve Format para preservar la resolución de 16 bits.

3. Seleccione File > Save As > OK.

E.2.2 Productos de altura de derretimiento
En sistemas de doble polarización, un producto de altura de derretimiento, VOL, se
configura y se programa de manera predeterminada.

Este producto utiliza tareas VOL_A y VOL_B para calcular la altura de la capa de
derretimiento.

Figura 120 Configuración del producto de altura de derretimiento
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E.2.3 Programador del producto
Si necesita otros productos en el sitio del radar, agréguelos al Product Scheduler
(Programador del producto). Esto se aplica a la producción de datos tanto del sitio del radar
como del sitio central.

Tareas de entrada Productos

Surveillance Vigilancia de reflectividad del clima.

VOL_A y VOL_B Productos para usuario final relacionados con la reflectividad, como detección de lluvia o
tormenta, o mediciones hidrológicas.1)

WIND Productos relacionados con el viento.

Por ejemplo, V, VVP, WIND y SHEAR.

1) En sistemas de doble polarización, utilice el algoritmo R (Z, KDP) para productos QPE, como tasa de precipitación o
acumulación.

Figura 121 Programador de productos predeterminado
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Garantía
Para obtener nuestros términos y condiciones estándar de garantía, consulte www.vaisala.com/warranty.

Tenga presente que dicha garantía puede perder su validez en caso de daño debido al desgaste normal, a
condiciones de operación excepcionales, a manipulación o instalación negligente, o a modificaciones no
autorizadas. Para conocer los detalles de la garantía de cada producto, consulte el contrato de suministro o
las condiciones de venta correspondientes.

Soporte técnico

Comuníquese con el soporte técnico de Vaisala en helpdesk@vaisala.com. Proporcione, al
menos, la siguiente información complementaria, según corresponda:

• Nombre del producto, modelo y número de serie
• Versión de software y firmware
• Nombre y ubicación del lugar de instalación
• Nombre e información de contacto del técnico que pueda proporcionar más

información sobre el problema

Para obtener más información, consulte el www.vaisala.com/support.

Reciclaje

Recicle todo el material aplicable de acuerdo con las normativas locales.
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